CE and LC taken to the next level - consolidating expertise for more powerful separations

Liquid chromatography (LC) and capillary electrophoresis (CE) are among the most powerful tools available to scientists today. AB SCIEX is expanding the power of these technologies by combining the nano and micro liquid chromatography expertise of our Eksigent solutions and the microscale separation expertise from Beckman Coulter Life Sciences, to create the business unit known as SCIEX Separations.

The goal, to create a new generation of separation systems and techniques that incorporate nano LC, micro LC, analytical flow LC, CE, and MS in new and more innovative ways. Our advances in these areas will lead to complementary and orthogonal solutions that will help drive breakthroughs by enabling scientists to address a wider range of analytical challenges.

SCIEX Separations. Be part of it.

For contact details and additional information please visit: http://www.sciex.com/ce
Fourth Revision, A29142AD, August 2014
AB SCIEX branding boiler copy added to Front Cover and Back page.
AB SCIEX consolidation with Beckman Coulter insert added for SCIEX Separations.
Beckman Coulter changed to AB SCIEX in some instances except for Cover, Copyright, SCIEX Separations insert, and Revision History pages.
Numerous changes made throughout the manual due to the GeXP software being updated to work with Windows 7.
Safety Information

This section provides safety information and instructions for the hardware and accessories of the system. It includes the following topics:

- "Safety Symbols" on page vi
- "Chemical and Biological Safety" on page vii
- "Electrical Safety" on page vii
- "Moving Parts" on page viii
- "Laser Safety" on page viii

Notes and Warnings

The following information describes the notes and warnings used in this document.

NOTE Contains supplemental or explanatory information concerning the current topic or procedural step.

IMPORTANT Used whenever an action or circumstance may potentially cause personal injury. Mechanical damage may also result. Also can contain information about a possible software program failure, draw attention to a specific software setting or point out that a loss of data may occur if information stated within the paragraph is not adhered to or if procedures are executed incorrectly.

CAUTION Used to prevent equipment damage. To disregard that caution may cause mechanical damage, however, personal injury is not likely.

WARNING If the equipment is used in a manner not specified by AB SCIEX, the protection provided by the equipment may be impaired.
### Safety Symbols

The symbols displayed below and on the instrument should remind you to read and understand all safety instructions before attempting installation, operation, maintenance, or repair to this instrument.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚡</td>
<td>HIGH VOLTAGE Paragraphs marked by this symbol indicate that a potential hazard to your personal safety exists from a high voltage source.</td>
</tr>
<tr>
<td>⚠️</td>
<td>ATTENTION SAFETY SYMBOL This symbol calls attention to important information to read, or is accompanied by another symbol indicating a particular safety hazard. The information is located either on the label with the symbol or in the GeXP documentation.</td>
</tr>
<tr>
<td>⚠️ <img src="image" alt="Biohazard" /></td>
<td>BIOHAZARD Paragraphs marked by this symbol indicate that a potential hazard to your personal safety exists from a biological source.</td>
</tr>
<tr>
<td>⚠️ <img src="image" alt="Laser" /></td>
<td>LASER LIGHT Paragraphs marked by this symbol indicate that a potential hazard to your personal safety exists from a laser source.</td>
</tr>
<tr>
<td>⚠️ <img src="image" alt="Caution" /></td>
<td>CAUTION SHARP OBJECTS Paragraphs marked by this symbol indicate that a potential hazard to your personal safety exists from unblunted corners or other appendages on the outside or inside of the equipment.</td>
</tr>
<tr>
<td>⚠️ <img src="image" alt="Notice" /></td>
<td>HOT SURFACE Paragraphs marked by this symbol indicate that a potential hazard to your personal safety exists from heated surfaces or other appendages on the outside or inside of the equipment.</td>
</tr>
<tr>
<td><img src="image" alt="Protective Earth" /></td>
<td>PROTECTIVE EARTH OR GROUND TERMINAL This symbol identifies the location of the protective earth or ground terminal plug on the equipment.</td>
</tr>
<tr>
<td><img src="image" alt="Off Position" /></td>
<td>OFF POSITION OF PRINCIPAL POWER SWITCH This symbol graphically represents the equipment main power push-button switch when it is in the off position.</td>
</tr>
</tbody>
</table>
Safety Information

Chemical and Biological Safety

**WARNING** Normal operation of the system can involve the use of solvents and reagents that are toxic, flammable, or biologically harmful.

- Observe all precautionary information printed on the original solution containers.
- Operate the system in the appropriate environment.
- Take all necessary precautions when using pathology or toxic materials to prevent the generation of aerosols.
- Observe all applicable precautionary procedures when using flammable solvents in or near the instrument.
- Wear appropriate laboratory attire, for example, safety glasses, gloves, lab coat and breathing apparatus, when working with hazardous materials.
- Dispose of all waste solutions in a proper manner.

Electrical Safety

To reduce risk of electrical shock, all devices employ a three-wire electrical cable and plug to connect the equipment to earth ground.

- Ensure that the wall outlet receptacle is properly wired and earth grounded.
- **DO NOT** use a three-to-two wire plug adapter.
- **DO NOT** use a two-wire extension cord or a two-wire multiple-outlet power strip.
- Disconnect power to the system before performing maintenance.
- **DO NOT** remove any panels; panels should be removed only by qualified service personnel.

**WARNING** A high voltage power supply is used with this instrument. Safety interlocks disable high-voltage output while the capillary access cover is open and remove the risk of shock while performing routine instrument functions. However, removal of any panel may expose an individual to the possibility of severe electrical shock and/or mechanical injury. For this reason, any service requiring removal of a panel or otherwise overriding or disabling safety interlocks must be done by AB SCIEX personnel only.
Moving Parts
Moving parts are limited to the sample handling system. Plate movement is safety interlocked through the sample access cover. To avoid injury due to moving parts, observe the following:

- Keep loose clothing and hair away from the plate area.
- Never attempt to physically restrict movement of the plate assembly.

Laser Safety

| WARNING | The GenomeLab Instrument uses a “Class 3B” laser. The “3B” classification means that “direct intrabeam viewing of this type of laser is always hazardous to personnel.”

The laser and several other integral components are housed in a sealed container that together comprise the laser assembly. The laser assembly has no user serviceable parts. Service of the laser assembly is restricted to certified AB SCIEX field engineers.

During normal operation of the system, laser light is not accessible to the user. Therefore, the overall laser classification of the CE Instrument is “Class 1,” defined as “lasers which are safe under reasonably foreseeable conditions of operation.”

To prevent users from potentially harmful laser light, observe all safety warnings (see Figure 1 for label locations) and NEVER REMOVE THE OUTER CASING OF THE LASER ASSEMBLY. |
Figure 1 Laser Label Locations

1. Capillary Access Cover (extended)   2. Laser Assembly Cover
System Operation and Electromagnetic Interference

NOTE The following information addresses the EMI effect on system performance and provides recommended mitigations.

Under the test conditions specified by the European normative electromagnetic compatibility standard EN 61326-1, the instrument may exhibit temporary degradations in performance in accordance with the table below.

Because the environmental circumstances contributing to the problem can vary, several different mitigation techniques have been provided that should help eliminate or reduce the interference.

Troubleshooting Performance

<table>
<thead>
<tr>
<th>Test Condition</th>
<th>Effect on Performance</th>
<th>Mitigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radio Frequency Field Interference (RFI) System exposed</td>
<td>May cause temporary degradation of data accuracy. In some cases, significant noise may</td>
<td>• Always run duplicates and controls.</td>
</tr>
<tr>
<td>to electromagnetic field strengths of greater than or</td>
<td>appear in the measured results. Separation data will return to normal performance</td>
<td>• Evaluate peaks carefully for anomalous results.</td>
</tr>
<tr>
<td>equal to 3 V / m at multiple frequency bands.</td>
<td>once exposure is removed.</td>
<td>• Re-run sample.</td>
</tr>
<tr>
<td></td>
<td>May cause temporary loss of capillary temperature control resulting in lower than</td>
<td>• Move location of the product by several meters.</td>
</tr>
<tr>
<td></td>
<td>expected capillary temperature. The system logs the effect in the run log. It will</td>
<td>• Change the orientation of the equipment by 90 degrees.</td>
</tr>
<tr>
<td></td>
<td>return to normal performance once exposure is removed.</td>
<td>• Avoid using transmitters or cellular phones within 1 meter of the equipment.</td>
</tr>
<tr>
<td></td>
<td>May cause temporary loss of capillary temperature control resulting in run not being</td>
<td>• Review the temperatures in the run log for any anomalies and re-run as necessary.</td>
</tr>
<tr>
<td></td>
<td>initiated because temperature cannot reach desired level.</td>
<td></td>
</tr>
</tbody>
</table>

Disposal and Recycling

It is important to understand and follow all laws regarding the safe and proper disposal of electrical instrumentation. The symbol of a crossed-out wheeled bin on the product is required in accordance with the Waste Electrical and Electronic Equipment (WEEE) Directive of the European Union. The presence of this marking on the product indicates that the device:

• was put on the European Market after August 13, 2005.
• is not to be disposed via the municipal waste collection system of any member state of the European Union.

For products under the requirement of WEEE directive, please contact your dealer or local AB SCIEX office for the proper decontamination information and take-back program, which will facilitate the proper collection, treatment, recovery, recycling, and safe disposal of the device.
Table of Contents

Safety Information ............................................................... v
  Notes and Warnings ........................................................... v
  System Operation and Electromagnetic Interference ......................... x
  Disposal and Recycling ......................................................... x

Foreword ................................................................................. 1
  About this Guide ................................................................. 1
  Technical Support ................................................................. 2

Section 1 Getting Started ....................................................... 3
  1.1 System Overview ............................................................. 3
    Purpose of this System ......................................................... 3
    Functional Description ....................................................... 3
  1.2 Operating the System ....................................................... 14
    Preparing a Sample ............................................................ 14
    Starting-Up the System ........................................................ 14
    Creating a Database and Project Folder .................................. 15
    Setting up a Sample ........................................................... 15
    Running a Sample ............................................................. 16

Section 2 Sample Setup Module ............................................... 21
  2.1 Overview ......................................................................... 21
    Using the Main Window ....................................................... 21
    Menu Bar Options ............................................................... 24
    Toolbar Icons ..................................................................... 29
  2.2 Using the Sample Setup Module ........................................ 30
    Opening a Sample Plate ....................................................... 30
    Creating a New Sample Plate ............................................... 30
    Opening a Sample Plate ....................................................... 31
    Creating a New Sample Plate ............................................... 32
    Selecting Samples ............................................................. 32
    Using Property Sets ............................................................ 37
    Using Methods .................................................................... 39
    Defining Data Processing Conditions .................................... 41
    Printing the Plate Report or Specifying Sample Plate Print Options .. 42
    Specifying Sample Plate Export Options ................................ 43
    Export Options .................................................................... 43
    Export Options - Sequencing Results .................................... 44
    Importing Sample Plate Information from TXT Files .................. 44
    Exporting Sample Plate Data ................................................ 46
    Locking a Sample Plate ....................................................... 46
    Viewing the Summary ......................................................... 46
## Section 5  Sequence Investigator Module  .................................................. 171

5.1 Sequence Investigator Module Overview .................................................. 171
   Main Window .................................................................................. 171
   Menu Bar Options ......................................................................... 173
   Toolbar Icons ................................................................................... 177

5.2 Sequence Investigator Procedures ......................................................... 179
   Creating a Reference File ................................................................. 179
   Selecting a Reference and Sequence Results .................................. 180
   Numbering ....................................................................................... 182
   Viewing Reference Amino Acid Translations .................................. 182
   Viewing Sequence Traces ................................................................. 182
   Viewing Consensus Amino Acid Translations .................................. 183
   Printing Reports .............................................................................. 187
   Exporting the Sequence .................................................................... 187
   Saving the Data ................................................................................ 188

## Section 6  Fragment Analysis Module ............................................................ 189

6.1 Fragment Analysis Module Overview ....................................................... 189
   Main Window ................................................................................... 190
   Menu Bar Options ............................................................................ 191
   Toolbar Icons .................................................................................. 196

6.2 Fragment Analysis Procedures ................................................................. 198
   Performance Safeguards .................................................................. 198

6.3 Working with Studies in the Fragment Analysis Module ......................... 199
   Selecting the Components of the New Study ..................................... 200
   Selecting Raw Data for the New Study .............................................. 201
   Selecting an Analysis Parameter Set .................................................. 203
   Analyzing the Data .......................................................................... 204
   Selecting Additional Results to add to the Study ................................. 205

6.4 Defining Fragment Analysis Parameters .................................................. 206
   General Tab ....................................................................................... 207
   Analysis Method Tab ......................................................................... 208
   Quantitation Tab .............................................................................. 211
   STR Locus Tags Tab ......................................................................... 212
   SNP Locus Tags Tab ......................................................................... 214
   Advanced Tab ................................................................................... 216

6.5 Using the STR Locus Tag Editor ............................................................... 218
   Locus Tab ......................................................................................... 218
   Allele ID Criteria ............................................................................. 221

6.6 Using the SNP Locus Tag Editor ............................................................... 225
   Result Set Filtering ........................................................................... 226
   Accessing the Result Set View ........................................................... 227
   Applying Exclusion Filters to the Result Set Data ............................... 228
   Finding Exclusion Filters ................................................................... 228
   Viewing the Summary ...................................................................... 229
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customizing the Result Set View</td>
<td>229</td>
</tr>
<tr>
<td>Viewing Electropherogram Data</td>
<td>229</td>
</tr>
<tr>
<td>Re-Analyzing Results</td>
<td>234</td>
</tr>
<tr>
<td>6.7 Using Fragment Lists</td>
<td>237</td>
</tr>
<tr>
<td>Accessing the Fragment List View</td>
<td>237</td>
</tr>
<tr>
<td>Applying Exclusion Filters to the Fragment List</td>
<td>238</td>
</tr>
<tr>
<td>Available Exclusion Filters</td>
<td>238</td>
</tr>
<tr>
<td>Customizing the Fragment List</td>
<td>238</td>
</tr>
<tr>
<td>Manually Selecting Peaks for the Fragment List</td>
<td>238</td>
</tr>
<tr>
<td>Exporting a Fragment List to CSV File</td>
<td>238</td>
</tr>
<tr>
<td>Showing a Stacked Graph</td>
<td>239</td>
</tr>
<tr>
<td>Including, Excluding &amp; Resetting Peaks in the Fragment List</td>
<td>239</td>
</tr>
<tr>
<td>6.8 Performing Bin Analysis</td>
<td>239</td>
</tr>
<tr>
<td>Setting up a Bin Analysis</td>
<td>239</td>
</tr>
<tr>
<td>Defining Parameters</td>
<td>240</td>
</tr>
<tr>
<td>Viewing Bin Analysis</td>
<td>241</td>
</tr>
<tr>
<td>Investigating Points</td>
<td>242</td>
</tr>
<tr>
<td>Updating the Locus Tag and Allele List</td>
<td>243</td>
</tr>
<tr>
<td>Reviewing the Source Data</td>
<td>244</td>
</tr>
<tr>
<td>6.9 Calculating Peak Ratios</td>
<td>245</td>
</tr>
<tr>
<td>Beginning a Peak Ratio Calculation</td>
<td>245</td>
</tr>
<tr>
<td>Selecting a Reference Trace</td>
<td>247</td>
</tr>
<tr>
<td>Selecting a Reference Peak</td>
<td>247</td>
</tr>
<tr>
<td>Selecting a Test Peak</td>
<td>248</td>
</tr>
<tr>
<td>6.10 Performing AFLP Analysis</td>
<td>248</td>
</tr>
<tr>
<td>Using the AFLP Feature</td>
<td>248</td>
</tr>
<tr>
<td>Setting the AFLP Analysis Parameters</td>
<td>249</td>
</tr>
<tr>
<td>Starting a New AFLP Analysis</td>
<td>250</td>
</tr>
<tr>
<td>Viewing the Cluster Analysis</td>
<td>250</td>
</tr>
<tr>
<td>Setting Cluster Analysis Parameters</td>
<td>251</td>
</tr>
<tr>
<td>Customizing the AFLP Table</td>
<td>252</td>
</tr>
<tr>
<td>Exporting the AFLP Analysis Results</td>
<td>252</td>
</tr>
<tr>
<td>6.11 Performing LOH Analysis</td>
<td>252</td>
</tr>
<tr>
<td>6.12 Customizing the Results List</td>
<td>254</td>
</tr>
<tr>
<td>Selecting Columns for Display</td>
<td>254</td>
</tr>
<tr>
<td>Sorting the Results List</td>
<td>255</td>
</tr>
<tr>
<td>6.13 Reporting Results</td>
<td>257</td>
</tr>
<tr>
<td>Using Report Templates</td>
<td>258</td>
</tr>
<tr>
<td>Editing Graph Displays</td>
<td>259</td>
</tr>
<tr>
<td>6.14 Exporting Results</td>
<td>262</td>
</tr>
<tr>
<td>Text File Format</td>
<td>264</td>
</tr>
<tr>
<td>CEQ File Format</td>
<td>265</td>
</tr>
<tr>
<td>Exporting Fragment Lists or Genotypes from a Study</td>
<td>265</td>
</tr>
<tr>
<td>Transferring Fragment Data to GeXP Data Tool</td>
<td>266</td>
</tr>
</tbody>
</table>
Section 7  Gene Expression ................................................. 271
  7.1 Gene Expression Overview ........................................ 271
  7.2 Multiplex Primer Design using NCBI Primer-BLAST .......... 273
    Pre-Design Considerations ....................................... 273
    Primer Design using NCBI Primer-BLAST ....................... 274
    Assemble a Multiplex ............................................ 275
    Evaluating Primer and Amplicon Sequences using NCBI BLAST Searches ........................................ 276
  7.3 Run Samples and Review Results in Fragment Analysis Result Set View .... 277
    Prepare The GeXP System Before The Sample Run ............. 277
    Create A New Study ............................................. 278
    Review Data in Result Set View ................................ 279
  7.4 Set-up Locus Tag and Allele IDs ............................... 282
  7.5 Apply Exclusion Filter and Export Fragment Results ....... 293
    Apply Exclusion Filter .......................................... 293
    Export Fragment Results ....................................... 293
  7.6 GeXP Data Tool .................................................... 295
    Downloading GeXP Data Tool .................................... 295
    Launching GeXP Data Tool ....................................... 295
    GeXP Data Tool Applications .................................... 295
    Loading Additional Sample Data Files .......................... 301
    Additional Features of the GeXP Data Tool .................... 302
    Calculation and Formulas ....................................... 303
    Error Messages ................................................... 303
  7.7 GeXP Quant Tool .................................................. 305
    Downloading GeXP Quant Tool ................................... 305
    Launching GeXP Quant Tool ..................................... 305
    Performing Quantitative Analysis with GeXP Quant Tool .... 306
    Performing Fold Change Calculation ............................ 313

Section 8  Database Management ........................................ 315
  8.1 Data Manager Module Overview .................................. 315
    Main Window ....................................................... 316
    Menu Bar Options ................................................ 316
    Toolbar Icons .................................................... 321
  8.2 Data Manager Procedures ........................................ 323
    Storing Methods and Parameters ................................ 323
    Creating a Database .............................................. 323
    Setting the Working Database .................................. 324
    Creating and Naming a Project ................................ 324
    Deleting a Project or Database .................................. 324
    Renaming a Project or Database: ................................ 324
    Checking the Database Size ...................................... 325
    Reducing the Database Size ..................................... 325
    Backing Up a Database .......................................... 326
    Restoring the Database ......................................... 327
Section 9 Maintenance and Diagnostics ........................................ 339

9.1 Routine Maintenance .................................................. 339
   Cleaning the Capillary Array ........................................ 340
   Replacing the Gel Waste Bottle For Dual Rail System ............ 345
   Replacing the Gel Waste Bottle For Single Rail System .......... 346
   Replacing the Wetting Tray ......................................... 347

9.2 Direct Control and Replenishment .................................. 349
   Accessing the Direct Control Window ............................... 349
   Loading the Sample Plate and Buffer Plate For Dual Rail System 350
   Loading the Sample Plate and Buffer Plate For Single Rail System 353
   Specifying Capillary Temperature ................................ 356
   Denaturing a Sample .................................................. 356
   Injecting a Sample ................................................... 356
   Performing a Separation ............................................. 357
   Replenishing the Capillaries with Gel. ......................... 357
   Purging the Manifold ............................................... 358
   Performing an Optical Alignment ................................. 358
   Viewing Capillary Information .................................. 358
   Viewing Gel Information .......................................... 360
   Viewing or Changing Buffer Information ........................ 360
   Removing and Replacing the Capillary Array ..................... 360
   Removing and Replacing a Gel Cartridge/Gel Pump Plug For Dual Rail System 367
   Removing and Replacing a Gel Cartridge/Gel Pump Plug For Single Rail System 371
   Removing the Manifold Plug ...................................... 374

9.3 Biological Waste Disposal ........................................... 376
   Disposal of Formamide from the Sample Plate .................. 376
   Disposal of Buffer/Gel Mixture from the Buffer Plate ........... 377
   Disposal of the Capillary Array ................................... 378
   Disposal of the Gel Cartridge .................................... 378
   Disposal of D.I. Water/Gel Mixture from the Wetting Tray ...... 378
   Disposal of the Gel Waste Bottle ................................. 379

9.4 Consumable Items List ................................................ 380

9.5 Diagnostics ............................................................. 385
   Re-Initializing the System .......................................... 385
   Homing the Plates and/or Gel Pump ............................ 385
   Viewing PC Settings ............................................... 385
   Viewing Instrument Status ....................................... 385
   Viewing Optical Scan Data ...................................... 385
   Monitoring the Baseline .......................................... 386
About this Guide

This guide is intended for use with the GenomeLab Genetic Analysis System (referred to as the “CE system” in this guide). This guide is divided into the following sections:

- **“Foreword,”** this section, describes the purpose of this guide, provides a list of its contents, discusses the use of the notes used in the document, tells how to get online Help, and provides service contact information.
- **“Getting Started,”** discusses the purpose and functional description of the system, provides an overview of the three main components (chemistry, hardware, and software) comprising the system, and details the safety features relevant to the system. It also provides step-by-step procedures for operating the system.
- **“Sample Setup Module,”** provides an overview of the module, including its menu options, toolbars, and dialog boxes. It also shows you how to work with sample plates using this module, such as opening, setting up, exporting, and importing sample plates.
- **“Run Module,”** provides an overview of the Run module, including its menu options, toolbars, and dialog boxes. It also shows you how to run sample plates and set the display options using this module.
- **“Sequence Analysis,”** provides an overview of the module, including its menu options, toolbars, and dialog boxes. It shows you how to use this module to run a sequence analysis, and to set up its parameters, result properties, and display options. It also describes how to work with, report, and export sequence analysis results.
- **“Sequence Investigator Module,”** provides an overview of the module, including its menu options, toolbars, and dialog boxes. It also shows you how to use this module to investigate and compare sequence analysis results.
- **“Fragment Analysis Module,”** provides an overview of the module, including its menu options, toolbars, and dialog boxes. It shows you how to use this module to work with Studies, to run a fragment analysis, and to set up its parameters, result properties, and display options. It also describes how to work with, report, and export fragment analysis results.
- **“Gene Expression,”** describes how to use the GenomeLab GeXP Genetic Analysis System and the associated softwares to perform gene expressing analysis.
- **“Database Management,”** provides an overview of the module, including its menu options, toolbars, and dialog boxes. It provides procedures for database activities, such as setting up and managing databases, exporting/importing data, and managing user accounts.
- **“Maintenance and Diagnostics,”** provides routine maintenance, replenishment, diagnostic, and biological waste disposal procedures. It also lists the consumable materials used in the system.
Technical Support

If you encounter a problem that is not discussed in this guide and you need technical support, contact your local dealer, the provider of this product, or contact AB SCIEX directly using the information below.

**NOTE** Whenever you call your local dealer or AB SCIEX, be sure to have your registration material, instrument serial number, and software version number available. For future reference, record this information here.

---

**Instrument Serial Number:**

**Software Version:**

**Firmware Version:**

**Dealer Name:**

**Dealer Phone Number:**

---

**Mail**

SCIEX Headquarters  
500 Old Connecticut Path  
Framingham, MA 01701  
U.S.A.

**Customer Technical Service**

Support in the United States  
1 877-740-2129

Support in All Other Countries  
[www.sciex.com](http://www.sciex.com)
This chapter discusses the purpose and functional description of the system, provides an overview of the three main components (chemistry, hardware, and software) comprising the system, and details the safety features relevant to the system. It also provides step-by-step procedures for operating the system.

1.1 System Overview

This section describes the purpose and function of the CE system, provides an overview of the main components comprising the system, and details the safety features relevant to the system.

Purpose of this System

The purpose of the Capillary Electrophoretic (CE) Genetic Analysis System is two-fold:

- To determine the nucleotide sequence of any given DNA sample
- To estimate sizes of DNA fragments

Functional Description

The GenomeLab Genetic Analysis System is fully automated and capable of determining the base sequence and fragment length of DNA samples that have been prepared with Beckman Coulter, Inc. dye-labeled reagents. Four-color, dye-labeled terminator chemistry kits are used to process samples for base sequence analysis. Generation of samples for fragment length analysis is performed using one of two techniques:

- dye-labeled primers for micro-satellite, gene expression AFLP and other similar applications
- four-color dye-labeled terminator chemistry, for the single nucleotide polymorphism application

The dual rail CE system incorporates two plate holders and accepts two 96-well plates at one time. Each row of eight samples (sample set), containing labeled DNA fragments, is automatically denatured and then separated by capillary electrophoresis. The separation gel is automatically replaced in the eight capillaries after each separation. The separation gel supply is an easily replaced cartridge with a capacity sufficient for two full microplates.

The instrument performs detection using laser-induced fluorescence in four spectral channels. It automatically processes the four-channel raw data sets generated by each of the eight capillaries to produce high-quality base sequences or fragment lists after separation.

Raw and analyzed data are stored in a database and may also be exported in file formats compatible with common analysis applications.
Hardware

The hardware performs sample handling as well as tasks associated with the separation and detection phases of electrophoresis.

Figure 1.1 shows the GenomeLab instrument. The following sections describe the GenomeLab instrument's user-accessible hardware components.

Figure 1.1 Instrument Hardware Overview

1. Sample Access Cover (extended) 7. Manifold Access Cover
2. Capillary Access Cover (extended) 8. Gel Waste Bottle
4. Plate Holders/Sample Transport 10. Gel Pump
5. Capillary Temperature Control Cover 11. Gel Pump/Gel Cartridge Access Cover
6. Rubber Latches
**Sample Access Cover**
Provides access to the buffer plate, wetting tray, and sample plate.

**Capillary Access Cover**
Provides access to the capillary array through the capillary temperature control cover.

**Capillary Temperature Control Cover**
Provides an enclosed environment for the capillary temperature control and allows access to the capillary array.

**Capillary Array**
Used to produce raw data for sequencing and fragment analysis is 33 centimeters in length, and has an i.d. of 75 micrometers. The capillary array (Figure 1.2) has three components: electrode block (inlet), eight capillaries, and the array fitting (outlet).

The electrode block is the DNA sample inlet side of the array. It holds eight hollow, stainless-steel electrodes. Each stainless-steel electrode holds a capillary in the center. These electrodes are designed for immersion into an entire row (8 wells) of a 96-well microplate (8-rows x 12-columns).

The capillaries pass through and exit the array fitting. When the fitting is installed, the ends of the capillaries are inserted into the gel/buffer manifold reservoir.

The array fitting contains the detection window and is the outlet side of the array. The detection window of the fitting exposes the eight capillaries to laser excitation. The external polyimide coating of the capillaries has been removed for this purpose.

**NOTE** When the capillary array is not installed (for example, during shipping and storage), the manifold plug is inserted into the manifold (array fitting outlet) to prevent any gel (inside of the CE system) from drying.

![Figure 1.2 Capillary Array](image)

1. Capillaries  
2. Electrode Block (inlet)  
3. Array Fitting (outlet)
Plenum
The CE system is supplied with a capillary heater plenum suitable for use with a 33 cm long capillary array. This short plenum assembly has a capillary array routing notch and a conical depression on the back as shown in Figure 1.3.

NOTE Refer to the caution label on the front of the plenum assembly for positive identification.

![Figure 1.3 Plenum Assembly (Back View)](image)

Sample Transport and Plate Holders
The Sample Transport (Figure 1.4) contains the plate holders used to hold the sample plate, the buffer plate with buffer evaporation cover, and the wetting tray.

![Figure 1.4 Sample Transport and Plate Holders](image)
Sample Plate
The sample plate (Figure 1.5) is used to hold the samples for separation. The plate is a V-bottom, thermal cycler-compatible, polypropylene plate containing 96 wells (8-rows x 12-columns). The wells have a 200 µL volume capacity.

![Sample Plate](image)

Figure 1.5 Sample Plate

Buffer Plate with Buffer Evaporation Cover
The buffer plate (Figure 1.6) holds the DNA separation buffer used during a sample run. The plate is a flat-bottom, polystyrene, non-sterile plate containing 96 wells. When placed over the buffer plate, an evaporation cover maintains the proper buffer level (250-300 µL) in the buffer plate by preventing the buffer from evaporating. The cover slips over the buffer plate position of the sample transport. As the CE system advances through the sample plate during a run, the instrument pushes the evaporation cover back far enough to expose the next row of buffer wells to use in the next sample set run.

![Buffer Evaporation Cover and Buffer Plate](image)

Figure 1.6 Buffer Evaporation Cover and Buffer Plate

1. Buffer Evaporation Cover
2. Buffer Plate

Wetting Tray
The wetting tray (Figure 1.7) is used to immerse the ends of the capillaries in deionized water. When properly filled, the capillaries can be maintained for approximately seven days in the wetting tray without attention. During continuous use of the CE system, the wetting tray should be replenished with deionized water after a 96-well microplate has been run or prior to a sample plate run.

The wetting tray is also used to rinse capillary tips and provide a receptacle for separation medium that was purged from the capillaries.
CAUTION No more than one 96-well plate should be processed for each wetting tray, without replenishing the Wetting Tray. For details, see "Replacing the Wetting Tray" on page 347.

Figure 1.7 Wetting Tray

Gel Waste Bottle
The gel waste bottle (Figure 1.8) is used to capture and store the waste gel that is pushed out of the manifold during the purge function. The bottle can hold the equivalent of 25 gel cartridges. To prevent overflow, observe the gel level in the waste bottle.

Figure 1.8 Gel Waste Bottle

Gel Pump/Gel Cartridge Access Cover
Provides access to the gel pump and gel cartridge.

Table 1.1 Gel Pump, Gel Cartridge, and Gel Pump Plug

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gel Pump</td>
<td>Used to replenish the capillaries with fresh gel (from the cartridge) after each sample set and two 96-well plate runs.</td>
</tr>
</tbody>
</table>
Table 1.1 Gel Pump, Gel Cartridge, and Gel Pump Plug

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gel Cartridge</td>
<td>Contains the fresh DNA separation gel. The separation gel is used for both Sequence and Fragment Analysis. As an example, the 20 ml gel cartridge on the dual rail system is shown below in Figure 1.9.</td>
</tr>
<tr>
<td>Gel Pump Plug</td>
<td>When the gel cartridge is not installed (for example, during shipping and storage) the gel pump plug is inserted into the pump barrel to prevent gel from drying in the system.</td>
</tr>
</tbody>
</table>

Figure 1.9 Gel Pump

1. Gel Pump/Gel Cartridge Access Cover  4. Cartridge Locking Lever
2. Cartridge Locking Lever  5. Cartridge Barrel
3. Cartridge Barrel
**Status Indicator Lights**

There are three status indicators: PWR (power), LASER, and HV (high voltage), as shown in the figure below.

![Figure 1.10 CE System Location of Status Indicator Lights](image-url)

**Table 1.2 Status Indicator Lights**

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Green light is on when the CE system is powered on. The light is off when the CE system is powered off.</td>
</tr>
<tr>
<td>LASER</td>
<td>Green light is on when the lasers are turned on during a run. The light is off when the lasers are turned off.</td>
</tr>
<tr>
<td>HV</td>
<td>Green light is on when the high voltage is applied during the injection or separation. The light is off when the high voltage is turned off.</td>
</tr>
</tbody>
</table>
Software: User Interface

The software provides the interface for manual or automatic (pre-programmed) control of the system and for data capture and basic data analysis. Combine with sentence below.

The CE system provides a graphical user interface (GUI) that enables you to open programs and initiate commands by clicking buttons or selecting menu options. To open the Main Menu, double-click the CE system icon on your computer's desktop:

The Main Menu opens, as shown in the following example. To access a module, click its icon on the Main Menu, as described in "Software Module Descriptions" on page 12. After opening a software module, the Main Menu collapses, either to the Windows taskbar or as a shortcut toolbar, as described in "Main Menu Collapse Options" on page 13.

Figure 1.11 GenomeLab Genetic Analysis System Main Menu
Software Module Descriptions

The following table shows the shortcut icons available on the Main Menu and describes the module that opens when you click the corresponding shortcut icon.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Module Description</th>
</tr>
</thead>
</table>
| ![Sample Setup Module](#) | **Sample Setup Module**  
Create, save, and modify sample plates. Use sample plates to assign methods to control sample sets and determine the sequence of methods used to produce data. |
| ![Run Module](#) | **Run Module**  
Run sample plates and control individual functions of the instrument. |
| ![Sequence Analysis Module](#) | **Sequence Analysis Module**  
View, analyze, compare, manipulate, and print base sequence data produced by sample runs. |
| ![Sequence Investigator Module](#) | **Sequence Investigator Module**  
Compare sequences and create a consensus to compare against a reference. |
| ![Fragment Analysis Module](#) | **Fragment Analysis Module**  
View, analyze, compare, manipulate, and print fragment data produced by sample runs. |
| ![Data Manager Module](#) | **Data Manager Module**  
Modify and print database files |
| ![Exit](#) | **Exit**  
Closes the CE system software. |
Main Menu Collapse Options
After opening the Main Menu, you can set its collapse features using the pop-up menu. To do this, right-click the Main Menu’s title bar and select your option from the pop-up menu, as shown in the following illustration.

Figure 1.12 Main Menu Window Pop-Up Menu

The following table describes the collapse options.

Table 1.4 Main Menu Window Collapse Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collapse to Toolbar</td>
<td>Select this option to immediately collapse the Main Menu to display the Main Menu toolbar.</td>
</tr>
<tr>
<td>Always Collapse to Toolbar</td>
<td>Select this option (✓) to set the Main Menu to collapse to the Main Menu toolbar every time you open a software module from the Main Menu. Selecting Always Collapse to Toolbar makes it the default setting, instead of Always Collapse to Taskbar.</td>
</tr>
<tr>
<td>Always Collapse to Taskbar</td>
<td>Select this option (✓) to set the Main Menu to collapse to the Windows taskbar every time you open a software module from the Main Menu. Selecting Always Collapse to Taskbar makes it the default setting, instead of Always Collapse to Toolbar. From any application, you can access the Main Menu by left-clicking the Main Menu button, located on the Windows taskbar.</td>
</tr>
</tbody>
</table>

Main Menu Toolbar
Provides access to all CE system modules from any active application window. By default, the Main Menu toolbar provides a miniature version of software module icons as a horizontal toolbar, as shown in the following example.
To move the toolbar, click the title bar and hold the left mouse button while dragging the toolbar to another location. When given enough space, the toolbar becomes a two-column vertical toolbar, as shown in the following example.

The toolbar resizes to fit in any location in the active application window. To move the toolbar to a more convenient location, click the title bar and hold the left mouse button while dragging the toolbar to one of the four edges of the application's window.

The Main Menu toolbar icons are miniature versions of the ones provided in the expanded Main Menu. Clicking one of these icons opens the corresponding software module, as described “Software Module Descriptions” on page 12.

1.2 Operating the System

Perform the tasks involved in analyzing or managing samples and sample data.

Although the following procedures are independent from setting up and starting the system, perform the procedures below in the sequence provided.

Before you begin, confirm that the Capillary is ready for use. See "Removing and Replacing the Capillary Array" on page 360. Install a new Gel Waste Bottle. See "Replacing the Gel Waste Bottle For Dual Rail System" on page 345.

Preparing a Sample

Prepare a sample for sequence or fragment analysis in accordance with using the instructions contained in either the CE system DTCS or the Quick Start Chemistry Kits or the PCR Reagent manufacturers kit for Fragment Analysis.

Starting-Up the System

1. Turn on the PC and wait for Windows to start.
2. Turn on the instrument.
3. From the Windows desktop, select Start | Programs | GenomeLab System | Control Center. The instrument initializes and after several seconds displays the Main Menu.
Creating a Database and Project Folder

Opening the Data Manager Module

From the Main Menu, click on the DATABASE icon and verify that the Data Manager window is displayed.

Creating a Database

To create a database:

1. In the Data Manager window, select File | New Database. The New Database dialog box opens.
2. Enter the name for this new database.
3. Select Set as Working Database.
4. Click OK.

Creating and Naming a Project Folder

To create and name a project folder:

1. In the Data Manager window, highlight the database where the project will reside and select File | New.
2. Highlight the new project and select File | Rename.
3. Enter a descriptive name for this project and press Enter.
4. Select File | Exit to close the Data Manager module.

Setting up a Sample

To set up a sample:

1. From the Main Menu, click the SETUP icon and verify that the Sample Plate Selection dialog is displayed.
2. Select the Create a new sample plate radio button and click OK.
3. Set up the sample plates by naming the desired cells.
4. Add any associated notes or property information.
5. Select a method from the drop-down menu at the bottom of the sample set.
6. Select the appropriate analysis parameters (as well as report and export parameters, if needed).
7. Enter the barcode in the Barcode field.
8. Select File | Save As. Enter a name for the sample plate.
9. Select the project you just created from the Project Name drop-down menu and click OK.
Running a Sample

Starting the Run Module

From the Main Menu, click the Run icon and verify that the Run window is displayed.

Checking the Capillary Array

Check the capillary life and usage on the life tab and if necessary, perform the procedure "Removing and Replacing the Capillary Array" on page 360, and then return here.

Installing a Gel Cartridge

Check the gel life and usage on the life tab and if necessary, perform the procedure "Removing and Replacing a Gel Cartridge/Gel Pump Plug For Dual Rail System" on page 367, and then return here.

Installing the Gel Waste Bottle

If necessary, perform the procedure "Replacing the Gel Waste Bottle For Dual Rail System" on page 345, and then return here.

Preparing Plates for a Run

1. Load samples into the sample plate and cover with mineral oil.
2. Load buffer (250-300 µL) into the buffer plate.
3. Fill the wetting tray with D.I. water to the level indicator marker.

**IMPORTANT** No more than one 96-well plate should be processed, for each wetting tray, without replenishing the wetting tray.

**NOTE** Periodically check the liquid level in the wetting tray.

**CAUTION** NEVER allow the liquid level to rise into the eight cannula recesses of the wetting tray lid, nor drop below the fill level indicator line. The top surface of the wetting tray lid must remain clean and dry under any and all circumstances.
Starting the Sample Plate Run For Dual Rail System

1. Select **Run | Start Sample Plate**. The Sample Plate Run Confirmation dialog box is displayed.

![Sample Plate Run Confirmation Dialog Box](image)

**Figure 1.13 Sample Plate Run Confirmation Dialog Box**

2. Select the desired project on the appropriate side (left or right) for each prepared sample plate and click **OK**.

3. Click **Load Plates**. The Access Plates dialog box is displayed.

![Access Plates Dialog](image)

**Figure 1.14 Access Plates Dialog**

4. Click **Start** to continue.
5. Install the plate and select the **Plate Loaded** option for the Left and/or Right plate, if applicable, and then select the side to immerse the capillaries.

**NOTE** Prepare the new plates before proceeding. Once the capillaries have been exposed to air, you will have 15 minutes to load the plates.

![Figure 1.15 Capillaries Exposed Dialog Box](image)

6. Click **Load** to continue.

**NOTE** Refer to “Installing the Wetting Tray” on page 347, “Loading the Sample Plate” on page 350 and “Loading the Buffer Plate and Evaporation Cover” on page 351.

7. Click **Start** to begin the Run.

### Starting the Sample Plate Run For Single Rail System

1. Select **Run | Start Sample Plate** from the Run menu.

2. In the **Select Sample Plate To Run** dialog box (Figure 1.16), select the desired project and sample plate and click **OK**.

![Figure 1.16 Select Sample Plate To Run Dialog](image)
3. In the **Confirm Configuration** dialog box (Figure 1.17), verify the sample and buffer set locations.

![Figure 1.17 Confirm Configuration Dialog](image)

4. Click **Load Plates**. The dialog in Figure 1.18 will appear.

![Figure 1.18 Unload Plates Dialog](image)

5. Click **Unload**. The Capillaries Exposed dialog (Figure 1.19) will appear.
6. Install sample plate, buffer plate and wetting tray into their appropriate positions and click **Load**.

7. Click **Start** to begin the Run.
2.1 Overview

Create, save, and modify methods and sample plates. Methods consist of sequential events needed to perform a DNA separation. Sample plates provide a way to name and organize samples.

The sample plate definition contains the 96-well plate locations of the samples as well as the method assigned to each sample. The capillary array must run the same separation parameters across eight samples, one column at a time. Each column that contains samples is called a Sample Set. The separation parameters applied to each sample set are specified in the Method. Method parameters can be changed to create new methods.

Using the Main Window

The portions of the Sample Setup module’s main window are described in Table 2.1.
The following table describes the items called out in Figure 2.1.

### Table 2.1 Main Window, Sample Plate Module

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Title Bar - Shows the module name (Sample Setup) and the active sample plate DefaultSamplePlate.</td>
</tr>
<tr>
<td>B</td>
<td>Menu Bar - See &quot;Menu Bar Options&quot; on page 24.</td>
</tr>
<tr>
<td>C</td>
<td>Toolbar - See &quot;Toolbar Icons&quot; on page 29.</td>
</tr>
<tr>
<td>D</td>
<td>Legend - Shows the color coding information (Saved or Edited) of the individual cells.</td>
</tr>
<tr>
<td>E</td>
<td><strong>Sample Name</strong> and <strong>Subject ID</strong> of the currently active cell. The radio button toggles the sample plate cell labels between <strong>Sample Name</strong> and <strong>Subject ID</strong>. Use the <strong>Barcode</strong> field to enter the barcode for the current plate.</td>
</tr>
<tr>
<td>F</td>
<td>Sample Plate - Displays 96 cells that correspond to a 96-well sample plate. (Sample plate columns are numbered 1 through 12 and Rows are labeled A through H. This naming convention uniquely identifies each sample location.)</td>
</tr>
</tbody>
</table>
| G    | Currently active (selected) method. Use this drop-down list to select a pre-defined method to the corresponding samples in the column above. Selecting a method assigns it to all samples in a column (sample set).  
  - **Frag** methods are used for all fragment analysis applications other than SNP primer extension  
  - **LFR** method is used for long fast read sequencing on the 33 cm array  
  - **SNP** method is used for the SNP primer extension application |
| H    |  
  - **Note** tab - Displays the Note sub-window, that can be used to describe or apply a property set to single or multiple samples.  
  - **Method** tab - Displays the Method sub-window, that shows the parameters defined for the selected method and allows you to edit or create separation methods.  
  - **Analysis** tab - Display the Analysis sub-window, that can be used to:  
    - Enable or disable the automatic analysis mode  
    - Select and edit a Sequence Analysis or Fragment Analysis parameter set  
    - Enable or disable automatic report printing and edit print report options  
    - Enable or disable automatic exporting of data and change export options |
Editing Property Values
Attach information and a property set to the highlighted samples. This informational note will accompany the sample throughout its lifetime.

Use the **New Item**, **Delete**, **Move Item Up**, **Move Item Down**, and **Edit** icons to modify the property sets.

Figure 2.2  Note Sub-Window

Editing Sample Properties
Sort and remove sample properties.

1. To select a field in an existing property set, left-click the cell.
2. Next, use the **Tab** key to move your selection from cell to cell. The **Tab** key moves the focus from property to value and then to the next row and the arrow keys to move in the direction selected.
3. Press **Enter** to move the focus down the table one cell at a time, within the same column.
   - To select an entire column for sorting, click its header. The selected column is highlighted.
   - To select a row, click its number. As with the column selection, the selected row is highlighted.
   - To select consecutive rows, left-click and drag the cursor through the blocks. Click the toolbar arrow buttons to move the row up or down one cell.
   - To delete the contents of the rows, select the desired rows and click **Delete**. A warning message appears, prompting you to confirm deletion. Click **Yes** to delete the contents or **No** to return to the editor.

Viewing the Method Tab
The Method sub-window displays the parameters of the method for the selected samples. Click the **Edit** button to modify one or all of the parameters of the existing method or to create a new method.

Figure 2.3  Sample Setup Method Sub-Window
Using the Analysis Tab

Enable or disable the **Perform Analysis** mode. When enabled (✓), this mode causes the CE system to analyze the sample at the end of the run. Set the **Perform Analysis** option for each sample separately, row/column, or entire plate.

1. Select the desired **Analysis Parameter Set** for each sample from the drop-down list.
2. Select each sample separately, row/column or entire plate.
3. Enable or disable automatic printing of reports and/or edit the print report parameters.
4. Select **Edit Print Format For Plate**. The Report Format dialog box appears, showing the current report settings for the sample plate. The Print Format applies to all samples. Print Report applies to individual samples.
5. Enable/disable automatic exporting of data and/or change export options.
6. Click **Edit Export Options For Plate**. The Export dialog appears, showing the current settings for the sample plate. The Export Format applies to all samples. Export Report applies to individual samples.

**NOTE** New Sequence or Fragment Analysis Parameters must be created in their respective analysis modules.

---

**Figure 2.4 Sample Setup Analysis Tab**

**Menu Bar Options**

The following example shows the Sample Setup menu bar options.
The following topics describe each of these menus and their options.

**File Menu**

Click the File menu to display its drop-down menu, as shown in the following example.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Opens an empty sample plate.</td>
</tr>
<tr>
<td>Open</td>
<td>Select an existing sample plate to open.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the selected sample plate.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current sample plate.</td>
</tr>
<tr>
<td>Save As</td>
<td>Save the sample plate with a new name.</td>
</tr>
<tr>
<td>Import</td>
<td>Import a sample plate (tab-delimited ASCII text [<em>TXT</em>] format).</td>
</tr>
<tr>
<td>Export</td>
<td>Export a sample plate (tab-delimited ASCII text [<em>TXT</em>] format).</td>
</tr>
<tr>
<td>Properties</td>
<td>Provides an information window concerning the active sample plate.</td>
</tr>
<tr>
<td>Default Report Format</td>
<td>Define the report formats for new and imported sample plates.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a facsimile of a hardcopy printout of the active sample plate.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Define printer properties.</td>
</tr>
<tr>
<td>Print</td>
<td>Displays a sub-menu from which you can choose to print a detailed report of the active sample plate, the contents of the sample plate, the plate summary, or the selected method.</td>
</tr>
<tr>
<td>Print Screen</td>
<td>Displays a sub-menu from which you can choose to print an image of the computer desktop or application window to the printer.</td>
</tr>
</tbody>
</table>
Sample Setup Module
Overview

Table 2.2 Edit Menu, Sample Setup Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Use to undo the last action performed.</td>
</tr>
<tr>
<td>Redo</td>
<td>Use to redo the last undo action.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Empties all cell properties in the active sample plate.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all cells in the sample plate.</td>
</tr>
<tr>
<td>Cut</td>
<td>Deletes text in one or more cells of the sample plate and copies it to the clipboard. You can then paste the cut text into different cells.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies text or the applied properties selected from one or more cells of the sample plate. You can then paste the cut text into different cells.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts copied or cut items at the cursor insertion point.</td>
</tr>
<tr>
<td>Find</td>
<td>Opens the Find dialog box, which you can use to search for text within the sample name entered in a sample plate.</td>
</tr>
<tr>
<td>Replace</td>
<td>Opens the Replace dialog box, which you can use to search and replace text within the sample names entered in a sample plate.</td>
</tr>
</tbody>
</table>

Perform the standard editing operations: cut, copy, paste, find, and replace. It also provides an option for modifying previously defined parameters of a method contained in the active sample plate.

The following table describes the Sample Setup module's Edit menu options.

Table 2.3 Edit Menu, Sample Setup Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Use to undo the last action performed.</td>
</tr>
<tr>
<td>Redo</td>
<td>Use to redo the last undo action.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Empties all cell properties in the active sample plate.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all cells in the sample plate.</td>
</tr>
<tr>
<td>Cut</td>
<td>Deletes text in one or more cells of the sample plate and copies it to the clipboard. You can then paste the cut text into different cells.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies text or the applied properties selected from one or more cells of the sample plate. You can then paste the cut text into different cells.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts copied or cut items at the cursor insertion point.</td>
</tr>
<tr>
<td>Find</td>
<td>Opens the Find dialog box, which you can use to search for text within the sample name entered in a sample plate.</td>
</tr>
<tr>
<td>Replace</td>
<td>Opens the Replace dialog box, which you can use to search and replace text within the sample names entered in a sample plate.</td>
</tr>
</tbody>
</table>
View Menu
Click the View menu to display its drop-down menu, as shown in the following example.

Activate or deactivate window display options. The following table describes the Sample Setup module’s View menu options.

Table 2.4 View Menu, Sample Setup Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Toggles between displaying/not displaying the toolbar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Toggles between displaying/not displaying the status bar.</td>
</tr>
<tr>
<td>Cell Coordinates</td>
<td>Toggles between displaying/not displaying the coordinates of the plate cells.</td>
</tr>
<tr>
<td>Sample Property Sets</td>
<td>Create, delete, or modify the property set.</td>
</tr>
<tr>
<td>Summary</td>
<td>Displays a summary of the currently selected plate.</td>
</tr>
<tr>
<td>View by Subject ID</td>
<td>Toggles the sample plate cell labels between Sample Name and Subject ID.</td>
</tr>
<tr>
<td>Working Database</td>
<td>Displays a dialog box showing the database in use.</td>
</tr>
</tbody>
</table>

Run Menu
Click the View menu to display its drop-down menu, as shown in the following example.

This menu provides one option.

Table 2.5 Run Menu, Sample Setup Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Invokes the Run module and loads the active sample plate.</td>
</tr>
</tbody>
</table>
Window Menu
Click the Window menu to display its drop-down menu, as shown in the following example.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>Toggles between open sample plates.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the active sample plate or sample plate summary.</td>
</tr>
</tbody>
</table>

The following table describes the Sample Setup module's Window menu options.

Table 2.6 Window Menu, Sample Setup Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>Toggles between open sample plates.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the active sample plate or sample plate summary.</td>
</tr>
</tbody>
</table>

Help Menu
Click the Help menu to display its drop-down menu, as shown in the following example.

The following table describes the Help menu options.

Table 2.7 Help Menu, Sample Setup Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Select this option to display the CE system online help. By default, the help system displays the Contents in the navigation pane, located on the left, and the introductory topic in the topic pane, located on the right. You can use the Contents to select and print specific help topics. The navigation pane also provides a Search tab and an Index tab. These tabs let you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td>Using Help</td>
<td>Select this option to display the Contents window on how to use the Windows Help system.</td>
</tr>
<tr>
<td>About GenomeLab System</td>
<td>Select this option to access software, instrument, and system information.</td>
</tr>
<tr>
<td>Beckman Coulter Home Page</td>
<td>Select this option to access the Beckman Coulter Home Page on the Internet.</td>
</tr>
</tbody>
</table>
Toolbar Icons

The Sample Setup module's toolbar contains icons that correspond to common menu options.

The following table describes the Sample Setup toolbar icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>New - Opens an empty sample plate.</td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Open - Select an existing sample plate to open.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save - Saves the current sample plate to the same directory with the same name and format as was used on the previous save.</td>
</tr>
<tr>
<td><img src="image" alt="Print Sample Plate" /></td>
<td>Print Sample Plate - Print data associated with the active sample plate.</td>
</tr>
<tr>
<td><img src="image" alt="Print Preview" /></td>
<td>Print Preview - Displays a sample format of a hard-copy printout of the active sample plate. A toolbar at the top of the window provides options for navigation, viewing, and printing the display. To restore the default screen, press the Esc key or click the Close button.</td>
</tr>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Cut - Deletes text selected in one or more cells of the sample plate, which you can &quot;paste&quot; into a different cell or cells.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy - Duplicates text selected in one or more cells of the sample plate, which you can &quot;paste&quot; into a different cell or cells.</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Paste - Inserts into one or more cells the text copied to the buffer when using the Copy or Cut function.</td>
</tr>
<tr>
<td><img src="image" alt="Unlock" /></td>
<td>Unlock - Indicates that the active plate is available for editing. Clicking this icon locks the plate to prevent editing and changes the icon to .</td>
</tr>
<tr>
<td><img src="image" alt="Run" /></td>
<td>Run - Opens the Run module and executes the active sample plate.</td>
</tr>
<tr>
<td><img src="image" alt="Select All" /></td>
<td>Select All - Highlights (selects) all cells in the sample plate.</td>
</tr>
<tr>
<td><img src="image" alt="Clear All" /></td>
<td>Clear All - Removes all cell properties in the sample plate.</td>
</tr>
<tr>
<td><img src="image" alt="View Summary" /></td>
<td>View Summary - Displays a summary of a specific sample plate. To use this, open the desired sample plate, then click this icon. The Sample Plate Summary spreadsheet appears with a summary of each sample in the plate. This is a read-only spreadsheet and cannot be edited.</td>
</tr>
<tr>
<td><img src="image" alt="Help Topics" /></td>
<td>Help Topics - Displays the CE system online help. By default, the help system displays the Contents in the navigation pane, located on the left, and the introductory topic in the topic pane, located on the right. You can use the Contents to select and print specific help topics. The navigation pane also provides a Search tab and an Index tab. These tabs let you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td><img src="image" alt="Context-Sensitive Help" /></td>
<td>Context-Sensitive Help - Click this icon and then on a menu item to open the Help file related to the selection.</td>
</tr>
</tbody>
</table>
2.2 Using the Sample Setup Module

Open, set up, import and export sample plates.

To open the Sample Setup module, click the **Sample Setup** icon on the Main Menu:

![Sample Setup Icon](image)

Opening a Sample Plate

Open an existing sample plate or create a new one.

1. Get to this location in the software.
2. Step instructions.

The Sample Plate Selection dialog will open.

![Sample Plate Selection Dialog Box](image)

Figure 2.5 Sample Plate Selection Dialog Box

Creating a New Sample Plate

1. To create a new sample plate, select the **Create a new sample plate** radio button.
2. Click **OK**. The Sample Plate window opens.
Opening a Sample Plate

1. To open an existing sample plate, select the appropriate plate from the list.
2. To help in the search, filter the plates by their displayed date. Selecting the **Enable** option.
3. Use the **Up** and **Down** scroll arrows to change the **Start Date** and **End Date**.
4. Click **OK** to open the selected sample plate.

Find Barcode

Use the Find Barcode option to search for a sample plate using its barcode.

1. From the drop-down list, select the **Project Name** that contains the sample plate barcode.
2. Click **Find Barcode** and type the sample plate barcode exactly as it was saved.

If the sample plate barcode exists, it will open the plate. You may also use the wildcards "*" and "?" in your search. If the search finds more than one match, the Barcode Selection dialog box opens, allowing you to select the proper plate.

Figure 2.6 Find Barcode Dialog Box

**NOTE** To search all projects for the sample name, select -(none)- from the **Project Name** drop-down list before clicking **Find Barcode**.

**NOTE** If the sample plate does not appear in the list of available items, it may be residing in another project. To select the project where the sample plate resides, select the project from the **Project Name** drop-down list.

**NOTE** If the sample plate exists in a different database, you can reset the working database. For details, see “Setting the Working Database” on page 324.

Other Ways to Open a Sample Plate

You can also open a new or existing sample plate at any time while using the Sample Setup module.

- To open a new sample plate from the File menu, select **File | New**.
- To open a new sample plate using the toolbar, click ![New Plate](new_plate_icon). 
- To open an existing sample plate, from the **File** menu, select **File | Open**. Use the Sample Plate Selection dialog box to select your sample plate.
- To open an existing sample plate using the toolbar, click ![Open Plate](open_plate_icon). Use the Sample Plate Selection dialog box to select your sample plate.
Creating a New Sample Plate

To create a new sample plate:

1. Click . A blank sample plate opens.
2. Select and highlight the cell or cells where the samples will reside.
3. Enter the name of the samples in the Sample Name field and then press Enter.
4. Enter the barcode for the plate in the Barcode field.
5. Apply sample specific information in the Note window of the Note tab and apply property sets and values.
6. Assign a method to each sample set.
To edit the method or create a new method, see "Creating or Editing a Method" on page 40.

• To automatically analyze data after a sample set run, select the Analysis tab, then select the Automatic Analysis check box. The system will analyze the sample data using the parameter set selected from the drop-down list. For details, see "Defining Data Processing Conditions" on page 41.

• To automatically print a report after a sample set run, see "Printing the Plate Report or Specifying Sample Plate Print Options" on page 42.

• To automatically export data after a sample set run, see "Specifying Sample Plate Export Options" on page 43.

7. Select File \ Save As. In the Save As dialog box:
   a. Select a Project Name from the drop-down list.
   b. Enter a name for this plate in the name field.
   c. Click OK to save the plate.

Selecting Samples

Select individual samples positions. In addition, select the entire plate, row, or column using a single click. Use the Shift or Ctrl keys to select contiguous and non-contiguous cells.

Selecting the Entire Sample Plate

Select the entire sample plate by left-clicking the grid box on the upper-left corner of the plate grid. To remove the selection, left-click any sample in the grid.

Figure 2.7 Select the Entire Plate
Selecting the Entire Row

Place the mouse pointer over the row label on the left-hand side of the row to be selected. A small black arrow will replace the mouse pointer. Click once to select the row. To remove the selection, click any sample in the grid.

![Select an Entire Row](image1)

Selecting the Entire Column

Place the mouse pointer over the column label at the top of the column to be selected. A small black arrow replaces the mouse pointer (see Figure 2.9). Click once to select the column. To remove the selection, click any sample in the grid.

![Select the Entire Column](image2)

Selecting Contiguous Cells

To select contiguous cells:

1. Left-click the first cell in the column or row.
2. Press and hold the Shift key.
3. Left-click the last cell (in the column or row) to be selected.
4. Release the Shift key.

![Select Contiguous Cells](image3)
Selecting Non-Contiguous Cells

1. Click the first cell.
2. Use the Ctrl+Click function to select each additional cell.

Viewing a Sample Plate by Sample Name/Subject ID

Use the View | View by Subject ID option to toggle the sample plate view between Sample Name and Subject ID. This works in conjunction with the options found next to the Sample Name and Subject ID fields, as shown in the following example.
Naming Samples and Assigning Subject IDs
The sample plate window appends the plate location to each Sample Name entered in a sample cell. For example, enter “MySample” as the name of the cell at position A3 in the plate. The sample plate view identifies the sample as “MySample.A3”.

NOTE Position the mouse pointer over a named cell to display a “tool tip” that identifies both the sample name and Subject ID.

If you enter a Subject ID before entering a sample name, the system automatically populates the Sample Name field, which you can change at any time.

To name a single sample:
1. Select the cell where the sample resides in the plate.
2. Enter the name of the sample in the Sample Name text box and press the Enter key.
3. Enter the Subject ID in the Subject ID text box and press Enter.

To name contiguous samples:
1. Select the cells where the samples reside in the plate by clicking and dragging the mouse cursor.
2. Enter the name of the samples in the Sample Name text box and press the Enter key.
3. Enter the Subject ID in the Subject ID text box and press Enter.

Naming all Wells
To name all wells in the plate:
1. Click Select All.
2. Enter the name of the samples in the Sample Name field and press Enter.
3. Enter the Subject ID data and press Enter.

To name multiple non-contiguous samples that are not within the same sample set:
1. Click on the first cell.
2. Press and hold the Ctrl key while selecting the additional samples.
3. Enter the name of the samples in the Sample Name text box and press the Enter key.
4. Enter the Subject ID in the Subject ID text box and press Enter. The plate editor displays each edited cell with a green background shade. The Plate Status indicator displays “Plate Edited.” This indicates that the plate must be saved.

NOTE If you attempt to close the plate before saving it, a Save Changes dialog box opens.
5. Save the plate to retain the changes.
Viewing Cell Coordinates
To view or hide cell coordinates, select View | Cell Coordinates. The option will toggle the display of the coordinates off and on.

Searching for Text in the Sample Plate
1. Select Edit | Find. Use the options in the Find dialog to specify the search criteria.
2. Enter the desired text in the Search what field.
   - Select Down to search down each column, beginning at the highlighted or selected cell.
   - Select Up to search up each column, beginning at the highlighted or selected cell.
   - Select the Match whole word only option to locate text that is flanked by spaces. If you do not select “Match whole word only,” the system finds the text, even if it is part of another word.
   - Select the Match case option to find the entered text exactly as typed into the field. If “Match case” is not selected, the system will find all occurrences of the text, regardless of the case.
   - Select the Use wildcards check box (✓) to include wildcard characters in your search. The follow table describes the possible wildcards.

Table 2.9 Wildcard Characters

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>The asterisk specifies to search for any letters before or after the entered text.</td>
</tr>
<tr>
<td>?</td>
<td>The question mark represents any single letter.</td>
</tr>
<tr>
<td>[!]</td>
<td>The exclamation point within brackets makes the query negative. Enter the letter following the “!” within the brackets if you want the system to find anything that is not the entered text. For example, entering ![A] finds any string that does not start with “A”.</td>
</tr>
</tbody>
</table>

NOTE The system supports the following wildcard combinations: ![]*, *, and ![?]. The system does not support the combination *[!].
3. Click Find Next to find the next occurrence of the entered text.

Search for and Replacing Text in the Sample Plate
1. Select Edit | Replace. Use the Replace options to specify your search and replace settings.
2. Enter the desired text in the Find what text field.
   - Select the Match whole word only check box (✓) to locate text that is flanked by spaces. If “Match whole word only” is not selected, the system will find the text, even if it is part of another word.
   - Select the Match case check box (✓) to find the entered text exactly the way you type it into the field. If you do not select “Match case,” the system finds all occurrences of the text, regardless of case.
Select the **Use wildcards** check box (✓) to include wildcard characters in your search. The following table describes the possible wildcards.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>The asterisk specifies to search for any letters before or after the entered text.</td>
</tr>
<tr>
<td>?</td>
<td>The question mark represents any single letter.</td>
</tr>
</tbody>
</table>
| ![ ]     | The exclamation point within brackets makes the query negative. Enter the letter following the “!” within the brackets if you want the system to find anything that is not the entered text. For example, entering ![A] finds any string that does not start with “A”.

**NOTE** The system will support the following wildcard combinations: ![*], *?, and ?![?]. The system does not support the combination *![].

- Enter the text you wish to replace with in the **Replace with** text field.

3. Choose the desired Search and Replace actions:
   - Click **Find Next** to find the next occurrence of the entered text.
   - Click **Replace** to replace the highlighted text with the text in the Replace with field.
   - Click **Replace All** to automatically replace all occurrences of the search text with the replace text.

**Using Property Sets**

Property sets are groups of information (properties) that apply to a sample.

1. To access the sample property sets, select **View | Sample Property Sets** or select a sample cell in the sample plate screen and refer to the Note tab.

2. In the property set table, use the **Tab** or arrow keys to move from cell to cell.
   - Press the **Tab** key moves the focus from property to value and then to the next row and the arrow keys move in the direction selected.
   - Press the **Enter** key moves the focus down the table one cell at a time, within the same column.

3. To select an entire column for sorting, click on its header. The selected column becomes highlighted.

4. To select a row, click on its number. As with the column selection, the selected row becomes highlighted.
5. To select consecutive rows, left-click and hold the mouse button while dragging the cursor over table cells.

6. To move a selected row up or down one cell at a time, click the toolbar arrow icons.

7. To delete the contents of the rows, select the desired rows and click the Delete icon. A warning message opens, prompting you to confirm deletion:
   - Click No to return to the editor without deleting the property.
   - Click Yes to delete the contents and remove the row from the property set.

**Entering a New Property**

1. Click . A new row appears into the property table.
2. Enter the new property name and value into the cells of the new row.
   - To assign a pre-defined property set, click and select from the defined property sets as shown below.

![Sample Property Sets Dialog Box](image)

**Figure 2.14 Sample Property Sets Dialog Box**
Creating and Storing a Custom Property set

1. Click the Create button in the Defined Sets portion of the Sample Property Sets dialog.
2. Enter a name in the Create Property Set dialog box (Figure 2.15).
3. If desired, use the Copy settings from drop-down list to choose an existing property set to copy into the new one.

![Create Property Set Dialog Box]

---

Using Methods

A method is a program that includes a sequence of events that the system will use to collect the data. The method controls the hardware, the temperatures, voltages, and times, which work together to gather data. The system comes with several methods that are optimized for the different software applications.

- Use the Frag methods to collect data for fragment analysis.
- Use the LFR methods to collect sequence data.
- Use the SNP method to collect SNP primer extension data.

After creating a new sample plate, the Method selection for each column is left blank.

Assigning Methods

To assign a method.

1. Click on and select a cell in the column.
2. Click the down-arrow to open the method selection list (Figure 2.16) and select the method.

![Method Selection Drop-Down List]
Using the Sample Setup Module

3. Edit the new method as desired.

**NOTE** You must assign a method to each named row before saving the sample plate. If any named row is not assigned a method and a save is attempted, a warning message appears, listing each column that needs a method assigned to it.

**Applying Methods to Multiple Sample Sets**

To apply a method to multiple sample sets:

1. Highlight the desired sample sets as explained in "Selecting Samples" on page 32.
2. Select Edit | Auto-Fill Method Name. The Choose Method dialog box opens.
3. Select a method from the drop-down list.
4. In the Auto Fill area of the dialog box, select **Selected sample sets only**, then click **OK**.

To apply a method to all sample sets:

1. Select Edit | Auto-Fill Method Name. The Choose Method dialog box opens.
2. Select a method from the drop-down list.
3. In the Auto Fill area of the dialog box, select **All sample sets**, then click **OK**.

To view the selected method, click the Method tab.

**Conditioning the System**

It is recommended to purge the manifold with fresh gel followed by a capillary gel fill, before each plate run.

If the system has not been used for a long period of time, thoroughly purge the manifold and run the condition method before performing a sample separation. Performing the condition method fills the capillaries with gel 6 times.

**NOTE** Thoroughly clean the wetting tray with D.I. water before every run to remove old or dried gel.

**Creating or Editing a Method**

To create and/or edit a method:

1. Select Edit | Method from the Sample Setup main screen.
2. Highlight the desired method in the Choose Method to Edit dialog box and click **OK**.
3. When the Method - Capillary Temperature dialog box opens, enter a temperature between 35 and 60° C.
   a. Select the **Wait for Cap Temp** option (if desired).
   b. Click **OK** to exit the Method dialog box or continue with step 4 to make additional changes to the method.
4. Select Denature from the Event list.
   a. Enter a duration between 0 and 180 seconds (if 0 is selected, there will be no denaturation).
   b. Click **OK** to exit the Method dialog box or continue with step 5 to make additional changes to the method.
5. Select Pause from the Event list.
Sample Setup Module

Using the Sample Setup Module

a. Enter a time duration between 0 and 10 minutes.
b. Click OK to exit the Method dialog box or continue with step 6 to make additional changes to the method.

6. Select Inject from the Event list.
a. Enter an injection voltage between 0.1 and 12.0 kV.
b. Enter a time duration in seconds.
c. Click OK to exit the Method dialog box or continue with step 7 to make additional changes to the method.

7. Select Separate from the Event list.
a. Enter the separation voltage between 0.1 and 12.0 kV.
b. Enter a time duration in minutes.
c. Click Advanced to specify the two separation phases for the method.
d. Click OK to return to the Method dialog box.

The first phase is to “coax” the sample into the capillaries. The second phase is to perform the normal separation of the samples.

8. Click OK to exit the Method dialog box or continue to make additional changes to the method.

9. In the Save As dialog box:
a. Select a Project Name from the drop-down list.
b. Enter a name in the name field.
c. Click OK.

Defining Data Processing Conditions

Analysis parameter sets define the conditions specific to an experiment used in data processing. Modification of the Sequence or Fragment Analysis Parameters can only be performed in their respective analysis modules.

Sequence Analysis Parameter Sets define the start and end times for the analysis of raw data, the threshold below which bases are called as 'N's, and the information necessary to detect the start of data to be analyzed, including the delay between the detected start of data and the start of data analysis, the signal to noise ratio, the minimum duration, and the threshold above which data are considered peaks.

Fragment Analysis Parameter Sets, including SNP analysis, are used to process the fragment data to estimated fragment sizes and to identify alleles. Fragment sizes are estimated by generating a calibration curve from a set of size standards run with the unknown samples. The Fragment Analysis Parameter set defines the analysis model used to generate the calibration curve, dye label mobility corrections, allele identification criteria (locus tags), quantitation values, and other factors that will affect how your data are analyzed.
Assigning Analysis Parameter Sets

- For a Sequence Analysis, select a **Sequence Analysis** as the Parameter Set
- For Fragment Analysis, select a **Fragment Analysis** as the Parameter Set

Performing an Analysis on a Sample

To perform an analysis on a sample:

1. Select the cell/cells as described in "Selecting Samples" on page 32.
2. Select the **Analysis tab** at the bottom of the window.
3. Select the **Perform Analysis** option.
4. Select the parameter set from the **Parameter Set** drop-down list (see Figure 2.17).

Printing the Plate Report or Specifying Sample Plate Print Options

Define the print options and report format for the currently open sample plate.

1. With a cell highlighted, select the **Analysis Tab**.
2. Select the **Print Report** check box (✓) to print a report immediately after completion of the run.
3. Click **Edit Print Format For Plate**. The Report Format dialog box opens.
4. Verify or select the **Printer** and **Page Layout** options.
   - If desired, click **Colors** and verify or modify the trace colors of the **Raw Data** and/or **Analyzed Data**, then click **OK**.
5. In the Sample Elements area of the Report Format dialog box, select each element to be printed.
   - If desired, click **Options** and verify or change the **Raw Data, Sequence Analysis Result Data, Fragment Analysis Result Data, Base Sequence Grouping and Current Trace Options** selections in the Print Options dialog box, then click **OK**.
6. Click **OK** on the Report Format dialog box to save the changes and close the dialog box.
Specifying Sample Plate Export Options

Exporting Sample Results
To export sample results after separation:

1. Select the Export Data option in the Export section of the Analysis Tab (Figure 2.17).
2. Click on the Edit Export Options for Plate button.
3. Select the target folder.
4. Select the desired Sample Elements for the export format chosen. Refer to the Online Help for a description of these parameters and the export formats.
5. Select the desired options for the chosen export format. See "Export Options" on page 43 for descriptions of the export options used for exporting sample results.
6. Click OK.

NOTE The export formats selected will apply to all samples automatically exported during the plate run.

Export Options

Removing CEQ Tracking Suffix
Select this option to remove the appended sample plate position and time/date stamp from the exported files.
Resolving Filename Conflicts
Select this option to automatically increment the exported files of the same name with a unique sequence number.

Export Options - Sequencing Results
The following options are specific to sequencing results only.

Apply Trimming
Select this option to remove the trimmed data from a sequence before it is exported. The export replaces all internal trims with the letter “x”.

Export Only If Sequence > X nt
After performing the trimming operation, the resulting sequence may be too small to be useful. Select the Export Only If Sequence > X nt option to specify a minimum size for the sequence output, when exporting. This exports only those sequences greater than the set number of nucleotides.

See the Online Help for additional Export Sample Elements.

Importing Sample Plate Information from TXT Files.

Importing a Sample Plate with Default Run Method and Analysis Parameters
Import the sample plate txt file(s) to the CE System. The run default separation method(s) and analysis parameters that were pre-selected in the imported sample plate data sets will be used for running and analyzing the plate.

1. Select an appropriate Working Database and Project in the Data Manager module.
2. Open the Sample Setup module.
3. From the Menu Bar, select File | Import.
4. In the Import dialog, navigate to the folder containing the Sample Plate TXT file.
5. Highlight the selected sample plate TXT file and click Open in the Import dialog.
6. The imported sample plate grid window will appear.
7. Re-confirm the values and properties for all Sample Plate objects: the barcode, the sample names, the separation method(s), the note, the analysis parameters, report and export options.
8. From the Menu Bar, select File | Save As.
9. Save the Sample Plate to the desired project with a new name.
10. Repeat steps 1 through 8 for the second Sample Plate, if one is present.

Importing a Sample Plate

Using Non-Default Run Method or Analysis Parameters
If using non-default methods, the appropriate run method(s) and analysis parameters that were pre-selected in the Data Sets must be set up in the CE System software before importing the sample plate TXT file(s).
1. Launch the Data Manager.
2. Setup an appropriate Working Database or create a new Working Database and Project.
3. Launch the Sample Setup module.
4. Cancel the Sample Plate Selection popup window.
5. From the Menu Bar, select Edit | Method.
6. From the Choose Method to Edit dialog, confirm the presence of the appropriate or pre-selected run method(s).
7. If not present, highlight any existing method and click OK.
8. Select the appropriate Event Type and edit the method as explained in "Creating or Editing a Method" on page 40.
9. When finished, click Save As and save the edited method to an appropriate Project with the same method name as specified in the plate Import file.

Using a Sequence Reaction Separation

1. Launch the Sequence Analysis module.
2. In the Sequence Analysis module, select Analysis | Working Analysis Parameters.
3. From the Working Parameters dialog, select Use Stored parameters.
4. Confirm the presence of the appropriate/pre-selected analysis parameters in the Select Analysis Parameters popup window.
   - If not present, cancel the Select Analysis Parameters and click Edit in the Working Parameters dialog.
5. Select the desired tab and edit the parameters as appropriate in the Sequence Analysis Parameters Editor dialog box. See "Editing Sequence Analysis Parameters" on page 124 for a description of the Sequence Analysis Parameters Editor and creating Analysis Parameters.
6. When finished, click Save As and save the edited parameters to an appropriate Project with the same analysis parameters name as specified in the plate Import file.

Performing a Fragment Analysis Separation

1. Launch the Fragment Analysis Module.
2. In the Fragment Analysis Module, select Analysis | Analysis Parameters.
3. From the Analysis Parameters dialog, select the appropriate analysis parameters in the Select Analysis Parameters Set field.
   - If not present, click Edit and modify the appropriate analysis parameters in the Edit Fragment Analysis Parameters dialog. See "Defining Fragment Analysis Parameters" on page 206 for a description of this dialog.
4. When finished, click Save As and save the edited parameters to an appropriate Project with the same analysis parameters name as specified in the plate Import file.

After creating the Non-Default Run Method and Analysis Parameters, follow the same steps as in Importing a Sample Plate with Default Run Method and Analysis Parameters, as listed above.
Exporting Sample Plate Data

Export the sample plate data to use in compatible equipment or to manually edit the plate information.

**IMPORTANT** If a Sample Plate file is already open, make sure it has been saved before proceeding.

To export the sample plate:

1. Open the sample plate file.
2. Select **File | Export**.
3. Select **Resolve Filename Conflicts** to prevent the file from overwriting a previous file with the same name. If another file with the same name exists, the export function increments the new file with a unique sequence number.

**NOTE** If you do not select **Resolve Filename Conflicts** and a file with the same name exists, the system displays a warning message, asking if you want to replace the old file with the new one. Select **Yes** to overwrite the existing file or **No** to cancel the export.

4. Select a location to save the file.
5. Enter a filename or leave the name as it is.
6. Click **OK**.

Locking a Sample Plate

To prevent editing of the currently displayed plate, select **File | Lock**. The Notes, Method, and Analysis tabs are disabled when the Sample Plate is locked.

Viewing the Summary

To display a read-only window showing the attributes of the currently selected plate, select **View | View Summary**.
This chapter provides an overview of the Run module, including its menu options, toolbars, and dialog boxes. It also shows you how to run sample plates and set the display options using this module.

3.1 Run Module Overview

Launch pre-programmed sample plates and control individual functions of the instrument.

Use the Run module for:

- Running a sample plate
- Performing all instrument control and operational functions such as:
  - denaturing samples
  - injecting and separating samples
  - loading and unloading plates
  - controlling the capillary chamber temperature
  - filling the capillaries with gel
Using the Run Control Main Window

The following illustration identifies the areas on the Run module’s main window that are described in Table 3.1.

![Main Window, Run Module](image)

**Figure 3.1 Main Window, Run Module**

The following table describes the items called out in the image above.

**Table 3.1 Main Window, Run Module**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Title Bar - Displays the name of the module (Run Control) and the user-defined system name.</td>
</tr>
<tr>
<td>B</td>
<td>Menu Bar - See &quot;Menu Bar Options&quot; on page 49.</td>
</tr>
<tr>
<td>C</td>
<td>Toolbars - See &quot;Toolbar Icons&quot; on page 55.</td>
</tr>
<tr>
<td>D</td>
<td>Window Selection Tabs - Toggle between windows (see &quot;Window Selection Tabs&quot; on page 62).</td>
</tr>
<tr>
<td>E</td>
<td>Display Area - Graphically displays the raw data of the selected capillary or capillaries.</td>
</tr>
<tr>
<td>F</td>
<td>Status Monitor - Displays the current state of the run, capillary and gel cartridge status, and system on-line/off-line status.</td>
</tr>
</tbody>
</table>
Run Module

Run Module Overview

Table 3.1 Main Window, Run Module

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Capillary Buttons - Letters A through H represent the eight capillaries in the array. Selecting one of these buttons displays an associated pane shown in the display area.</td>
</tr>
</tbody>
</table>
| H    | Status Bar - Displays messages such as:  
  - Currently active database - Displays the name of the active database.  
  - Active Plate - Displays the side of the active plate (left/right).  
  - Pause To Load - If you selected **Pause to load**, this area displays the wait time.  
  - Configured 2nd Plate - If you loaded a second plate, this area displays the name of the plate.  
  - Display fields on the right of the status bar indicate which of the following keys are latched down:  
    - CAP - **Caps Lock** key is enabled.  
    - NUM - **Num Lock** key is enabled.  
    - SCRL - **Scroll Lock** key is enabled. |

Menu Bar Options

The following example shows the Run Control menu bar options.

The following topics describe each of these menus and their options.

File Menu

Click the File menu to display its drop-down menu, as shown in the following example.

![File Menu Example](image)

Use the **File** menu to save the log file, set system preferences, and print the log, or an item on the window. The following table describes the File menu options within the Run Module.

Table 3.2 File Menu, Run Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Data Monitor Defaults</td>
<td>Restores the colors of the data monitor to the original default shipped with the instrument.</td>
</tr>
<tr>
<td>Save Log</td>
<td>Saves the system log in a folder you select. The log is identified by the date and a unique identifier.</td>
</tr>
</tbody>
</table>
Run Module

Run Module Overview

View Menu
Click the View menu to display its drop-down menu, as shown in the following example.

![View Menu Example](image)

**NOTE** A ‘✓’ next to an option indicates that the option is enabled.
Activate or deactivate window display options.

The following table describes the Run module’s View menu options.

### Table 3.3 View Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Preferences</td>
<td>View and modify the <strong>System Name</strong>, <strong>Operator Name</strong>, <strong>Project Name</strong> and <strong>Dye Names</strong> for Fragment Analysis and/or to activate or deactivate the alarms. (See &quot;Defining System Preferences&quot; on page 68.)</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Define printer properties.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a facsimile of a hardcopy printout of the system log prior to printing.</td>
</tr>
<tr>
<td>Print Log</td>
<td>Prints the system log.</td>
</tr>
</tbody>
</table>

Table 3.2 File Menu, Run Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Preferences</td>
<td>View and modify the <strong>System Name</strong>, <strong>Operator Name</strong>, <strong>Project Name</strong> and <strong>Dye Names</strong> for Fragment Analysis and/or to activate or deactivate the alarms. (See &quot;Defining System Preferences&quot; on page 68.)</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Define printer properties.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a facsimile of a hardcopy printout of the system log prior to printing.</td>
</tr>
<tr>
<td>Print Log</td>
<td>Prints the system log.</td>
</tr>
</tbody>
</table>

**NOTE** A ‘✓’ next to an option indicates that the option is enabled.
Activate or deactivate window display options.

The following table describes the Run module’s View menu options.
Direct Control Menu
Manage separation functions, conditions, or system components. These capabilities serve in both method development and diagnostic tools.

---

### Table 3.4 Direct Control Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unload Plates</td>
<td>Move the plate holder to the position at the front of the instrument to load or unload plates. See &quot;Loading the Sample Plate&quot; on page 350.</td>
</tr>
<tr>
<td>Plate Position</td>
<td>Graphically select the well location where the capillaries will be immersed.</td>
</tr>
<tr>
<td>Capillary Temperature</td>
<td>Set the capillary holding temperature. This temperature will be over-ridden at the end of each sample plate or when cancelled. See &quot;Specifying Capillary Temperature&quot; on page 356.</td>
</tr>
<tr>
<td>Denature Samples</td>
<td>Initiate the denaturing of samples. See &quot;Denaturing a Sample&quot; on page 356.</td>
</tr>
<tr>
<td>Optical Alignment</td>
<td>Align the lasers with the detection windows of the eight capillaries. You can save and view the data in the Sequence Analysis module. See &quot;Performing an Optical Alignment&quot; on page 358.</td>
</tr>
<tr>
<td>Inject</td>
<td>Initiate the injection of the sample prior to separation. See &quot;Injecting a Sample&quot; on page 356.</td>
</tr>
<tr>
<td>Separate</td>
<td>Initiate the separation of injected samples. The data generated is not saved. See &quot;Performing a Separation&quot; on page 357.</td>
</tr>
<tr>
<td>Gel Capillary Fill</td>
<td>Fill all capillaries with fresh gel. (This forces any gel present in the capillary out to the specified waste position in the buffer plate or wetting tray.) See &quot;Replenishing the Capillaries with Gel&quot; on page 357.</td>
</tr>
<tr>
<td>Manifold Purge</td>
<td>Clear the manifold of air bubbles and/or remaining DNA fragments before the next separation process. See &quot;Purging the Manifold&quot; on page 358.</td>
</tr>
</tbody>
</table>
Tools Menu

Click the Tools menu to display its drop-down menu, as shown in the following example.

```
Tools
   ✔ Autoscroll
   ✔ Autoscale
   Pause Data Display
   ➥ Unzoom
   ➥ Unzoom All
   Display Options...
   ➥ View Last Analysis...
```

**NOTE**  A " ✔ " next to an option indicates that the option is enabled.

The following table describes the Run module's Tools menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autoscroll</td>
<td>Toggles Autoscroll off and on. When enabled (✔), the system will scale all data to the last 10 minutes of the run on the X-axis and confine the display of data to the pane on the Y-axis. Selecting a checked option removes the check mark and disables the feature.</td>
</tr>
<tr>
<td>Autoscale</td>
<td>Toggles Autoscale off and on. When enabled (✔), the system automatically scales the data displayed on the window to the fit into the pane. If autoscaling is disabled, the data is scaled to its true values. Selecting a checked option removes the check mark and disables the feature.</td>
</tr>
<tr>
<td>Pause Data Display</td>
<td>Pauses or resumes data display. When enabled (✔), this option pauses data display. (Pausing data does not stop the stream of data, just the display of data.)</td>
</tr>
<tr>
<td>Unzoom</td>
<td>Select Unzoom to undo one zoom level.</td>
</tr>
<tr>
<td>Unzoom All</td>
<td>Select Unzoom All to undo all zoom levels.</td>
</tr>
<tr>
<td>Display Options</td>
<td>Opens the Display Options dialog box, which you can use to modify the parameters for currently displayed data, including its title, X-axis, Y-axis, dye traces, current traces, and colors. For details, see “Setting or Changing Display Options” on page 73</td>
</tr>
<tr>
<td>View Last Analysis</td>
<td>Select View Last Analysis to open the Sequence or Fragment Analysis module and display the most recently analyzed sample set of a running sample plate. For details, see “Viewing the Last Analysis Performed” on page 75.</td>
</tr>
</tbody>
</table>
Run Menu
Click the Run menu to display its drop-down menu, as shown in the following example.

The following table describes the Run module’s Run menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Sample Plate</td>
<td>Opens the Sample Plate Run Confirmation dialog box.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses a running sample plate.</td>
</tr>
<tr>
<td>Pause to Load</td>
<td>Load a second plate while a plate is running. For details, see “Pause to Load” on page 71.</td>
</tr>
<tr>
<td>Stop System</td>
<td>Stop a running sample plate or direct control process. For details, see “Stopping a Sample Plate Run” on page 72.</td>
</tr>
<tr>
<td>Monitor Baseline</td>
<td>Set the desired parameters. For details, see “Monitoring the Baseline” on page 386.</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>View the instrument version, laser power, PC Settings, monitor status, and to home the plates and/or the gel pump. For details, see “Diagnostics” on page 385.</td>
</tr>
<tr>
<td>Reset</td>
<td>Re-synchronizes system hardware with the firmware and to reset the system log.</td>
</tr>
</tbody>
</table>
Log Options Menu
Click the Log Options menu to display its drop-down menu, as shown in the following example.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Errors Only</td>
<td>Toggles this option off and on. When enabled (✓), the Log window lists only errors.</td>
</tr>
<tr>
<td>All Detail</td>
<td>Toggles this option off and on. When enabled (✓), the Log window includes all messages and system activity.</td>
</tr>
<tr>
<td>Sample Plate Only</td>
<td>Toggles this option off and on. When enabled (✓), the Log window displays only the items related to a running sample plate.</td>
</tr>
<tr>
<td>Freeze Log</td>
<td>Toggles this option off and on. Select this option to freeze or resume the display in the Log window. (Freezing the log data does not stop the run, just the display of log data.)</td>
</tr>
</tbody>
</table>

NOTE A "✓" next to an option indicates that the option is enabled.

The Log Options menu options are available when displaying the Log tab. The following table describes the Run module's Log menu options.

### Table 3.7 Log Options Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Errors Only</td>
<td>Toggles this option off and on. When enabled (✓), the Log window lists only errors.</td>
</tr>
<tr>
<td>All Detail</td>
<td>Toggles this option off and on. When enabled (✓), the Log window includes all messages and system activity.</td>
</tr>
<tr>
<td>Sample Plate Only</td>
<td>Toggles this option off and on. When enabled (✓), the Log window displays only the items related to a running sample plate.</td>
</tr>
<tr>
<td>Freeze Log</td>
<td>Toggles this option off and on. Select this option to freeze or resume the display in the Log window. (Freezing the log data does not stop the run, just the display of log data.)</td>
</tr>
</tbody>
</table>

Replenish Menu
Click the Replenish menu to display its drop-down menu, as shown in the following example.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capillary Information</td>
<td>Opens the Capillary Information dialog box. Use this dialog box to enter information that applies to your capillary array. For details, see &quot;Viewing Capillary Information&quot; on page 358.</td>
</tr>
<tr>
<td>Install Capillary Array</td>
<td>Opens the Install Capillary Array dialog box. Use this dialog box to install the capillary array. Verify or change the information, then install the array.</td>
</tr>
</tbody>
</table>

The following table describes the Run module's Replenish menu options.

### Table 3.8 Replenish Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capillary Information</td>
<td>Opens the Capillary Information dialog box. Use this dialog box to enter information that applies to your capillary array. For details, see &quot;Viewing Capillary Information&quot; on page 358.</td>
</tr>
<tr>
<td>Install Capillary Array</td>
<td>Opens the Install Capillary Array dialog box. Use this dialog box to install the capillary array. Verify or change the information, then install the array.</td>
</tr>
</tbody>
</table>
Run Module

Run Module Overview

Toolbar Icons

The Run module provides six toolbars: Standard, Direct Control, Data Monitor, Log, Sequence Dye Colors, and Fragment Dye Colors. Each icon of the various toolbars corresponds to a commonly used menu item.

The following tables describe the function of each of the toolbar icons.

Standard Toolbar

The following example shows the Sample Setup module’s Standard toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 3.9.

Table 3.8 Replenish Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Capillary Array</td>
<td>Displays the first in a series capillary array dialog boxes that let you remove the currently installed capillary array. For details, see “Removing and Replacing the Capillary Array” on page 360.</td>
</tr>
<tr>
<td>Gel Cartridge/Buffer Information</td>
<td>Opens the Gel Cartridge/Buffer Information dialog box, which provides information concerning the gel cartridge and buffer. For details, see “Viewing Gel Information” on page 360.</td>
</tr>
<tr>
<td>Install Gel Cartridge</td>
<td>Opens the Install Gel Cartridge dialog box.</td>
</tr>
<tr>
<td>Release Gel Cartridge</td>
<td>Use this option to remove the gel cartridge or, if you are not going to install a working gel cartridge, to insert a clean empty cartridge or gel pump plug into the cartridge chamber. For details, see “Removing and Replacing a Gel Cartridge/Gel Pump Plug For Dual Rail System” on page 367.</td>
</tr>
<tr>
<td>Replace Wetting Tray</td>
<td>Displays the first in a series of dialog boxes that let you replace the wetting tray. For details, see “Replacing the Wetting Tray” on page 347.</td>
</tr>
<tr>
<td>Empty Waste Bottle</td>
<td>Displays the first in a series of dialog boxes that let you empty the waste bottle. See “Replacing the Gel Waste Bottle For Dual Rail System” on page 345 or “Replacing the Gel Waste Bottle For Single Rail System” on page 346.</td>
</tr>
</tbody>
</table>

Table 3.9 Standard Toolbar, Run Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>Restore Data Monitor Defaults - Displays the default color selections at the time of installation.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Run Sample Plate - Runs a sample plate.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Pause - Pauses the currently running sample plate.</td>
</tr>
</tbody>
</table>
Run Module
Run Module Overview

Table 3.9 Standard Toolbar, Run Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Stop Icon]</td>
<td>Stop - Stops the currently running sample plate or direct control process.</td>
</tr>
<tr>
<td>![View Last Results Icon]</td>
<td>View Last Results - Executes the Sequence or Fragment Analysis module with the analysis of the last sample set run.</td>
</tr>
<tr>
<td>![Help Topics Icon]</td>
<td>Help Topics - Displays the CE system online help. By default, the help system displays the Contents in the navigation pane, located on the left, and the introductory topic in the topic pane, located on the right. You can use the Contents to select and print specific help topics. The navigation pane also provides a Search tab and an Index tab. These tabs let you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td>![Online Help Icon]</td>
<td>Online Help - Click this icon and then on a menu item to open the help topic related to the selection.</td>
</tr>
</tbody>
</table>

Direct Control Toolbar

The following example shows the Sample Setup module’s Direct Control toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 3.4.

Figure 3.3 Direct Control Toolbar, Run Module

Figure 3.4 Direct Control Toolbar, Run Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Inject Icon]</td>
<td>Inject - Injects sample prior to its separation and detection. See “Injecting a Sample” on page 356.</td>
</tr>
<tr>
<td>![Separate Icon]</td>
<td>Separate - Initiates the separation of injected samples. See “Performing a Separation” on page 357.</td>
</tr>
<tr>
<td>![Fill Capillary with Gel Icon]</td>
<td>Fill Capillary with Gel - Fills all eight of the capillaries with fresh gel. See “Replenishing the Capillaries with Gel” on page 357.</td>
</tr>
<tr>
<td>![Capillary Temperature Icon]</td>
<td>Capillary Temperature - Specifies the desired temperature for the capillaries. See “Specifying Capillary Temperature” on page 356.</td>
</tr>
<tr>
<td>![Denature Icon]</td>
<td>Denature - Denatures the samples residing in a specific sample set. See “Denaturing a Sample” on page 356.</td>
</tr>
<tr>
<td>![Optical Alignment Icon]</td>
<td>Optical Alignment - Performs the alignment of the lasers with the capillary windows. See “Performing an Optical Alignment” on page 358.</td>
</tr>
<tr>
<td>![Plate Position Icon]</td>
<td>Plate Position - Selects where you want to position and immerse the capillaries.</td>
</tr>
<tr>
<td>![Load/Unload Plates Icon]</td>
<td>Load/Unload Plates - Selects the position where the capillaries are immersed in the plate or wetting tray and moves the plates to the Load position at the front of the instrument for loading/unloading plates.</td>
</tr>
</tbody>
</table>
Run Module Overview

Data Monitor Toolbar

The following example shows the Sample Setup module's Data Monitor toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 3.10.

Table 3.10 Data Monitor Toolbar, Run Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon.png" alt="Unzoom" /></td>
<td>Unzoom - Undoes one zoom level.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Unzoom All" /></td>
<td>Unzoom All - Undoes all zoom levels.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Autoscroll" /></td>
<td>Autoscroll - Scale all data to the last 10 minutes of the run on the X axis and confine the display of data to the pane on the Y axis.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Autoscale On/Off" /></td>
<td>Autoscale On/Off - By default, data displayed on the screen is scaled automatically to the confines of the screen (autoscale is on). If autoscaling is disabled, the data is scaled to its true values.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Pause Data Update" /></td>
<td>Pause Data Update - Pause the display of data. (Pausing data does not stop the stream of data, just the display of data.)</td>
</tr>
<tr>
<td><img src="icon.png" alt="Monitor Baseline" /></td>
<td>Monitor Baseline - Displays the baseline data trace. For details, see &quot;Monitoring the Baseline&quot; on page 386.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Display Options" /></td>
<td>Display Options - Modifies any or all display parameters. See &quot;Setting or Changing Display Options&quot; on page 73.</td>
</tr>
</tbody>
</table>
Log Toolbar
The following example shows the Sample Setup module's Log toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 3.11.

Figure 3.6 Log Toolbar, Run Module

Table 3.11 Log Toolbar, Run Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print - Print the system log at any time the program is active. System Logs contain all of the messages and activity from the time the program is opened to the time the program is closed.</td>
</tr>
<tr>
<td><img src="image" alt="Print Preview" /></td>
<td>Print Preview - Display a print preview of the System Log.</td>
</tr>
</tbody>
</table>

Run Sample Toolbar
The following example shows the Sample Setup module's Run Sample toolbar icon.

Figure 3.7 Run Sample Toolbar Icon

Click this toolbar button to open the Sample Plate Run Confirmation dialog box.

Sequence Dye Colors Toolbar
The following example shows the Sample Setup module's Sequence Dye Colors toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 3.12

Figure 3.8 Sequence Dye Colors Toolbar, Run Module

Table 3.12 Sequence Dye Colors Toolbar, Run Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="A:" /></td>
<td>Red is the default color assigned to the Adenine (A:) nucleotide bases in the analyzed data pane.</td>
</tr>
<tr>
<td><img src="image" alt="C:" /></td>
<td>Black is the default indicator assigned to the Cytosine (C:) nucleotide bases in the analyzed data pane.</td>
</tr>
<tr>
<td><img src="image" alt="G:" /></td>
<td>Green is the default color assigned to the Guanine (G:) nucleotide bases in the analyzed data pane.</td>
</tr>
<tr>
<td><img src="image" alt="T:" /></td>
<td>Blue is the default color assigned to the Thymine (T:) nucleotide bases in the analyzed data pane.</td>
</tr>
</tbody>
</table>
Fragment Dye Colors Toolbar
The following example shows the Sample Setup module's Fragment Dye Colors toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 3.13.

Figure 3.8 Fragment Dye Colors Toolbar, Run Module

Table 3.13 Fragment Dye Colors Toolbar, Run Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1</td>
<td>Red is the default color assigned to Dye #1 in the fragment data pane and D1 is the default name.</td>
</tr>
<tr>
<td>D2</td>
<td>Black is the default color assigned to Dye #2 in the fragment data pane and D2 is the default name.</td>
</tr>
<tr>
<td>D3</td>
<td>Green is the default color assigned to Dye #3 in the fragment data pane and D3 is the default name.</td>
</tr>
<tr>
<td>D4</td>
<td>Blue is the default color assigned to Dye #4 in the fragment data pane and D4 is the default name.</td>
</tr>
</tbody>
</table>
Status Monitor

The Status Monitor displays the state of the current run. Figure 3.9 shows the status monitor and Table 3.14 describes the areas.

Figure 3.9 Status Monitor Displays, Run Module
## Run Module Overview

### Table 3.14 Status Monitor Displays, Run Module

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A - Progress Indicator</td>
<td>This area of the Status Monitor shows the Status, Event Type, and Progress of a running sample plate or process.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Status Monitor Example" /></td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> Times displayed are approximations.</td>
</tr>
</tbody>
</table>
| B - Information Tabs  | Select any of four tabs to display the corresponding status details:  
|                       | - Sample - Lists the sample plate, sample names and the method being used.  
|                       | - Device - Displays the condition or value of devices or parameters.  
|                       | - μAmp - Shows the approximate overall microamperes (μA) and voltage used during the separation.  
|                       | - Life - Displays the remaining gel, capillary usage and laser hours.  
| C - Capillary Status  | Indicates certain capillary usage, gel cartridge life and on-line status. When the life of the gel or capillary array is exceeded, the associated indicator turns red. When the system is on-line, the indicator is green. |
Window Selection Tabs

View data on the Data Monitor, Direct Control, Log, and Instrument Data. The following topics describe these windows.

Data Monitor Window

The following example shows the Data Monitor window. To open this window, select the Data Monitor tab. This window displays information associated with a sample's analysis.

Table 3.15 Data Monitor Window, Run Module

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Data Monitor Tab - Displays the Data Monitor window.</td>
</tr>
<tr>
<td>B</td>
<td>Data Monitor Window - Displays the data for the running sample plate for the selected capillary buttons.</td>
</tr>
<tr>
<td>C</td>
<td>Capillary Buttons - These buttons (A through H) represent the eight capillaries of the array.</td>
</tr>
</tbody>
</table>
Direct Control Window

This window contains selectable areas and function buttons that perform some of the distinct tasks listed in the Direct Control and Replenish drop-down menus. For details, see "Direct Control Menu" on page 51 and "Replenish Menu" on page 54.

![Direct Control Window, Run Module](image)

The example above identifies the selectable areas on the Direct Control window. When you click a selectable area, the system initiates a unique Direct Control task. Table 3.16 lists the tasks available in this window.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Capillary Temperature - Change the capillary temperature.</td>
</tr>
<tr>
<td>B</td>
<td>Gel Capillary Fill - Fill all capillaries with fresh gel. (Any gel present in the capillary is forced out to the specified waste position in the buffer plate or wetting tray.)</td>
</tr>
<tr>
<td>C</td>
<td>Optical Alignment - Align the lasers with the detection windows of the eight capillaries. Data can be saved and viewed in the SequenceAnalysis module.</td>
</tr>
</tbody>
</table>
Run Module
Run Module Overview

Table 3.16 Direct Control Window, Selectable Areas

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Manifold Purge - Clears the manifold of air bubbles and/or remaining DNA fragments before the next separation process.</td>
</tr>
<tr>
<td>E</td>
<td>Install/Release Gel Cartridge - Releases and/or installs a gel cartridge.</td>
</tr>
<tr>
<td>F</td>
<td>Denature Samples - Initiates the denaturing of samples.</td>
</tr>
<tr>
<td>G</td>
<td>Plate Position - Select the plate or tray position where the capillaries will be immersed.</td>
</tr>
<tr>
<td>H</td>
<td>Wetting Tray - Replace or refill the wetting tray.</td>
</tr>
<tr>
<td>I</td>
<td>Install/Release Capillary - Installs the capillary array. Verify or change the information requested, and then install the array.</td>
</tr>
</tbody>
</table>

Access Plates

Load/Unload Plates - Displays the Unload Plates dialog box and:
- Select the position for capillary immersion in the plate or wetting tray.
- Move the plates to the Load position at the front of the instrument to load or unload plates.

Inject

Inject - Initiates injection of the sample prior to separation.

Separate

Separate - Initiates the separation of injected samples.

For procedures on using the Direct Control window to replenish the system, see "Direct Control and Replenishment" on page 349.
Log Window

View all of the messages and activity for a sample plate run. The following example shows the Log window. To open this window, select the Log tab.

![Log Window](image)

Figure 3.12 Log Window, Run Module

Table 3.17 Log Window, Run Module

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Window Selection Tab - Select this tab to access the Log window.</td>
</tr>
<tr>
<td>B</td>
<td>Freeze Log - Freezes the display in the Log window. (Freezing the log data does not stop the collection of data, just the display of data.)</td>
</tr>
<tr>
<td>C</td>
<td>Display Area - Provides the list of logged events.</td>
</tr>
</tbody>
</table>
**Instrument Data Window**

View the current for the eight capillaries and the voltage level of the instrument for the current run. To open this window, select the Instrument Data tab.

![Instrument Data Window](image)

**Figure 3.13 Instrument Data Window, Run Module**

**Table 3.18 Instrument Data Window, Run Module**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Current and Voltage Buttons - Select panes for display.</td>
</tr>
<tr>
<td>B</td>
<td>Window Selection Tab - Select this tab to access this window.</td>
</tr>
<tr>
<td>C</td>
<td>Display Area - Displays the current and voltage levels of selected current run.</td>
</tr>
</tbody>
</table>
3.2 Using the Run Module

Run sample plates and set the display options.

To open the Run module from the Main Menu, click the Run icon:

Gel Plug Warning

When you open the Run module, the system initializes and checks the gel cartridge condition. If the system detects an installed gel plug, the Device Warning Message appears, as shown in Figure 3.14.

In addition to this warning message, the Device tab indicates the state of the Cartridge. When a gel plug is present, the Device tab indicates plug in the Cartridge field, as shown in Figure 3.15.

The plug must be removed and replaced with a gel cartridge before the next run. When a cartridge is present, the Device tab indicates Gel in the Cartridge field, as shown in Figure 3.16.

Figure 3.14 Device Warning Message - Gel Plug Installed

Figure 3.15 Device Tab – Gel Plug installed

Figure 3.16 Device Tab – Gel Cartridge installed
Defining System Preferences

To define the system preferences:

1. Select File | System Preferences. The System Preferences dialog box opens, as shown in the following example.

![System Preferences Dialog Box](image)

2. Enter the System Name and Operator Name.
3. Select the Project Name.
4. Define Dye Names for the Fragment Analysis module, if desired.
5. Enable or disable the alarms.
6. Click OK.

Running Sample Plates

To run two sample plates (once plate information has been created and saved for both plates):

1. Select Run | Start Sample Plate. The Sample Plate Run Configuration dialog box opens.
2. Select the name of the sample plate from the Sample Plate Name drop-down list for the Left and Right Plates.
5. Follow the screen instructions in Capillaries Exposed dialog boxes to load the wetting tray, sample plate, and buffer plate by following the instructions.
6. Click Load to finish loading plates.
7. Verify the sample position in the plate.
8. Click Start to initiate the run.

**NOTE** If the working database exceeds 500 MB, an error message appears. If this happens, follow then troubleshooting procedures described in "Database Size" on page 69, then return to these steps.
Database Size

If you select a database that is greater than 1700 megabytes, the following warning message appears when you create and run a sample plate.

![Figure 3.18 Run -- Database Size Warning Message]

To resolve this problem:

1. Click No to dismiss the warning dialog box.
2. Exit the Run module and the Sample Setup module.
3. Make sure all of the other modules are closed.
4. Open the Data Manager module.
5. Create a new database. For details, see "Creating a Database" on page 323.
6. Copy the sample plate from the previous working database to the new database.
7. Click OK All to copy any objects referenced by the sample plate to the new database.
8. Exit the Data Manager module and launch the Run module.
9. Select Run | Start Sample Plate.
10. Select the new sample plate and click OK.

The system processes the plate and stores it in the new database.

**NOTE** It is recommended that you archive databases that are larger than about 1700 MB. For details, see "Checking the Database Size" on page 325.

Gel Re-estimation

The system determines if the gel cartridge volume is sufficient to safely process the plate.

- If the gel volume is greater that 1.5 mL more than the minimum amount needed to process the plate, the plate runs and the system does not re-estimate the gel volume.
- If the system determines that the gel cartridge volume is less than the volume needed to safely process the plate, the system displays the two re-estimation message boxes before running the sample plate.
In the first step, the system homes the gel pump and displays the Gel Volume Re-estimation message, as shown in Figure 3.19.

**Figure 3.19 Gel Volume Re-estimation - Step 1 Message Box**

In the second step, the system engages the gel pump plunger and accurately determines the gel volume. (See Figure 3.20.)

**Figure 3.20 Gel Volume Re-estimation - Step 2 Message Box**

If the actual volume (re-estimated by the system) is less than 1.0 mL more than the total volume to run the plate, the Sample Plate Gel Usage dialog box opens, as shown in Figure 3.21.

**Figure 3.21 Gel Usage Confirmation Dialog Box**

11. Click **Accept** to proceed with the run.
12. Specify the sample sets to run.
13. Select **Replace Gel Cartridge** to replace the gel cartridge before the run (if necessary).
Gel Volume Notification

If you attempt any operation that requires gel and there is not enough gel in the cartridge to perform the operation, a warning message appears.

For example, if you attempt to perform a capillary gel fill when the cartridge does not have enough gel, the system displays the message shown in Figure 3.22.

Figure 3.22 Gel Warning Dialog Box

If you attempt to run a sample plate and the gel cartridge does not have enough gel to process any sample sets in that plate, the system displays the message shown in Figure 3.23.

Figure 3.23 Gel Usage Confirmation Dialog Box

To end the run and return to the Run main window, click **Abort**.

Pausing a Sample Plate Run

- To pause the currently executing sample plate, click the **Pause** icon. The system pauses at the next executable step of the sample plate.
- To resume the run, click the **Pause** icon again.

Pause to Load

To pause a current run so you can load another plate:
Run Module
Using the Run Module

1. Select **Run | Pause to Load** to pause the system and load another plate. The Pause To Load Plates dialog box opens, as shown in the following example.

   ![Pause to Load Plates Dialog Box](image)

   **Figure 3.24 Pause to Load Plates Dialog Box**

2. Select one of the following load options:
   - **Load plate after the current sample set:** This option delays loading of plates until after immediate sample run. After completion of sample separation, the system enters the Access Plates condition. After loading the new plate, the system runs the next sample set from the original sample plate.
   - **Stop current sample set now to load plate:** This option immediately stops the run to allow for plate loading. If selected, the **Save Collected Data** option becomes available, allowing the previously collected data to be saved.
   - **Stop current sample plate now to load plate:** This option breaks the plate run before the next sample. If selected, the **Save Collected Data** option become available, allowing the previously collected data to be saved.

3. Click **OK**.

### Stopping a Sample Plate Run

To stop the currently executing sample plate:

1. Select **Run | Stop System** or click the **Stop System** toolbar icon. The the Stop System dialog box opens, as shown in the following example.

   ![Stop System Dialog Box](image)

   **Figure 3.25 Stop System Dialog Box**

2. Select the desired Stop Options radio button:
Run Module
Using the Run Module

- **Stop sample plate**: Stops the currently running sample plate immediately.
- **All Plates**: Check this box to make the *Stop sample plate* selection apply to both sample plates.
- **Skip current sample set**: Skips the currently running sample set.
- **Stop after current sample set completes**: Stops the run after the currently running sample set has been completed.
- **Save Collected Data**: Saves data already collected for the currently executing sample set.
- **Perform Shutdown Method**: Purges the system of any remaining DNA fragments and refills the capillaries with fresh gel after the sample plate has been cancelled. (The capillary temperature will be set to 35°C.)

3. Click **OK**.

### Setting or Changing Display Options

To set or change the graph data display options:

1. Open the Display Options dialog box using one of these methods:
   - Select **Tools | Display Options**.
   - While viewing a graph display of sequence data, right-click the graph and select **Display Options**.

   The Display Options screen opens, as shown in **Figure 3.26**.

![Figure 3.26 Display Options Dialog Box](image-url)
Run Module
Using the Run Module

2. Select the tab that identifies the type of display options you want to change. For details, see the following topics:
   - "Title Properties Tab" on page 74
   - "X Axis Options Tab" on page 74
   - "Y Axis Options Tab" on page 74
   - "Colors Tab" on page 74
   - "Dye Traces Tab" on page 74
   - "Current Trace Tab" on page 75

   **NOTE** For detailed descriptions while using this dialog box, click Help.

**Title Properties Tab**
Set or change the title of the displayed data panel.

1. In the Display Options dialog box, select the Title tab.
2. Change any item as necessary.
3. Click Apply to continue or OK to close the Display Options dialog box.

**X Axis Options Tab**
Define the X Axis properties of the displayed data panels.

1. In the Display Options dialog box, select the X Axis Options tab.
2. Change any item as necessary.
3. Click Apply to continue or OK to close the Display Options dialog box.

**Y Axis Options Tab**
Define the Y Axis properties of the displayed data panels.

1. In the Display Options dialog box, select the Y Axis Options tab.
2. Change any item as necessary.
3. Click Apply to continue or OK to close the Display Options dialog box.

**Colors Tab**
Define the color options of the window, the current traces, the voltage trace, or the optical scan trace.

1. In the Display Options dialog box, select the Colors tab.
2. Change any item as desired.
3. Click Apply to continue or OK to close the Display Options dialog box.

**Dye Traces Tab**
Set or change the dye trace properties.

1. In the Display Options dialog box, select the Dye Traces tab.
2. Select the traces to display or not display, under Show Dye Traces.
3. To change a color of any dye trace, click on the appropriate Dye Colors dye, select a color from the Color dialog box, then click OK.

4. When finished with Dye Traces, click Apply to continue or OK to close the Display Options dialog box.

Current Trace Tab
Set or change the current trace options:

1. In the Display Options dialog box, select the Current Traces tab.
2. Select the radio button for the current type to display under Data.
3. Click OK.

Viewing the Last Analysis Performed
View the last analysis performed on the CE system:

1. With a sample plate running (and with Automatic Analysis selected), select Tools | View Last Analysis. The Sequence Analysis Module dialog box opens and displays the last row of sample analyzed, along with the Sample Plate toolbar.
2. To view additional samples, select the appropriate sample positions in the sample plate toolbar and click Open.

If the last analysis was a sequence analysis result, the Sequence Analysis module opens, displaying the analyzed sequence data. If a Fragment Analysis separation was performed, the raw data will be displayed in the Sequence Analysis module.
3.3 Using Direct Control

Click on the Direct Control icon.

NOTE Use Figure 3.27, User Accessible Hardware Components, to locate hardware components referenced in this section.

Figure 3.27 User Accessible Hardware Components

1. Sample Access Cover (extended) 7. Manifold Access Cover
2. Capillary Access Cover (extended) 8. Gel Waste Bottle
4. Plate Holders/Sample Transport 10. Gel Pump
5. Capillary Temperature Control Cover 11. Gel Pump/Gel Cartridge Access Cover
6. Rubber Latches
Loading the Sample Plate and Buffer Plate For Dual Rail System

1. Select **Direct Control | Access Plates** from the menu.

   ![Access Plates Dialog Box](image)

   **Figure 3.28 Access Plates Dialog Box**

2. Click **Start**. The Capillaries Exposed dialog opens as shown below.

   ![Capillaries Exposed Dialogs](image)

   **Figure 3.29 Capillaries Exposed Dialogs**

3. Wait until the dialog warning turns green.

4. Open the Sample Access Cover (**Figure 3.27**) and lift it to the vertical locking position.

**Loading the Sample Plate**

1. Make sure the Wetting Station is installed or perform the following procedure, "**Installing the Wetting Tray**" on page 347, and then return here.

2. Align the Sample Plate Guide Pin with the notched corner of the sample plate and gently lower the plate into position (**Figure 3.30**).
Run Module
Using Direct Control

Figure 3.30  Loading the Sample Plate

1. Sample Plate  
2. Wetting Tray Retainers  
3. Sample Plate Holder  
4. Sample Plate Notched Edge  
5. ALIGN together  
6. Sample Plate Guide Pin

Loading the Buffer Plate and Evaporation Cover

1. Align the notched corner of the Buffer Plate with the alignment line on the Buffer Plate Holder (Figure 3.31).
2. Gently push the Buffer Plate towards the front of the instrument and then set the plate into the transport.
3. At the rear of the Buffer Plate Holder, align the Buffer Evaporation Cover Guide Pin with the Buffer Evaporation Cover Alignment Notch and then gently lower the cover over the Buffer Plate.
When finished positioning the sample and buffer plates, close the Sample Access Cover and then select the position from which the plates were loaded (left or right).

4. The **Capillaries Exposed** dialog will display and click **Load**.  

**CAUTION** The separation gel within the capillaries will dry out if the capillaries are left exposed to the air for more than 15 minutes.

### Loading the Sample Plate and Buffer Plate For Single Rail System

1. Select **Direct Control | Unload Plates** from the menu.
2. Click **Unload**. The Capillaries Exposed dialog will appear.

![Capillaries Exposed Dialog](image)

**Figure 3.33 Capillaries Exposed Dialog**

3. Open the Sample Access Cover (**Figure 3.27**) and lift it to the vertical locking position.
   - If Sample Plate was selected, skip to “Loading the Sample Plate.”
   - If Buffer Plate was selected, skip to “Loading the Buffer Plate and Evaporation Cover.”

**Loading the Sample Plate**

1. Make sure the Wetting Station is installed or perform the following procedure, "Installing the Wetting Tray" on page 347, and then return here.
2. Align the Sample Plate Guide Pin with the notched corner of the sample plate and gently lower the plate into position (**Figure 3.34**).

![Loading the Sample Plate](image)

**Figure 3.34 Loading the Sample Plate**

- 1. Sample Plate
- 2. Wetting Tray Retainers
- 3. Sample Plate Holder
- 4. Sample Plate Notched Edge
- 5. ALIGN together
- 6. Sample Plate Guide Pin
3. When finished positioning the plate, close the Sample Access Cover and then click the Load button of the Capillaries Exposed dialog box (Figure 3.35).

**CAUTION** The separation gel within the capillaries will dry out if the capillaries are left exposed to the air for more than 15 minutes.

![Capillaries Exposed Dialog](image)

**Figure 3.35 Capillaries Exposed Dialog**

**Loading the Buffer Plate and Evaporation Cover**

1. Align the notched corner of the Buffer Plate with the alignment line on the Buffer Plate Holder (Figure 3.31).
2. Gently push the Buffer Plate towards the front of the instrument and then set the plate into the transport.
3. At the rear of the Buffer Plate Holder, align the Buffer Evaporation Cover Guide Pin with the Buffer Evaporation Cover Alignment Notch and then gently lower the cover over the Buffer Plate.

![Loading the Buffer Plate and Buffer Evaporation Cover](image)

**Figure 3.36 Loading the Buffer Plate and Buffer Evaporation Cover**
Run Module
Using Direct Control

1. Front Location
2. Buffer Evaporation Cover
3. Buffer Plate
4. Buffer Evaporation Cover Alignment Notch
5. Wetting Tray Retainers

4. When finished positioning the plate, close the Sample Access Cover and then click the Load button of the Capillaries Exposed dialog box (Figure 3.35).

Setting the Capillary Temperature

1. Select Direct Control | Capillary Temperature from the menu.
2. In the Capillary Temperature dialog box enter a capillary holding temperature value in degrees centigrade.
3. Select Wait for temperature to be reached and then click Start.

Denaturing a Sample

1. Select Direct Control | Denature from the menu.
2. In the Denature Samples dialog box, enter a time duration in seconds.
3. Identify the position of the Sample Set and click Denature.

Injecting a Sample

1. Select Direct Control | Inject from the menu.
2. In the Inject dialog box, enter the Voltage in kV and enter a Time Duration in seconds.
3. Use the Sample Set option to set the position of the samples and then click Inject.

Performing a Separation

1. Select Direct Control | Separate from the menu.
2. In the Separate dialog box:
   a. Enter a value for the voltage in kV.
   b. Enter a time duration in minutes.
   c. Identify the position of the buffer using the Buffer Set spin controls and then select Separate.

NOTE Data will not be saved.

Replenishing the Capillaries with Gel

1. Select Direct Control | Gel Capillary Fill from the menu.
2. From the Gel Capillary Fill dialog box, select the Buffer Plate or Wetting Tray option to identify the position where waste will be expelled from the capillaries.
   - If Buffer Plate was selected, use the Buffer Plate spin controls to identify the waste position in the buffer plate and then select Fill.
• If Wetting Tray was selected, click Fill.

Purging the Manifold
1. Select Direct Control | Manifold Purge from the menu.
2. In the Manifold Purge dialog box, enter a volume in milliliters (mL).
3. Enter the number of cycles and then select Purge.

Performing an Optical Alignment
To align the lasers with the detection windows of the eight capillaries:
1. Select Direct Control | Optical Alignment from the Run menu.
2. To save the alignment data, select the Autosave check box.
3. Enter a name in the Name field.
4. Select a Work Folder from the drop-down menu.
5. Select Align.
   IMPORTANT Prior to performing an Optical Alignment, it is advisable to purge the Array Manifold and fill the capillaries with fresh gel (in that order). See “Purging the Manifold” and “Replenishing the Capillaries with Gel”.

Monitoring the Baseline
To monitor the system baseline:

NOTE An optical alignment must be performed before enabling the Monitor Baseline function. This will ensure accurate determination of the system baseline.
1. Perform an optical alignment.
2. Select Run | Monitor Baseline. The dialog will open.

Figure 3.37 Monitor Baseline Dialog Box
3. In the Monitor Baseline dialog, select Enable Monitor Baseline, then click OK.
4. Select the Data Monitor tab to view the baseline trace.
   After reviewing the baseline trace, disable Monitor Baseline. To do this:
Run Module
Using Direct Control

1. Select Run | Monitor Baseline.
2. In the Monitor Baseline dialog, select the Enable Monitor Baseline option, then click OK.

Viewing Capillary Information

1. Select Replenish | Capillary Information from the Run module menu bar.
2. Use the Capillary Information dialog box (Figure 3.38) to view the following information:

![Figure 3.38 Capillary Information Dialog](image)

3. View the following information:
   - **Part Number**: Displays the part number of the installed capillary array.
   - **Serial Number**: Displays the serial number of the installed capillary array. (The serial number is used to track the capillary array along with the samples that have used the array.)
   - **Date Installed**: Displays the date the capillary array was installed.
   - **Time Installed**: Displays the time the capillary array was installed.
   - **Number of Runs**: Specify the desired number using the spin-control. (Set more than the recommended number of separations to be performed before the system alerts you that the recommended number of runs has been exceeded.)
   - **Days on instrument**: Specify the number of days on the instrument using the spin-control. (This allows the capillary array to reside on the instrument longer than the recommended length of time before the system alerts you that the recommended number of days on the instrument has been exceeded.)
   - **Advanced**: Displays the Capillary Advanced Information dialog box. This dialog box displays the length and diameter of the installed capillary array based on the part number entered in the New Capillary Array dialog box. The fields are read-only and cannot be edited. Click OK to enter the information and close the dialog box.
4. When finished, click OK to close the dialog box.
Viewing Gel Information

1. Select **Replenish | Gel Cartridge/Buffer Information** from the Run Module menu bar.
2. Use the Gel Cartridge/Buffer Information dialog box (Figure 3.39) to view the following information:
   - **Part Number:** Displays the part number of the installed gel cartridge.
   - **Lot Number:** Displays the lot number of the installed gel cartridge. (The lot number is used to track the gel lot along with the separations that have used the gel.)
   - **Gel Name:** The name of the gel.
   - **Date Installed:** Displays the date the gel cartridge was installed.
   - **Time Installed:** Displays the time the gel cartridge was installed.
   - **Hours on Instrument:** Displays the number of hours that the gel cartridge has remained on the instrument.
3. When finished, select **OK** to close the dialog box.

![Figure 3.39 Gel Cartridge/Buffer Information Dialog Box](image)

Viewing or Changing Buffer Information

1. Select **Replenish | Gel Cartridge/Buffer Information** from the Run Module menu bar.
2. Use the Gel Cartridge/Buffer Information dialog box (see the figure above) to view or change the buffer lot number.

**NOTE** The buffer lot number can only be changed when the instrument is not performing a separation.
Run Module
Using Direct Control

Removing and Replacing the Capillary Array

**CAUTION** Be careful when installing or removing the capillary array to prevent damage and maintain low background signals. Clean all gel residue thoroughly.

**NOTE** This procedure assumes that an expended capillary array is being replaced with a new capillary array.

1. Select **Replenish | Release Capillary Array** from the **Run** menu. After the system prepares for release of the capillary array, the **Remove Capillary Array** dialog (Figure 3.40) is displayed.

![Figure 3.40 Remove Capillary Array Dialog Box](image)

2. Open the Sample Access Cover (Figure 3.41) and lift it to the vertical locking position.
3. Open the Capillary Access Cover and lift it to the vertical locking position.
4. Disconnect the two rubber latches holding the Capillary Temperature Control cover and lift the cover to the vertical locking position.
5. Loosen the Manifold Access Cover captive screw (Figure 3.41), then remove the cover and set it aside.
6. Loosen the two Plenum Assembly captive screws (Figure 3.42), then pull the Plenum Assembly straight back and away from the instrument and set it aside.

**CAUTION** Slowly remove the Plenum Assembly, as the electrode block may disengage from its mounting posts and become damaged.
Run Module
Using Direct Control

Figure 3.42 Plenum Assembly Removal

1. Captive Screw
2. Rubber Latch
3. Plenum Assembly
4. Captive Screw

7. Lift the Eject Lever (Figure 3.43) to release the Array Fitting.
8. Grasp the Array Fitting tab (Figure 3.43) and then:
   a. Pull the fitting approximately one inch out of the manifold.
   b. Touch the tip of the fitting to the bottom of the Optics Base Plate.
   c. Hold and wait five seconds for the gel strand to dry.
   d. Pull the fitting away from the instrument.
   e. Wipe gel strands off of the instrument using a damp tissue.

NOTE Note the number of runs and days on the instrument for this capillary array for reference. If this capillary array is to be re-installed, this information is necessary. A label has been provided on the back of the array packaging container so that this information may be recorded.
Figure 3.43 Removing/Replacing the Array Fitting

1. Guide Pins  
2. Eject Lever  
3. Array Fitting  
4. Gel Strand  
5. Optics Base Plate (bottom)  
6. Array Fitting

9. Grasp the Electrode Block tab (Figure 3.44) and pull the block out and away from the instrument.

10. From the Remove Capillary Array dialog box (Figure 3.40), select the Replace Capillary Array option and click OK.
Figure 3.44 Removing/Replacing the Electrode Block

1. Guide Block Pins
2. Electrode Block

**CAUTION** Always grip the capillary array fitting near the end during removal or installation of the tip cap to prevent flexing and possible breakage of the capillary array as shown below (Figure 3.45).
11. While holding the Array Fitting tab (of the new capillary array), align the Array Fitting (Figure 3.43) with the manifold opening and guide pins. Push the fitting into the manifold until it is completely seated against the bases of the Guide Pins. Make sure that the fitting tab is placed downward when inserting the capillary array into its slot.

12. While holding the Electrode Block tab, align the Electrode Block (Figure 3.44) with the guide block pins and gently push it in until resistance is met. (The resistance is from the spring-loaded contacts.)

13. When installing the capillary array, carefully route the capillaries through the hole in the Plenum Assembly (Figure 3.46) and straight across the guide block pins (Figure 3.44).

**Figure 3.45 Array Fitting**

**NOTE** When reinstalling the Plenum Assembly, gently gather the capillaries between your thumb and forefinger to make sure they pass through the hole in the Plenum Assembly without any constriction.

14. Replace the Plenum Assembly and tighten the two captive screws (Figure 3.42).

15. Replace the Manifold Access Cover and tighten the captive screw (Figure 3.41).

16. Lower the Capillary Temperature Control Cover and secure the two rubber latches.

17. Lower the Capillary Access Cover and Sample Access Cover to their locking positions.
   - If you are installing a new capillary array, in the Install Capillary Array dialog box (Figure 3.47), select the correct part number, enter the serial number, click **Set to New**, then click **Done**. The number of runs and days on instrument will revert to “0.”
   - If you are installing the previous capillary array, do not change the serial number, number of runs, or the number of days on the instrument as they will be correct.
   - If you are installing a capillary array that was previously used, but not the last capillary array on the instrument, enter its part number (if applicable) serial.
Run Module
Using Direct Control

number, and adjust the number of runs and the previous cumulative days on the instrument. Then click **Done**.

**NOTE** Note the number of runs and days on the instrument for this capillary array for reference.

![Install Capillary Array Dialog Box](image)

**Figure 3.47 Install Capillary Array Dialog Box**

18. The Confirm Capillary Array Selection dialog will appear. Read it and make the selection **Yes** to continue, or **No** to abort the capillary installation.
Removing and Replacing a Gel Cartridge/Gel Pump Plug For Dual Rail System

**CAUTION** Care must be exercised when installing/removing a gel cartridge due to the viscosity of the gel mixture.

**NOTE** This procedure assumes that an expended gel cartridge is being replaced with a fresh gel cartridge or that a used gel cartridge is being removed (for storage purposes) and being replaced with the gel pump plug.

1. Select **Replenish | Release Gel Cartridge** from the **Run Module** menu bar. When the system is ready to release the gel cartridge, the Release Gel Cartridge dialog box will be displayed. Wait until the lead screw is completely disengaged.

2. Open the Gel Pump/Gel Cartridge Access Cover (Figure 3.48) by gently pushing in on the top of the cover. (The cover is spring-loaded and will pop open.)

3. Pull on the Cartridge Locking Lever. (The barrel will swing outwards to approximately a 90° angle from its locked position.)

4. Grasp the wings of the gel cartridge/gel pump plug and pull it out of the barrel (Figure 3.49).

**NOTE** Always note the lot number and the hours on the instrument for a gel cartridge if you are planning to use it for more than one session.

---

**Figure 3.48 Removing/Replacing the Gel Cartridge**

1. Gel Pump/Gel Cartridge Access Cover  
2. Cartridge Locking Lever  
3. Cartridge Barrel  
4. Cartridge Locking Lever  
5. Cartridge Barrel
Run Module
Using Direct Control

5. If necessary, use a tissue to wipe gel strands off of the instrument.

![Diagram of gel cartridge replacement](901503L.AJ)

**Figure 3.49 Removing/Replacing the Gel Cartridge - Continued**

6. Remove any air pockets from the gel cartridge by grasping the cartridge wings between your first two fingers, and pressing the plunger with your thumb until a small amount of gel is pushed out of the cartridge tip.

7. Insert the new cartridge or the gel pump plug into the barrel and lock it into position by aligning the cartridge wings with the cartridge holder and pushing in.

8. Push the cartridge locking lever towards the back of the instrument (approximately a 90° angle) into its locked position.

9. Close the Gel Pump/Gel Cartridge Access Cover.

10. In the Remove Gel Cartridge dialog box (Figure 3.50):
    - Click **Install Cartridge** to indicate that a gel cartridge was installed.
    - OR
    - Click **Install Plug** to indicate that the gel pump plug (or empty cartridge) was installed.
11. If **Install Plug** was selected in step 10, proceed to step 12.

   If **Install Cartridge** was selected in step 10, use the Install Gel Cartridge dialog box (Figure 3.51) to enter the following information:
   
   a. If you are installing a new gel cartridge, click **New**. The system will automatically update the date and time installed and set the **Hours on Instrument** to “0.”
   
   b. Next, enter the lot number.
   
   c. If you are installing a used Gel Cartridge, select **Used**.
      
      - If you are installing the previous used gel cartridge, do not change the lot number, or the hours on the instrument, as they will be correct.
      - If you are installing a previously used gel cartridge, but it was not the last one on the instrument, enter its part number and/or lot number, and adjust the hours to properly reflect the hours this cartridge has been on the instrument.
   
   d. Click **Done** on the Install Gel Cartridge dialog.

   **NOTE** Always note the lot number and the hours on the instrument for a gel cartridge if you are planning to use it for more than one session. The lot number is an alphanumeric text box for your own identification purposes.

12. Dispose of the used tissue and spent gel cartridge in accordance with the procedure, "Maintenance and Diagnostics" on page 339.
Removing and Replacing a Gel Cartridge/Gel Pump Plug For Single Rail System

**CAUTION** Care must be exercised when installing/removing a gel cartridge due to the viscosity of the gel mixture.

**NOTE** This procedure assumes that an expended gel cartridge is being replaced with a fresh gel cartridge or that a used gel cartridge is being removed (for storage purposes) and being replaced with the gel pump plug.

1. Select **Replenish | Release Gel Cartridge** from the **Run Module** menu bar. When the system is ready to release the gel cartridge, the Release Gel Cartridge dialog box will be displayed. Wait until the lead screw is completely disengaged.

2. Open the Gel Pump/Gel Cartridge Access Cover (Figure 3.52) by gently pushing in on the top of the cover. (The cover is spring-loaded and will pop open.)

3. Pull on the Cartridge Locking Lever. (The barrel will swing outwards to approximately a 90° angle from its locked position.)

4. Grasp the wings of the gel cartridge/gel pump plug and pull it out of the barrel (Figure 3.53).

**NOTE** Always note the lot number and the hours on the instrument for a gel cartridge if you are planning to use it for more than one session.
5. If necessary, use a tissue to wipe gel strands off of the instrument.

6. Remove any air pockets from the gel cartridge by grasping the cartridge wings between your first two fingers, and pressing the plunger with your thumb until a small amount of gel is pushed out of the cartridge tip.

7. Insert the new cartridge or the gel pump plug into the barrel and lock it into position by aligning the cartridge wings with the cartridge holder and pushing in.

8. Push the cartridge locking lever towards the back of the instrument (approximately a 90° angle) into its locked position.

9. Close the Gel Pump/Gel Cartridge Access Cover.

10. In the Remove Gel Cartridge dialog box (Figure 3.54):
    - Click **Install Cartridge** to indicate that a gel cartridge was installed.
    - OR
    - Click **Install Plug** to indicate that the gel pump plug (or empty cartridge) was installed.
Run Module
Using Direct Control

Figure 3.54 Remove Gel Cartridge Dialog Box

11. If Install Plug was selected in step 10, proceed to step 12.

   If Install Cartridge was selected in step 10, use the Install Gel Cartridge dialog box (Figure 3.55) to enter the following information:

   a. If you are installing a new gel cartridge, click the Set to New button, select the part number from the drop-down menu, enter the lot number, and then click OK. The system will automatically update the date and time installed and set the Hours on Instrument to “0.”

   b. If you are installing the previous gel cartridge, do not change the lot number, or the hours on the instrument, as they will be correct.

   c. If you are installing a previously used gel cartridge, but it was not the last one on the instrument, enter its part number and/or lot number, and adjust the hours to properly reflect the hours this cartridge has been on the instrument.

   d. Click Done on the Install Gel Cartridge dialog.

   NOTE Always note the lot number and the hours on the instrument for a gel cartridge if you are planning to use it for more than one session.

   NOTE The lot number is an alphanumeric text box for your own identification purposes.

   CAUTION If the gel cartridge has been on the instrument for more than 72 hours, it is likely that the gel will produce undesirable results.

Figure 3.55 Install Gel Cartridge Dialog Box

12. Dispose of the used tissue and spent gel cartridge in accordance with the procedure, "Maintenance and Diagnostics" on page 339.
Removing the Manifold Plug

The Manifold Plug is installed during shipping and when the instrument is not in use, to prevent the gel from drying.

**NOTE** This procedure assumes that the Manifold Plug is being removed in preparation for Capillary Array installation.

1. Select **Replenish I Release Capillary Array** from the Run Module main menu.
3. Open the Sample Access Cover and lift it to the vertical locking position.
4. Open the Capillary Access Cover and lift it to the vertical locking position.
5. Unlatch the two rubber latches holding the Capillary Temperature Control Cover and lift it to the vertical locking position (Figure 3.56).
6. Loosen the Manifold Access Cover captive screw, remove the cover and set it aside.
Run Module
Using Direct Control

Figure 3.56 Manifold Access Cover

1. Capillary Temperature Control Cover
2. Plenum Assembly
3. Manifold Access Cover
4. Captive Screw
5. Manifold Access Cover (removed)

7. Lift the Eject Lever to release the Manifold Plug.
8. Grasp the Manifold Plug tab (Figure 3.57) and then:
   a. Pull the plug approximately one inch out of the manifold.
   b. Touch the tip of the plug to the bottom of the Optics Base Plate.
   c. Hold and wait five seconds for the gel strand to dry.
   d. Pull the plug out and set it aside for future use.
   e. Wipe gel strands off of the instrument using a damp tissue.
9. Click **OK** on the Remove Manifold Plug dialog box.
10. To install the capillary array, see "Removing and Replacing the Capillary Array" on page 86.
Sequence Analysis

This chapter provides an overview of the Sequence Analysis module, including its menu options, toolbars, and dialog boxes. It shows you how to use this module to run a sequence analysis, and to set up its parameters, result properties, and display options. It also describes how to work with, report, and export sequence analysis results.

4.1 Sequence Analysis Module Overview

View, analyze, compare, edit, and print data of the following types:

- Raw Data*
- Current Data*
- Voltage Data*
- Analyzed Data
- Base Sequences
- Optical Scan Data*
- Baseline Data*
- Quality Parameters*

* These types of data cannot be edited.

This module accepts raw data and analyzed data. Editing and re-analysis functions enable you to verify the accuracy of the base calls. You can also export these data to third-party packages for further analysis.

Main Window

The following illustration identifies the areas on the Sequence Analysis module's main window that are described in Table 4.1.
Figure 4.1 Main Window, Sequence Analysis Module

The following table describes the items called out in Figure 4.1.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Title Bar - Shows the module name (Sequence Analysis) and the currently active sample.</td>
</tr>
<tr>
<td>B</td>
<td>Menu Bar - See &quot;Menu Bar Options&quot; on page 105.</td>
</tr>
<tr>
<td>C</td>
<td>Toolbar - See &quot;Toolbar Icons&quot; on page 114.</td>
</tr>
<tr>
<td>D</td>
<td>Display Area - Graphically displays the opened data.</td>
</tr>
<tr>
<td>E</td>
<td>Double-clicking on a base sequence text letter (A, C, G, T) in the Dye Colors toolbar opens the Color dialog box, which you can use to change the dye color displayed for the selected dye.</td>
</tr>
</tbody>
</table>
The following example shows the Sequence Analysis module's menu bar.

![Menu Bar Options](image)

The following topics describe each of these menus and their options.
**Sequence Analysis**

**Sequence Analysis Module Overview**

**File Menu**

Click the **File** menu to display its drop-down menu, as shown in the following example.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open...</td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
</tr>
<tr>
<td>Close Tab</td>
<td><strong>Ctrl+O</strong></td>
</tr>
<tr>
<td>Save</td>
<td></td>
</tr>
<tr>
<td>Save As...</td>
<td><strong>Ctrl+S</strong></td>
</tr>
<tr>
<td>Report...</td>
<td></td>
</tr>
<tr>
<td>Export...</td>
<td></td>
</tr>
<tr>
<td>Export from Data</td>
<td></td>
</tr>
<tr>
<td>Preferences...</td>
<td></td>
</tr>
<tr>
<td>Properties...</td>
<td></td>
</tr>
<tr>
<td>Report Correct...</td>
<td></td>
</tr>
<tr>
<td>Print Program</td>
<td><strong>Ctrl+R</strong></td>
</tr>
<tr>
<td>Print Report</td>
<td><strong>Ctrl+P</strong></td>
</tr>
<tr>
<td>Print Selected Pane</td>
<td><strong>Ctrl+P</strong></td>
</tr>
<tr>
<td>Print Desktop</td>
<td></td>
</tr>
</tbody>
</table>

- **File Menu, Sequence Analysis Module**

Use the **File** menu to open, save, import, export, and print data and to set preferences. The following table describes the Sequence Analysis module's **File** menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Open Sample Data, Sequence Analysis Parameters, Optical Scan Data, Sequence Results, and Sample Plate Results.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the open sample.</td>
</tr>
<tr>
<td>Close Tab</td>
<td>Closes the active tab.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves existing data.</td>
</tr>
<tr>
<td>Save As</td>
<td>Save data to a new name.</td>
</tr>
<tr>
<td>Import</td>
<td>Locate and select data to import. The system can import data in Standard Chromatogram Format (<em>.scf) or Electropherogram Sample Data (</em>.esd) format.</td>
</tr>
</tbody>
</table>
### Table 4.2 File Menu, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>Export data in one of the following formats:</td>
</tr>
<tr>
<td></td>
<td>• Standard Chromatogram Format Ver 3.00 (*.scf)</td>
</tr>
<tr>
<td></td>
<td>• Standard Chromatogram Format Ver 2.10 (*.scf)</td>
</tr>
<tr>
<td></td>
<td>• Tab Delimited ASCII Text (*.txt)</td>
</tr>
<tr>
<td></td>
<td>• SEQ Sequence Text (*.seq)</td>
</tr>
<tr>
<td></td>
<td>• FASTA and Quality (*.fasta)</td>
</tr>
<tr>
<td></td>
<td>• PHRED and SCF (*.fasta.phd.1)</td>
</tr>
<tr>
<td></td>
<td>• ESD (*.esd)</td>
</tr>
<tr>
<td></td>
<td>• CEQ (<em>.cq</em>)</td>
</tr>
<tr>
<td>Export from Plate</td>
<td>Opens or exports samples from a specific sample plate. To select multiple samples, press the Shift key while selecting samples. (The Sample Plate toolbar must be open to use this menu option.)</td>
</tr>
<tr>
<td>Preferences</td>
<td>Used to:</td>
</tr>
<tr>
<td></td>
<td>• View or change the panes displayed when you first open a sample.</td>
</tr>
<tr>
<td></td>
<td>• Show the Report Format dialog box selecting File Print Report.</td>
</tr>
<tr>
<td></td>
<td>• Open all associated results that belong to a sample when a samples is opened.</td>
</tr>
<tr>
<td></td>
<td>• Open/export the most recent results from a sample plate.</td>
</tr>
<tr>
<td></td>
<td>• Show the Analysis Log during analysis.</td>
</tr>
<tr>
<td></td>
<td>• Print the entire desktop.</td>
</tr>
<tr>
<td></td>
<td>• Print the application window, including all toolbars.</td>
</tr>
<tr>
<td></td>
<td>• Print only the displayed panes.</td>
</tr>
<tr>
<td></td>
<td>• Select audio playback speed.</td>
</tr>
<tr>
<td>Properties</td>
<td>View the general properties of the currently selected item. You can view the item type, database, and project where the item resides, as well as the date and time the item was last modified. You may also view the sample name, sample plate, sample position in the sample plate, the instrument, and the operator name. You can also view the Property Set, run Method, Analysis, Alignment, Consumables and Note of the currently selected sample.</td>
</tr>
<tr>
<td>Report Format</td>
<td>Specify the format of the report to be generated for the active sample.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a facsimile of a hardcopy printout of the selected sample plate.</td>
</tr>
<tr>
<td>Print Report</td>
<td>Prints the report.</td>
</tr>
<tr>
<td>Print Selected Pane</td>
<td>Prints the selected pane.</td>
</tr>
<tr>
<td>Print Desktop</td>
<td>Prints the desktop, application, or main window as defined in the Preferences dialog box.</td>
</tr>
<tr>
<td>Recent Objects</td>
<td>Lists the most recently opened objects. The first set of four is sample data and the second set of four is sequence results.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Sequence Analysis module.</td>
</tr>
</tbody>
</table>
Sequence Analysis

Sequence Analysis Module Overview

Edit Menu

Click the Edit menu to display its drop-down menu, as shown in the following example.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Cancels the last action performed.</td>
</tr>
<tr>
<td>Redo</td>
<td>Reverses the last undo action.</td>
</tr>
<tr>
<td>Cut</td>
<td>Cuts selected bases and copies them to the clipboard. To activate/inactivate this function, select Tools</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies selected bases to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts one or more copied or cut bases from the clipboard to the selected text position. To activate/inactivate this function, select Tools</td>
</tr>
<tr>
<td>Apply Quality-based Trimming</td>
<td>Commits to the quality-based trimming.</td>
</tr>
<tr>
<td>Apply Sequence-based Trimming</td>
<td>Commits to the sequence-based trimming.</td>
</tr>
<tr>
<td>Audio Enable</td>
<td>Toggles between enabling or disabling audio. If enabled while in Edit mode, the system audibly announces each letter as you type a base letter.</td>
</tr>
<tr>
<td>Audio Playback</td>
<td>Audibly announces a series of selected base sequence text.</td>
</tr>
</tbody>
</table>
View Menu

Click the View menu to display its drop-down menu, as shown in the following example.

![View Menu Example]

**NOTE**  A "✓" next to an option indicates that the option is enabled.

The following table describes the Sequence Analysis module's View menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbars</td>
<td>Used to select which toolbars to display. Select (✓) the options that identify the toolbars you want displayed. To hide a toolbar, clear its check box. See &quot;Toolbar Icons&quot; on page 114.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Toggles between displaying or not displaying the status bar.</td>
</tr>
<tr>
<td>Analyzed Data</td>
<td>Displays the data that has been analyzed for the active sample.</td>
</tr>
<tr>
<td>Base Sequence</td>
<td>Displays a text view of the bases from the analyzed data for the active sample.</td>
</tr>
<tr>
<td>Raw Data</td>
<td>Displays the raw data for the active sample.</td>
</tr>
<tr>
<td>Current</td>
<td>Displays the current data for the active sample.</td>
</tr>
<tr>
<td>Voltage</td>
<td>Displays voltage data for the active sample.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Displays the alignment data for the active sample.</td>
</tr>
<tr>
<td>Alignment Accuracy</td>
<td>Displays the alignment accuracy data for the active sample.</td>
</tr>
<tr>
<td>Quality Parameters</td>
<td>Shows a graphical representation of the quality values for the active sample.</td>
</tr>
<tr>
<td>Trimming Report</td>
<td>Toggles the trimming report pane on or off.</td>
</tr>
<tr>
<td>Parameters Used to Compute</td>
<td>Displays the sequence analysis parameters used to produce the analyzed data. This dialog box provides the same information displayed when editing these parameters; however, the fields in this dialog box are read-only, and are not editable. This item is not available for data that has not yet been analyzed. For parameter descriptions, see &quot;Editing Sequence Analysis Parameters&quot; on page 124 or click Help when using the dialog box.</td>
</tr>
</tbody>
</table>
Table 4.4 View Menu, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Log</td>
<td>Displays the messages received from the instrument during the sample run.</td>
</tr>
<tr>
<td>Working Database</td>
<td>Displays the name of the database in use.</td>
</tr>
</tbody>
</table>

Tools Menu

Click the Tools menu to display its drop-down menu, as shown in the following example.

```
Tools
- Zoom
- Pan
- Align
- Edit

Unzoom
Unzoom All
Autoscale

Base Spacing
Base Synch
Bases on Top

Compare
Compare Synch
Align Compare Views

Display Options...
Heterozygote Display Color...
```

NOTE  A “✓” next to an option indicates that the option is enabled.

The following table describes the Sequence Analysis module's Tools menu options.

Table 4.5 Tools Menu, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Magnifies a specific area of data in the display.</td>
</tr>
<tr>
<td>Pan</td>
<td>Moves analyzed data in the X and Y direction.</td>
</tr>
<tr>
<td>Align</td>
<td>Visually align bases and peaks in the analyzed data pane.</td>
</tr>
<tr>
<td>Edit</td>
<td>Insert, change, and/or delete bases.</td>
</tr>
<tr>
<td>Unzoom</td>
<td>Undoes one zoom level.</td>
</tr>
<tr>
<td>Unzoom All</td>
<td>Undoes all zoom levels.</td>
</tr>
<tr>
<td>Autoscale</td>
<td>Scales data to the confines of the pane. If autoscaling is disabled, the system scales the data to their true values. Use this item to turn autoscaling on or off.</td>
</tr>
<tr>
<td>Base Spacing</td>
<td>Sets the space between base sequence text in groups of 0, 3, 5, or 10.</td>
</tr>
<tr>
<td>Base Synch</td>
<td>With both the analyzed data and base sequence panes open, synchronizes the analyzed data display with the highlighted base sequence text, showing the corresponding peak or peaks between two hairlines for the selected base.</td>
</tr>
<tr>
<td>Bases on Top</td>
<td>Toggles the base sequence text between displaying on the top or bottom in the analyzed data pane.</td>
</tr>
<tr>
<td>Compare</td>
<td>Selects an analyzed data set to compare to the current analyzed data set.</td>
</tr>
</tbody>
</table>
Table 4.5 Tools Menu, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare Synch</td>
<td>Synchronizes scaling, zooming, and panning of two analyzed data sets while in the Compare mode.</td>
</tr>
<tr>
<td>Align Compare Views</td>
<td>Aligns selected points of each of the displayed analyzed data sets while in the Compare mode.</td>
</tr>
<tr>
<td>Display Options</td>
<td>Opens the Display Options dialog box, which provides tabs used to modify any or all of the following parameters: Title, X Axis Options, Y Axis Options, Dye Traces, Current Traces, Colors, and Quality Parameters. For details, see &quot;Setting or Changing Display Options&quot; on page 153 or click Help when using the dialog box.</td>
</tr>
<tr>
<td>Heterozygote Display Color</td>
<td>Opens the Colors dialog box, which you can use to change the color of the heterozygotes in the base sequence pane. For details, see &quot;Changing Display Colors&quot; on page 155.</td>
</tr>
</tbody>
</table>

Analysis Menu

Click the **Analysis** menu to display its drop-down menu, as shown in the following example.

```
Analysis
  Analyze ...
  Stop
Working Analysis Parameters...
  Restore Original Base Sequence
Batch Analysis ...
  Reanalyze Batch ...
  View Selected Batch Sample Result
Skip Current Sample
Skip Current Sample Set
Skip Current Sample Plate
Pause After Current Sample
Resume Batch Processing
Third Party Analysis ...
Third Party Analysis Setup ...
Service Alignment
  Align With Template ...
  Batch Alignment ...
Trim Based On Quality
  Trim Based On Sequence
Batch Trimming ...
```

The following table describes the Sequence Analysis module's **Analysis** menu options.

Table 4.6 Analysis Menu, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze</td>
<td>Analyze active sample data or reanalyze existing sequence results. Selecting this option opens the current Working Parameters dialog box. Click OK to start the analysis.</td>
</tr>
<tr>
<td>Stop</td>
<td>Terminates the analysis currently in progress.</td>
</tr>
</tbody>
</table>
## Table 4.6 Analysis Menu, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working Analysis Parameters</td>
<td>View and change the analysis parameters to be used for subsequent analyses. For details, see “Editing Sequence Analysis Parameters” on page 124.</td>
</tr>
<tr>
<td>Restore Original Base Sequence</td>
<td>Returns analyzed data displays and base sequence text back to their original states (losing all edits).</td>
</tr>
<tr>
<td>Batch Analysis</td>
<td>Analyze multiple sample data or sample plate results sequentially. Selecting this option opens the following dialog box. For details, see “Performing a Batch Analysis” on page 156.</td>
</tr>
<tr>
<td>Reanalyze Batch</td>
<td>After performing a batch analysis, use this option to perform the analysis again. For details, see “Reanalyzing a Batch” on page 157.</td>
</tr>
<tr>
<td>View Selected Batch Sample Result</td>
<td>After performing a batch analysis, use this option to view the results of a selected sample in the upper pane of the batch analysis window.</td>
</tr>
<tr>
<td>Skip Current Sample</td>
<td>While performing a batch analysis, use this option to pass over the sample currently being analyzed. (This item is not available if Sample Plate Results was selected from the Batch Analysis Selection dialog box.)</td>
</tr>
<tr>
<td>Skip Current Sample Set</td>
<td>While performing a batch analysis, use this option to pass over the sample set currently being analyzed. (This item is not available if Sample Data was selected from the Batch Analysis Selection dialog box.)</td>
</tr>
<tr>
<td>Skip Current Sample Plate</td>
<td>While performing a batch analysis, use this option to pass over the sample plate currently being analyzed. (This item is not available if Sample Data was selected from the Batch Analysis Selection dialog box.)</td>
</tr>
<tr>
<td>Pause After Current Sample</td>
<td>Momentarily stops a batch analysis after the system analyzes the currently running sample. Use Resume Batch Processing to continue the analysis.</td>
</tr>
<tr>
<td>Resume Batch Processing</td>
<td>Resumes a batch analysis after it has been paused.</td>
</tr>
<tr>
<td>Third Party Analysis</td>
<td>Launches the third-party analysis package specified in the Third Party Analysis Setup dialog box.</td>
</tr>
<tr>
<td>Third Party Analysis Setup</td>
<td>Specifies the path, third-party analysis package (loaded on your PC), and the export format of the data.</td>
</tr>
<tr>
<td>Service Alignment</td>
<td>Used to:</td>
</tr>
<tr>
<td></td>
<td>• Align the sequence against puc18dG.</td>
</tr>
<tr>
<td></td>
<td>• Print the alignment report.</td>
</tr>
<tr>
<td></td>
<td>• Export the alignment data (as a text file).</td>
</tr>
<tr>
<td>Align with Template</td>
<td>Performs an alignment of the sequence against the current alignment settings.</td>
</tr>
<tr>
<td>Batch Alignment</td>
<td>Performs a batch alignment.</td>
</tr>
<tr>
<td>Trim Based on Quality</td>
<td>Opens the Current Working Parameters dialog box. Click Edit to open the Quality-based Trimming tab.</td>
</tr>
<tr>
<td>Trim Based on Sequence</td>
<td>Opens the Current Working Parameters dialog box. Click Edit to open the Sequence-based Trimming tab in the Sequence Analysis Parameters Editor.</td>
</tr>
<tr>
<td>Batch Trim</td>
<td>Opens the Batch Trimming dialog box.</td>
</tr>
</tbody>
</table>
Window Menu
Click the Window menu to display its drop-down menu, as shown in the following example.

The following table describes the Sequence Analysis module's Window menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Cascades the open windows.</td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td>Tiles the windows in a horizontal</td>
</tr>
<tr>
<td></td>
<td>orientation.</td>
</tr>
<tr>
<td>Tile Vertically</td>
<td>Tiles the windows in a vertical</td>
</tr>
<tr>
<td></td>
<td>orientation.</td>
</tr>
<tr>
<td>Close All</td>
<td>Closes any currently active windows.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Automatically arranges the icons.</td>
</tr>
</tbody>
</table>

Help Menu
Click the Help menu to display its drop-down menu, as shown in the following example.

The following table describes the Help menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Select this option to display the CE system online help. By default, the</td>
</tr>
<tr>
<td></td>
<td>help system displays the Contents in the navigation pane, located on the</td>
</tr>
<tr>
<td></td>
<td>left, and the introductory topic in the topic pane, located on the right.</td>
</tr>
<tr>
<td></td>
<td>You can use the Contents to select and print specific help topics. The</td>
</tr>
<tr>
<td></td>
<td>navigation pane also provides a Search tab and an Index tab. These tabs let</td>
</tr>
<tr>
<td></td>
<td>you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td>Using Help</td>
<td>Select this option to display the Contents window on how to use the Windows</td>
</tr>
<tr>
<td></td>
<td>Help system.</td>
</tr>
<tr>
<td>About GenomeLab System</td>
<td>Select this option to access software, instrument, and system information.</td>
</tr>
<tr>
<td>Beckman Coulter Home Page</td>
<td>Select this option to access the Beckman Coulter Home Page on the Internet.</td>
</tr>
</tbody>
</table>
**Toolbar Icons**

The Sequence Analysis module provides seven toolbars: (1) Standard, (2) Data, (3) Sample View, (4) Sequence Dye Colors, (5) Batch Control, (6) Sample Plate and (7) Base Sequence. Each icon on these toolbars corresponds to a commonly used menu item. By default, all toolbars (except Sample Plate and Base Sequence) are displayed when you first open the Sequence Analysis module.

The following tables describe the function of each of the toolbar icons.

**Standard Toolbar**

The following example shows the Sequence Analysis module's Standard toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 4.9.

![Standard Toolbar, Sequence Analysis Module](image)

**Table 4.9 Standard Toolbar, Sequence Analysis Module**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open Icon" /></td>
<td>Open - Opens data files, including: Sample Data, Sequence Analysis Parameters, Optical Scan Data, Sequence Results, and Sample Plate Results.</td>
</tr>
<tr>
<td><img src="image" alt="Save Icon" /></td>
<td>Save - Saves existing data.</td>
</tr>
<tr>
<td><img src="image" alt="Print Icon" /></td>
<td>Print - Prints the report.</td>
</tr>
<tr>
<td><img src="image" alt="Print Preview Icon" /></td>
<td>Print Preview - Displays a facsimile of a hardcopy printout of the selected sample plate.</td>
</tr>
<tr>
<td><img src="image" alt="Print Desktop Icon" /></td>
<td>Print Desktop - Prints the desktop, application, or main window as defined in the Preferences dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Cut Icon" /></td>
<td>Cut - Cuts selected bases from the selected position and copies them to the clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Copy Icon" /></td>
<td>Copy - Copies selected bases to the clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Paste Icon" /></td>
<td>Paste - Inserts one or more copied or cut bases to the selected text position.</td>
</tr>
<tr>
<td><img src="image" alt="Undo Icon" /></td>
<td>Undo - Undoes the last action performed.</td>
</tr>
<tr>
<td><img src="image" alt="Redo Icon" /></td>
<td>Redo - Redoes the last undo action.</td>
</tr>
<tr>
<td><img src="image" alt="Apply Quality-based Trimming Icon" /></td>
<td>Apply Quality-based Trimming - Commits to the quality-based trimming.</td>
</tr>
<tr>
<td><img src="image" alt="Apply Sequence-based Trimming Icon" /></td>
<td>Apply Sequence-based Trimming - Commits to the sequence-based trimming.</td>
</tr>
<tr>
<td><img src="image" alt="Audio Enable Icon" /></td>
<td>Audio Enable - Toggles between enabling or disabling audio. When this option is enabled in Edit mode, the system audibly announces each base letter typed.</td>
</tr>
</tbody>
</table>
## Table 4.9 Standard Toolbar, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Audio Playback" /></td>
<td>Audio Playback - Audibly announces a series of selected base sequence text.</td>
</tr>
<tr>
<td><img src="image2" alt="Working Analysis Parameters" /></td>
<td>Working Analysis Parameters - View and/or change the analysis parameters to be used for subsequent analyses.</td>
</tr>
<tr>
<td><img src="image3" alt="Analyze" /></td>
<td>Analyze - Analyze active sample data or reanalyze existing sequence results. Selecting this option opens the current Working Parameters dialog box. Click <strong>OK</strong> to start the analysis.</td>
</tr>
<tr>
<td><img src="image4" alt="Stop" /></td>
<td>Stop - Terminates the analysis currently in progress.</td>
</tr>
<tr>
<td><img src="image5" alt="Trim Based on Quality" /></td>
<td>Trim Based on Quality - Performs a trim based on quality.</td>
</tr>
<tr>
<td><img src="image6" alt="Trim Based on Sequence" /></td>
<td>Trim Based on Sequence - Performs a trim based on a sequence.</td>
</tr>
<tr>
<td><img src="image7" alt="Restore Original Base Sequence" /></td>
<td>Restore Original Base Sequence - Returns analyzed data display and base sequence text back to its original state (losing all edits).</td>
</tr>
<tr>
<td><img src="image8" alt="Third Party Analysis" /></td>
<td>Third Party Analysis - Opens the third-party analysis package specified in the Third Party Analysis Setup dialog box.</td>
</tr>
<tr>
<td><img src="image9" alt="Align" /></td>
<td>Align - Performs an alignment of the sequence against the current alignment settings.</td>
</tr>
<tr>
<td><img src="image10" alt="Base Sequence Toolbar" /></td>
<td>Base Sequence Toolbar - Displays the base sequence toolbar that allows you to search for text and ambiguity codes.</td>
</tr>
<tr>
<td><img src="image11" alt="View Sample Plate Toolbar" /></td>
<td>View Sample Plate Toolbar - Displays the sample plate toolbar that allows you to select the samples to open or export.</td>
</tr>
<tr>
<td><img src="image12" alt="Heterozygote Backward Search" /></td>
<td>Heterozygote Backward Search - Search backwards for heterozygotes in the base sequence text pane.</td>
</tr>
<tr>
<td><img src="image13" alt="Heterozygote Forward Search" /></td>
<td>Heterozygote Forward Search - Search forward for heterozygotes in the base sequence text pane.</td>
</tr>
<tr>
<td><img src="image14" alt="Help Topics" /></td>
<td>Help Topics - Displays the CE system online help. By default, the help system displays the Contents in the navigation pane, located on the left, and the introductory topic in the topic pane, located on the right. You can use the Contents to select and print specific help topics. The navigation pane also provides a Search tab and an Index tab. These tabs let you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td><img src="image15" alt="Context-Sensitive Help" /></td>
<td>Context-Sensitive Help - Click this icon and then on a menu item to open the Help file related to the selection.</td>
</tr>
</tbody>
</table>
Data Toolbar
The following example shows the Sequence Analysis module's Data toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 4.10.

Figure 4.3  Data Toolbar, Sequence Analysis Module

Table 4.10 Data Toolbar, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom Mode" /></td>
<td>Zoom Mode - Magnifies a specific area of data in the display.</td>
</tr>
<tr>
<td><img src="image" alt="Pan Mode" /></td>
<td>Pan Mode - Move analyzed data in the X and Y direction.</td>
</tr>
<tr>
<td><img src="image" alt="Align Mode" /></td>
<td>Align Mode - Visually aligns bases and peaks in the analyzed data pane.</td>
</tr>
<tr>
<td><img src="image" alt="Edit Mode" /></td>
<td>Edit Mode - Insert, change, and/or delete bases.</td>
</tr>
<tr>
<td><img src="image" alt="Unzoom" /></td>
<td>Unzoom - Zoom out one level.</td>
</tr>
<tr>
<td><img src="image" alt="Unzoom All" /></td>
<td>Unzoom All - Zoom out all levels.</td>
</tr>
<tr>
<td><img src="image" alt="Autoscale" /></td>
<td>Autoscale - Scales data to the confines of the pane. If autoscaling is disabled, the data is scaled to its true values. Use this item to turn autoscaling on or off.</td>
</tr>
<tr>
<td><img src="image" alt="Base Spacing" /></td>
<td>Base Spacing - Sets the space between base sequence text in groups of 0, 3, 5, or 10.</td>
</tr>
<tr>
<td><img src="image" alt="Base Synch" /></td>
<td>Base Synch - With both the analyzed data and base sequence panes open, synchronizes the analyzed data display with the highlighted base sequence text showing the corresponding peak or peaks between two hairlines for the selected base.</td>
</tr>
<tr>
<td><img src="image" alt="Bases on Top" /></td>
<td>Bases on Top - Toggles the base sequence text between displaying on the top or bottom in the analyzed data pane.</td>
</tr>
<tr>
<td><img src="image" alt="Compare Synch" /></td>
<td>Compare Synch - Synchronizes scaling, zooming, and panning of two analyzed data sets while in the Compare mode.</td>
</tr>
<tr>
<td><img src="image" alt="Align" /></td>
<td>Align - Aligns selected points of each of the displayed analyzed data sets while in the Compare mode.</td>
</tr>
<tr>
<td><img src="image" alt="Display Options" /></td>
<td>Display Options - Opens the Display Options dialog box.</td>
</tr>
</tbody>
</table>
Sample View Toolbar
The following example shows the Sequence Analysis module's Sample View toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 4.11

![Sample View Toolbar](image)

Figure 4.4 Sequence Analysis Module, Sample View Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Analyzed Data" /></td>
<td>Analyzed Data - Displays the data that has been analyzed for the active sample.</td>
</tr>
<tr>
<td><img src="image" alt="Base Sequence" /></td>
<td>Base Sequence - Displays a text view of the bases from the analyzed data for the active sample.</td>
</tr>
<tr>
<td><img src="image" alt="Raw Data" /></td>
<td>Raw Data - Displays the raw data for the active sample.</td>
</tr>
<tr>
<td><img src="image" alt="Current" /></td>
<td>Current - Displays the current data from the capillary arrays for the active sample.</td>
</tr>
<tr>
<td><img src="image" alt="Voltage" /></td>
<td>Voltage - Displays the voltage data from the instrument for the active sample.</td>
</tr>
<tr>
<td><img src="image" alt="Compare Data" /></td>
<td>Compare Data - Compare the active analyzed data set against another analyzed data set.</td>
</tr>
<tr>
<td><img src="image" alt="Quality Parameters" /></td>
<td>Quality Parameters - Displays a graphical representation of the quality values for the active sample.</td>
</tr>
</tbody>
</table>

Dye Colors Toolbar
The following example shows the Sequence Analysis module's Dye Colors toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 4.12.

![Dye Colors Toolbar](image)

Figure 4.5 Sequence Analysis Module, Dye Colors Toolbar
Table 4.12 Dye Colors Toolbar, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A: (red)</td>
<td>Red is the default color assigned to the Adenine (A:) nucleotide bases in the analyzed data pane.</td>
</tr>
<tr>
<td>C: (black)</td>
<td>Black is the default indicator assigned to the Cytosine (C:) nucleotide bases in the analyzed data pane.</td>
</tr>
<tr>
<td>G: (green)</td>
<td>Green is the default color assigned to the Guanine (G:) nucleotide bases in the analyzed data pane.</td>
</tr>
<tr>
<td>T: (blue)</td>
<td>Blue is the default color assigned to the Thymine (T:) nucleotide bases in the analyzed data pane.</td>
</tr>
<tr>
<td>N: (gray)</td>
<td>Gray is the default color assigned to ambiguous nucleotide bases in the analyzed data pane.</td>
</tr>
</tbody>
</table>

Batch Control Toolbar

The following example shows the Sequence Analysis module's Batch Control toolbar. For descriptions of the actions that occur when you click a toolbar icon, see Table 4.13.

Table 4.13 Batch Control Toolbar, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Batch Analysis Icon]</td>
<td>Batch Analysis - Analyze multiple sample data or sample plate results sequentially.</td>
</tr>
<tr>
<td>![Batch Alignment Icon]</td>
<td>Batch Alignment - Select sequence results or sample plate results to align.</td>
</tr>
<tr>
<td>![Batch Trimming Icon]</td>
<td>Batch Trimming - Trims multiple sample data or sample plate results sequentially.</td>
</tr>
<tr>
<td>![Reanalyze Batch Icon]</td>
<td>Reanalyze Batch - After performing a batch analysis, use this option to perform a new analysis on the same data set.</td>
</tr>
<tr>
<td>![Stop Analysis Icon]</td>
<td>Stop Analysis - Terminates the analysis currently in progress.</td>
</tr>
<tr>
<td>![Pause Icon]</td>
<td>Pause - Momentarily stops a batch analysis after the currently running sample has been analyzed. Use Resume Batch Processing to continue the analysis.</td>
</tr>
<tr>
<td>![Resume Icon]</td>
<td>Resume - Resumes a batch analysis after it has been paused.</td>
</tr>
<tr>
<td>![Skip Sample Icon]</td>
<td>Skip Sample - While performing a batch analysis, click this icon to pass over the sample currently being analyzed. (This item is not available if Sample Plate Results was selected from the Batch Analysis Selection dialog box.)</td>
</tr>
</tbody>
</table>
Sequence Analysis

Sequence Analysis Module Overview

Sample Plate Toolbar

To display the Sample Plate toolbar, select View | Toolbars, then select the Sample Plate check box, as shown in the following example.

Table 4.13 Batch Control Toolbar, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Skip Set Icon" /></td>
<td>Skip Set - While performing a batch analysis, click this icon to pass over the sample set currently being analyzed. (This item is not available if Sample Data was selected from the Batch Analysis Selection dialog box.)</td>
</tr>
<tr>
<td><img src="image" alt="Skip Plate Icon" /></td>
<td>Skip Plate - While performing a batch analysis, click this icon to pass over the sample plate currently being analyzed. (This item is not available if Sample Data was selected from the Batch Analysis Selection dialog box.)</td>
</tr>
<tr>
<td><img src="image" alt="View Results Icon" /></td>
<td>View Results - After performing a batch analysis, click this icon to view the results of a selected sample in the upper pane of the Batch Analysis window.</td>
</tr>
</tbody>
</table>

Sample Plate Toolbar

To display the Sample Plate toolbar, select View | Toolbars, then select the Sample Plate check box, as shown in the following example.

Figure 4.7 Sequence Analysis Module, Sample Plate Toolbar

Use this toolbar to specify the samples to open or export. Select the desired plate from the Plate drop-down list. Valid samples appear as filled wells. Wells not specified as samples appear dark or empty. Click on the samples to open or export.

- To view the name of a sample and associated result, position the cursor over the sample. The sample and result names appear in the Sample and Result text boxes.
- To select contiguous samples, click on the first sample in the series, hold down the Shift key, then click on the last sample in the series. The selected samples are highlighted.
Sequence Analysis
Sequence Analysis Module Overview

Base Sequence Toolbar
To display the Base Sequence toolbar, select View | Toolbars, then select the Base Sequence check box, as shown in the following example.

Figure 4.8 Sequence Analysis Module, Base Sequence Toolbar
Use this dialog box to search for specific base sequences and to view quality parameters. Enter the desired string of bases and click the arrow buttons to search backwards and forwards through the base sequence text.

To use regular expressions to locate the desired text, use the characters described in Table 4.14.

Table 4.14 Characters Used in Expressions

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>`</td>
<td>`</td>
</tr>
<tr>
<td>.</td>
<td>The dot (.) will match any character.</td>
</tr>
<tr>
<td>*</td>
<td>The asterisk (*) indicates that the character to the left of the asterisk in the expression should match 0 or more times.</td>
</tr>
<tr>
<td>+</td>
<td>The plus (+) is similar to the asterisk but there should be at least one match of the character to the left of the + sign in the expression.</td>
</tr>
<tr>
<td>?</td>
<td>The question mark (?) matches the character to its left 0 or 1 times.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Brackets ([ and ]) enclosing a set of characters indicates that any of the enclosed characters may match the target character.</td>
</tr>
</tbody>
</table>

- To search for the text regardless of case, select the Ignore Case check box (☑).
- To search for the exact match for text (not the IUB codes), select the Exact Match check box (☑).
- To search for text within a range, highlight the range of interest in the base sequence pane and select the Search Highlighted Range check box (☑).
The following table identifies the IUB codes you can enter to find the corresponding bases when the **Exact Match** check box is clear.

**Table 4.15 IUB Codes**

<table>
<thead>
<tr>
<th>IUB</th>
<th>Bases</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>G, A, T, or C</td>
</tr>
<tr>
<td>V</td>
<td>G, A, or C</td>
</tr>
<tr>
<td>B</td>
<td>G, T, or C</td>
</tr>
<tr>
<td>H</td>
<td>A, T, or C</td>
</tr>
<tr>
<td>D</td>
<td>G, A, or T</td>
</tr>
<tr>
<td>K</td>
<td>G or T</td>
</tr>
<tr>
<td>S</td>
<td>G or C</td>
</tr>
<tr>
<td>W</td>
<td>A or T</td>
</tr>
<tr>
<td>M</td>
<td>A or C</td>
</tr>
<tr>
<td>Y</td>
<td>C or T</td>
</tr>
<tr>
<td>R</td>
<td>A or G</td>
</tr>
</tbody>
</table>
4.2 Using the Sequence Analysis Module

Run a sequence analysis, and set up its parameters, result properties, and display options, then work with, report, and export sequence analysis results.

Click the Sequence Analysis icon:

Viewing Sample Data

To view sample data:

1. Click on Sequence Analysis, then select File | Open. The Open dialog box opens, as shown below:

![Open Dialog Box](image)

2. Select the appropriate tab (Sample Data, Sample Plate Results, Sequence Results, Sequence Analysis Parameters, or Optical Scan Data).
3. Select the desired item from the list box, then click OK.
4. Use the Sample View toolbar icons to display the desired data.
The following table describes each tab in the Open dialog box.

**Table 4.16 Open Dialog Box Tabs, Sequence Analysis Module**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Data</td>
<td>Displays the list of raw data and baseline data stored in the selected project. On the right-hand side of the list box you may view the date and time the sample was run. You may want to open a raw data set to analyze it.</td>
</tr>
<tr>
<td>Sequence Results</td>
<td>Displays the list of analyzed data that resides in the selected project. On the right-hand side of the list box you may view the date and time the sample was run as well as the raw data from which the sequence result was derived. Sequence data consists of analyzed data and its base sequence text. When you open sequence data you may also view the associated raw data, current, and voltage. This option is available for sequence analysis only. To filter the list, select the <strong>Enable</strong> check box (✓) and enter the <strong>Start</strong> and <strong>End</strong> dates for the items you wish to view. Click <strong>Refresh</strong> to view the filtered results.</td>
</tr>
<tr>
<td>Sample Plate Results</td>
<td>Displays the list of sample plates run in the selected project. Selecting a sample plate result displays the Sample Plate toolbar. Click on the desired samples, then click <strong>Open</strong>. The desired samples open.</td>
</tr>
<tr>
<td>Sequence Analysis Parameters</td>
<td>Displays the Sequence Analysis Parameters saved in the project. The Sequence Analysis Parameter Set determines the start and end times for the analysis of raw data, the threshold above which data are considered peaks, the data start criteria, the heterozygote detection parameters, and the alignment template and parameters. You may also edit sequence analysis parameters under the Analysis tab in the Sample Setup module.</td>
</tr>
<tr>
<td>Optical Scan Data</td>
<td>Lists the alignment optical scan data available in the selected project. Optical scan data are the result of the two lasers scanning the capillaries to determine the position of the capillary windows where the lasers focus when collecting data. If the scan is successful, eight peaks appear for each laser, denoting that all eight capillary windows were established.</td>
</tr>
</tbody>
</table>

See **Table 4.11, Sample View Toolbar, Sequence Analysis Module**, for more information on the Sample View Toolbar descriptions.
Editing Sequence Analysis Parameters

The Sequence Analysis Parameters Editor dialog box consists of six tabs: General, Initial Data Detection, Heterozygote Detection, Quality-based Trimming, Sequence-based Trimming, and Alignment Reference.

To edit the Sequence Analysis Parameters:

1. Select Analysis | Working Analysis Parameters to open the Working Parameters dialog box.
2. Click Edit. The Sequence Analysis Parameters Editor dialog box opens, as shown below.

![Figure 4.10 Sequence Analysis Parameters Editor Dialog Box](image)

3. Use the tabs on this dialog box to make appropriate changes. For parameter descriptions, see the following topics:
   - "General Tab" on page 124
   - "Initial Data Detection Tab" on page 126
   - "Heterozygote Detection Tab" on page 127
   - "Alignment Reference Tab - Sequence Analysis Parameters Editor" on page 129
   - "Quality-based Trimming Tab" on page 132
   - "Using Sequence-based Trimming" on page 133
4. Click Save As to create a new Sequence Analysis Parameter name or click OK to save the changes and exit the editor.

General Tab

Use the General tab of the Sequence Analysis Parameters Editor dialog box to specify the parameters used to perform the basecalling operation on the desired samples, whether or not you are performing an alignment.

**NOTE** If you opened this dialog box by selecting View | Parameters Used to Compute Sequence, this dialog box displays the analysis values, but disables the fields described below.
The following table describes the options available on the Sequence Analysis Parameters - General tab.

### Table 4.17 General Tab, Sequence Analysis Parameters Editor

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| N Threshold          | Specifies the value for the threshold below which N's are substituted for called bases. Enter the desired value in the N Threshold text box. The range is 0.00 to 1.00. For example, entering:  
  - 1.00 calls all bases as indeterminate (N's).  
  - 0.50 calls all bases with an estimated error of probability of greater than 50% as N's.  
  - 0.00 does not call any N's.  
  - 0.60 is recommended (called bases with an estimated error probability of greater than 40% will be called N's). |
| Analysis Start/Stop  | Enter the time in minutes from the start of the raw data where the analysis is to begin, and the time in minutes from the start of the raw data where the analysis is to end.  
  - Start: The default value of '0' for the start time uses the system algorithm to find the start of valid data and the values entered under the Initial Data Detection tab.  
  - Stop: The default value of '0' for the stop time analyzes to the end of collected raw data. |
| PCR Product          | Selecting this check box (✓) causes analysis to end when a sudden drop off of signal lasting at least two minutes is encountered. This prevents the analysis of baseline data. |
| <200 Bases           | Signifies that the sequences generated from PCR are less than 200 nucleotides in length. Selecting this check box (✓) changes the default values for the Delay and Minimum Duration on the Initial Data Detection tab. The default value for Delay is 0.20 minutes and the default value for Minimum Duration is 2.00 minutes.  
  NOTE This option is available only when PCR Product is selected. |
| Use Default Mobility Calib. | Select this check box (✓) to optimize the analysis results of most short PCR products. This stabilizes the data adjustment that accounts for the difference in mobility of fragments due to their respective dye labels. This differential mobility has the greatest effect on the shorter fragments and has to be accounted for in the analysis of data that includes short fragments.  
  NOTE This option is automatically selected when <200 Bases is selected, which is recommended. |
| Pre-peak Reduction   | Select this check box (✓) if you want the software to identify and reduce the inclusion of 'pre-peaks' in the analyzed data. Pre-peaks are artifacts that may appear one base prior to the significant peak. They are usually caused by including primers that are not full-length in the sequencing reaction. Sometimes they are caused by slippage of the enzyme during the extension reaction in which case the pre-peaks are often found starting near the end of a series of the same base. |
Use the Initial Data Detection tab of the Sequence Analysis Parameters Editor dialog box to enable the system to detect the start of data to be analyzed. The system attempts to detect valid data using the system algorithm and values entered on this tab only if the Analysis Start time on the General tab is set to “0.0”.

NOTE If you opened this dialog box by selecting View | Parameters Used to Compute Sequence, this dialog box displays the analysis values, but disables the fields described below.

NOTE Set the Initial Data Detection parameters based on the sample cleanup method used. If the cleanup method leaves large peaks due to unincorporated dye at the beginning of data, set the parameters to avoid these blobs. (This makes it difficult to read to the end of the primer; however, the basecall accuracy improves since dye peaks do not interfere with early mobility correction.) If the cleanup method tends to leave dye peaks at the beginning of data, set the Threshold to 30 or 35 and set the Delay to 0.75. (If there are still fat peaks at the start of analyzed data, make this a larger delay.)

NOTE If the cleanup eliminates dye peaks, you can read closer to the end of the primer by setting the Threshold to 20, and the Delay to 0.6.
The following table describes the options available on the Sequence Analysis Parameters - Initial Data Detection tab.

**Table 4.18 Initial Data Detection Tab, Sequence Analysis Parameters Editor**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Threshold</strong></td>
<td>Enter the maximum ratio value of all the data in the energy profile above which the signal must rise before the analysis starts detecting data. The data must stay above this threshold for the minimum duration without gaps for more than 21 seconds. The range is 0 to 100%. The default is 40%.</td>
</tr>
</tbody>
</table>
| **Delay**       | Enter a value for the delay between the detected start of data when the data that will be analyzed. The range is 0.00 to 180.00 minutes.  
  - If <200 Bases is not checked on the General tab, the default value is 0.75 minutes.  
  - If <200 Bases is checked, the default value is 0.20 minutes. |
| **Signal to Noise** | Enter the Signal to Noise value to specify the signal to noise ratio for significant data. The range is 3.00 to 1000.00. The default value is 7.00. |
| **Minimum Duration** | Enter the value at which the signal-to-noise threshold must exceed with no gaps greater than 21 seconds. The range is 2.00 to 50.00 minutes.  
  - If <200 Bases is not checked on the General tab, the default value is 5.00 minutes.  
  - If <200 Bases is checked, the default value is 2.00 minutes. |

**Heterozygote Detection Tab**

Use the Heterozygote Detection tab of the Sequence Analysis Parameters dialog box to enable Heterozygote detection and to specify the parameters for detecting heterozygotes. If you enable this feature, the next analysis run detects heterozygotes and displays ambiguity codes where appropriate.

**Figure 4.12 Heterozygote Detection Tab - Sequence Analysis Parameters Editor**

**NOTE** If you opened this dialog box by selecting View | Parameters Used to Compute Sequence, this dialog box displays the analysis values, but disables the fields described below.
The following table describes the options available on the Sequence Analysis Parameters - Heterozygote Detection tab.

**Table 4.19 Heterozygote Detection Tab, Sequence Analysis Parameters Editor**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detect Heterozygotes</td>
<td>Select this check box (√) if you want heterozygotes detected. When selected, the <em>N Threshold</em> (on the General tab) is disabled, and “N’s” will not be called. The system detects heterozygotes after it determines the &quot;final basecall&quot;. It detects peaks that meet the sensitivity criterion and examines each called base to determine if another peak nearby meets the <strong>Spacing</strong> and <strong>Height Ratio</strong> criteria specified. If one or more nearby peaks meet the criteria, the system merges their identities with the called base to produce an ambiguity code. <strong>NOTE</strong> If you specify the Detect Heterozygote option, ‘N’s’ are not called. The <em>N Threshold</em> text box is grayed out to disable calling “N’s.”</td>
</tr>
<tr>
<td>% of Average Peak</td>
<td>Enter a value to determine how far to look on either side of each called base to look for other peaks. This value is centered over the peak for the called base; for instance, a value of 50 looks 25% on either side of the peak for secondary peaks. The range is 0-100%</td>
</tr>
<tr>
<td>Spacing</td>
<td></td>
</tr>
<tr>
<td>Height Ratio</td>
<td>Enter the height ratio of the secondary peak relative to called base peak. The range is 0-100%.</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>Enter the value that specifies the minimum sharpness of detected secondary peaks. The higher the value, the higher the sensitivity used to detect smaller, less visually defined peaks. The range is 0.00 to 1.00.</td>
</tr>
<tr>
<td>Range</td>
<td>Enter the range in the called sequence where the system looks for heterozygotes within a called sequence. Also provide the number of bases prior to the last called base you want heterozygote detection to end in the case of short PCR samples that may vary in length. The range is 0-length of the sequence.</td>
</tr>
</tbody>
</table>

If a value is outside of an expected range, a message box opens, requesting you to enter a valid value. The system uses the IUB ambiguity codes shown in the following table to represent heterozygous bases.

**Table 4.20 IUB Ambiguity Codes**

<table>
<thead>
<tr>
<th>Code</th>
<th>Definition</th>
<th>Mnemonic</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Adenine</td>
<td>A</td>
</tr>
<tr>
<td>C</td>
<td>Cytosine</td>
<td>C</td>
</tr>
<tr>
<td>G</td>
<td>Guanine</td>
<td>G</td>
</tr>
<tr>
<td>T</td>
<td>Thymine</td>
<td>T</td>
</tr>
<tr>
<td>R</td>
<td>AG</td>
<td>puRine</td>
</tr>
<tr>
<td>Y</td>
<td>CT</td>
<td>pYrimidine</td>
</tr>
<tr>
<td>K</td>
<td>GT</td>
<td>Keto</td>
</tr>
<tr>
<td>M</td>
<td>AC</td>
<td>aMino</td>
</tr>
</tbody>
</table>
The system reports the heterozygous bases in the analyzed data and in the base sequence data.

**Alignment Reference Tab**

Use the Alignment Reference tab of the Sequence Analysis Parameters dialog box to enable automatic alignment and to specify the template against which you want to align the active sequence.

<table>
<thead>
<tr>
<th>Code</th>
<th>Definition</th>
<th>Mnemonic</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>GC</td>
<td>Strong 3 H bonds</td>
</tr>
<tr>
<td>W</td>
<td>AT</td>
<td>Weak 2 H bonds</td>
</tr>
<tr>
<td>B</td>
<td>CGT</td>
<td>Not A</td>
</tr>
<tr>
<td>D</td>
<td>AGT</td>
<td>Not C</td>
</tr>
<tr>
<td>H</td>
<td>ACT</td>
<td>Not G</td>
</tr>
<tr>
<td>V</td>
<td>ACG</td>
<td>Not T</td>
</tr>
<tr>
<td>N</td>
<td>AGCT</td>
<td>aNything</td>
</tr>
</tbody>
</table>

The system reports the heterozygous bases in the analyzed data and in the base sequence data.

**NOTE** If you opened this dialog box by selecting View | Parameters Used to Compute Sequence, this dialog box displays the analysis values, but disables the fields described below.
The following table describes the options available on the Sequence Analysis Parameters - Alignment Reference tab.

**Table 4.21 Alignment Reference Tab, Sequence Analysis Parameters Editor**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform Alignment</td>
<td>Select this check box (☑) to perform an alignment automatically when running an analysis. The alignment uses the alignment template and parameters (specified below) and in the Advanced Alignment Parameters dialog box.</td>
</tr>
<tr>
<td>Reference</td>
<td>Select the desired alignment template by clicking on its corresponding radio button (puc18dG, puc 18, or m13). To select a different template, click Reference File. Click Browse and navigate to the folder that contains the reference file, then select it and click OK. The text box displays the name of the selected reference file.</td>
</tr>
<tr>
<td>Cutoff Accuracy</td>
<td>Enter the desired Cutoff Accuracy. The alignment detects the base number in the called sequence at which the accuracy falls below this Cutoff Accuracy value. The range is 0.0 to 100.0%.</td>
</tr>
<tr>
<td>Allowed N's</td>
<td>Enter the percentage of N's allowed to occur before they are counted as errors when determining the alignment accuracy. The range is 0.0 to 100.0%.</td>
</tr>
<tr>
<td>Advanced Alignment</td>
<td>Click this button to open the Advanced Alignment Parameters dialog box.</td>
</tr>
<tr>
<td>Parameters</td>
<td></td>
</tr>
</tbody>
</table>

**Advanced Alignment Parameters**

Use the Advanced Alignment Parameters dialog box to define the Advanced Alignment Parameters used to perform alignments with the active sequence.

![Advanced Alignment Parameters Dialog Box](image)

**Figure 4.14 Advanced Alignment Parameters Dialog Box**

**NOTE** If you opened this dialog box by selecting View Parameters Used to Compute Sequence, this dialog box displays the analysis values, but disables the fields described below.

The system uses a scoring matrix to perform the alignment and displays the alignment that produces the highest total score. In general, matches should be given higher scores than non-matches.
The following table describes the options available on the Advanced Alignment Parameters dialog box.

### Table 4.22 Advanced Alignment Parameters, Sequence Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Alignment Scoring** | • **Match** - Sets the value of a match between a base position of the sequence and the reference template. The range is -1000.0 to 1000.0. A value of "1" is the default value.  
  • **MisMatch** - Sets the value of a mismatch between a base position of the sequence and the alignment sequence. The range is -1000.0 to 1000.0. A value of "-2.0" is the default value.  
  • **Insert start** - Sets the value of an insertion of a base in the sequence that does not exist in the alignment sequence. The range is -1000.0 to 1000.0. A value of "-4.0" is the default value.  
  • **Insert extend** - Sets the value of a consecutive insertion of a base in the sequence that does not exist in the alignment sequence. The range is -1000.0 to 1000.0. A value of "-3.0" is the default value.  
  • **Delete start** - Sets the value of a deletion of a base in the sequence that does not correspond to the alignment sequence. The range is -1000.0 to 1000.0. A value of "-4.0" is the default value.  
  • **Delete extend** - Sets the value of a consecutive deletion of a base in the sequence that does not exist in the alignment sequence. The range is -1000.0 to 1000.0. A value of "-3.0" is the default value. |
| **Alignment Controls** | • To optimize the alignment to find matching substrings first, then run the alignment algorithm only on the bases remaining outside the substrings, reducing execution time and storage space, select **Find matching substrings** (✔). This check box is selected by default.  
  • To use only substrings with the highest score, and ignore the rest, as opposed to using every character from both strings to compute the similarity score, select **Find Local alignment** (✔).  
  • To specify that overhanging bases on the template or sequence will not be counted in the alignment score, select **Left Edge Free** (✔) and/or **Right Edge Free** (✔).  
  • To specify a minimum length for detected substrings, enter the number of bases needed to constitute a substring in the **Minimum substring length** text box. The range is 5 to 2000. The default value is "30". |
Quality-based Trimming Tab

Use quality-based trimming to trim poor quality data from the ends of the sequence. The resulting base sequence and trace views display the base letters of the poor quality data as strike through.

![Quality-based Trimming Tab](image)

**Figure 4.15 Quality-based Trimming Tab**

The following table describes the options available on the Sequence Analysis Parameters - Quality-based Trimming tab.

**Table 4.23 Quality-based Trimming Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ends To Be Trimmed</td>
<td>Click the radio button to select the ends to be trimmed:</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Both Ends</strong> to trim outside the 5' and 3' coding region.</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Left (5') End</strong> to trim to the left of the 5' end.</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Right (3') End</strong> to trim to the right of the 3' end.</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>None</strong> if you do not want to perform quality-based trimming.</td>
</tr>
<tr>
<td>Trimming Stringency</td>
<td>Click and drag the slider control to set the quality values from low to high.</td>
</tr>
<tr>
<td></td>
<td>There are five possible selections ranging from <strong>Low</strong> to <strong>High</strong> that correspond to error rate of 0.07, 0.06, 0.05, 0.03, 0.01. The default value is <strong>Medium</strong> (5%).</td>
</tr>
</tbody>
</table>
Using Sequence-based Trimming

Apply contaminant (sequence-based) trimming. This can be done in batch analysis mode or in sequence analysis mode. The resulting base sequence and trace views display the base letters of the vector and other subsequences as underlined. If multiple vector or subsequences matched, they appear as multiple underlined in the Trace View.

Figure 4.16 Sequence-based Trimming Tab
Contaminant trimming can be based on any combination of the following:

- Vector sequences such as plasmid, BAC, PAC, and cosmids.
- Primer sequences
- Restriction enzyme sites

**NOTE** If you opened this dialog box by selecting View | Parameters Used to Compute Sequence, this dialog box displays the analysis values, but disables the fields described below.

The following table describes the options available on the Sequence Analysis Parameters - Sequence-based Trimming tab.

<table>
<thead>
<tr>
<th>Table 4.24 Sequence-based Trimming Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>Perform Sequence-based Trimming</td>
</tr>
</tbody>
</table>
| Vector/Other Sequence Files           | • Click + to select a reference sequence. It must be in the .fasta format and stored in an accessible folder.  
• Click − to remove a previously selected reference sequence.  
**NOTE** There is no practical limit on the number of .fasta reference sequences used; however, larger files (greater than 200 Kbase) increase processing time. |
| Max. # of Vector/Other Sequences      | Set the number of sequences to appear in the result. This number is determined by the goodness of alignment by scoring the found subsequences and displaying only the top number selected. The trimming log details all vectors/other sequences found regardless of the score. |
| Min. Substring Length                 | Set the minimum substring length. Only the subsequences that meet or exceed this length will be trimmed. |
| Distance from End                     | Set the distance from the end of the sequence and contaminant for automatic removal. You may set the Left (5’) independently from the Right (3’) end. |
| Enable Internal Matches               | Select this check box (✓) to allow trimming within the sequence. |
Performing Quality-based Trimming

Setting Up Quality-based Trimming

To setup quality-based trimming:

1. Open the Sequence Analysis module.
2. Open a result and select **Analysis | Working Analysis Parameters**.
3. Click **Edit** to open the Sequence Analysis Parameters Editor.
4. Select the Quality-based Trimming tab.
5. Select **Ends To Be Trimmed** and **Trimming Stringency**.
6. Click **Save As** and save the new parameters.
7. Click **OK**.
8. Select **Analysis | Trim Based on Quality**. The analysis parameters, created in the steps above, should be listed. If not, click **Use Stored Parameters** and select the appropriate analysis parameters.
9. Click **OK**.

The resulting base sequence and trace views display the base letters, if poor quality, as strike through after performing a quality-based trim.

**NOTE** When performing quality-based and sequence-based trimming, quality-based trimming is always performed first.
Applying Quality Trimming

If the trimming is acceptable, select Edit | **Apply Quality-based Trimming** to apply the resulting base sequence and trace view.

**Figure 4.18 Base Sequence and Trace Views after Quality-based Trimming — Quality-based Trimming Applied**

**NOTE** To recover the original sequence after performing **Apply Quality-based Trimming**, select **Edit | Undo**.
Performing Sequence-based Trimming

Setting Up Sequence-based Trimming

To setup sequence-based trimming:

1. Open the Sequence Analysis module.
2. Open a result and select **Analysis | Working Analysis Parameters**.
3. Click the **Edit** button to open the Sequence Analysis Parameters Editor.
4. Select the Sequence-based Trimming tab.
5. Select the **Perform Sequence-based Trimming** check box (✓) and select the desired options.
6. Click **Save As** and save the new parameters.
7. Click **OK**.
8. Select **Edit | Trim Based on Sequence**. The analysis parameters, created in the steps above, should be listed. If not, click **Use Stored Parameters** and select the appropriate analysis parameters.
9. Click **OK**.

**NOTE** When performing quality-based and sequence-based trimming, quality-based trimming is always performed first.

The following example shows the resulting base sequence and trace view after performing a sequence-based trim.

![Figure 4.19 Base Sequence and Trace Views after Sequence-based Trimming](image)

CTGAAAAGACATCCCCAGGAATGCAGATCGAACGAACATCGAAATCTGAACACCCGTGAGATCTGTTTTGCTGAGTCTGGTCTA

AGGAATTTAATATGTCACGTGATCGAGACGATCAGTCTTCTGTGGGACGAGAAGTGAC

TCAACAGTGTCAGAAGCTGATGTCGAGACATCTGAGACAGATCAGTCTTCTGTGGGACGAGAAGTGAC

GTTGTTGGTTTCTGAGACATCGAAGCTGATGTCGAGACAGATCAGTCTTCTGTGGGACGAGAAGTGAC

ATGAGCAGATTTAACACCATGGAGAATCTGTGGGAGATTGATCTGTTTTGCTGAGTCTGGTCTA

AGGAATTTAATATGTCACGTGATCGAGACGATCAGTCTTCTGTGGGACGAGAAGTGAC

TCAACAGTGTCAGAAGCTGATGTCGAGACATCTGAGACAGATCAGTCTTCTGTGGGACGAGAAGTGAC

GTTGTTGGTTTCTGAGACATCGAAGCTGATGTCGAGACAGATCAGTCTTCTGTGGGACGAGAAGTGAC

Figure 4.19 Base Sequence and Trace Views after Sequence-based Trimming
Applying Sequence-based Trimming

If the trimming is acceptable, select **Edit | Apply Sequence-based Trimming** to remove the trims from the sequence. The following example shows the resulting base sequence and trace view after applying sequence-based trimming.

**NOTE** When applying sequence-based trimming, quality-based trimming is automatically applied first if quality-based trimming was performed.

![Figure 4.20 Base Sequence and Trace Views after Sequence-based Trimming](image)

**NOTE** To recover the original sequence after performing **Apply Sequence-based Trimming**, select **Edit | Undo**.

Internal Trimming

Select the **Enable Internal Matches** check box (✓) on the Sequence-based Trimming tab to trim subsequences from within the sequence. To exclude a subsequence from final removal, right-click on the subsequence and select **Vector/Other Subsequences | subsequence** where **subsequence** is the subsequence name.
NOTE The system removes only the selected subsequences from the sequence when you apply trimming.

Figure 4.21 Base Sequence and Trace Views after Sequence-based Trimming – Enable Internal Matches
After you apply sequence-based trimming, the system replaces the internal matches in the resulting base sequence and trace view with the letter "x", as shown in the following example.

**Figure 4.22 Base Sequence and Trace Views after Sequence-based Trimming – Enable Internal Matches**

**Batch Trimming**
Enable automatic trimming of a large number of results. To perform batch trimming:

1. Open the Sequence Analysis module.
2. Select **Analysis > Batch Trimming**.
3. Select the Sequence Results or Sample Plate Results tab.
4. Select the results to be trimmed.
5. Click the right-arrow to move the selected results to the “selected” list box.

6. Click **OK**.

7. Verify that the required analysis parameters are selected in the Working Parameters dialog box. (If not, click **Use Stored Parameters** and select the appropriate analysis parameters).

8. If necessary, select the **Export Results** check box (✔) to export the results to files. The Edit Export Options button becomes available. For details, see "Export Options" on page 143.

9. Click **OK**.
Trimming Report
Exporting results creates a Trimming Report, which you can view and print.

To view the Trimming Report, select View | Trimming Report. The new pane opens at the bottom of the screen displaying the following details:

- Result Name
- Original Sequence Length
- Length after Quality-based Trimming
- Vector/Other Subsequence Name
- First Base Trimmed
- Last Base Trimmed
- Enabled
- Length after Sequence-based Trimming
- Exported

From the Trimming Report pane, you can format the grid, print the grid data, and export the data as comma separated (.csv) or tab delimited (.txt) text files.

To access these options, right-click over the Trimming Report, then select the desired option from the pop-up menu.

The following table describes these options.

Table 4.25  Trimming Report Right-Click Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Grid Data</td>
<td>Select this option to print the entire grid as it is represented on the screen.</td>
</tr>
<tr>
<td>Export Grid Data</td>
<td>Select this option to save the grid data as a comma separated (<em>.csv) or tab delimited (</em>.txt) text file.</td>
</tr>
<tr>
<td>Format Grid</td>
<td>Select this option to open a cascading menu with formatting options, as shown in the following example.</td>
</tr>
</tbody>
</table>

Use this menu to customize the look of the data grid. If you hide rows or columns using this menu, the Print Grid Data option omits them; however, this does not affect the Exported Grid Data (this exports all data).
Export Options

The Export dialog box provides two options you can choose when exporting sequence data, as described in the following table.

Table 4.26 Export Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Trimming</td>
<td>If you selected the Export option during sample setup or batch analysis, selecting the Apply Trimming option removes the trims from the sequence before it is exported. The exported file replaces all internal trims with the letter “x”.</td>
</tr>
<tr>
<td>Export Only If Sequence &gt; X nt</td>
<td>The resulting sequence, after trimming, may be too small to be useful. Use the Export Only If Sequence &gt; X nt option to specify a minimum size that the sequence must be when exporting. This exports only those sequences greater than the set number of nucleotides.</td>
</tr>
</tbody>
</table>

Figure 4.24 Export Options

Editing Bases

You can edit bases displayed in the analyzed and bases data panes using the Sequence Analysis module's Tools menu. The system identifies edited bases by showing them in lower-case letters.

Inserting Bases in the Analyzed Data Pane

To insert bases in the analyzed data pane:

1. Select Tools | Edit.
2. Click on an area between two bases. The Insert Base dialog box opens.
3. Select the desired base.
4. Click OK.
The screen inserts the base as a lower-case letter in both the analyzed data and the base sequence panes.

Inserting Bases in the Base Sequence Pane
To insert bases in the base sequence pane:

1. Select Tools | Edit.
2. Place the mouse cursor between the two bases where you want to insert the base.
3. Type in the new base.
The screen inserts the base as a lower-case letter in both the analyzed data and the base sequence panes.

Changing Bases in the Analyzed Data Pane
To change bases in the analyzed data pane:

1. Select Tools | Edit.
2. Click on a base in the analyzed data pane. The Change Base dialog box opens.
3. Select the desired base.
4. Click OK.
The screen shows the changed base as a lower-case letter in both the analyzed data and the base sequence panes.

Changing Bases in the Base Sequence Pane
To change bases in the base sequence pane:

1. Select Tools | Edit.
2. Highlight the bases to change in the base sequence text.
3. Type in the new bases.
The screen shows the changed base as a lower-case letter in both the analyzed data and the base sequence panes.

**NOTE** The left and right arrow keys move the cursor through the data in the base sequence pane. To select bases, hold the Shift key down while using the left and right arrow keys to select the desired bases.

Deleting Bases in the Base Sequence Pane
To delete bases in the base sequence pane:

1. Select Tools | Edit.
2. Highlight the bases in the base sequence text to delete.
3. Press the Delete key (or use the Cut icon).
The screen removes the selected bases from both the base sequence and analyzed data panes.
Specifying Base Grouping
To specify base grouping in the base sequence pane:

1. Select **Tools | Base Spacing** to open the cascading menu.
2. Select the desired group spacing.

Viewing the Analysis Log
The system logs all the steps used in performing the base-calling routine on the raw data in the analysis log. For example, the system logs a message when it is unable to find the end of PCR product data.

You may view the analysis log to see if the system was unable to find the end of PCR data. The following message appears in the analysis log: “Analyzed Data: Cannot compute stop time. Using data stop time of xxx.xx minutes”, as shown in the following example.

![Figure 4.25 Analysis Log](image)

Occasionally, the system cannot find the end of PCR product data, even if the **PCR Product** option is selected. To determine if this is the case, review the analysis log and use this information in future analysis of the same sample.

To view the analysis log:

1. Open the sequence results you would like to review.

**NOTE** If the sample data has not yet been analyzed, analyze the sample data set using the desired analysis parameters. Select the **PCR Product** check box (✓) and enter 0.0 for both the **Analysis Start** and **Stop** times.

2. Select **View | Analysis Log** to view the analysis log for the sequence result.

The analysis log appears in a pane at the bottom of the window.
Sequence Result Properties

View method, analysis, alignment, consumable, general, notes, and property set information. To view these properties:

1. Select File | Properties when a sequence result is open. The Properties dialog box opens.

   NOTE The Alignment tab appears in this dialog box only if you have performed an alignment on the open sequence result.

2. Select the tab that displays the type of properties you want to view. For details, see the following topics:
   - "General Tab" on page 146
   - "Notes Tab" on page 147
   - "Property Set Tab" on page 148
   - "Method Tab" on page 149
   - "Analysis Tab" on page 150
   - "Alignment Tab" on page 151
   - "Consumables Tab" on page 152

   NOTE To view detailed descriptions while using this dialog box, click Help.

3. When finished reviewing the properties, click Close.

General Tab

Use the General tab to view the general properties of the currently selected sequence result.

![Properties Dialog Box](image)

Figure 4.26 General Tab, Properties Dialog Box

View the item type, database, and project where the item resides, as well as the date and time the item was last modified. You may also view the sample name, sample plate, sample position in the sample plate, the instrument, and the operator name.
Notes Tab
Use the Notes tab to view the note that was entered in the Sample Setup when the sample ID was defined. Select File | Properties | Notes.

Figure 4.27 Note Tab, Properties Dialog Box
Property Set Tab
Use the Property Set tab to view the selected property set that was entered in the Sample Setup when the sample ID was defined. Select File | Properties | Property Set.

Figure 4.28  Property Set Tab, Properties Dialog
Method Tab

View the method associated with the result, and the steps used to perform the separation, as well as their associated values.

In addition, view the parameters for the first part and the second part of the separation, as well as the total separation time.

Select **File | Properties | Method**.

![Figure 4.29 Method Tab, Properties Dialog Box](image)

**Figure 4.29 Method Tab, Properties Dialog Box**
Sequence Analysis
Using the Sequence Analysis Module

Analysis Tab
View the analysis parameters used to produce the open sequence result. View the name of the parameter set used as well as all of the parameters and color calibration used to perform the analysis.

Select **File | Properties | Analysis**.

![Properties Dialog Box](image)

**Figure 4.30  Analysis Tab, Properties Dialog Box**
Alignment Tab
View the alignment template information and the alignment parameters used to create the alignment of the currently open result.

Select **File | Properties | Alignment**.

![Properties Dialog Box]

**Figure 4.31 Analysis Tab, Properties Dialog Box**

**NOTE**  This tab is visible only if an alignment has been performed on the sequence result.
**Consumables Tab**
View the status and identity of the capillary array, the gel, and the buffer information.

Select **File | Properties | Consumables**.

![Consumables Tab, Properties Dialog Box](image)

*Figure 4.32 Consumables Tab, Properties Dialog Box*
Setting or Changing Display Options

To set or change the graph data display options:

1. Open the Display Options dialog box using one of these methods:
   - Select **Tools | Display Options**.
   - While viewing a graph display of sequence data, right-click the graph and select **Display Options**.

   The Display Options screen opens, as shown in Figure 4.33.

2. Select the tab that identifies the type of display options you want to change. For details, see the following topics:
   - "Title Properties Tab" on page 154
   - "X Axis Options Tab" on page 154
   - "Y Axis Options Tab" on page 154
   - "Colors Tab" on page 154
   - "Dye Traces Tab" on page 154
   - "Current Trace Tab" on page 154

   **NOTE** To view detailed descriptions while using this dialog box, click **Help**.
Title Properties Tab
To set or change the title of the displayed data panel:

1. In the Display Options dialog box, select the **Title** tab.
2. Change any item as necessary.
3. Click **Apply** to continue or **OK** to close the Display Options dialog box.

X Axis Options Tab
To define the X Axis properties of the displayed data panels:

1. In the Display Options dialog box, select the **X Axis Options** tab.
2. Change any item as necessary.
3. Click **Apply** to continue or **OK** to close the Display Options dialog box.

Y Axis Options Tab
To define the Y Axis properties of the displayed data panels:

1. In the Display Options dialog box, select the **Y Axis Options** tab.
2. Change any item as necessary.
3. Click **Apply** to continue or **OK** to close the Display Options dialog box.

Colors Tab
To define the color options of the window, the current traces, the voltage trace, or the optical scan trace:

1. In the Display Options dialog box, select the **Colors** tab.
2. Change any item as desired.
3. Click **Apply** to continue or **OK** to close the Display Options dialog box.

Dye Traces Tab
To set or change the dye trace properties:

1. In the Display Options dialog box, select the **Dye Traces** tab.
2. Select the traces to display or not display, under **Show Dye Traces**.
3. To change a color of any dye trace, click on the appropriate **Dye Colors** dye, select a color from the **Color** dialog box, then click **OK**.
4. When finished with Dye Traces, click **Apply** to continue or **OK** to close the Display Options dialog box.

Current Trace Tab
To set or change the current trace options:

1. In the Display Options dialog box, select the **Current Traces** tab.
2. Select the radio button for the current type to display under **Data**.
3. Click **OK**.
Changing Display Colors

In addition to using the Display Options dialog box Colors tab (page 154) to set display colors, you can change colors used in raw data and heterozygote base displays, as described in the following topics.

**Raw Data Colors**

To display the Raw Data Colors toolbar:

1. Select View | Toolbars.
2. Select the desired toolbar options.
3. Click Close.

To change the colors of the raw data traces:

1. On the Raw Data Colors toolbar, click on the trace color to change (A, C, G, or T). The Color palette dialog box opens as shown below.

![Color Dialog Box](image)

**Figure 4.34 Color Dialog Box**

2. Select the new color.
3. Click OK.

**Heterozygote Display Color**

The heterozygous bases are bold and red, by default. To change the color of the heterozygotes in the base sequence pane:

2. Select a new color.
3. Click OK. The color of the ambiguity codes changes in the base sequence text.

**NOTE** To search for heterozygotes, use the Heterozygote Backward Search and the Heterozygote Forward Search icons in the Standard toolbar.
Pinning Results

Several analyses (single or batch) may be necessary before a given result is satisfactory. Overwrite a previous result or produce additional result tabs, using functions in the CE System.

- To overwrite a previous result, click the pin in the left-hand corner of the result tab to “unpin” the result. A reanalysis of that sample overwrites the existing result.
- To produce a new results tab, click the pin to “pin” the result. Upon reanalysis, the system creates a new tab containing the reanalyzed results.

Performing a Batch Analysis

To analyze more than one sample simultaneously:


   ![Batch Analysis Selection Dialog Box](image)

   **Figure 4.35 Batch Analysis Selection Dialog Box**

2. Select a project name from the Project drop-down list at the bottom of the dialog box.
3. Select the appropriate tab: Sample Data or Sample Plate Results.
4. Select Enable and enter a filtering start and stop date, if desired.
5. Highlight a sample name and click the right arrow to move the sample name to the selected list box (on the right). Continue highlighting sample names and moving them to the selected list box until you have selected all the samples for analysis.
6. Click OK. The Analysis Parameters Editor dialog box opens.
7. Select the appropriate analysis parameters or edit an existing parameter set and click **OK**. The batch processing begins and a window opens.

![Batch Analysis Window]

**Figure 4.36 Sequence Analysis - Batch Processing**

**Reanalyzing a Batch**

To reanalyze a batch:

1. After performing a batch analysis, select **Analysis | Reanalyze Batch**.  
2. Select a new parameter set or edit the currently selected set from the Working Analysis Parameters dialog box to obtain different results.  
3. Click **OK** to start the reanalysis.  

**NOTE** To keep the results from the previous analysis, “pin” the results tab by clicking on the pin icon 🔄. Otherwise, the system overwrites the results with any subsequent reanalyses.

**Viewing the Selected Batch Result**

To view the selected batch result after performing a batch analysis:

1. Click the desired sample in the upper pane of the batch analysis window.  
2. Select **Analysis | View Selected Batch Sample Result**.

**Skipping the Current Sample Analysis in a Batch**

To skip the current sample during a batch analysis, select **Analysis | Skip Current Sample**.

**Skipping the Current Sample Set Analysis in a Batch**

To skip the sample set during a batch analysis, select **Analysis | Skip Current Sample Set**.
Skipping the Current Sample Plate Analysis in a Batch
To skip the current sample plate during a batch analysis, select Analysis | Skip Current Sample Plate.

Restoring the Original Sequence Data
With a Results file open, select Analysis | Restore Original Base Sequence to return the result data to its original state, losing all edits.

Using Compare Mode
Select up to 15 results to compare against the open result, enabling the comparison of a maximum of 16 sequence results at one time, while within the Sequence Analysis mode.

IMPORTANT If you select more than 16 results from the Compare dialog box, a message box opens, displaying the following warning:

The maximum number of results allowed for comparison with the open result is 15.

Please select again.

Comparing Sequence Results
To compare sequence results:

1. Launch the Sequence Analysis application.
2. Select File | Open.
3. Select the Sequence Results tab and select one sequence result.
4. Click OK to open the result.
5. Click on the Compare button on the Sample View toolbar:

The Compare dialog box opens.
6. Select up to fifteen results.
7. Click OK.

The system processes all fifteen results and the original result, and displays the results on the screen.

NOTE The originally opened sequence result appears in the top pane.
To enable Compare Synch, select Tools | Compare Synch.

Zooming Results
Click on the Zoom Mode icon and zoom in on a region in the original sequence result and the other fifteen results zoom into the same region.

Select Tools | Unzoom All and all sixteen results zoom out so you can view the entire result.
Panning Results

To pan results, click the Pan Mode icon.

- Pan through the data in the original sequence and all sixteen results pan together.
- Pan through the data in a result other than the original one and all sixteen results pan together.
- Use the horizontal scroll bar to move the data along the X-axis. The data panes scroll synchronously.

Aligning Results

To align results, click the Align Mode icon.

- Select a point in the original result.
- Select points in the other results you want to align with the point in the original result.
- Access the Display Options dialog box by double clicking in the original result pane. If you choose the X axis or the Y axis range, the range changes in all of the panes.
- Disable Compare Synch by selecting Tools | Compare Synch.
- Check zoom, align, and pan and the panes function independently of each other.
- Close the Compare tab by selecting File | Close Tab.

Sequence Result Report

The sequence result report includes additional information when certain Sample Elements are selected in the Report Format dialog box. The following table describes what each sample element includes.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Contains summary information for the sample such as sample name, position,</td>
</tr>
<tr>
<td></td>
<td>the method under which it was run, the sample plate name, the analysis</td>
</tr>
<tr>
<td></td>
<td>parameter set name, and capillary serial number. In addition, the sample note,</td>
</tr>
<tr>
<td></td>
<td>property set, and consumables information associated with the sample will be</td>
</tr>
<tr>
<td></td>
<td>printed.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> This is the same information found on the General, Note, Property Set,</td>
</tr>
<tr>
<td></td>
<td>and Consumables tabs in the Properties dialog box.</td>
</tr>
<tr>
<td>Raw Data</td>
<td>Includes the unanalyzed data from the sample run.</td>
</tr>
<tr>
<td>Result Data</td>
<td>Displays data that has undergone final processing to produce result data. If</td>
</tr>
<tr>
<td></td>
<td>the data has been analyzed using a sequence analysis parameter set, the data</td>
</tr>
<tr>
<td></td>
<td>with each peak assigned a base is printed.</td>
</tr>
<tr>
<td>Result Output</td>
<td>Displays the final output in text form. If the data has been analyzed using</td>
</tr>
<tr>
<td></td>
<td>a sequence analysis parameter set, the called sequence will be printed in text</td>
</tr>
<tr>
<td></td>
<td>form. This section of the report corresponds to the base sequence text.</td>
</tr>
<tr>
<td>Current</td>
<td>Includes the trace associated with the current output of each capillary or the</td>
</tr>
<tr>
<td></td>
<td>total current of the sample set run.</td>
</tr>
</tbody>
</table>
To define the report format and content, select **File | Report Format**.

To print the report without previewing or formatting prior to printing, select **File | Print Report**.

To view the report, select **File | Print Preview**.

---

### Table 4.27 Sequence Result Report Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>Includes the trace associated with the voltage output of the system during the sample set run.</td>
</tr>
<tr>
<td>Analysis Log</td>
<td>Contains all of the steps used to perform the base-calling routine on the raw data.</td>
</tr>
<tr>
<td>Run Log</td>
<td>Contains all of the actions performed and instrument messages for the sample run.</td>
</tr>
<tr>
<td>Method Summary</td>
<td>Contains the details of the method used to perform the sample run. This is the information found on the Method tab of the Properties dialog box.</td>
</tr>
<tr>
<td>Analysis Parameters</td>
<td>Shows the parameters used to produce result data and output for a given sample, including heterozygote detection and alignment. If the data has been analyzed using a sequence analysis parameter set, the sequence analysis parameter set will be printed. In addition, the alignment template and the alignment parameters information will be included in this section, when applicable. This information is available on the Analysis and Alignment tabs of the Properties dialog box. It includes alignment information only if an alignment was performed.</td>
</tr>
<tr>
<td>Quality Parameters</td>
<td>Includes the parameters that indicate that any given base is an A, C, G, or T along with a value to indicate the likelihood that the call is correct.</td>
</tr>
<tr>
<td>Trimming Log</td>
<td>Shows the parameters used in quality-based and sequence-based trimming. It includes the original sequence length, the length after quality-based sequencing, the length after sequence-based trimming, the vectors trimmed, and the base sequence in its original and trimmed forms. For sequence-based trims, an “x” replaces the trimmed bases that are located further than that specified in the Distance from End setting or if they are an internal match.</td>
</tr>
<tr>
<td>Alignment Results</td>
<td>Displays the text results of the alignment between a template sequence and a sequence result. The top row of text is the base number, the second line is the template sequence, the third line is the sample sequence and the last line is the consensus.</td>
</tr>
<tr>
<td>Alignment Accuracy</td>
<td>Shows the statistical analysis of the accuracy of the sample sequence. This section groups the errors in the alignment into 50-base regions and displays the number and type of error for each region.</td>
</tr>
</tbody>
</table>
The following example shows a sample report.

Figure 4.37 Sequence Results Report
Displaying Quality Parameters in a Report
To display the quality parameters in a report:

1. Select **File | Report Format**.
2. In the **Sample Elements** section, select the **Quality Parameters** option.
3. Click **OK**.

![Report Format Dialog Box](image)

**Figure 4.38 Report Format Dialog Box**

- To view the quality parameters of an analyzed data set prior to printing, select **File | Print Preview**.
- To exit the **Print Preview** option, click **Close**.
- To print the quality parameters for that data set, select **File | Print Report**.
The system prints the Quality Values as numerical values, as shown in the following example.

### Figure 4.39 Quality Parameters Report

The following table describes the categories on the quality parameters report.

### Table 4.28 Quality Parameters Report Categories

<table>
<thead>
<tr>
<th>Number</th>
<th>Number of the Called Base</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base</td>
<td>Single letter designation of the called base (A, C, G, T or other IUB code)</td>
</tr>
<tr>
<td>A</td>
<td>Base identity score assigned by the base-caller, ranging from 0 - 255</td>
</tr>
<tr>
<td>C</td>
<td>Base identity score assigned by the base-caller, ranging from 0 - 255</td>
</tr>
<tr>
<td>G</td>
<td>Base identity score assigned by the base-caller, ranging from 0 - 255</td>
</tr>
<tr>
<td>T</td>
<td>Base identity score assigned by the base-caller, ranging from 0 - 255</td>
</tr>
<tr>
<td>Call Score</td>
<td>Calculated probability of correctness indicated on a linear (0.00 - 1.00) scale</td>
</tr>
<tr>
<td>Quality Value</td>
<td>Probability of correctness presented on a logarithmic (1 - 100) scale</td>
</tr>
<tr>
<td>Migration</td>
<td>Actual migration time (in minutes) in the raw data corresponding to the called bases</td>
</tr>
<tr>
<td>Data Point</td>
<td>Actual number of the data points in the analyzed data corresponding to the called bases</td>
</tr>
<tr>
<td>Insert</td>
<td>Indicates whether a base has been manually added to the base sequence</td>
</tr>
<tr>
<td>Edit</td>
<td>Indicates whether the base call has been manually changed</td>
</tr>
</tbody>
</table>
Magnifying (Zooming) Data
To magnify data:

1. Click on the upper left-hand point of the area to be magnified.
2. Drag the mouse cursor down to the lower right-hand point of the area and then release the mouse button.
3. Repeat this procedure to increase magnification.

**NOTE** Use the Unzoom 📦 or Unzoom All 📦 icons to zoom out.

Panning Data
To pan back and forth in the data pane:

1. Select **Tools | Pan**.
2. Click anywhere in the raw or analyzed data panes and drag the mouse cursor left or right to move the display.
3. Deactivate the pan mode by selecting **Tools | Zoom** or by clicking on the **Autoscale** button.

Synchronizing Result Data with Result Output
To synchronize the analyzed data with the base sequence:

1. Access the Sequence Analysis module.
2. Open the desired analyzed data.
3. Select **Tools | Base Synch (Peak Synch)** or click the **Synch** icon.
4. Select a base or range of bases in the base sequence pane. The corresponding peaks appear between two hairline markers in sequence analysis.

Aligning Bases and Peaks
To align the bases in the base sequence pane with the peaks in the analyzed data pane:

1. Select **File | Open**.
2. In the Open dialog box, select the Results tab, highlight the desired sequence results, then click **OK**.
3. Click the **Align Mode** 🕒 icon to visually align the peak with the base call.
4. Click on the apex of the peak for which you want to view the alignment. (A hairline cursor is displayed through the apex of the peak to its corresponding base.)
5. Click the **Zoom**, **Pan**, or **Edit** button to exit from the Align mode.
Specifying the Base Call Location
To specify the base call location:

1. Open a sequence results file.
2. Select **Tools | Bases on Top** to toggle the bases from the top to the bottom of the analyzed data pane or vice versa.

Using Audio Enable
To enable the audio feature:

1. With a sequence results file open, select **Edit | Audio Enable**.
2. Enter text into the base sequence pane to hear the letter bases announced as they are typed.

**NOTE** To enter text in the base sequence pane, **Edit** mode must be enabled.

Using Audio Playback
To enable the audio playback feature:

1. With a sequence results file open, highlight a series of base sequence text.
2. Select **Edit | Audio Playback** to hear the announcement of the highlighted base sequence text.

**NOTE** To use this feature, **Edit** mode must be enabled.

Viewing Color Calibrations
To view a color calibration for a sequence result:

1. Select **File | Open**.
2. In the Open dialog box, select the **Sequence Results** tab, highlight the desired result name, then click **OK**.
3. Select **View | Parameters Used to Compute Sequence**.
4. In the Parameters Used dialog box, click **Color**.
   - To view the color calibration prior to the run, select the **Initial Values** radio button.
   - To view the color calibration after the run, select the **Final Values** radio button.

**NOTE** This is a read-only dialog box. To make changes to the color calibrations, select **Analysis | Working Analysis Parameters | Edit | Color**.

   - To add a successful color calibration to the list of available color calibrations, click **Save As** in the Color Calibration Editor dialog box. Enter the desired name, then click **OK**.

Computing a New Color Calibration
To compute a new color calibration:

1. Select **Analysis | Working Analysis Parameters**.
2. In the **Working Parameters** dialog box, click **Edit**.
3. Click **Color** in the Sequence Analysis Parameters Editor dialog box.
4. Select the **Compute new color matrix** check box (✔).

5. Select the **Use Final Values as Initial Values** check box (✔) to use the final values for the initial values for the computation (recommended if the peak resolution is good).

### Exporting Sequence Result

To export from the Sequence Analysis module:

1. Launch the Sequence Analysis module and open a sequence result.
2. Select **File | Export** to open the Export dialog box.
3. Select a target folder and file name.

**NOTE** Do not use special characters in the file name: “/ : * ? \ < > |”.

4. Select the desired format in the **Save as type** drop-down list as shown in the following example.

![Figure 4.40 Sequence Analysis Export Dialog Box](image)

5. Click **Export**.
**Sequence Export File Types**

The following table describes the available export file types and options.

### Table 4.29  Sequence Export Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| SCF (.scf)   | Use the SCF (Standard Chromatogram Format) format to store analyzed DNA sequence data for a single sample. The format describes both ‘public’ and ‘private’ data sections. The well-defined public data section contains trace data points, the called sequence, the positions of each called base within the trace data, and the call scores for each called base. It also includes a public comment section. The private section may store other information that most software packages ignore.  

The CE system uses the private data section to store sample data (including raw data along with current and voltage data). You can store sample data from either sequencing or fragment analysis samples. The notes and property sets for the sample are stored in the comment section. The CE system software supports SCF versions 2.1 and 3.0. (You would use this format, for instance, to export analyzed sequence data into Lasergene’s SeqMan from DNASTAR Inc.). Third-party packages cannot currently view raw data, current, or voltage. However, custom applications can be written to view the data.

Use the SCF format to transfer data from instrument to instrument, or to import data from third-party software into the Sequence Analysis module. Using SCF to exchange data between instruments removes information, such as sample plate name, capillary array serial number, etc. To maintain exact copies of data including header information, use the CEQ format and import and export these data using the Data Manager.  

| Tab-Delimited Text (.txt) | The Tab-delimited format is valid for raw data, sequence results, and fragment results. Select the Raw Data check box (✓) to include raw data, as well as current and voltage data. Select the Results Data and Results Output check boxes (✓) to include the sequence results.  

The data points are expressed as text values which can be viewed in any text editor or in Excel. |
| SEQ (.seq) | The Seq format only applies to the sequence results portion (such as text bases) of analyzed sequence data. This format is used, for instance, to export data into Lasergene’s SeqMan from DNASTAR Inc. Selecting the SEQ format exports the Result Output (Base Sequence) automatically if the sample has been analyzed with a sequence analysis parameter set. If the sample has been analyzed with a fragment analysis parameter set, nothing is exported. |
## Sequence Analysis

### Using the Sequence Analysis Module

**FASTA (.fasta)**

The FASTA format only applies to the sequence results portion (such as text bases) of analyzed data, and contains a comment line that is used to identify the data. Along with the text file, a quality values file is also generated (*.FASTA.QUAL) which lists the quality value for each base. (Quality values correspond to \(-10 \times \log_{10}[\text{error rate}]\)). The range for the quality values is 1 to 99. Edited and inserted bases have a value of 99. You would use this format, for instance, to export data into PHRAP.

Selecting the FASTA format exports the Result Output (Base Sequence) and the Quality Parameters automatically if the sample has been analyzed with a sequence analysis parameter set. If the sample has been analyzed with a fragment analysis parameter set, nothing is exported.

**NOTE** For instance, in PHRED, a quality value of 10 means 1 error in 10. A quality value of 20 means an error rate of 1 error in 100. A quality value of 30 means an error rate of 1 error in 1,000. A quality value of 40 means an error rate of 1 error in 10,000, etc. Normally PHRED would export these quality values into PHRAP. In the case of exporting from the CE system, we bypass PHRED and export directly into PHRAP.

**PHRED (.scf.phd.1)**

The PHRED format produces two files: a PHRED file and an SCF file. A PHRED file is a text file composed of a SEQUENCE section containing a COMMENT and DNA section. The SEQUENCE section also contains the name of the Analyzed Result that was stored.

The COMMENT section contains the file name of the associated SCF file (CHROMAT_FILE) that was produced along with the PHRED file. The values for ABI_THUMBPRINT and PHRED_VERSION are fixed text "N/A." The values for CALL_METHOD and QUALITY_LEVELS are fixed as "CEQ" and "99" respectively for the CE system. The TIME stamp is the current time at the time of export.

The DNA section is composed of the base-call (always lower-case), PHRED Quality Value, and the Peak Index (data point) of the analyzed data contained within the associated SCF file. Values are separated by spaces.

Selecting the PHRED format exports the Result Data, Result Output (Base Sequence), and Quality Parameters automatically if the sample has been analyzed with a sequence analysis parameter set. If the sample has been analyzed with a fragment analysis parameter set, nothing is exported.

**ESD (.esd)**

The ESD, electropherogram sample data, format is used to export raw data from the CE system to a third-party software package for analysis. Selecting this option exports only the raw data, and no other information.

### Table 4.29 Sequence Export Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FASTA (.fasta)</td>
<td>The FASTA format only applies to the sequence results portion (such as text bases) of analyzed data, and contains a comment line that is used to identify the data. Along with the text file, a quality values file is also generated (*.FASTA.QUAL) which lists the quality value for each base. (Quality values correspond to (-10 \times \log_{10}[\text{error rate}])). The range for the quality values is 1 to 99. Edited and inserted bases have a value of 99. You would use this format, for instance, to export data into PHRAP. Selecting the FASTA format exports the Result Output (Base Sequence) and the Quality Parameters automatically if the sample has been analyzed with a sequence analysis parameter set. If the sample has been analyzed with a fragment analysis parameter set, nothing is exported. <strong>NOTE</strong> For instance, in PHRED, a quality value of 10 means 1 error in 10. A quality value of 20 means an error rate of 1 error in 100. A quality value of 30 means an error rate of 1 error in 1,000. A quality value of 40 means an error rate of 1 error in 10,000, etc. Normally PHRED would export these quality values into PHRAP. In the case of exporting from the CE system, we bypass PHRED and export directly into PHRAP.</td>
</tr>
<tr>
<td>PHRED (.scf.phd.1)</td>
<td>The PHRED format produces two files: a PHRED file and an SCF file. A PHRED file is a text file composed of a SEQUENCE section containing a COMMENT and DNA section. The SEQUENCE section also contains the name of the Analyzed Result that was stored. The COMMENT section contains the file name of the associated SCF file (CHROMAT_FILE) that was produced along with the PHRED file. The values for ABI_THUMBPRINT and PHRED_VERSION are fixed text &quot;N/A.&quot; The values for CALL_METHOD and QUALITY_LEVELS are fixed as &quot;CEQ&quot; and &quot;99&quot; respectively for the CE system. The TIME stamp is the current time at the time of export. The DNA section is composed of the base-call (always lower-case), PHRED Quality Value, and the Peak Index (data point) of the analyzed data contained within the associated SCF file. Values are separated by spaces. Selecting the PHRED format exports the Result Data, Result Output (Base Sequence), and Quality Parameters automatically if the sample has been analyzed with a sequence analysis parameter set. If the sample has been analyzed with a fragment analysis parameter set, nothing is exported.</td>
</tr>
<tr>
<td>ESD (.esd)</td>
<td>The ESD, electropherogram sample data, format is used to export raw data from the CE system to a third-party software package for analysis. Selecting this option exports only the raw data, and no other information.</td>
</tr>
</tbody>
</table>
### Sequence Export Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| CEQ (.cq*)              | Selecting the CEQ format, the format native to our database, exports sample data, sequence or fragment results, sample plate results, sequence, or fragment analysis parameters, sample plates, methods, locus tags (fragment data only), standards (fragment data only), and optical scan data. The sample elements are automatically selected in the Export dialog box, such that all of the associated information listed above will be exported. This format essentially takes a “snapshot” of the file and can retain all of the information belonging to that file. This format can only be used when importing data into the Data Manager. This format can also be used when exporting data from the Sequence and the Fragment Analysis modules and the Data Manager. When exporting as CE system data, the various data types are exported to files with the following extensions:  
  - Sequence Analysis ParameterCQA  
  - Sequence InvestigatorCQC  
  - Fragment Size StandardCQD  
  - Fragment Analysis ParameterCQF  
  - Galvo Scan DataCQG  
  - Fragment Locus TagsCQL  
  - MethodsCQM  
  - SNP Locus TagsCQN  
  - Sequence ResultCQR  
  - Sample DataCQS  
  - Sample TableCQT  
  - Fragment ResultCQU  
  - Sample Table ResultCQX |
| Remove CEQ Tracking Suffix | You may automatically remove the plate position coordinates (*.A01, *.B02, etc.) and the time/date stamp from the sample name which is normally generated by the CE system software on export. To do so, select the Remove CEQ Tracking Suffix check box (✓). |
| Resolve Filename Conflicts | If the system encounters the same sample name at the destination, it usually overwrites the name (if you choose to remove the plate position coordinates and the time/date stamp which ensures a unique name). If you select the Resolve Filename Conflicts check box (✓), the system increments the sample names on export when it encounters duplicate names. For example, if the system encounters the duplicate sample name of “Fred” on export, it renames the file exported to “Fred_1”. |
| Apply Trimming            | Selecting this option removes the trims from the sequence before you export it and replaces internal trims with the letter “x”. |

### Customizing Filename Extension

To supply your own custom filename extension (or none at all) to exported files, modify the CEQ ini file as follows:
NOTE If there is no Export section in the CEQ.ini file, export any sample file to generate the Export section, then modify as needed.

Find the section [EXPORT] and add/modify the appropriate entry.

TXT_EXT for Text files, default is “.txt”
SEQ_EXT for SEQ files, default is “.seq”
FASTA_EXT for FASTA files, default is “.fasta”
SCF_EXT for SCF files, default is “.scf”
PHD_EXT for PHRED files, default is “.scf.phd.1”

To have no file extension added, set the entry to nothing (make sure there are no spaces after the “=”).

SCF_EXT= Example Output FileName: SpaSample

To use a unique file extension, add or modify the entry with the desired file extension (do not place the leading dot “.”, the system will add it).

SCF_EXT=scf v3

Output FileName: SpaSample.scf v3

To hide an entry and make the system use the default, either delete or place an “;” before it.

SCF_EXT=SCFV3

Output FileName: SpaSample.scf

Exporting Data to a Third-Party Package

CAUTION Verify that the third-party analysis package accepts the data transferred using a command-line, and that it is compatible with the file types provided by the CE system software before attempting to perform this procedure.

To export sequence data to a third-party analysis package:

1. Select File | Open.
2. In the Open dialog box, select the appropriate tab, highlight the desired data, then click OK.
4. In the Third Party Analysis Setup dialog box:
   a. Specify the path and executable file of the third-party analysis package.
   b. Select the appropriate Export Data Format radio button.
   c. Click OK.
5. Select Analysis | Third-Party Analysis.
6. In the Export dialog box, enter the filename, then click OK. The system exports the data and launches the third-party package, displaying the exported data.
This chapter provides an overview of the Sequence Investigator module, including its menu options, toolbars, and dialog boxes. It also shows you how to use this module to investigate and compare sequence analysis results.

### 5.1 Sequence Investigator Module Overview

Compare sequences to known reference sequences. For each comparison, you can use one or two new sequence results, in either orientation, to form a consensus for the comparison. The software automatically determines and matches the orientation of the sequences, forms the consensus, aligns the consensus with the reference sequence, and provides a detailed report of the differences.

The Sequence Investigator provides a number of tools you can use to inspect and edit the data before generating the final report. The navigator toolbar allows you to jump to points of interest, from specific base sequences to a variety of discrepancies in the aligned data set. The discrepancy map provides an overview of the coverage of the reference sequence by the sequences and indicates the locations of the discrepancies. Together, these alignment, inspection, editing, and reporting features make Sequence Investigator an ideal tool for identifying mutations or polymorphisms in DNA.

### Main Window

Figure 5.1 shows the Sequence Investigator screen layout. This consists of a title bar, menu bar, several toolbars, the display window, and the status bar.
**Table 5.1** Main Window, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Title Bar - Shows the module name, the active document name, and has the standard minimize , maximize and close icons at the top-right of the window.</td>
</tr>
<tr>
<td>B</td>
<td>Menu Bar - See &quot;Menu Bar Options&quot; on page 173.</td>
</tr>
<tr>
<td>C</td>
<td>Standard Toolbar - See &quot;Toolbar Icons&quot; on page 177.</td>
</tr>
</tbody>
</table>
| D    | Display Window - Use this area to graphically display the specific window or windows associated with the current task. This window displays the following panes:  
  - Alignment Panes - Displays the text alignment results, including the following elements: Base and codon numbering, reference and consensus amino acid translations, reference sequence, sample sequences, consensus sequence, and the difference line.  
  - Trace Data Panes - Displays trace data and base sequence results for the selected sample sequences. |
| E    | Dye Colors Toolbar - Use these user-defined colors in the trace data view and the bases in the text view when the text coloring is activated. |
| F    | Navigator Toolbar - Offers search and navigation tools within an alignment. |
Menu Bar Options

The following example shows the Sequence Investigator module menu bar options.

The following topics describe each of these menus and their options.

File Menu

Click the File menu to display its drop-down menu, as shown in the following example.

Use the File menu to create, open, save, export, set preferences, view properties, and print a document. The following table describes the Sequence Investigator module's File menu options.

Table 5.2 File Menu, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Prompts for a reference file from a Windows folder, or disk, and then prompts for one or two sequence results from the current working database.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens an existing compared sequence result.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the document.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the active document to a Windows folder.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the current document to a new name and/or folder.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports the current document as a text (<em>.txt) or a protein file (</em>.pro).</td>
</tr>
</tbody>
</table>

Table 5.1 Main Window, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Discrepancy Map Toolbar - Displays color-coded locations of any type of attributes selected. You may view the coverage of the reference and sample sequences.</td>
</tr>
<tr>
<td>H</td>
<td>Status Bar - Displays information concerning the current selection, including the position of the currently highlighted text.</td>
</tr>
</tbody>
</table>
Sequence Investigator Module

Sequence Investigator Module Overview

Table 5.2 File Menu, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td>Sets the preferences for the Sequence Investigator.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the properties of the current document.</td>
</tr>
<tr>
<td>Report Format</td>
<td>Set the format options used to print reports and adjust the printer settings.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a print preview of the active document using the format specified in the Report Format dialog box.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the active document as specified in the Report Format dialog box.</td>
</tr>
<tr>
<td>Print Desktop</td>
<td>Prints the active desktop area as specified in the Preferences dialog box.</td>
</tr>
<tr>
<td>Recent Objects</td>
<td>Provides a short cut to open previously opened documents.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the Sequence Investigator module.</td>
</tr>
</tbody>
</table>

Edit Menu

Click the Edit menu to display its drop-down menu, as shown in the following example.

Use the Edit menu to edit displayed data. The following table describes the Sequence Investigator module's Edit menu options.

Table 5.3 Edit Menu, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Inserts a space before the currently selected position.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected position.</td>
</tr>
<tr>
<td>Replace</td>
<td>Replaces the highlighted position with a selected IUB code.</td>
</tr>
<tr>
<td>Trim</td>
<td>Removes contiguous selected bases that contain an end base in the sample sequence base-call text.</td>
</tr>
<tr>
<td>Search</td>
<td>Searches forward and backward for the attributes or text specified in the navigator toolbar.</td>
</tr>
<tr>
<td>Restore To Original</td>
<td>Restores the compared sequence result to its original state (removing all changes).</td>
</tr>
<tr>
<td>Quality Threshold</td>
<td>Changes the quality threshold below which bases in the consensus are identified as having low quality.</td>
</tr>
<tr>
<td>Flip Traces</td>
<td>Moves the sequence trace shown in the top trace pane and exchanges its position with the bottom trace.</td>
</tr>
</tbody>
</table>
View Menu
Click the View menu to display its drop-down menu, as shown in the following example.

NOTE  A "✓" next to an option indicates that the option is enabled.

Use the View menu to display data as desired. The following table describes the Sequence Investigator module's View menu options.

Table 5.4 View Menu, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbars</td>
<td>Select the toolbars that will be displayed. Selecting one of these options</td>
</tr>
<tr>
<td></td>
<td>toggles between showing and hiding the corresponding toolbar. See &quot;Toolbar</td>
</tr>
<tr>
<td></td>
<td>Icons&quot; on page 177.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Toggles between showing and hiding the status bar.</td>
</tr>
<tr>
<td>Unzoom All</td>
<td>Shows each sequence in its entirety.</td>
</tr>
<tr>
<td>History</td>
<td>Opens the history log.</td>
</tr>
<tr>
<td>Base Numbering</td>
<td>Toggles base numbering off or on.</td>
</tr>
<tr>
<td>Codon Numbering</td>
<td>Toggles codon numbering off or on.</td>
</tr>
<tr>
<td>Sequences</td>
<td>Toggles between showing and hiding the sequences.</td>
</tr>
<tr>
<td>Reference Amino Acid Translation</td>
<td>Toggles between showing and hiding the reference amino acid translation.</td>
</tr>
<tr>
<td>Consensus Amino Acid Translation</td>
<td>Toggles between showing and hiding the consensus amino acid translation.</td>
</tr>
<tr>
<td>Differences</td>
<td>Toggles the sequence differences off or on.</td>
</tr>
<tr>
<td>Show Colors</td>
<td>Toggles color used for text and background.</td>
</tr>
<tr>
<td>Working Database</td>
<td>Displays the active database.</td>
</tr>
</tbody>
</table>
**Window Menu**

Click the **Window** menu to display its drop-down menu, as shown in the following example.

Use the **Window** menu to display data as desired. The following table describes the Sequence Investigator module's **Window** menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Cascades the open windows.</td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td>Tiles the windows in a horizontal orientation.</td>
</tr>
<tr>
<td>Tile Vertically</td>
<td>Tiles the windows in a vertical orientation.</td>
</tr>
<tr>
<td>Close All</td>
<td>Closes all open windows.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arranges all icons on the desktop.</td>
</tr>
<tr>
<td>Open file list</td>
<td>Displays a list of all open documents.</td>
</tr>
</tbody>
</table>

**Help Menu**

Click the **Help** menu to display its drop-down menu, as shown in the following example.

The following table describes the **Help** menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Select this option to display the CE system online help. By default, the help system displays the Contents in the navigation pane, located on the left, and the introductory topic in the topic pane, located on the right. You can use the Contents to select and print specific help topics. The navigation pane also provides a Search tab and an Index tab. These tabs let you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td>Using Help</td>
<td>Select this option to display the Contents window on how to use the Windows Help system.</td>
</tr>
</tbody>
</table>
Sequence Investigator Module

Sequence Investigator Module Overview

Table 5.6 Help Menu, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About GenomeLab System</td>
<td>Select this option to access software, instrument, and system information.</td>
</tr>
<tr>
<td>Beckman Coulter Home Page</td>
<td>Select this option to access the Beckman Coulter Home Page on the Internet.</td>
</tr>
</tbody>
</table>

Toolbar Icons

The toolbars provide quick and easy access to commonly used menu items. Each toolbar contains icons that correspond to commonly used menu items. Click the icon to execute the function. By default, all the toolbars appear when you first open the module.

Standard Toolbar Icons

The Sequence Investigator module's standard toolbar contains icons that correspond to common menu options.

Figure 5.2 Standard Toolbar, Sequence Investigator Module

The following table describes the Sequence Investigator standard toolbar icons.

Table 5.7 Toolbar Icons, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="1" alt="Icon" /></td>
<td>New - Prompts for a reference file from a Windows folder, or disk, then prompts for one or two sequence results from the current working database.</td>
</tr>
<tr>
<td><img src="2" alt="Icon" /></td>
<td>Open - Open an existing compared sequence result.</td>
</tr>
<tr>
<td><img src="3" alt="Icon" /></td>
<td>Save - Saves the active document to a Windows folder.</td>
</tr>
<tr>
<td><img src="4" alt="Icon" /></td>
<td>Print - Prints the active document as specified in the Report Format dialog box.</td>
</tr>
<tr>
<td><img src="5" alt="Icon" /></td>
<td>Print Preview - Displays a print preview of the active document using the format specified in the Report Format dialog box.</td>
</tr>
<tr>
<td><img src="6" alt="Icon" /></td>
<td>Print Desktop - Prints the active desktop area as specified in the Preferences dialog box.</td>
</tr>
<tr>
<td><img src="7" alt="Icon" /></td>
<td>Insert - Inserts a space before the currently selected position.</td>
</tr>
<tr>
<td><img src="8" alt="Icon" /></td>
<td>Delete - Deletes the selected position.</td>
</tr>
<tr>
<td><img src="9" alt="Icon" /></td>
<td>Trim - Removes contiguous selected bases that contain an end base in the sample sequence base-call text.</td>
</tr>
<tr>
<td><img src="10" alt="Icon" /></td>
<td>Restore to Original - Restores the compared sequence result to its original state (removing all changes).</td>
</tr>
</tbody>
</table>
Dye Colors Toolbar

The Sequence Investigator module's Dye Colors toolbar identifies the colors assigned to dyes displayed in the trace data view and for the bases in the text view. To change any of these color assignments, double-click the desired icon and use the Colors dialog box to choose another color.

Table 5.7 Toolbar Icons, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Unzoom Icon" /></td>
<td>Unzoom all - Displays both sequence traces in their entirety.</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Sequences Icon" /></td>
<td>Toggle Sequences - Displays or hides the sequences in the text view.</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Reference AA Translation Icon" /></td>
<td>Toggle Reference AA Translation - Displays or hides the reference amino acid translation line in the text view.</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Consensus AA Translation Icon" /></td>
<td>Toggle Consensus AA Translation - Displays or hides the consensus amino acid translation line in the text view.</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Differences Icon" /></td>
<td>Toggle Differences - Displays or hides the differences line in the text view.</td>
</tr>
<tr>
<td><img src="image" alt="Dye Color Coded Text Icon" /></td>
<td>Dye Color Coded Text - Displays base text in the specified dye colors when selected. Displays the base text in black and white when not selected.</td>
</tr>
<tr>
<td><img src="image" alt="Dye Color Coded Text block Icon" /></td>
<td>Dye Color Coded Text block - Displays the base text background in the specified dye colors when selected.</td>
</tr>
<tr>
<td><img src="image" alt="Help Topics Icon" /></td>
<td>Help Topics - Displays the CE system online help. By default, the help system displays the Contents in the navigation pane, located on the left, and the introductory topic in the topic pane, located on the right. You can use the Contents to select and print specific help topics. The navigation pane also provides a Search tab and an Index tab. These tabs let you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td><img src="image" alt="Context-Sensitive Help Icon" /></td>
<td>Context-Sensitive Help - Click this icon and then on a menu item to open the Help file related to the selection.</td>
</tr>
</tbody>
</table>

Dye Colors Toolbar

The following table describes the Sequence Investigator Dye Colors toolbar icons.

Table 5.8 Dye Colors Toolbar Icons, Sequence Investigator Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="A (red)" /></td>
<td>Red is the default color assigned to the Adenine (A) nucleotide in the data view.</td>
</tr>
<tr>
<td><img src="image" alt="C (black)" /></td>
<td>Black is the default color assigned to the Cytosine (C) nucleotide in the data view.</td>
</tr>
<tr>
<td><img src="image" alt="G (green)" /></td>
<td>Green is the default color assigned to the Guanine (G) nucleotide in the data view.</td>
</tr>
</tbody>
</table>
5.2 Sequence Investigator Procedures

This section shows you how to use this module to investigate and compare sequence analysis results.

To open the Sequence Investigator module, click the Investigator icon from the Main Menu:

Creating a Reference File

The reference file is a text file you can create using Notepad or any other text editor. It may be composed of one or two sections: the sequence and, optionally, specific nucleotide or amino acid mutations. To create the file, enter the text of the sequence starting in the first line of the text editor. You may break the sequence text into several lines.

**NOTE** To create a reference file from the Sequence Analysis module, export the data in *.seq format or choose *.txt with only Result Output checked.

To enter known protein or nucleotide mutations:

1. On the line below the reference sequence, type an open bracket, followed by “KNOWN AA MUTATIONS” and/or “KNOWN BASE MUTATIONS”, then type a closed bracket.
2. On the next line, type the current reference amino acid or base, the position number using the amino acid or base number, then the expected amino acid or base change.

The following example shows a sample reference:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T (blue)</td>
<td>Blue is the default color assigned to the Thymine (T) nucleotide in the data view.</td>
</tr>
<tr>
<td>N (gray)</td>
<td>Gray is the default color assigned to ambiguous nucleotides other than A, C, G or T.</td>
</tr>
</tbody>
</table>
Sequence Investigator Module
Sequence Investigator Procedures

NOTE
The system creates a default Reference folder during software installation. You may store your reference files in that location or in any other folder. When you create a new comparison, navigate to the appropriate folder to select your reference.

Selecting a Reference and Sequence Results

1. Open the Sequence Investigator module.

Reference Sequence  ->  TCCTGTC
Amino Acid Mutations ->  [KNOWN AA MUTATIONS]
Known Amino Acid Notation ->  Q2K
Base Mutations  ->  [KNOWN BASE MUTATIONS]
Known Base Notation ->  A50C

Figure 5.4 Sample Reference
3. Select the sample reference and click **Open**. The Open Sequence Results dialog box opens, as shown in the following example.

![Open Reference Dialog Box](image)

**Figure 5.5 Open Reference Dialog Box**

4. Select one or two results and click **OK**.

**NOTE** To select two results, left-click the first result, press and hold the **Ctrl** key, then left-click the second result.

![Open Sequence Results Dialog Box](image)

**Figure 5.6 Open Sequence Results Dialog Box**

5. If two results are in different projects, select **(none)** as the **Project Name** to display all available results files for a given database. A new window opens.

**NOTE** By default the standard, navigator, dye color, and discrepancy map toolbars appear docked. If they are not displayed, select **View | Toolbars** and enable the desired toolbar.
Numbering

Base and codon numbering start at the beginning of the reference sequence. The system uses these numbers as a navigational reference point.

The column position numbering begins at the first base in the comparison. This may be a reference base, a sample sequence base, or a consensus base, depending on the alignment of the sequences being compared. The selected column number appears in the lower right-hand corner of the status bar. The History Log records all edits made in the Sequence Investigator, and their column number.

Viewing Reference Amino Acid Translations

When the system generates the comparison, it translates the nucleotide sequence of the reference file into an amino acid sequence and displays it above the reference base sequence line. From the beginning of the reference, the bases are separated into groups of three nucleotides (codons). Each group is translated into an amino acid which is displayed above the codon. Each codon is shaded to show its boundaries. (If an inserted space exists, signified by a dash “–,” the space is included in the codon.)

The amino acid designation is left-justified above the codon. If two amino acids are possible, the letters designating the possible amino acids appear. If the system detects more than two possible amino acids at any location, it displays an asterisk instead.

To show or hide the reference amino acid sequence, select View | Reference Amino Acid Translation. The screen displays or hides the reference amino acid translation, depending on whether the item is checked or unchecked.

Viewing Sequence Traces

When you first perform a comparison, select one or two sequences to form the consensus. After performing the comparison, the system displays the traces for these sequences. When you click on any position in alignment view, the corresponding peaks in the traces move to the center of the trace view, framed by two vertical lines.

When you first open or create a comparison, the system scales the traces to improve readability.

- To zoom each sequence pane individually and repeatedly, left-click and hold the mouse button while dragging the pointer to form a box around the desired area, then release the mouse button.
- To unzoom both traces, click the Unzoom All icon . The traces in both panes revert to a completely unzoomed state, displaying the entire range of the sequence results.
- To unzoom one of the two open data traces, right-click in the desired trace pane and select Unzoom Pane. The selected trace displays the entire range of the result.

You cannot edit sequence traces in the Sequence Investigator. However, you may edit sequence traces using the Sequence Analysis module. If you use an edited result for your comparison, your edited bases appear in lower case.
Viewing Consensus Amino Acid Translations

When the system generates the comparison, it translates the consensus nucleotide sequence into an amino acid sequence and displays it below the consensus sequence. The amino acid translation starts at the first base relative to a reference codon. The consensus is also segmented into codons, which are translated into their amino acids.

If edits occur in the consensus, a re-translation of the consensus amino acid translation occurs automatically and the system automatically updates the discrepancy map and the differences line.

Each codon is shaded to show its boundaries. If a heterozygote occurs, the system notes up to two possibilities; if more possibilities exist, an asterisk appears instead.

The consensus sequence is editable within the Sequence Investigator. Edited bases appear in lower-case letters.

Using Quality Values

- If you are using a single sequence, the quality value assigned to each base in the consensus match each base in the sequence.
- When using two sequences and the bases agree, one of two calculations occur:
  - If the orientation of the two sequences is opposing, the system adds two quality values.
  - If the orientation is the same, the system uses the higher quality value.
- If the bases disagree, the system performs a calculation to determine the probability of error for that position, providing a quality value which is the difference between the higher and lower value.

To set the value at which bases in the consensus are considered low quality, select Edit | Quality Threshold. Low quality bases are identified in the differences line, the navigator toolbar, and the discrepancy map.

Viewing Sequence Investigator Differences

The system uses codes to denote the type of discrepancy encountered when performing the comparison. These codes are shown in the differences section of the alignment pane. To turn the differences line on or off, select View | Differences. The highest level code appears in the differences line in the location where the discrepancy occurred.

**NOTE** Any consensus position may have multiple difference codes associated with it. The codes have a hierarchy; the system displays the code with the highest precedence. To view all difference codes associated with any position, display the navigator toolbar by selecting View | Toolbars | Navigator. The differences text box in the navigator toolbar displays the difference codes in order of precedence.

Navigation and Editing

The navigator toolbar allows you to search for locations of interest in the consensus based on attributes, as well as search for specific bases and view their associated quality values and difference codes.

If the navigator toolbar is hidden from view, select View | Toolbars | Navigator. The system displays the navigator toolbar (Figure 5.7). When docked, the toolbar appears to the left of the screen display.
If you need more space for your screen display, you may move the navigator toolbar so it floats over the screen display.

- To reposition a docked toolbar, select any background area of the dialog box, press and hold the left mouse button while dragging the toolbar to a convenient position on the screen, then release the mouse button.
- To re-dock a floating toolbar, left-click the toolbar's title bar, press and hold the left mouse button while dragging the toolbar to the lower-left corner of the screen, then release the mouse button.

**NOTE** For details on how to use the search and editing capabilities provided on the navigator toolbar, click Help to open its context-sensitive help topic.

![Navigator Toolbar - Floating](image)

**Figure 5.7 Navigator Toolbar - Floating**

When editing the consensus, follow these guidelines:

- Complete all trim operations before performing other types of editing. Using any other editing operation disables the trim feature.
- You may insert and delete spaces in the reference sequence, but not change bases.
- Select a single consensus base if you want to perform base editing.

**NOTE** The system adds all editing operations to the history log along with the date, time, and position of the operation.

**Complementing the Sequence**

When the system performs a comparison, it determines which orientation, forward or reverse, to provide a better fit with the reference. If the system determines that the sequences
generate a better comparison in the opposite orientation, it automatically reverse complements the sequences.

To manually reverse complement a sample, right-click the desired trace data pane, then select Reverse Complement. The trace and associated bases are reverse complemented.

**Flipping the Traces**
You may want to switch the order of sequence displayed. To move the sequence trace shown in the top trace pane and exchange its position with the bottom trace, select Edit | Flip Traces or right-click in one of the trace data panes and select Flip Traces. This exchanges the position of the sequences in both the alignment pane and the trace panes.

**Trimming the Bases**
When you first open or create a compared sequence result, the sequences used in the comparison appear in the alignment pane. You can then trim the ends of the sequences.

If sequences are not shown, select View | Sequences to display the sequences in the alignment pane.

To trim the sequence:

1. Select a group of sequence bases at either end of the sequence.
2. Click the Trim icon to remove unwanted bases from the alignment. This deletes the bases from the text and trace data views.

**NOTE**  You may only trim at either end of the sequence. You may not trim within the sequence.

After each trim, the system automatically aligns and redisplays the alignment text and traces.

**NOTE** The system adds trim operations to the history log, along with bases trimmed with date and time of trim operation. To access the history log, select View | History.

**Searching the Consensus for Specific Attributes**
To search the consensus for specific attributes:

1. Select the Consensus Attribute Search radio button.
2. Select the attributes that you want to define as the search criteria.
3. Click on the forward (>>) or reverse (<<) button to search the consensus in the specified direction.

**NOTE**  You may also press the Ctrl and the arrow (←, →) keys to perform the search.

When the search finds consensus bases that conform to the search criteria, it highlights them.

**Searching the Consensus for Specific Bases**
To search for a specific base or contiguous multiple bases:

1. Select the Consensus Text Search radio button.
2. Enter the bases in the text box.
3. Specify the search criteria:
To search for the exact match for text, select the **Exact Match** check box (✓). Use the forward and back arrow buttons or press the **Ctrl** and arrow (←, →) keys to search backwards and forwards through the base sequence for more text searches.

To search for a base without requiring an exact match, clear the **Exact Match** check box. The search result includes all exact matches as well as all IUB codes with an overlapping base.

For example, a search for the ambiguity code **K** not only results in the bases **G** or **T**, but also result in any ambiguity code that **contains** **G** or **T**. The search stops on all ambiguity codes other than **M**. (The bases represented by **M** are **A** and **C**.) Also, searching for an **A**, **C**, **G**, or **T** matches any ambiguity codes containing the base. For example, searching for **A** results in any ambiguity code containing **A** (specifically, **M**, **R**, **W**, **U**, **H**, **D**, and **N**).

**Editing the Consensus**

To edit the base selected by the search, type the desired base or select **Edit** | **Replace**, then select the desired base or ambiguity code.

To automatically jump to the next base that matches your search criteria once you have completed the edit, select **Forward** or **Backward** on the Edit tab of the Preferences dialog box.

**Displaying the Discrepancy Map**

The discrepancy map toolbar allows you to look for areas of interest in relationship to the reference. You may view the coverage of the consensus and sample sequences. You may also view the color-coded locations in the experiment of any type of attributes of interest that you specify.

**Figure 5.8 Discrepancy Map Toolbar**

- The top bar, **Ê**, in the discrepancy map represents the reference sequence.
- The second **Ê** and third **Î** bar (if two sample sequences were selected) displays the coverage of the sample sequences in relation to the reference.
- The next area, **Î**, represents the consensus and shows the color-coded regions of interest associated with the specified attributes.

A red marker behind the reference, sample, and consensus bars corresponds to the selected area in the trace data view and the selected base in the trace text view. You can use this toolbar to navigate to desired areas by clicking on any point of interest. The alignment and trace data panes refresh and display the area.
For a global view of the desired attributes, select the corresponding check boxes located on the right side of the map. For each selected attribute, the system adds a new bar to the consensus area showing the locations where selected attributes exist.

To change the color code of the attribute display:

1. Click on the color well at the left of the attribute. The color palette for the selected well opens.
2. Select a new color.
3. Click OK. The discrepancy map uses the newly selected color.

**Printing Reports**

You may print a report for the active compared sequence result. To set up a report:

1. Select **File | Report Format**.
2. Select the default printer from the **Printer Name** down-down list.
3. Set your preferred page layout by selecting **Portrait** or **Landscape**.
4. Select the option elements you want displayed in your report (Table 5.9).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Prints information such as the name of the compared sequence and the name of the sample sequences as well as the database and project where the sample resides.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Prints the reference amino acid translation, the reference, the sequences, the difference codes, the consensus, and the consensus amino acid translation.</td>
</tr>
<tr>
<td>History Log</td>
<td>Prints a history of changes you performed in the alignment.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Prints the statistics of the report, such as the number of discrepancies before and after editing.</td>
</tr>
<tr>
<td>Mutations</td>
<td>Prints all mutations, including known and novel bases and amino acids.</td>
</tr>
</tbody>
</table>

**Exporting the Sequence**

You may export the active compared sequence in either of three formats, as described in the following table.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>text (*.txt)</td>
<td>Exports the base sequence of the consensus.</td>
</tr>
</tbody>
</table>
To export the active compared sequence:

1. Select **File | Export**.
2. Choose the desired format, as described in Table 5.9.
3. Click **OK** to export the data.

**NOTE** If a file with the same name exists in the selected directory, the system prompts you to rename the new file or confirm that you want to overwrite the existing file.

The system displays an hourglass while exporting the data.

### Saving the Data

To save a new document:

1. Select **File | Save**. A Save As dialog box opens, prompting you to enter a file name and folder location.
2. Select the folder location and enter a file name.
3. Click **Save**. The system saves the data to the file for later retrieval.

**NOTE** If the document has previously been saved, select **File | Save** to save the document immediately.

To change the name or location of an existing file:

1. Select **File | Save As**. A Save As dialog box opens, prompting you to enter a file name and folder location.
2. Select the folder location and enter a file name.
3. Click **Save**.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tab delimited text (*.txt)</td>
<td>Exports data as a single line and all carriage returns (\n) are replaced with tabs (→).</td>
</tr>
<tr>
<td>protein (*.pro)</td>
<td>Exports the amino acid sequence. To set the protein format, select **File</td>
</tr>
<tr>
<td></td>
<td>• <strong>Condensed</strong>: Provides all protein translations in the same text line and designates heterozygotes between brackets.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Expanded</strong>: Includes all possible translations on different lines.</td>
</tr>
</tbody>
</table>

The following example compares the differences between condensed and expanded protein formats:

```
```

Condensed

```
KVSILPLV[LP]K

KVSMLPL[LP]K

KVSMLPLV[LP]K
```

Expanded
The analysis of fragment or allele data is performed with the CE system software, by using Studies. A Study represents a collection of quality sample results used for locus tag generation, genotyping, quantitation, or AFLP profile generation. Ultimately, a Study contains a common group of sample results that are analyzed and exported together.

This chapter provides an overview of the Fragment Analysis module, including its menu options, toolbars, and dialog boxes. It shows how to use this module to work with Studies, to run a fragment analysis, to set up parameters, to use result properties, and to display options. It also describes how to work with, report, and export fragment analysis functions.

### 6.1 Fragment Analysis Module Overview

The Fragment Analysis module processes fragment data from the CE system platform and provides size and allele information for detected peaks. The system organizes parameters that identify alleles as locus tags that you can customize. You can then view, export, and print the analysis results.

Analysis parameter sets provide parameters specific to an experiment, allowing size calibration and locus tag assignment as necessary, when processing data.

Data analysis can be a manual function or set to run automatically. Edit and re-analysis functions provide the capability to verify the accuracy of the data.

Graphically view, analyze, edit, compare, and print data of the following drop-down listing types:

- Raw Data*
- Fragment Data
- Fragment Lists
- Information about locus tags and assigned alleles

Also available are Current Data* and Voltage Data*.

* These types of data cannot be edited.
Main Window

The following illustration identifies the areas on the Fragment Analysis module's main window that are described in Table 6.1.

Figure 6.1 Main Window, Fragment Analysis Module

The following table describes the items called out in Figure 6.1.

Table 6.1 Main Window, Fragment Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Title Bar - Shows the module name (Fragment Analysis) and the name of the currently open Study.</td>
</tr>
<tr>
<td>B</td>
<td>Menu Bar - See &quot;Menu Bar Options&quot; on page 191.</td>
</tr>
<tr>
<td>C</td>
<td>Display Area - Graphically displays the opened data.</td>
</tr>
<tr>
<td>D</td>
<td>Toolbar - See &quot;Toolbar Icons&quot; on page 196.</td>
</tr>
<tr>
<td>E</td>
<td>Dye Colors - Double-clicking on a dye color opens the Color dialog box. Change the dye color displayed for that particular dye. Clicking on the dye name (D1, D2, D3, D4) removes that dye trace from all traces.</td>
</tr>
<tr>
<td>F</td>
<td>Study Explorer - Displays and provides access to all of the parameters available in the selected Study. These are divided into the tabbed sections: Analyses, Data, and Reports, which you can select at the bottom of the Study Explorer frame.</td>
</tr>
<tr>
<td>G</td>
<td>Status Bar - Displays information concerning the current selection.</td>
</tr>
</tbody>
</table>
Menu Bar Options

The following example shows the Fragment Analysis module's menu bar options.

Menu Bar Options

The following topics describe each of these menus and their options.

File Menu

Click the File menu to display its drop-down menu, as shown in the following example.

Use the File menu to create, open, manage, and save Studies, or export, edit, and transfer Fragment results. The following table describes the Fragment Analysis module's File menu options.

Table 6.2 File Menu, Fragment Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Study</td>
<td>Starts a new Study from either raw data or analyzed results.</td>
</tr>
<tr>
<td>Open Study</td>
<td>Opens an existing Study.</td>
</tr>
<tr>
<td>Close Study</td>
<td>Closes the active Study.</td>
</tr>
<tr>
<td>Manage Studies</td>
<td>View and select all Studies saved to the database.</td>
</tr>
<tr>
<td>Save Study</td>
<td>Saves the new or edited Study.</td>
</tr>
<tr>
<td>Save Study As</td>
<td>Saves the current Study with a new name.</td>
</tr>
<tr>
<td>Add Raw Data to Study</td>
<td>Select additional data (raw data) to add to the Study.</td>
</tr>
<tr>
<td>Add Result Data to Study</td>
<td>Select additional data (previously analyzed result data) to add to the Study.</td>
</tr>
</tbody>
</table>
### Table 6.2 File Menu, Fragment Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Results</td>
<td>Export data in one of the following formats:</td>
</tr>
<tr>
<td></td>
<td>- Text (Tab Delimited) (*.txt)</td>
</tr>
<tr>
<td></td>
<td>- CEQ format (*.cq)</td>
</tr>
<tr>
<td></td>
<td>- CRV (*.CRV)</td>
</tr>
<tr>
<td>Export Fragments / Genotypes</td>
<td>Export the fragment / genotype data in one of the following formats:</td>
</tr>
<tr>
<td></td>
<td>- CSV (Comma Delimited) (*.csv)</td>
</tr>
<tr>
<td></td>
<td>- Linkage (Pedin) (*.pre)</td>
</tr>
<tr>
<td></td>
<td>- Discovery Manager (DMPopulation) (*.txt)</td>
</tr>
<tr>
<td></td>
<td>- Genotype Summary Report (Tab Delimited) (*.gsr)</td>
</tr>
<tr>
<td>Transfer Fragments for GeXP</td>
<td>Export fragment data in a *.csv file compatible with the GeXP Data Tool.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Set the following preferences:</td>
</tr>
<tr>
<td></td>
<td>- Select whether to display the Study window when the Fragment Analysis</td>
</tr>
<tr>
<td></td>
<td>module is launched.</td>
</tr>
<tr>
<td></td>
<td>- Specify whether to graph all electropherograms by size or time.</td>
</tr>
<tr>
<td></td>
<td>- Set the number of egrams to be cached.</td>
</tr>
<tr>
<td></td>
<td>- Select the initial view when selecting the Single Result View of a sample.</td>
</tr>
<tr>
<td></td>
<td>- Specify whether to display a warning message before resetting all manually</td>
</tr>
<tr>
<td></td>
<td>included or excluded bins during an AFLP analysis.</td>
</tr>
<tr>
<td></td>
<td>- Specify whether to display a warning message before reanalysis if old</td>
</tr>
<tr>
<td></td>
<td>results in the study will be replaced by new results.</td>
</tr>
<tr>
<td>Print Screen</td>
<td>Send an image of the computer desktop, application window, or main window to</td>
</tr>
<tr>
<td></td>
<td>the printer.</td>
</tr>
<tr>
<td>Recent Studies</td>
<td>Lists the most recently opened Studies.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Fragment Analysis module.</td>
</tr>
</tbody>
</table>

### View Menu

Click the **View** menu to display its drop-down menu, as shown in the following example.

![View Menu Example](image)

**NOTE** A " ✓ " next to an option indicates that the option is enabled.
The following table describes the Fragment Analysis module's View menu options.

**Table 6.3 View Menu, Fragment Analysis Module**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fragment List</td>
<td>Displays the Fragment List. The Fragment List contains information for all analyzed fragments included in the Study, such as size, height, area, locus, and allele ID.</td>
</tr>
<tr>
<td>Results Set</td>
<td>Displays the Results Set View. The Result Set contains information for all of the analyzed samples included in the Study.</td>
</tr>
<tr>
<td>Locus List Editor</td>
<td>Opens a dialog box that create the LocusList.txt file used for the Genotype Summary View (GSV).</td>
</tr>
<tr>
<td>Genotype Summary</td>
<td>Displays a Study’s genotype information (loci and alleles).</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Toggles between displaying or not displaying the Status Bar.</td>
</tr>
<tr>
<td>Study Explorer</td>
<td>Displays the Study Explorer. The Study Explorer provides access to all of the parameters available in the selected Study.</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Select which toolbars to display. See &quot;Toolbar Icons&quot; on page 196.</td>
</tr>
</tbody>
</table>

**Results Menu**

Click the Results menu to display its drop-down menu, as shown in the following example.

![Results Menu Example]

**NOTE** This menu is available only when displaying the Result Set View.

The following table describes the Fragment Analysis module's Results menu options.

**Table 6.4 Results Menu, Fragment Analysis Module**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Excluded</td>
<td>Shows fragment results that were excluded from the Fragment Results Grid.</td>
</tr>
<tr>
<td>Show Capillary Summary</td>
<td>Displays a table that identifies the number of samples that are included and excluded in the Result Set within each capillary.</td>
</tr>
</tbody>
</table>

**Fragments Menu**

Click the Fragments menu to display its drop-down menu, as shown in the following example.

![Fragments Menu Example]
The following table describes the Fragment Analysis module’s Fragments menu options.

**Table 6.5 Fragments Menu, Fragment Analysis Module**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Excluded</td>
<td>Shows fragments that were excluded from the Fragment List.</td>
</tr>
<tr>
<td>Manually Add Peaks</td>
<td>Provides an option to manually select peaks to be included in the fragment list.</td>
</tr>
<tr>
<td>Save Fragment Grid As CSV</td>
<td>Save the Fragment Grid as a comma delimited file (*.csv)</td>
</tr>
</tbody>
</table>

**Analysis Menu**

Click the Analysis menu to display its drop-down menu, as shown in the following example.

![Analysis Menu Example]

The following table describes the Fragment Analysis module’s Analysis menu options.

**Table 6.6 Analysis Menu, Fragment Analysis Module**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Parameters</td>
<td>• View the current working analysis parameters.</td>
</tr>
<tr>
<td></td>
<td>• Edit the working analysis parameters (maintained in memory for the duration of the application session).</td>
</tr>
<tr>
<td></td>
<td>• Select a previously saved parameter set to be used in the analysis.</td>
</tr>
<tr>
<td>New AFLP Analysis</td>
<td>Starts a new AFLP Analysis. See &quot;Performing AFLP Analysis&quot; on page 248.</td>
</tr>
<tr>
<td>New Binning Analysis</td>
<td>Starts a new Binning Analysis. See &quot;Performing Bin Analysis&quot; on page 239.</td>
</tr>
<tr>
<td>New Peak Ratio Analysis</td>
<td>Starts a new Peak Ratio Analysis. See &quot;Calculating Peak Ratios&quot; on page 245.</td>
</tr>
<tr>
<td>Run LOH Analysis</td>
<td>Runs a Loss of Heterozygosity Analysis. See &quot;Performing LOH Analysis&quot; on page 252.</td>
</tr>
</tbody>
</table>

**Reports Menu**

Click the Reports menu to display its drop-down menu, as shown in the following example.

![Reports Menu Example]
The following table describes the Fragment Analysis module's **Reports** menu options.

**Table 6.7 Reports Menu, Fragment Analysis Module**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Report</td>
<td>Select a template and context type for the report.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the display of the selected report.</td>
</tr>
</tbody>
</table>

**Window Menu**

Click the **Window** menu to display its drop-down menu, as shown in the following example.

<table>
<thead>
<tr>
<th>Window Menu Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Cascades the open windows.</td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td>Tiles the windows in a horizontal orientation.</td>
</tr>
<tr>
<td>Tile Vertically</td>
<td>Tiles the windows in a vertical orientation.</td>
</tr>
<tr>
<td>Close All</td>
<td>Closes all currently active windows.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Automatically arranges the icons.</td>
</tr>
<tr>
<td>1</td>
<td>Brings the selected window (#1) to the foreground.</td>
</tr>
</tbody>
</table>

**Help Menu**

Click the **Help** menu to display its drop-down menu, as shown in the following example.
The following table describes the **Help** menu options.

### Table 6.9 Help Menu, Fragment Analysis Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Select this option to display the CE system online help. By default, the help system displays the Contents in the navigation pane, located on the left, and the introductory topic in the topic pane, located on the right. You can use the Contents to select and print specific help topics. The navigation pane also provides a Search tab and an Index tab. These tabs let you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td>Using Help</td>
<td>Select this option to display the Contents window on how to use the Windows Help system.</td>
</tr>
<tr>
<td>About GenomeLab System</td>
<td>Select this option to access software, instrument, and system information.</td>
</tr>
<tr>
<td>Beckman Coulter Home Page</td>
<td>Select this option to access the Beckman Coulter Home Page on the Internet.</td>
</tr>
</tbody>
</table>

### Toolbar Icons

The Fragment Analysis module provides three toolbars that activate some of the most commonly used commands. **Figures 6.2** identifies these toolbars.

#### Study Toolbar

![Study Toolbar Icons](image)

#### Dye Colors Toolbar

![Dye Colors Toolbar Icons](image)

#### View Toolbar

![View Toolbar Icons](image)

#### EgramBand Toolbar

![EgramBand Toolbar Icons](image)

### Figure 6.2 Toolbars, Fragment Analysis Module

The following table describes these toolbar icons.

### Table 6.10 Toolbar Icons, Fragment Analysis Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>New - Create a new Study from either raw data or result data.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Open - Open an existing or recent Study.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Save - Saves the new or edited Study.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Study Explorer - Displays the Study Explorer.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Fragment List - Opens the Fragment List.</td>
</tr>
</tbody>
</table>
**Table 6.10 Toolbar Icons, Fragment Analysis Module**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Result Set Icon" /></td>
<td>Result Set - Opens the Result Set View.</td>
</tr>
<tr>
<td><strong>D1</strong> (red)</td>
<td>Red is the default color assigned to Dye #1 in the fragment data pane and <strong>D1</strong> is the default name.</td>
</tr>
<tr>
<td><strong>D2</strong> (black)</td>
<td>Black is the default color assigned to Dye #2 in the fragment data pane and <strong>D2</strong> is the default name.</td>
</tr>
<tr>
<td><strong>D3</strong> (green)</td>
<td>Green is the default color assigned to Dye #3 in the fragment data pane and <strong>D3</strong> is the default name.</td>
</tr>
<tr>
<td><strong>D4</strong> (blue)</td>
<td>Blue is the default color assigned to Dye #4 in the fragment data pane and <strong>D4</strong> is the default name.</td>
</tr>
</tbody>
</table>

**Table 6.11 EgramBand Toolbar**

**IMPORTANT** Portions of this toolbar are only available when viewing Sample Results in Single Result, Stacked Graph, and Overlay Graph View modes. Displaying the selected sample results in one of these modes will automatically display the appropriate EgramBand components for the selected display mode.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Y Height Icon" /></td>
<td>EgramBand Y Axis - Scale the Y axis.</td>
</tr>
<tr>
<td><img src="image.png" alt="X Width Icon" /></td>
<td>EgramBand X Axis - Scale the X axis.</td>
</tr>
<tr>
<td><img src="image.png" alt="Zoom Icon" /></td>
<td>EgramBand Zoom tool - Allows you to zoom in on a selected area of the Overlay Graph electropherogram display. This option is the default selection when in Overlay Graph mode.</td>
</tr>
<tr>
<td><img src="image.png" alt="Subset Icon" /></td>
<td>EgramBand Subset Selection tool - Allows you to select a subset of data to be displayed in Stacked Graph mode. This option is only available when in Overlay Graph mode.</td>
</tr>
</tbody>
</table>
6.2 Fragment Analysis Procedures

To open the Fragment Analysis module from the Main Menu, click the Fragment Analysis icon.

Figure 6.3 Fragment Analysis: New Study Window

Performance Safeguards

Controller Resources

The system checks the available controller resources before it starts processing results. If the system determines that the resources needed to complete the analysis are not available, it displays a warning message (see Figure 6.5). If this occurs, close all applications, re-start the Fragment Analysis module, and attempt the analysis again.

Figure 6.4 Controller Resources Warning
Database Size Warning

If a database is selected that is greater than 1700 megabytes, the following warning message will appear, if you try to perform additional data analysis steps:

![Database Size Warning](image)

Figure 6.5 Database Size Warning

6.3 Working with Studies in the Fragment Analysis Module

A Study is a set of multiple sample results together with the results of analyses performed on the group of sample results. You can use the Study Wizard to create a new Study easily. The Study Wizard guides you through the process of creating a new Study starting from either raw data or previously analyzed fragment results.

The Study window opens automatically when you start the Fragment Analysis module. You can open a new or existing Study immediately from this window or at any time while working within the Fragment Analysis module.
To access the Study window, select **File | New Study** or **File | Open Study**.

![Image of Study Window](image)

**Figure 6.6 Study Window - Creating or Opening a Study**

You can create a new Study from either **Raw Data** or previously **Analyzed Results**. Make your selection using one of the option buttons and click **OK** to continue.

The Study Wizard guides you through the steps of creating a Study. After the system analyzes the samples, you may include additional results in the new Study.

To open an existing Study, select it from the list of Study names available under either the **Existing Studies** tab or the **Recent Studies** tab. The **Date-Time** column indicates when the Study was created or last modified. When you have made your selection, click **OK** to open the existing Study.

**Selecting the Components of the New Study**

The first step in creating a new Study involves manually filtering data from the database by selecting the samples you would like to include in your Study. (This is first-level filtering.)

After the system analyzes these samples, you may further filter the sample results (second-level filtering) in the Result Set View.
Finally, you may filter the generated fragment and allele data (third-level filtering) in the Fragment List. This leaves a collection of identified fragments and alleles that exactly match the requirements of your Study.

**Selecting Raw Data for the New Study**

When you select the Raw Data option and click OK, the Study Wizard opens, displaying the Select Raw Data window.

![Select Raw Data Window](image_url)

**Figure 6.7 Select Raw Data Window - Selecting the Components of the New Study**

Use this window to select the raw data to be analyzed from a database of samples that have been run in a particular projects. The system includes the selected raw data in your Study and analyzes it as described in the following steps.

**NOTE** To view an individual sample electropherogram and other collected parameters prior to adding the sample to your Study, right-click on a highlighted sample and select Show Single Sample View.

The List View and Plate View tabs provide you with two ways to select raw data. Each selection method provides the same sample information presented in different ways.

**Selecting Raw Data from the List View Tab**

The List View tab allows you to select from a list of samples contained in a specific database and/or collected during a particular time frame.

1. Select the List View tab in the Select Raw Data window.
2. Select the project folder that contains the sample data that you wish to include in the Study from the Project drop-down list.

**NOTE** If the desired project is not listed, it may be located in a different database. To enter a different database, you must close all applications and set the working database. See "Setting the Working Database" on page 324 or "Set Working Database" in the online help for more information.
3. Filter data: If the data of interest was run during a particular time period, you can filter the data by selecting the Filter by date check box (☑) and choosing a range of dates to be searched. When enabled, the system displays only those samples that were run during the specified time period.

4. Select samples from the Raw Data / Available area:
   - To select the samples to be included in your Study, click to highlight the sample, then click the right-arrow button to move the selection to the Raw Data / Selected area.
   - To select all of the displayed samples to be included in your Study, click the double-right-arrow button to move them to the Raw Data / Selected area.
   - To remove samples from your Study, click to highlight the samples in the Raw Data / Selected area and click either of the left-arrow buttons to remove them from your selected samples.

**NOTE** You may select data from multiple projects to be included in your Study as long as they are located in the same database. Multiple results from multiple databases may not be combined into the same Study. Continue making selections from the list of available projects and data until all of the desired samples have been added to the Raw Data / Selected area.

5. Click **Next** to proceed to the Analysis Parameters window.

**Selecting Raw Data from the Plate View Tab**

The Plate View tab allows you to make your selections from a visual representation of the sample plate.

1. Select the **Plate View** tab in the Select Raw Data window.

![Figure 6.8 Selecting Raw Data from the Plate View Tab](image)
2. Select the project folder that contains the sample data that you want to include in the Study from the **Project** drop-down list.

**NOTE** If the desired project is not listed, it may be located in a different database. To enter a different database, you must close all applications and set the working database. See "Setting the Working Database" on page 324 or "Set Working Database" in the online help for more information.

3. Select the plate from the **Plates** drop-down list. A visual representation of the plate appears in the Current Plate area of the window.

- To select the samples for your Study, click on the well location of the sample of interest. The sample ID moves to the Current Plate / Selected Wells area of the window, indicating that the sample will be included in the Study.

**NOTE** See the Raw Data Legend area of the window for information regarding sample well selection.

- To remove samples from your Study, click on the well location of the sample you would like to remove. The sample ID moves to the Current Plate / Selected Wells area of the window, indicating that the sample has been removed from the Study.

- To select or remove entire rows or columns of wells, click on the corresponding row letters or column numbers.

- To select the entire plate to be included in your Study, click on the red box in the upper-left corner of the plate.

**NOTE** You may select Study data from multiple projects and/or multiple plates. Continue making selections from the list of available projects and plates to add all of the desired samples to the Raw Data / Selected area.

4. Click **Next** to proceed to the Analysis Parameters window.

**Selecting an Analysis Parameter Set**

The second step in creating a new Study from raw data involves defining the parameters to use when analyzing selected samples. Analysis parameters are used to process the fragment data to estimated fragment sizes and to identify alleles.
Use the Analysis Parameters window to create, select, or edit the analysis parameter set for analyzing the data selected for the new Study. Your choice of a particular set of analysis parameters depends on the particular fragments you are attempting to identify.

The CE system software has a set of default analysis parameters, used to estimate unknown fragment lengths. The calibration curve is based on the migration times of the size standard fragments. The default set of analysis parameters cannot be edited.

The default parameters are as follows:

- **DEFAULT FRAGMENT ANALYSIS PARAMETERS**: Used for applications such as STR, AFLP, etc.
- **DEFAULT GeXP ANALYSIS PARAMETERS**: Used for the Gene Expression application
- **DEFAULT SNP ANALYSIS PARAMETERS**: Used for the SNP application

### Selecting a Saved Analysis Parameter Set

In the Select Analysis Parameter Set area of the window, select the parameter set from the drop-down list.

The Parameter Set Summary area of the window displays summary information about the selected analysis parameter set. These include:

- Date and time the analysis parameter set was created or last modified.
- Selected size calibration standard, calibration curve, and optional dye mobility correction.
- Currently assigned locus tags that have been selected for this Study.

Click **Next** to proceed to the Analyze Data window.

**NOTE** If the available parameter sets do not apply to your Study, you can create a new set of analysis parameters or edit an existing set to meet the requirements of your Study. Refer to "Defining Fragment Analysis Parameters" on page 206 or the online help for more information.

### Analyzing the Data

With the new data selected and the analysis method defined, the third step in creating the Study is to analyze the data.

The Analyze Data window displays all samples selected for analysis, the date each was collected, the status (unanalyzed) of each sample, and the parameter set being applied to the Study (see Figures 6.10).

- To begin the analysis, click **Analyze**. As the system proceeds with the analysis, the progress bar becomes active and the lower dialog box displays the analysis log for each sample as it is analyzed.
To stop the analysis while it is in progress, click **Stop**. The system stops the analysis when it has finished with the sample in progress.

When the analysis is complete, the status column indicates if the analysis succeeded or failed for each sample included in the Study.

To review the analysis log, highlight a sample in the upper samples list and scroll through the analysis information in the lower analysis log area of the window.

Click **Next** to proceed to the Select Result Data window.

**Selecting Additional Results to add to the Study**

Add result data to your new Study, in this fourth step. Additional result data may include samples that were previously analyzed under a different set of analysis parameters than those analyzed in the preceding steps of the Study currently being developed.

The Select Result Data window is identical to the Select Raw Data window displayed in the first step of the Study Wizard.

**NOTE** Refer to the "Selecting Raw Data for the New Study" on page 201 for an explanation of the features available in the Select Result Data window.

Select any additional results that you would like to add to the new Study and click **Finish** to complete the Study.

To save your new Study, select **File | Save** or **File | Save As**.
6.4 **Defining Fragment Analysis Parameters**

The following sections describe how to edit a parameter set or create an entirely new set of analysis parameters to meet the specific requirements for your samples.

You can create or edit parameter sets using the Fragment Analysis Parameters window. This window contains a number of tabs in which you define the general parameter set information, set locus tag parameters, select an analysis method, assign quantitation values, and define several other factors that affect how your data is analyzed.

You can access the Fragment Analysis Parameters window either while developing a Study from within the Study Wizard (see "Selecting Raw Data for the New Study" on page 201). You can also access it at any time while working within the Fragment Analysis module by selecting **Analysis | Analysis Parameters**.

Using either method, the Analysis Parameters window opens, showing the currently saved parameter sets available for selection.

- To create a new parameter set, click **New**.
- To edit an existing parameter set, click **Edit**.

The following illustration shows the Edit Fragment Analysis Parameters window.

![Edit Fragment Analysis Parameters Window - Creating or Editing a Parameter Set](image)

**Figure 6.11 Edit Fragment Analysis Parameters Window - Creating or Editing a Parameter Set**
General Tab
The General tab is the first tab displayed when you first open the Fragment Analysis Parameters window. This tab contains general parameter set information and peak identification properties.

Parameter Set Information
Parameter Set information depends on whether you are creating a new parameter set or editing an existing parameter set:

- If you are creating a new parameter set, enter a descriptive name in the **Parameter Set Name** field and select the project where you want to save the parameter set.
- If you are editing an existing parameter set, you may choose to save the edited parameters under a different name. To do this, click **Save As** and enter the new name in the **Parameter Set Name** field. You may also choose to save the edited parameters under the original name. The default set of fragment analysis parameters cannot be edited.

The General tab's Parameter Set area shows the date and time the parameter set was created and modified.

Peak Criteria
You can edit the following Peak Criteria fields:

- **Slope threshold**: Specify the minimum rate of the signal increase on the leading edge of peaks in order for a peak (standard or unknown) to be detected.
  - Enter a value between 1 - 1000. The default value is 10.
  - The slope is proportional to the height of the peak and depends on the width of the peak. You can set this parameter to detect peaks of interest while eliminating smaller or broader peaks that may not be of interest.
  - The slope threshold is set relative to the baseline noise, as the baseline noise varies for each dye trace. Although you can define only one slope threshold value, the system adjusts for each dye, depending on the noise detected for that dye trace.

- **Relative peak height threshold (%)**: Set a minimum height criterion that unknown peaks must meet before being displayed in the fragment list or annotated in an electropherogram.
  - Enter a value between 0 - 100%. The default value is 1%.
  - The unknown peaks above this set value (%) relative to the second highest peak in each dye trace will be displayed in the fragment list and the sizes will be displayed in the electropherogram.
  - This value does not apply to standards.
  - To size the peaks only, clear the **Allele Identification** check boxes.

Allele Identification
The **Allele Identification** check boxes let you add either of the following parameters:

- **Identify STR Alleles**: Select this option (✔️) to include allele identification as specified in the allele lists of the selected Short Tandem Repeat (STR) locus tags.
Fragment Analysis Module
Defining Fragment Analysis Parameters

- **SNP Analysis**: Select this option () to include Single Nucleotide Polymorphism (SNP) analysis in the parameter set.

  **NOTE** You may include only one of these options in the same analysis.

**Size Estimation and Allele ID Confidence**

**Confidence level**: Set this level as required for your analysis. The confidence level (default value 95%) is equal to one minus the significance level of the built-in statistical tests used for allele identification and for computing apparent fragment size confidence intervals.

**Analysis Method Tab**
Set the size standard and model. The model selected should be the best fit for the size standard selected, as it is used to generate the size calibration model, which estimates sizes for the unknown fragments.

![Fragment Analysis Parameters Window - Analysis Method Tab](image)

**Figure 6.12 Fragment Analysis Parameters Window - Analysis Method Tab**

Size standards are sets of DNA fragments of known sizes, run with a sample and used to create the size calibration model. The system uses this model to relate the known fragment size to either migration time or mobility for estimating the size of the unknown fragments.

**NOTE** Refer to online help for information on creating size standards.
Setting Size Standards
To ensure the system finds the standards and makes correct associations between the fragment peaks and the fragment list, size standards must meet the following two requirements:

- Fragments in the larger half of the size range should be spaced uniformly. For example, the peaks in the range of 200 to 400 nucleotides of the `SizeStandard-400` are 20 nucleotides apart.

- Fragments in the smaller half of the size range should include a set of at least three fragments that are spaced approximately half the distance of those that are in the larger fragment size range. For example, in the `SizeStandard-400`, the peaks in the larger half of the size range are spaced 20 nucleotides apart, while some in the smaller half of the size range are spaced 10 nucleotides apart.

**NOTE** Custom Size Standards can be created and defined in the Data Manager module. See "Creating New Size Standards" on page 328.

Setting the Analysis Method
To set the analysis method:

1. Select the standard to run with the sample from the `Size Standard` drop-down list. The size standards available are: `SizeStandard-400`, `SizeStandard-600`, and `SizeStandard-80`. Your selection determines which size standards become available for selection in the Selected Peaks list to the right.

2. Select the peaks you want to use in the Selected Peaks list:
   - To use all fragments in the selected standard, click **Select All**.
   - To select individual fragments in the selected standard, select the check box next to each of the fragment sizes you want to run with the sample.
   - If you do not want to use any of the standard sizes, click **Deselect All**.

**NOTE** If you do not use a size standard when analyzing the data, the unknown fragments will not be sized.

3. Note the parameters provided in the following fields for the selected size standard:
   - **Dye**: displays the dye label on the size standard fragments.
   - **Size Standard Fit Coefficient**: displays the standard deviation of the differences between the actual fragment sizes and the apparent sizes of the standard fragments determined from a large number of repeated runs. This parameter is sometimes called the “lack-of-fit”.

4. Select the empirical model you want to use for generating the curve that best fits the identified standard fragments from the `Model` drop-down list.

**NOTE** The relationship between fragment size and mobility (or migration time) in the CE system with replaceable gels is non-linear, and is not described with sufficient accuracy with any theoretical model to yield reliable fragment size estimates. However, polynomials of varying degrees serve as practical empirical models that will accurately account for this non-linearity.

Based on the selected standard, you can use one of these following models:

- **Linear Fit** is a straight line model, which is useful only for a set of size standards spanning a very small range.
- **Quadratic Fit** adequately accounts for the non-linear dependence of mobility on size under some conditions, but usually over relatively short size ranges that are well separated from the size limits of the separation system.

- **Cubic Curve** generally represents the curvature in a time or mobility versus size plot well enough that errors in estimated sizes are dominated by other factors, such as effects of primary structure on mobility. This is usually the best choice for routine use with the **SizeStandard-400** set.

- **Quartic Curve** is a fourth degree polynomial that provides more accurate size estimates than a cubic curve when used for calibrations that span a long size-range or extend into size areas where the size selectivity of the separation system is very non-linear. This is usually the best choice for routine use with the **SizeStandard-600** set.

- **Local Southern** method estimates the size of a sample fragment from its mobility and that of the four standard fragments closest in size. If you select this method, the X Variable options are grayed-out and mobility is automatically selected.

5. Set the **Migration Variable** fields to either migration time or mobility as the independent variable for the Model. Size is the dependent variable.

- **Migration time**: Select this option to use the average migration times and sizes of the standard fragments to construct a size calibration.

- **Mobility**: Select this option to use fragment velocity (cm/s) divided by the separation potential (V/cm) with the sizes of the standard fragments to construct a size calibration.
Quantitation Tab

The Quantitation tab allows you to set the parameters for calculating the quantity of all peaks by comparing their heights or areas to a single peak of the same color whose quantity is known.

![Image of Fragment Analysis Parameters Window - Quantitation Tab]

Once you have entered the information for the known peak into this window, the system looks for the reference peak in each trace using the specified size or time. Based on this information, the system can then calculate the quantity of each of the remaining peaks in the sample.

ID Standard

In the ID Standard area of the window, select one of the following options as the method the system uses to identify your reference peak:

- **Size**: Select this option to identify your reference peak based on the fragment size specified in the Size field listed for each of the four dyes.
- **Time**: Select this option to identify your reference peak based on the migration time specified in the Time field listed for each of the four dyes.

Calculate Using

In the Calculate Using area of the window, select the method the system uses to calculate the quantity of your reference peak:
Fragment Analysis Module

Defining Fragment Analysis Parameters

- **Height**: Select this option to calculate the quantity of your reference peak based on its peak height.
- **Area**: Select this option to calculate the quantity of your reference peak based on its peak area.

**Quantitation Values**

Set the parameters for each dye. Enter values for each dye selection:

- **Size/Time**: These fields depend on the selected ID Standard:
  - If you selected **Size** as the ID Standard, the first field next to the dye requires you to enter the size of the reference peak (nucleotides) for that dye.
  - If you have selected **Time** as the ID Standard, the first field next to the dye requires you to enter the migration time of the reference peak (minutes) for that dye.

- **+/- Window**: Enter a variable quantity to consider when identifying the reference peak. For example, if you listed the size of your reference peak as 90 nucleotides, you may enter a value of ‘1’ in the +/- Window field. This value should compensate for any variability that might arise in identification of the reference peak.

**NOTE** The values entered in these fields are based on the ID Standard used, either +/- nucleotides (for Size) or +/- minutes (for Time).

- **Amount**: Enter the known quantity of your reference peak.
- **E**: Enter this value as the exponential notation.
- **Units**: Select the units for the quantity entered into the Amount field. Values may be any of the following:
  - Moles (mol)
  - Grams (g)
  - Molarity (M)
  - (g/L)

**STR Locus Tags Tab**

The STR Locus Tags tab allows you to select the Short Tandem Repeat (STR) locus tags used for allele identification with the current parameter.

**NOTE** Although the STR Locus Tags tab is similar in appearance and functionality to the SNP Locus Tags tab, the two types of Locus Tags are used for different purposes. STR Locus Tags use size to define allele fragments having a single specified dye label in a specified size range. SNP Locus Tags use multiple dye labels for fragments of a single specified size to define specific SNP variants.

The system uses locus tags to define a particular locus of interest. Each available locus tag is configured with a specific set of parameters that define the manner in which the system identifies detected fragments as allele fragments. These parameters include the fragment size range, repeat unit length, the dye used, and an allele list associated with the locus tag.

When you select a locus tag and perform an analysis, the system identifies the alleles present within the locus region using the estimated size of the fragments and the allele list.

**NOTE** The system estimates sizes only if you specified a size standard (see "Analysis Method Tab" on page 208) and calls alleles only if an allele list exists for the selected locus tag (see "Locus Tab" on page 218).
You can choose STR locus tags from a list of available STR locus tags previously configured for analysis. This tab also gives you access to the STR Locus Tag Editor, where you can edit existing or create new STR locus tags to meet the specific requirements of your samples.

![Fragment Analysis Parameters Window - Selecting STR Locus Tags](image)

**Figure 6.14 Fragment Analysis Parameters Window - Selecting STR Locus Tags**

**Selecting Locus Tags**

Select one or more locus tags you want included in your parameter set:

- To select an individual locus, select it in the Available list, then click the right-arrow (>) to move the selection to the Selected list.
- To select all available locus tags, click the double-right-arrow (>>) to move the selections to the Selected list.
- To remove locus tags from your parameter set, select the locus tag in the Selected list and click either of the left-arrow buttons to remove them from your parameter set.
- To edit a locus tag, highlight the selection and click **Edit Locus** to display the STR Locus Tag Editor window.
- To create a new locus tag, click **New Locus** to display the STR Locus Tag Editor window.

**NOTE** See "Using the STR Locus Tag Editor" on page 218 for information about creating or editing locus tags.
**SNP Locus Tags Tab**

The SNP Locus Tags tab allows you to select the locus tags used for SNP analysis with the current parameter set.

Use SNP locus tags to detect the presence of specific Single Nucleotide Polymorphisms (SNPs) in the group of sample data selected for the Study. SNP locus tags are much the same in many respects as STR locus tags. Each SNP locus tag is configured with a specific set of parameters that tell the system what fragment size to “look for” and to assign an allele name based on the color (dye label) of the identified fragment.

The results produced from a SNP analysis looks the same as those produced by an STR analysis. Fragments identified as alleles of a locus are labeled as such in the fragment list. No more than one fragment labeled with a given dye can belong to the same locus (up to four peaks can be labeled as alleles of the same locus, but each must be labeled with a different dye).

You can choose SNP locus tags from a list of available SNP locus tags previously configured for analysis. This tab also gives you access to the SNP Locus Tag Editor, where you can edit existing or create new SNP locus tags to meet the specific requirements of your sample.
Selecting Locus Tags

Select one or more locus tags you want included in your parameter set:

- To select an individual locus, select it in the Available list, then click the right-arrow (>) to move the selection to the Selected list.
- To select all available locus tags, click the double-right-arrow (>>) to move all of them to the Selected list.
- To remove locus tags from your parameter set, select each locus tag in the Selected list and click either of the left-arrow buttons to remove them from your parameter set.
- To edit a locus tag, select it and click Edit Locus to display the SNP Locus Tag Editor window.
- To create a new locus tag, click New Locus to display the SNP Locus Tag Editor window.

**NOTE** See "Using the SNP Locus Tag Editor" on page 225 for information about creating or editing locus tags.

Running a SNP Analysis

The following list identifies the three tasks you must complete before running an SNP analysis.

1. Select the SNP Locus Tags as part of the analysis in the SNP Locus Tags tab of the Analysis Parameters window (see "SNP Locus Tags Tab" on page 214).
2. Select SNP Analysis in the General tab of the Analysis Parameters window (see "General Tab" on page 207).
3. Select an appropriate SNP Size Standard (Size Standard-80) in the Analysis Method tab of the Analysis Parameters window (see "Analysis Method Tab" on page 208).
   - A size standard with exactly two fragments must be selected for SNP analysis to succeed.
   - The size standards must bracket all expected SNP fragments.
     - Both of these fragments must be selected.
     - The only valid model for a two-fragment standard is the Linear model.

These three requirements enable you to successfully run the SNP analysis, even if you do not select the mobility calibration, but the values obtained might vary slightly.

If you want to correct for the mobility differences between the reference fragments and each of the four possible dye-labeled SNP fragments, use the Advanced tab of the Analysis Parameters window to select the SNP Dye Mobility Calibration (see "Advanced Tab" on page 216).

**NOTE** The SNP Ver. 1 Dye Mobility Calibration is for use with the GenomeLab SNP Primer Extension Kit and the SNP Ver. 2 calibration is for use with the GenomeLab SNPStart Primer Extension Kit.
Advanced Tab

Set additional fragment analysis parameters. From this window, you can assign dye mobility correction values to compensate for the varying effects of different dyes on fragment mobility, select a standard mobility reference, and indicate whether to use the dye spectra from sample data or from saved system spectra.

**Figure 6.16  Fragment Analysis Parameters Window - Advanced Tab**

**Mobility**

Set up the mobility parameters for the current analysis.

- **Dye Mobility Calibration** specifies the calibration from the options available in the list. Based on your selection, this option adjusts migration times or mobility to compensate for the varying effects of different dyes on fragment mobility. To choose a value, select any of the following options from the drop-down list:
  - **PA ver.1**: Select this option when analyzing samples made from primers labeled with the phosphoramidite dyes (D2-PA, D3-PA, or D4-PA).
  - **AE ver.2**: Select this option to improve calibration and size estimates for primers labeled with the active ester dyes (D1, D2, D3, or D4).
  - **AE ver.1**: Select this option for the Fragment Analysis test sample.
  - **SNP ver 1**: Select this option when performing an SNP analysis using the GenomeLab SNP Primer Extension. The SNP analysis can proceed if you do not select this mobility correction, but the values obtained may vary slightly.
  - **SNP ver 2**: Select this option when performing a SNP analysis using the GenomeLab SNPStart Primer Extension Kit.
• **No Correction:** Keep this default value when you do not want the system to make any compensation for dye effects on fragment mobility.

**NOTE** When performing a Fragment Analysis Test Sample, you must use the **AE ver.1** dye mobility calibration for correct sizing of the fragments.

**Dye Spectra**

Dye Spectra values are calculations of the relative emission intensities of each dye in each of the four detection channels. The system calculates these values during each analysis and uses them to transform the four electropherogram channels to dye signal traces for each of the dye labels present in the sample.

When unable to calculate a dye spectrum from the sample, the analysis process terminates unless system dye spectra are available.

The Dye Spectra options allow you to select an existing set of dye spectra to use instead of estimating the dye spectra from each sample.

**NOTE** This option can shorten the analysis time by up to 50%.

The system stores only one set of system spectra, used automatically when the system cannot estimate one or more of the needed spectra from the sample data.

Select one of these Dye Spectra options:

- **Use calculated dye spectra:** This default setting specifies using the set of dye spectra obtained from the sample data.

- **Use system dye spectra:** When you select this option, you must also select each Dye check box for the dye traces you want generated. This setting applies the system dye spectra to the data, instead of estimating the dye spectra from the current sample being run.

**NOTE** The system dye spectra is established when running the Fragment Analysis Test Sample during installation when viewing the Dye Matrices window for a sample result in which spectra for all four dye labels were estimated.

After you run a Fragment Analysis Test Sample, the system displays a Spectral Matrix of this sample in the single result view under the Dye Matrices tab, which provides a **Save as System Dye Spectra** option.
6.5 Using the STR Locus Tag Editor

The STR Locus Tag Editor allows you to create a new Short Tandem Repeat (STR) Locus Tag or edit an existing one to be used for STR analysis. You can access this editor from the STR Locus Tag tab of the Analysis Parameters window (see "STR Locus Tags Tab" on page 212).

![Locus Tag Editor](image)

**Figure 6.17 Locus Tag Editor**

The Locus Tag Editor contains two tabs for creating or editing locus tags: the Locus Tag tab and the Allele ID Criteria tab. The top of the window displays the locus name and project.

You can save new or edited locus tags to a selected project for use in additional analyses.

**Locus Tab**

Use the Locus Tag tab to define the general locus and supplementary reporting information. These parameters include the fragment size range, repeat unit length, and the dye to be used. This is the minimum amount of information necessary to generate an allele list.

**Locus Information**

The Locus Information area of the window contains parameters used to generate a list of expected alleles in your analysis. Locus Information includes the following fields:

- **Locus Name**: Enter a locus identification in this field. This is an optional field.
- **Dye**: Select the dye to be used for the locus from the drop-down list.
• **Fragment length range between**: Enter the fragment length range (the minimum and maximum fragment size associated with the locus) in these two fields. This defines the range in which the system searches for the particular fragment.

• **Repeat unit length**: Enter the length of the repeat unit that represents the allele.

• **# of repeats in shortest Allele**: Select the number of repeats in the shortest allele from the drop-down list. Variant alleles that contain a particular repeat are designated by a decimal, followed by the number of bases in the partial repeat. For example, a variant allele with the designation 5.3 contains 5 complete repeat units and a partial repeat unit of 3 nucleotides.

### Naming Alleles

Select the method in which the system labels the identified alleles in the fragment list. For example, you can label the alleles the same as their expected fragment size in nucleotides (163, 164, 167,... etc.), in alphabetic order (A, B, C,...etc.), or in simple numeric order (1, 2, 3,...etc.).

Select the method in which to name the alleles in the fragment list:

- **Nominal size**: Select this option to label the alleles by their nominal fragment size.
- **Alphabetic**: Select this option to label the alleles in lettered order, then select the letter in the **Start at** field.
- **Numeric**: Select this option to label the alleles in numeric order, then select the number in the **Start at** field.

**NOTE** With the exception of **Ploidy**, the following fields are not required for any part of the analysis. They are used for supplementary reporting purposes only.

### Ancillary Information

The Ancillary Information area of the window allows you to select any supplementary reporting information to include with the locus tag parameters. This area includes the following fields:

- **Primer set name**: Enter the name of the primer set.
- **GenBank Accession**: Enter the GenBank Accession Number.
- **Repeat unit sequence**: Enter the sequence of the repeat unit associated with the locus tag.
- **Ploidy**: Enter the number of alleles associated with the locus tag.

### Primer Label (Optional)

The Primer Label area of the window allows you to indicate (for supplementary reporting purposes) on which strand the primer is labeled with the dye. You may choose one of these options:

- **Forward**: Select this option if the primer is dye labeled on the forward strand.
- **Reverse**: Select this option if the primer is dye labeled on the reverse strand.
- **None**: Select this option if you do not want to indicate which strand the primer is dye labeled.
Primer Sequence (Optional)
The Primer Sequence area of the window allows you to indicate (for supplementary reporting purposes) the specific sequence of the primer used. This can be up to 128 characters.

- **Forward**: If you labeled the primer on the forward strand, enter the sequence of the primer in the 5' to 3' direction.
- **Reverse**: If you labeled the primer on the reverse strand, enter the sequence of the primer in the 5' to 3' direction.

Generating an Allele List
After setting the locus values, click **Generate Allele List** to begin creating the allele list.

The system generates an allele list from the information provided. The allele list starts at the low end of the fragment length range. It creates an allele at each perfect repeat length until it reaches the end of the fragment length range.

The Allele List defines each allele under the following columns:

- **ID**: Uses the allele naming convention described in the section above.
- **Nominal Size**: Displays the generated fragment lengths as the initial integer values. You can modify these values to represent the allele sizes that appear when the data is analyzed. The nominal sizes are also displayed in the apparent size column, but these will usually be edited or regenerated.
- **Apparent Size**: Displays the fragment lengths, which are either entered using the locus tag editor, generated by interpolation or regression from an incomplete list, or generated from the automatic binning analysis feature (see "Performing Bin Analysis" on page 239). When apparent fragment lengths are user-entered or generated by interpolation or linear regression, you must enter the nominal sizes. When the apparent fragment lengths are generated by binning analysis, the nominal sizes are automatically generated.
- **Std. Dev. and Num. Points**: Describe the number of points included in each bin and the sample standard deviation. Both of these columns are generated using the automatic binning feature (see "Performing Bin Analysis" on page 239) and are empty for allele lists not based on a bin analysis.
- **Comment**: Displays any user comments associated with the allele.

Interpolation and Linear Regression
You can generate an allele list from a list of nominal sizes and a partial list of apparent sizes using Interpolation and Linear Regression.

- Interpolation calculates the apparent fragment sizes between two selected points.
- Linear Regression calculates the “line of best fit” for the selected alleles. The system uses this line to determine the apparent sizes for all points not selected. This option requires you to select more than two apparent fragment sizes.
To generate an allele list using one of these methods:

1. Individually edit the apparent fragment sizes within the allele list from which you want to generate interpolation or a linear regression line.

2. Select the alleles you want to use for generating the allele apparent sizes:
   - To select the rows within the allele list, click the row header of the allele list.
   - To select multiple consecutive alleles, press and hold the Shift key while dragging through the headers.
   - To select non-consecutive rows, press and hold the Ctrl key while selecting each of the rows with the left mouse button.

3. Right-click your selection and select **Interpolate** or **Regression**.

The Interpolation or Linear Regression function replaces existing or missing apparent fragment sizes or supplies the generated values.

**Allele ID Criteria**

The Allele ID Criteria tab contains the parameters used to accurately identify your alleles and to set these “true” alleles apart from various other anomalies identified in the fragment list.

A sample fragment represents a particular allele if its apparent size is similar to the size of a particular allele fragment in the allele list. However, because both the sequence and size of a fragment affects its mobility, the nominal allele size will not likely be the same as its apparent size. Therefore, the system identifies the alleles based on their “closeness” to an apparent size, using a user-defined confidence level.

**Confidence Interval**

You can either enter the confidence interval manually or generate it automatically using the bin analysis. When automatically generated, the value displayed depends on the overall standard deviation computed in the bin analysis and the user-specified confidence level (default = 95%). When you manually enter the confidence interval, the system uses the entered value and the confidence level to estimate an overall standard deviation.

Increasing the confidence interval increases the width of the bins. You should set the confidence interval to a value less than 0.5 nt.

If you enter a value of zero in the **Confidence Interval** field, the system uses only the standard deviation of the estimated sample fragment size in the statistical test used to identify a fragment as corresponding to an allele.

When you enter the confidence interval, the allele identification will not correspond to an error probability estimated from actual data, but is still a useful relative indicator of the “goodness” of the match.

- If would like to overwrite the confidence interval value generated by automatic binning, select **Overwrite system interval** value check box.
- If you are overwriting the system generated value, specify a confidence interval (number of nucleotides (+/-)) in the field provided.
Fragment Analysis Module
Using the STR Locus Tag Editor

Figure 6.18 Locus Tag Editor Window - Allele ID Criteria Tab

Stutter Definition
Stutter consists of small peaks, generally DNA amplification artifacts that form as a result of halted polymerase activity. When this happens, allele fragments form that differ in length from the true allele by an integral number of repeats (such as n-1, n-2, etc.). The absolute size of a fragment is a function of the variety of repeats (for example, dinucleotides, trinucleotides, etc.).

The Stutter Definition area of the window allows you to set the parameters for which the system can identify these peaks as stutter and not as true alleles.

- **Search for Stutter**: Select this option if you want the system to search for stutter. When selected, you must also choose at least one of the stutter options below it.
- **Stutter detection window width**: Select the number of repeats to specify the width of the window around each allele in which the system detects the stutter.
- **Maximum relative stutter peak height**: Enter the height percent of the stutter relative to the true allele below which detected peaks are considered stutters. Peaks above this threshold are considered unknown alleles.
- **Detect stutter shorter than allele**: Select this option to detect stutters shorter than (occurring prior to) the allele.
• **Detect stutter longer than allele**: Select this option to detect stutters longer than (occurring after to) the allele.

**Spurious Peak Detection**

Spurious peaks are generally small trace artifacts detected as a result of sample contaminants. These peaks tend to have a different shape than fragment peaks but often fall within the size range of a locus tag and are detected. However, they generally do not meet the criteria to be identified as known alleles and are therefore labeled as “spurious” peaks.

The Spurious Peak Detection area allows you to direct the system to look for spurious peaks in your analysis. You can specify a height threshold under which the system identifies a peak as a contaminant and not include it in your allele list.

To enable this option:

1. Select **Detect spurious peaks** if you want the system to remove any peaks that are below the maximum height threshold for spurious peaks.
2. In the **Maximum height for spurious peak** field, enter the percent of the spurious peak relative to the true allele below which detected peaks are considered spurious peaks.

**+A Detection**

+A Detection is an allele calling criteria used to compensate for a common DNA polymerase phenomenon of adding a “non-template directed” deoxyadenosine to the ends of PCR products. The result is a mixture of PCR products. Some of which are template “true length” (called “-A” products) while others are one nucleotide longer (called “+A” products).

The ratio of these two types of products can vary greatly between different reactions and primers. The result of having different fragment sizes from a single allele complicates the interpretation of fragment analysis data. Instead of one peak for one allele, there may be two that represent the same allele spaced one nucleotide apart.

The +A Detection area of the window allows you to specify how the system will differentiate between the true allele and the +A allele product.

**NOTE** You can select more than one of these check boxes at a time. Read through the following descriptions or refer to the tables below to see how these selections affect +A Detection and the allele peak assignments.

• **Apparent size includes +A**: Selecting this check box indicates that the sizes entered into the Apparent Size column of the allele list were for the +A fragments. The parameter affects where the system looks for peaks when identifying alleles.

• **Detect +/- A**: Selecting or clearing this check box determines:
  - When **Detect +/- A** is checked, the system identifies in the fragment list either the +A or -A peaks. The system then identifies one of them as the true allele based on your selection in the **Use +A peak to call allele** check box. It designates the other peak as either +A or -A accordingly.
  - When **Detect +/- A** is not checked, the system identifies one of the two alleles as the true allele based on the **Use +A peak to call allele** check box. It considers other peaks on the fragment list as unknown alleles.

• **Use +A peak to call Allele**: Select this check box if the +A form is expected to be the higher peak and leave it unchecked if the -A form is expected to be the higher peak.
- If the **Use +A peak to call allele** box is checked, the system identifies the +A peak as the true allele in the fragment list when the **Detect +/- A** box is also checked. It designates the other peak as either +A or -A accordingly.

- If the **Use +A peak to call allele** box is not checked, the system identifies the +A peak as the true allele in the fragment list when the **Detect +/- A** box is also not checked. The other peak will be included in the fragment list as an unknown allele.

- If the **Detect Spurious Peaks** check box is selected and the peak falls below the maximum height designation for spurious peaks, the other peak will be included in the fragment list as a spurious peak.

**NOTE**  The only time that **Use +A peak to call allele** is checked while the **Detect +/- A** is not checked is when there is complete conversion of the PCR product to +A. When neither **Use +A peak to call allele** nor **Detect +/- A** are checked, no +/-A labeling can occur.

In general, the reproducibility of size estimates is better for higher peaks than for lower peaks. Therefore, it is good practice to direct the system to use the higher of the peaks associated with the allele to identify the allele.

Additionally, it is generally a good idea to check the **Detect +/- A** option so the system correctly categorizes peaks. If the option is incorrectly configured, the alleles are still identified, but the +A and -A peaks are frequently categorized as unknown alleles and the system reports “Too many alleles” in the Comment column of the fragment data table.

**Table 6.13 Apparent Size Adjustments**

<table>
<thead>
<tr>
<th>+A Detection</th>
<th>Use +A Peak to Call Allele</th>
<th>Apparent Size Includes +A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use +A Peak to Call Allele Checked</td>
<td>No Size Adjustment</td>
<td>One nucleotide is subtracted from the apparent size of the allele in the allele list.</td>
</tr>
<tr>
<td>Apparent Size Includes +A Not Checked</td>
<td>One nucleotide is added to the apparent size of the allele in the allele list.</td>
<td>No Size Adjustment</td>
</tr>
</tbody>
</table>
6.6 Using the SNP Locus Tag Editor

Use the SNP Locus Tag Editor to create a new SNP locus tag or edit an existing one to be used for SNP analysis. You can access this editor from the SNP Locus Tag tab of the Analysis Parameters window (see "SNP Locus Tags Tab" on page 214).

Table 6.14 Truth Table for Setting +A Allele Identification

<table>
<thead>
<tr>
<th>+A Detection</th>
<th>Detect +/- A Checked</th>
<th>Detect +/- A Not Checked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use +A Peak to Call Allele Checked</td>
<td>All fragments assumed to be +A. The +A fragment is identified as the allele in the allele table. Fragments without +A (if any) are identified as -A peaks or spurious peaks.</td>
<td>All fragments assumed to be +A. The +A fragment is identified as the allele in the allele table. Fragments without +A (if any) are identified as unknown alleles or spurious peaks.</td>
</tr>
<tr>
<td>Use +A Peak to Call Allele Not Checked</td>
<td>All fragments assumed not to be +A. Any fragments without +A are identified as the allele in the allele table. Fragments with +A are identified as +A peaks or spurious peaks.</td>
<td>All fragments assumed not to be +A. Any fragments without +A are identified as the allele in the allele table. Fragments with +A are identified as unknown alleles or spurious peaks.</td>
</tr>
</tbody>
</table>
The Locus Tag Editor provides the following fields:

- **Locus Tag**: Enter or edit the name of the locus tag in this field.
- **Project**: Select the project to which the new or edited locus should be saved.
- **Locus Name**: Enter the identification of the locus in the field. This is the locus tag name that appears in the fragment list for all fragments that belong to this locus.
- **Apparent Fragment Size**: Enter a real number greater than 0 and less than or equal to 150. This represents the estimated size in nucleotides that the user expects for fragments belonging to this locus.
- **Ploidy**: This field is inactive for this system release.
- **Allele ID’s for**: This area provides fields for Allele IDs $D_1$, $D_2$, $D_3$, and $D_4$. Each field accepts 8 character alphanumeric values used to label the Allele ID’s in the fragment list. The default values are A, T, G & C. These fields cannot be blank.
- **Accession # and Primer Sequence** fields are not used for analysis and are for supplementary reporting purposes only. These fields are optional.

Apparent sizes of SNP probe fragments as estimated with SNP reference fragments often differ more from actual sizes than the STR allele fragments do. This is due to the effects of primary structure on fragment mobilities.

Therefore, it is important that the apparent size entered into the SNP locus tag definition is a known value. This is best determined in preliminary runs as the average apparent size of all of the possible variants that might occur in a Study.

Because the effects of different dye labels are relatively greater on shorter fragments, it is essential that in include the **Dye Mobility Calibration** in the parameter set for an SNP analysis.

### Result Set Filtering

The first steps in creating a Study involve applying a set of fragment analysis parameters to analyze the raw sample data. These parameters are specifically configured to process the fragment data for a particular sample or set of samples. The outcome of this analysis is a result set of data consisting of characterized fragments and identified alleles.

You can then use specific filters to scrutinize and selectively isolate results based on the parameters of the applied filters. In other words, the types of exclusions that you apply to the data “filter-out” all unwanted results from your Study. This process is known as “result set filtering.”
Accessing the Result Set View

You can view the Result Set View while working with a Study using one of these methods:

- Select **View | View Result Set**.

- Click the **Results Set** toolbar icon.

**Figure 6.20  Result Set View Window - Second Level Filtering**

The Result Set View window provides three key elements:

- **Fragment Results table** displays all analyzed samples, both included and excluded, that have been selected for the Study. The displayed columns are user-defined and can be modified to show a number of different system variables and information.

- **Exclusion Filter Set area** is where the user-defined exclusion filters are selected and applied to the data. Each column contains a menu of parameters to be applied as exclusion filters. The system comes equipped with one pre-defined sets of exclusion filters. You can create, modify, and save additional filter sets.

- **Summary area** displays a table that identifies the number of analyses that have been affected by the application of exclusion filters. As the result set is manipulated, you can view the number of samples that have been excluded from your Study based on your filter set parameters.
NOTE  The Filter Sets applied to the Result Set data (2nd Level Filtering) are different from the Filter Sets applied to the Fragment List data (3rd Level Filtering). In the Result Set, you apply filters to an entire sample that might contain numerous fragments. In the Fragment List, you apply filters to individual fragments that have been identified within the various samples. See "Using Fragment Lists" on page 237 for more information.

Applying Exclusion Filters to the Result Set Data

A Filter Set is a collection of any number of filters that are either pre-defined by the system or user-defined. The purpose of the Filter Set is to exclude any results that do not meet the criteria of the Study and to include results that do.

For example, suppose that your result set contains multiple samples collected under two different sets of fragment analysis parameters. One of these parameter sets used the SizeStandard-400 to determine the fragment sizes while the second parameter set used the SizeStandard-600 to make the determination.

To exclude any data that were analyzed with the SizeStandard-600:

1. Open the drop-down list in the Name column of the Filter Set area and select SS (Size Standard).
2. Open the drop-down list in the Operator column of the Filter Set area and select =.
3. Open the drop-down list in the Values column of the Filter Set area and type in SizeStandard-600.
4. Click Apply at the top of the Filter Set area.

All samples in the fragment results table that used the SizeStandard-600 are highlighted in teal (visible by selecting this parameter for display). This indicates that they have been excluded from the Study. The Excluded column in the Summary area has increased by the number of samples using the SizeStandard-600.

There are many filters available. You must apply each one using an operator and a value. You can apply any number of filters to a result set and save the filter sets for future use.

You can assign filter sets to filter out samples with excessive baseline noise, excessively broad peaks, no size standard, out of calibration range, etc.

This “second level” filtering leaves only the results you are sure of and saves you the time of removing unwanted fragment data later.

Finding Exclusion Filters

You can find all of the exclusion filters in the drop-down list available in the Name column of the Filter Set area. Once you have selected the name of the filter to use, you must select an operator (usually +, -, >=, etc.) and a value to be applied to the filter.

Refer to the online help for detailed descriptions of the available exclusion filters and their use.
Viewing the Summary

The Summary area displays a table that identifies the number of samples that have been affected by the application of exclusion filters. As you manipulate the result set, you can view the number of samples excluded from your Study based on your filter set parameters.

The Summary displays the following:

- The number of results that are included in result set within each sample capillary (A-H). As samples are filtered out of the result set by the exclusion filters, they are moved from this row to the “excluded” row.
- The number of results that have been excluded from the result set by the exclusion filters.
- The total number of all samples, both included and excluded, that are part of the result set.

Customizing the Result Set View

You can define the fragment result components available in the Result Set View. You can also modify them using right-click commands. These commands allow you to select specific columns to display in the fragment results, customize the arrangement of fragment results information, and modify several other parameters of the fragment results.

For details on using the Column Selector window, the Column Sort window, and other display parameters, see "Customizing the Results List" on page 254.

Viewing Electropherogram Data

You can view individual sample traces at any time, either individually or in selected groups along with the parameters used or collected during the separation and analysis steps. Sample traces can also be stacked or overlaid on top of one another for comparison purposes. All of these features are available through the right-click menus whenever a single or collection of samples is highlighted.

Single Sample View

Single Sample View displays all of the available information for an individual data sample, including the collected trace views, fragment data, separation and analysis parameters, the calibration curve, the run log, and more.

To access this information, right-click on the highlighted sample (or multiple samples) from any of the data or fragment lists and select Show Single Result.
Figure 6.21 Single Result View

The top of the Single Result window displays the name of the individual data sample selected. All of the information pertaining to the data sample is distributed under several different tabs within this window.

Table 6.15 provides a brief description of the components of each of the tabs in the Single Result View.

NOTE Refer to the online help for detailed descriptions of each of the available tabs in the Single Result View.

Table 6.15 Information Available in the Single Result View

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fragment Data</td>
<td>Displays a plot of the dye signal traces.</td>
</tr>
<tr>
<td>Raw Data</td>
<td>Displays a plot of the raw, four-channel electropherogram.</td>
</tr>
<tr>
<td>Fragment List</td>
<td>Displays a list of all fragments that meet the minimum relative height criterion set in the parameter set. This view displays all available fragment properties.</td>
</tr>
<tr>
<td>Current</td>
<td>Displays a graph of the separation current versus time for the duration of the separation event.</td>
</tr>
<tr>
<td>Inject Current</td>
<td>Displays a graph of the injection current versus time for the duration of the injection event.</td>
</tr>
<tr>
<td>Voltage</td>
<td>Displays a graph of the separation voltage versus time for the duration of the separation event.</td>
</tr>
</tbody>
</table>
### Table 6.15 Information Available in the Single Result View

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Log</td>
<td>Displays the list of messages generated by the primary analysis program during the analysis of the selected result. The analysis log contains information that can help determine the cause of an analysis failure.</td>
</tr>
<tr>
<td>Run Log</td>
<td>Displays the list of messages generated by the instrument during the pre-separation and separation events of the eight samples that include the individual selected result. Use the Run Log to troubleshoot the data in the case of a run failure.</td>
</tr>
<tr>
<td>Analysis Parameters</td>
<td>Displays a summary of the fragment analysis parameters applied to the raw data in the selected result.</td>
</tr>
<tr>
<td>Quantitation</td>
<td>Displays a summary of the peak information used to estimate fragment amounts within the selected result.</td>
</tr>
<tr>
<td>STR Locus Tags</td>
<td>Displays a list of STR locus tags that have been applied to the raw data in the selected result.</td>
</tr>
<tr>
<td>SNP Locus Tags</td>
<td>Displays a list of SNP locus tags that have been applied to the raw data in the selected result.</td>
</tr>
<tr>
<td>Size Calibration</td>
<td>Displays a description of the size standards and calibration curve used to calculate the sizes of the unknown fragments in the selected result.</td>
</tr>
<tr>
<td>Dye Matrices</td>
<td>Displays the dye spectra and dye mobility calibration parameters used in generating the selected result.</td>
</tr>
<tr>
<td>General/Notes</td>
<td>Displays a list of system and user-generated notes specific to the selected result (for example, sample name, dates, database location, and hardware information).</td>
</tr>
</tbody>
</table>
Trace Copies
To copy a trace as an image to the clipboard, right-click on the trace and select **Copy** (see Figure 6.22).

![Figure 6.22 Copying a Trace to the Clipboard](image-url)
The system copies subtitles with the image, as shown in Figure 6.23. To paste the image in other software, use the Paste command.

Figure 6.23 Trace with Labels

**Stacked Graph**
The Stacked Graph function aligns the electropherograms of selected results by size or time. Zooming and scrolling on the x-axis is synchronous between all plots selected while the y-axis of each plot selected is independently scaled, based on the available data.

To access this function, right-click the selected results from any of the results or fragment lists and select Show Stacked Graph.

**Overlay Graph**
The Overlay Graph function superimposes the electropherograms of selected results on a single x/y plot. To access the Overlay Graph, right-click the selected results from any of the results or fragment lists and select Show Overlay Graph.

This function has two different modes. The default mode, Zoom, allows you to draw a rectangular box around a selected area to zoom into. The second mode, Subset Selection, allows you to select a group of peaks and add them to a Stacked Graph view. To switch between the two modes, select the appropriate icon button from the EgramBand toolbar.

**Include/Exclude Results**
You can exclude results automatically using filter sets or manually by selecting the Exclude Results command. You can re-include any excluded results at any time using the Include Results / Peaks command available in the right-click menu.
To re-include results that were excluded in the Study, right-click the selected samples from any of the data or fragment lists and select **Include Results**.

When displaying excluded results, the screen uses a color code:

- Teal shading identifies results excluded automatically using filter sets.
- Maroon shading identifies results excluded manually.
- Light gray shading identifies previously excluded results that have been re-included.

You can hide both filtered and manually excluded results from view by de-selecting the **Show Excluded** command available in the right-click menu.

**NOTE** Refer to the online help for detailed descriptions of each of these and other display parameters.

### Re-Analyzing Results

The Fragment Analysis module contains a **Reanalyze Results** feature that allows you to select one or more samples from the Result Set view to be re-analyzed. This allows you to apply a different set of fragment analysis parameters to a previously analyzed data set to pick up missed peaks or to avoid picking up unwanted peaks. The data resulting from the re-analysis automatically replaces the older Result Set data, allowing you to quickly continue with your Study.

To re-analyze the results:

1. Select one or more results from the Result Set View.
2. Right-click the selected results and select **Reanalyze Results**.
   
   Reanalyze presents the following options:
   
   - From Sample Data replaces the previous analysis result with a complete new analysis, from raw data
   - Using New Parameters allows you to modify the analysis parameters previously used
   - Using Additional/Edited Locus Tags does not change the basis analysis, but allows you to modify allele identification

3. When selected, a message box opens prompting you to verify that you want to replace the selected results with re-analyzed results.
4. Click **Yes** to proceed with the re-analysis. The appropriate Fragment Analysis Parameters dialog window opens, allowing you to select a new or edited set of parameters to use for re-analyzing the data.

![Fragment Analysis Module](image)

**Figure 6.24 Selecting a Parameter Set to be used for Re-Analysis**

**NOTE** For details on selecting, creating, editing, and saving Fragment Analysis Parameter Sets, see "Defining Fragment Analysis Parameters" on page 206.

5. Select an Analysis Parameter Set.

6. Click **Next** to proceed to the Analyze Data window.
7. Click Analyze. During analysis, the system activates a progress bar and displays an analysis log for each sample analyzed. When finished, the status column indicates if the re-analysis passed or failed for each sample selected for re-analysis.

**NOTE** To stop an analysis currently in progress, click Stop. The system stops the analysis after completing the sample in progress.

8. Review the analysis log:
   a. Select a sample in the upper samples list.
   b. Scroll through the analysis information in the lower analysis log area of the window.

9. Click Finish to return to the Result Set View.

When finished re-analyzing the data, the system removes the initially selected results from the Study and replaces it with the re-analyzed results. The screen refreshes the Result Set View, including the Summary area, with the new data and reapplies the selected filters to the entire set of data.

**NOTE** Refer to the online help for detailed descriptions of the Re-Analysis process.
6.7 Using Fragment Lists

The Fragment List window allows you to view and modify the results of the fragment data identified in the Study. You may perform a third-level of filtering on this fragment list by applying additional exclusion filters.

Accessing the Fragment List View

To access the Fragment List view, use one of these methods:

- Select View | View Fragment List.
- Click the Fragment List toolbar icon.

The Fragment List window opens, as shown in the following example.

![Fragment List Window](image)

**Figure 6.26 Fragment List Window**

The Fragment List displays a table of all analyzed fragments included in the Study. You can modify the columns displayed to show different system variables and information.

You can use the Filter Set area to define and select exclusion filters you want applied to the fragment data. Create, modify, and save filter sets. Each Filter Set column provides a right-click menu of parameters you can use to apply as exclusion filters.

**NOTE** The Filter Sets applied to the Result Set data (second-level filtering) are different from the Filter Sets applied to the Fragment List data (third-level filtering). You can apply filters to the Result Set to filter an entire sample that may contain numerous fragments. You can also apply filters to the Fragment List to filter individual fragments identified within the various samples.
Applying Exclusion Filters to the Fragment List

Use the exclusion filter set to exclude any fragments that do not meet the criteria of the Study and to include fragments that do.

**NOTE** Refer to the online help for information and examples regarding the application of various filters to the Fragment List.

The system provides many filters, which you can apply using an operator and a value. You can apply any number of filters to a result set and save it for future use.

You can assign filter sets to filter out fragments in which no confidence interval was estimated, those with asymmetric peaks, stutter peaks, etc.

This third-level filtering keeps only the sample data with fragments that you are certain of, which saves you the time of “weeding out” inaccurate fragment data later in the analysis.

Available Exclusion Filters

You can find all of the exclusion filters using the drop-down list available in the Name column of the Filter Set area. After selecting the name of the filter to use, you must select an operator (usually +, <, >=, etc.) and a value to apply to the filter.

**NOTE** For details on using the Column Selector window, the Column Sort window, and other display parameters, see “Customizing the Results List” on page 254.

Customizing the Fragment List

You can define and modify the Fragment List components using the right-click menus. These commands allow you to select specific columns for display in the fragment list, customize the arrangement of fragment list information, and modify several other parameters of the fragment list.

For details regarding the Column Selector window, the Column Sort window, and other display parameters, see “Customizing the Fragment List” sections of the online help.

Manually Selecting Peaks for the Fragment List

Manually select peaks you want to add to or clear from a fragment list or building a new one from scratch.

To access this function, right-click within the fragment list and select **Manually Select Peak**. When selected, the system asks if you want to clear the existing fragment list. Choose one of the following:

- Click **No** if you want to keep the list but add or remove peaks from it.
- Click **Yes** if you want to discard the system-generated list and start over.

Exporting a Fragment List to CSV File

You can export the fragment list to other third-party spreadsheet programs. To export the fragment list:

1. Right-click the selected samples from any of the data or fragment lists.
2. Select **Export to CSV File**. The Export window opens.
3. Select a name and location to save the file.

**NOTE** See "Exporting Fragment Lists or Genotypes from a Study" on page 265 for more information regarding data export.

**Showing a Stacked Graph**

The Stacked Graph function aligns individual selected traces by size or time. Zooming and scrolling on the x-axis is synchronous between all plots selected while the y-axis of each plot selected is independently scaled, based on the available data.

To access this function, right-click the selected samples in the fragment list and select the Show Stacked Graph.

**Including, Excluding & Resetting Peaks in the Fragment List**

You can individually include or exclude peaks from the existing fragment list:

- To include a peak in the fragment list, right-click the selected fragments and select the Include Peak.
- To exclude a peak in the fragment list, right-click the selected fragments and select the Exclude Peak.

An updated stacked trace view, from which you can select the peaks of interest:

1. Left-click the peak of interest to select it.
2. Right-click to display the peak menu.
   - To display all fragments excluded from the fragment list, select Show Excluded Fragments.
   - To reset peaks modified in the fragment list to their original configuration, select Reset Peak.

### 6.8 Performing Bin Analysis

"Binning" is a one-dimensional clustering, by size, of fragments compiled from multiple samples. You can use bin analysis to generate an allele list that represents the population you are studying. For example, you might want to use this to establish a database of information on alleles and possible anomalies associated with them (such as imperfect repeats).

Binning of alleles from multiple samples allow you to create a new allele list or update an existing allele list for a locus tag based on the collection of fragment results.

During bin analysis, the system groups fragments by size to form “bins” characterized by an average apparent size and standard deviation of the fragments in the bin.

**Setting up a Bin Analysis**

Bin analysis requires an exiting result set, either from a previously saved Study or a new Study created exclusively for this purpose.

To set up a bin analysis:

1. Open the result set you want to analyze.
2. Select Analysis | New Binning Analysis.
NOTE As an alternative, you can access Bin Analysis from the Analyses tab of the Study Explorer. The New Binning Analysis window opens, as shown in the following illustration.

![New Binning Analysis Window - Bin Parameters](image)

**Figure 6.27 New Binning Analysis Window - Bin Parameters**

**NOTE** Bin Analysis requires a minimum of 10 samples.

### Defining Parameters

The first step in creating a new bin analysis is to set the bin analysis parameters. These parameters identify the fragment list data you want to include in the bin analysis. By setting these parameters you define the appearance of the view generated. After they are set, the system uses the information from the selected result set to generate a scatter plot. The plot consists of all of the analyzed fragment data displayed as a function of the peak height (y-axis) and fragment length (x-axis).

To set the bin analysis parameters:

1. Select the dye used during the raw data analysis from the **Dye** drop-down list. **NOTE** You can examine only one dye at a time during each bin analysis.
2. Enter the fragment range (the minimum and maximum fragment size) in the **Fragment Range From** and **To** fields.
3. Enter the **Maximum Bin Width** (maximum difference between the smallest and largest fragments within a bin) in nucleotides.
4. Enter the **Minimum Data Points Per Bin** (the limiting number of points necessary to form a bin in the scatter plot).
5. Enter the length of the repeat unit of the allele in the **Repeat Unit Length** field.
6. Select the preferred allele naming convention (see "Naming Alleles" on page 219).
7. Click **Next**. The system applies the new parameters to the scatter plot and assigns the bins as specified.

![New Binning Analysis Window - Bin Analysis View](image)

**Figure 6.28** New Binning Analysis Window - Bin Analysis View

**Viewing Bin Analysis**

After applying the bin analysis parameters to the selected data, the system displays the results of the bin analysis. This bin analysis view is composed of three areas representing the selected results.

**Bin View**

The Bin View consists of a scatter plot diagram showing the Fragment Size (x-axis) versus the Relative Signal Strength (y-axis). The points plotted represent the results selected when you created the Study. The bins are defined and visible with the majority of the result points within their borders.

**Allele List**

The system develops the initial Allele List from information provided in the first window of the Bin parameters plus the data from the fragment list (see previous). After completing the analysis, you can correct the allele list using the following options:

- **Phase Shift**: Enter an integer value (nucleotide) in either direction to move all identified bins. This overrides the system-determined position of perfect repeat alleles.
· **Minimum Relative Peak Height**: Enter a value to exclude any data points generated from small “noise” peaks. The relative peak height is calculated in the color and size range specified in the initial binning parameters window.

· **Show Phantom Bins**: Select **Show Phantom Bins** (✔️) to highlight the area of all system-generated phantom bins.

  The system generates phantom bins at all intervening positions for whole number nominal sizes not already assigned to a bin. Phantom bins encompass expected fragment sizes (based on other observed sizes) that may or may not be present in the data set.

  To convert phantom bins to real bins (alleles), right-click the desired bin location and select **Create Allele**. The system adds a line to the Allele List representing the new bin, which you should check for consistency.

**Trace Views**

At the bottom of the Trace Views area, select **Show Bins** (✔️) to display the bins with each trace shown in the stacked trace views.

**Investigating Points**

Position your mouse-pointer over any point in the Bin View plot and left-click to select it. The Trace View displays a trace for the selected point. You can use this trace as a visual comparison to other points. The visual comparison of the two traces help you confirm assigning a data point to an already defined bin, or to a new bin of its own.

The system assigns a **Name** and **Bin ID** using the naming and ID conventions selected in the bin analysis parameters window. The ID assigned by the system reflects the bin number with a decimal point and the number of bases over that of the bins.

For example: ID = 5.2 indicates a fragment with 5 repeats and 2 extra bases. If you prefer a different allele ID, you can click the system suggested ID and make changes. The final classification is up to you.

Continue selecting points and viewing their traces until you are satisfied with all the points in the histogram.

The system stores the information for a new allele or the modified information of an existing one, which you can apply in later records. The system automatically recalculates the statistics based on the edited results.
Updating the Locus Tag and Allele List

After completing the bin analysis, the system generates an allele list based on the information gathered during the analysis. It updates the list, but at this point has saved it to the database. The system prompts you for the locus tag to save to the generated allele list.

![Figure 6.29 New Binning Analysis Window - Updating Locus Tag](image)

You can use this window to select an existing **Locus Tag** from the drop-down list or add any **Ancillary Information** to the selected locus tag at this time.

Save the new data to the selected locus tag to update the allele list with Locus Information, including **Dye**, **Size**, and **Repeat Unit Length**.

**NOTE** Refer to "Locus Tab" on page 218 or "Using the SNP Locus Tag Editor" on page 225 for more information about locus tag parameters.

The system saves the following information:

- Observed Size (bin mean)
- Bin Minimum & Maximum
- Standard Deviation
- # of Data Points
- Minimum Peak Height
- X and Y coordinates of all the data points in the plot (stored as additional information)
The system automatically updates the allele list with the new information obtained during the bin analysis.

**Reviewing the Source Data**

After applying the Bin Analysis parameters to the data, selecting the reference and trace points, and updating the locus tag and allele list, you can review the source data for all included samples before completing the Bin Analysis.

The Fragment Results table and Summary area list all of the data samples included in the Bin Analysis. You may view and compare individual samples manually to include or exclude individual samples or groups of samples from the analysis and re-analyze selected samples.

![Figure 6.30 New Binning Analysis window - Reviewing the Source Data](image)

Click **Finish** to add the Bin Analysis to your Study.
6.9 Calculating Peak Ratios

After creating a Study, you can begin Peak Ratio calculations. Peak Ratio calculations analyze a Study result to quantify the amount of DNA present in a fragment. The system calculates the DNA quantity as a relative comparison to a user-defined reference peak.

Beginning a Peak Ratio Calculation

When viewing an exiting Study, select Analysis | New Peak Ratio to calculate peak ratios. The Peak Ratios window opens.

Figure 6.31 New Peak Ratio Window

The Peak Ratios window displays all of the result data and the selected parameters used to quantify the amount of DNA present in your sample.

Reference Result Peaks

This area shows the selected reference and test peak information. You select the reference result, which contains the best reference and test peaks for the system to use for a relative analytical comparison of trace peaks.

You may select any number of test peaks, but only one reference peak for each Peak Ratio Analysis.

Analysis Parameters

- **Use Peak Height**: Select this option to perform a quantitation based on peak height (Relative Fluorescence Units (RFU)).
Use Peak Area: Select this option to perform a quantitation based on peak area (mm x RFU).

Reference Peak Known Quantity: (Optional) If desired, enter the known quantity of your reference peak in the field. You must enter this value in scientific notation. Select the units for the quantity from the drop-down list. The options are moles, grams, molarity, and g/L. The system uses this information to calculate the quantity of DNA in the other results.

Highlight Variation
Highlight Variant Ratios: Select this option to enable the system to highlight any result ratios that deviate from average values. The criteria for variant ratios are specified by either the Standard Deviation about the mean or the % Error:
- Standard Deviation: Select this option to base the system criteria for identifying any variant ratios on the number of standard deviations from the mean. Enter the standard deviation number as the value a ratio must meet before the system considers the ratio a variant.
- % Error: Select this option to enable the system to base its criteria for identifying any variant ratios on the percentage of error. Enter the percent value of error the system allows a ratio to reach before it considers the ratio to be variant.

Peak Ratio Result Table
The system performs the analysis based on the selected reference and at least one test peak.

Show Excluded: Select this option if you want the result table to display peaks excluded from the analysis.

The Peak Ratio Result Table displays details in the following columns:
- Status: Displays an R if the result has been selected as a reference.
- Result Name: Displays the result name.
- Ratio R/T: Displays the ratio of the reference peak to the test peak.
- Ratio T/R: Displays the ratio of the test peak to the reference peak.
- Timestamp: Displays the time the quantitation was performed.
- Sample Name: Displays the sample name.
- Reference Peak Height: Displays the height of the selected reference peak.
- Test Peak Height: Displays the height of the selected test peak.
- Test Peak Quantity: Displays the calculated quantity of the test peak based on user-supplied reference values.
- Comments: Displays any user comments associated with the result.

Mean, Data Points & Standard Deviation
The lower-left area of the Peak Ratio window displays system-generated values for each of the calculated columns in the Peak Ratio Result Table. Based on the reference and test peaks selected, the system calculates the Mean, the # of Data Points, and the Standard Deviation.
**Selecting a Reference Trace**

A reference trace is a user-selected trace assigned as a reference by the system for comparative analysis of peak height and area. You can select the reference trace from either the Peak Ratio Result Table or from the Fragment Result Set Traces areas of the window.

- To select the reference trace from the Peak Ratio Result Table, right-click your selection and select **Set Result As Reference**.
  
The system highlights the result trace with a dark background and moves the trace to the top of the Result Set Traces area of the window to distinguish it as the reference result trace. It marks the fragment result with an **R** in the left-most column to distinguish it as the reference trace.
- To de-select the reference result, right-click the reference result and select **Set Result As Reference** again to toggle the command to the “off” position (unchecked).
  
The system removes the **R** from the de-selected trace and returns it to its original highlight status and position in the Fragment Result Set Traces area of the window.
- To select the reference peak from the Result Set Traces area, right-click your selection and select **Reference**.
  
The system highlights the result trace with a dark background and moves the trace to the top of the Result Set Traces area of the window to distinguish it as the reference result trace. It marks the corresponding result with an **R** in the left-most column to distinguish it as the reference peak.
- To de-select the reference result, right-click the reference result trace and select **Reference** again to toggle the command to the “off” position (unchecked).
  
The system removes the **R** from the de-selected trace returns it to its original highlight status and position in the Fragment Result Set Traces area of the window.

**Selecting a Reference Peak**

A reference peak is a trace peak you select from the reference result trace. The system compares the reference peak to the test peak, calculates a relative length, height, and area, then adds the results to the Peak Ratio Results Table.

- To select the reference peak, right-click an individual peak from the selected Result Set Trace located at the top of the Fragment Result Set Traces area of the window and select **Reference Peak**.
  
The system then calculates the length, area, and height of the test peaks by comparison and enters this information into the Quantitation Result Table.
- To de-select the reference peak from the Reference Result Peaks table, right-click the reference peak and select **Set Peak As Reference** again to toggle the command to the “off” position (unchecked).
- To de-select the reference peak from the Fragment Result Set Traces area, right-click the reference peak and select **Peak | Reference** to remove the check mark.
### Selecting a Test Peak

A test peak is a trace peak that you select from the reference result trace. The system compares the test peak to the reference peak, calculates a relative height and area, then adds the results to the Peak Ratio Results Table.

- To select the test peak, right-click an individual peak from the selected Result Set Trace, located at the top of the Result Set Traces area of the window, and select **Test Peak**.
  
  The system calculates the area and height by comparing it with the reference peak, then enters this information into the Peak Ratio Result Table. It uses each selected test peak to calculate ratios with the corresponding reference peak of the same trace.

- Select test peaks in the same manner until all desired peaks are identified.

- To de-select a test peak from the Reference Result Peaks table, right-click the test peak and select **Set Peak As Test** to toggle the command to the “off” position (unchecked).

- To de-select a test peak from the Fragment Result Set Traces area, right-click the test peak and select **Peak | Test** to remove the check mark.

### 6.10 Performing AFLP Analysis

Amplified Fragment Length Polymorphism (AFLP) Analysis is a highly sensitive DNA fingerprinting technique that relies on the selective amplification of restriction fragments from a total digest of genomic DNA.

The CE system includes AFLP Fingerprint analysis, which allows you to rapidly score AFLP fingerprints with output in a text format, which is compatible with most statistical and pattern matching systems. The AFLP analysis tool is a cluster analysis module that scores the presence or absence of a fragment of a given size per sample.

### Using the AFLP Feature

The AFLP feature takes all results from the Study and creates bins from fragments with sizes that fall within a user-defined bin width.

For each of the possible fragments in the Study, the system assigns a “1” if it finds a fragment in that sample and assigns it a “0” if the fragment is absent. It then creates a table of 1’s and 0’s. You can export the text to most other statistical analysis and spreadsheet software.
Setting the AFLP Analysis Parameters

To start a new AFLP analysis, select Analysis | New AFLP Analysis. The New AFLP window opens.

NOTE You can also access this from the Analyses tab of the Study Explorer.

Figure 6.32 New AFLP Window

AFLP Analysis Parameters

The analysis parameters area allows you to set filtering parameters for including or excluding fragment results in your AFLP analysis.

- **Maximum Bin Width**: Sets the limiting value given to the width of the individual bins. The default value is 1.0 nt. Enter the value in nucleotides.
  
  Within each dye label, the system clusters the fragments with the sizes that fall within the set bin width and creates a bin with the size rounded to the next integer.

- **Y Threshold**: Serves as an exclusion filter, defining the lowest acceptable value (peak height) for the y-axis. The default value is zero RFU. Set the y-threshold in relative fluorescence units (RFU).
  
  The system excludes fragments with heights less than this threshold value from the clustering process.

- **Exclude Fully Populated Bins**: Select this option to exclude bins represented in all samples (such as non-polymorphic fragments).

- **Exclude Samples without Qualifying Peaks**: Select this option to exclude samples that have no qualifying peaks.

AFLP Dyes

The Dyes fields determine the dye colors the system uses during the cluster analysis.

If the results list contains samples with fragments that have more than one dye (either multiple dye-labeled fragments pooled in a sample or multiple samples with single dye-labeled fragments in each sample), you can select the appropriate dyes for export.
Starting a New AFLP Analysis

After setting the analysis parameters, click OK to generate the New AFLP Analysis.

![Figure 6.33 New AFLP Analysis Window](image)

Viewing the Cluster Analysis

After completing the clustering operation, the system displays a table showing the results of the AFLP analysis. You can format this table as either rows or columns of data for easy export to a third-party software program for further analysis (see sample axis below).

This table presents the data in rows or columns as follows:

- **Bin**: Displays the bin number. It assigns bins with A and B suffixes if two adjacent bins fall in the same integer after rounding the Bin X Mean.
- **Dye**: Displays the dye included.
- **Samples**: Displays the sample count within the bin.
- **Fragments**: Displays the fragment count within the bin.
- **X-Min**: Displays the minimum fragment size within the bin.
- **X-Max**: Displays the maximum fragment size within the bin.
- **X-Mean**: Displays the mean fragment size within the bin.
- **X-Var**: Displays the fragment size variation within the bin.
- **Y-Mean**: Displays the mean peak height within the bin.
- **Numbered headings**: Show the number of sample components (peaks/fragments) within each bin for each sample.
Setting Cluster Analysis Parameters

The selections available at the bottom of the AFLP Cluster Analysis window provides additional settings that affect the values and output format of the fields displayed.

You can select one of the following Sample Bin options:

- **Fragment Count**: Displays the number of components within each sample bin as either zero components, one component, or multiple components.
- **Binary Presence**: Indicates the binary presence or absence within each sample bin.
- **Fragments Max Y**: Displays the absolute peak height of the fragments within each sample bin.

Select one or more of the following options to modify the displayed details:

- **Exclude Fully Populated Bins**: Excludes bins that are represented in all samples (such as non-polymorphic fragments).
- **Exclude Samples without Qualifying Peaks**: Excludes samples that have no qualifying peaks.
- **Show Excluded Elements**: Highlights all fragment data that was excluded from the analysis.
- **Sample Axis**: Arranges the table presentation by either Rows or Columns. As an alternative, you can switch between these views using the right-click menu. To do this, select the row or column heading, then select Transpose.

The following fields let you make additional adjustments to both the width and threshold:

- **Maximum Bin Width**: Sets the limiting value given to the width of the individual bins. The default value is 1.0 nt. Enter the value in nucleotides.
  
  Within each dye label, the system clusters the fragments with the sizes that fall within the set bin width and creates a bin with the size rounded to the next integer.

- **Y Threshold**: Serves as an exclusion filter, defining the lowest acceptable value (peak height) for the y-axis. The default value is zero RFU. Set the y-threshold in relative fluorescence units (RFU).
  
  The system excludes fragments with heights less than this threshold value from the clustering process.

**NOTE** You can reduce the chance of finding multiple components in a bin by decreasing the bin width.
Customizing the AFLP Table

The components of the cluster analysis are user-defined. You can modify them using the right-click menus. These commands allow you to select specific columns for display in the fragment list, customize the arrangement of fragment list information, and modify several other parameters of the fragment list.

**NOTE** See "Customizing the Results List" on page 254 for details regarding how to use the Column Selector window, the Column Sort window, and other display parameters.

Exporting the AFLP Analysis Results

To export the AFLP analysis results:

1. Select File | Export AFLP. The Export AFLP window opens.
2. Select a file name and destination folder for the data.
3. Click Save.

Some third-party software may require that you export the sample information in a specific format. When choosing to display the sample names in rows, you can display the alleles in separate columns or in one column. You can include the Bin Labels in the file by checking the appropriate boxes in the Export File Format for file export.

The Dyes parameters determine the dye color the system uses during the cluster analysis. If the results list contains samples with fragments that have more than one dye (either multiple dye-labeled fragments pooled in a sample or multiple samples with single dye-labeled fragments in each sample), you can select the appropriate dyes to be exported.

6.11 Performing LOH Analysis

The Fragment Analysis module comes equipped with a macro that is intended to detect Loss of Heterozygosity (LOH) between alleles from Normal (reference) samples and those from other samples.

In LOH Analysis, pairs of samples to be compared must have the same “root” names followed by characters that allow the distinction between reference and test samples or loci. All data to be analyzed reside in a temporary file created by the System Fragment Analysis application.

The macro scans the fragment results contained in the Study to determine the loci to include in the LOH analysis. For each result in the Study, a list of alleles is then generated at each locus. The peak heights of alleles identified in similarly named samples are then compared and their status determined (LOH, AI, MI, Homozygous, NoNorm Alleles).
To start LOH Analysis:

1. Select **Analysis | Run LOH Analysis** to launch Microsoft Excel™. The LOH.xml file opens, displaying the **START** sheet.

![Image of Microsoft Excel window with LOH Analysis settings](image)

**Figure 6.34 Run LOH Analysis**

**NOTE** You must select **Enable Macros** to run the LOH Analysis; otherwise, a prompt reminds you to enable this feature.

2. From the LOH.xls **START** sheet, set the **LOH Threshold** (and the **AI Threshold** if desired).

3. Specify the unique character combination used to identify Normal samples or loci (i.e. Norm).

4. Specify whether Normal and Tumour samples are in the same well:
   - If you are running Normal and Tumour samples are run in the same well, select the corresponding check box.
   - If Normal and Tumour samples are in different wells, clear this check box.

5. Click **Start**.

**NOTE** Do not use the keyboard or the mouse during LOH analysis.

6. If desired, save the results when the processing is complete.

**NOTE** To save the data correctly, you must save the LOH Analysis results as a Microsoft Excel Workbook (*.xls) file type. You must also change the file name from the default name displayed in the Save As... dialog box; otherwise, the system saves result as a temporary file, which it will overwrite in the next LOH Analysis.

**NOTE** If more than two alleles are found for a locus, the last allele listed for the locus will be followed by an asterisk (“*”).
6.12 Customizing the Results List

The components of the results list are user-defined. You can modify them using the right-click menus. These commands allow you to select specific columns to display in the results list, customize the arrangement of information, add or remove columns, and modify several other parameters of the results displayed. Customized lists are available in the Result Set View, the Fragment List, AFLP Analysis, and Peak Ratio tables.

Selecting Columns for Display

The Column Selector window contains a list of all possible columns that you can display in the list. You can select these columns individually or in groups, arrange them in any order, and lock them so they always remain in view when scrolling through the fragment list.

Accessing the Column Selector Window

To access the Column Selector window, right-click the column header area of the list to display, then select Select Columns. The Column Selector window opens, as shown in the following example.

![Figure 6.35 Column Selector window - Selecting Columns for Display in the Table](image)

**NOTE** The application area in which you select the Column Selector window (such as Result Set View, Fragment List, or AFLP Cluster Analysis) determines which columns are available for display.

**NOTE** Refer to the online help for detailed descriptions of the available columns and their use.

Selecting Columns for Display

- Highlight the column selection in the Possible Columns area of the window and click the right-arrow to move the selection to the Selected Columns area of the window.
- To select all columns for display in the list, click the double-right-arrow.
Customizing the Results List

To remove columns from the Selected Columns area, highlight the column selection and click the **left-arrow** to move the selection back to the Possible Columns area.

To remove all columns from the list, right-click the header and select the **Hide Column**.

Arranging the Column Display

You can arrange the left-to-right order of columns in the list by ordering the columns top-to-bottom in the Selected Columns area of the Column Selector window:

- Highlight the column selection in the Selected Columns area and click either the **up-arrow** or **down-arrow** buttons to move the column to the selected location.
- Order the columns top-to-bottom in the Selected Columns area relative to the left-to-right order you want the columns to be displayed in the fragment result table.

Locking the Column Position

You can lock selected columns into position so they remain in view as you scroll across the remaining columns in the list. This helps when the results list contains multiple columns of data which require left-to-right scrolling and you want to keep a particular column (such as the result name or status) always in view.

- To lock a column, highlight the column in the Selected Columns area of the Column Selector window and click **Lock**. A lock icon appears next to the selected column to indicate that the column position is locked.

**NOTE** This also locks all columns positioned above the lock location in the Selected Columns area, and thus to the left of the locked position in the list. If this includes columns that you do not want locked, use the positioning arrows to move the columns out of the lock range.

- If the view is filled with locked columns, you may not be able to scroll through the grid. If this happens, reduce the number or widths of the locked columns
- To move the lock position to a different column location, click **up-arrow/lock** or **down-arrow/lock** in the Column Selector window.
- To remove the column lock, click **Unlock** in the Column Selector window.
- To lock and unlock columns directly from the fragment result table, right-click the column header and select **Lock Column** or **Unlock Column**.

Sorting the Results List

You can sort the components of the results list in ascending or descending order for any of the column parameters displayed. For example, you can sort the results list by ascending bin number, descending bin fragment count, etc. You can sort columns in the Result Set View, the Fragment List, AFLP Analysis, and Peak Ratios tables.

**Sorting an Individual Column**

- Right-click the header of the column you want to sort and select **Sort Column**. The system sorts the column in either ascending or descending order, depending on the order in which it was previously arranged.
- To sort the same column in the reverse order, right-click the header and select **Sort Column** again.
**Accessing the Column Sort Window**

To access the Column Sort window, right-click the column header area of the fragment list and select **Sort Columns**.

![Column Sort Window](image)

**Figure 6.36  Column Sort Window - Sorting the Results List Data Columns**

To sort a column:

1. Select the column parameter you want to be sort from the drop-down list.
2. Select the order in which you want the parameter sorted (**Ascending** or **Descending**).
3. Repeat the first two steps for each additional columns that you want to sort.
4. Click **OK** to sort the list.

**NOTE**  See the online help for more information on these and other display modifications.
6.13 Reporting Results

The CE system software includes a powerful suite of utilities for creating reports. It also allows you to export data and results to other third-party software packages.

Figure 6.37 New Report Dialog Box

All of the reporting features available in the Fragment Analysis module are located under the Reports tab of the Study Explorer. In addition, you can generate a new report using the Reports menu located on the menu bar.

The New Report window allows you to select the type of report you would like to generate from a list of available report templates (see "Using Report Templates" on page 258) and saved data. You can access the New Report window from either the Report menu or the Study Explorer.

To create a New Report from the Report menu:

2. Select the type of report you would like to generate from the Template drop-down list. The selections available depend on the data contained in the open Study.
3. Select the saved data from which you want to generate a report from the Context drop-down menu.
4. Click OK to display the new report containing the selected information.

To create a New Report from the Study Explorer:

1. Select the Reports tab available at the bottom of the Study Explorer frame of the window.
2. Right-click to highlight the type of report you would like to generate from the list of those available in the Reports tab and select New. The New Report window opens, displaying the Context Type for your selection.

3. Select the report template from the Template drop-down menu. The selections available depend on the Context Type.

4. Click OK to display the new report containing the selected information.

Using Report Templates

There are several types of elements in each report template:

- Header text for data, tables, or graphs. For example Bin Scatter plot
- Regular Data Objects. For example: Context.Locus.Name (Locus)
- Loop Delimiters. For example: BeginLoop: Allele = Context.Locus.Alleles

<table>
<thead>
<tr>
<th>ID</th>
<th>Allele.ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal Size:</td>
<td>FormatNumber(Allele.TrueSize, 0)</td>
</tr>
<tr>
<td>Apparent Size:</td>
<td>FormatNumber(Allele.ApparentSize, 2)</td>
</tr>
<tr>
<td>Standard Deviation:</td>
<td>FormatNumber(Sqr(Allele.FragmentSizeVariance))</td>
</tr>
<tr>
<td>Number of Data Points:</td>
<td>Allele.FragmentCount</td>
</tr>
<tr>
<td>Comment:</td>
<td>Allele.Comment</td>
</tr>
</tbody>
</table>

EndLoop: Allele = Context.Locus.Alleles

- Table Delimiters:

<table>
<thead>
<tr>
<th>ID</th>
<th>Nominal Size (nt)</th>
<th>Apparent Size (nt)</th>
<th>Standard Deviation (nt)</th>
<th>Num. Points</th>
<th>Comments</th>
</tr>
</thead>
</table>

- Graph Objects. For example:
  Graph: Service.BinGraph (Context, Site, DisplayOptions)
Graph Placeholder pictures, as shown in the following example.

Figure 6.38 Placeholder Pictures

You can edit or remove header text at will. Use the header text provided in the Report Templates to identify the data objects that follow.

You can remove, but should not edit, the data object descriptions, highlighted in gray, because they are specifically coded to extract data from the database. Do not overwrite the original report template .doc files. They contain a compilation of all available data objects for reporting.

Use loop delimiters or table iterations of similar data. While the data object names may appear squashed in the report template, if the data fits in the space provided, the tables should look normal in the report.

Graph objects and graph placeholders must remain together for proper graph display.

Editing Graph Displays

You can edit five features of the graph displays: 1) X scale type. 2) X-axis scale, 3) Y-axis scale, 4) Pane Count or Pane Width, and 5) Dyes displayed.

To edit the graph:

1. Right-click the graph placeholder and select **Format Object**.
2. Select the Web tab and create the following text:

   ```html
   <DisplayOptions
     (Your commands will go here)
   />
   ``

X-Scale Type

The possible values for **XScaleType** are **Default**, **BySize**, and **ByTime**. **XScaleType** only applies to electropherogram view. **Default** allows the graph type to determine whether to display by size or by time. If you do not specify the **XScaleType** attribute, it defaults to **Default**.
In the `DisplayOptions` section of the alternative text box, enter by size or time as follows:

```xml
<DisplayOptions
  XScaleType="BySize"
/> OR
<DisplayOptions
  XScaleType="ByTime"
/>```

**X-Axis**

X-axis values specify either the size or the time, depending on the `XScaleType`. If either or both are not specified, they take on the minimum and maximum values from `Unzoom all graph`.

In the `DisplayOptions` section of the alternative text box, enter minimum and maximum values as follows:

```xml
<DisplayOptions
  XScaleType="BySize"
  MinX="100"
  MaxX="300"
/>```

**Y-Axis**

In the `DisplayOptions` section of the alternative text box, enter minimum and maximum values as follows:

```xml
<DisplayOptions
  XScaleType="BySize"
  MinX="100"
  MaxX="300"
  MinY="0"
  MaxY="10000"
/>```

If you do not specify either or both `MinY` and `MaxY`, they take on the minimum and maximum values from `Unzoom all graph`.

**Pane Count or the Pane Width**

You may specify either `PaneCount` or `PaneWidth`:

- If you specify `PaneCount`, it represents the number of panes in which to break the graph. If you do not specify either `PaneCount` or `PaneWidth`, the system uses the default `PaneCount` of 1. `PaneCount` is an integer.

- If you specify `PaneWidth`, it represents either the size or time per pane, depending on the `XScaleType`. The graph is broken into `((MaxX - MinX) / PaneWidth)` full sized panes, as well as one additional pane if required for the remaining data. `PaneWidth` is a float.

In the `DisplayOptions` section of the Alternative text box, enter the desired number of panes to distribute the X-axis range of data over as follows:
Dyes Displayed on the Graph

**SelectedDyes** are dye selection options. It allows the e-gram graph to select which dye to report. The Fragment Analysis view dye visibility does not affect this option. The possible value for **SelectedDyes** are all, 1, 2, 3, 4 or combination of 1, 2, 3, 4. **All** displays all four dyes.

By default, the display for the four dyes is: 1 = D1, 2 = D2 etc.

In the **DisplayOptions** section of the alternative text box, enter the desired dyes as follows:

```xml
<DisplayOptions
  XScaleType="BySize"
  MinX="100"
  MaxX="300"
  MinY="0"
  MaxY="10000"
  PaneCount="3"
  SelectedDyes="1,4"
/>
```
### Exporting Results

When exporting a fragment result in text format, you can include all properties. You can then open the exported file in any text editor or MS Excel to preview the file prior to printing.

To export results:

1. Open the Fragment Analysis module.
2. Select **File | Export Results**. The Export Results window opens, as shown in the following example.

![Export Results Window](image)

**Figure 6.39 Export Results**

3. Select the results you want to export from a list of available results located in various projects:
   a. Select the **Project** that contains the sample data that you want to export from the **Project** drop-down list.
   b. In the Available list, select the samples to export, then click the **right-arrow (>)** to move the selection to the Selected list.

**NOTE** The functionality of this window is very similar to that of the Select Raw Data window described in "Selecting the Components of the New Study" on page 200.

4. When you have finished making your selections, click **Next** to proceed to the Export Options window.
5. Define the export parameters and options, including the file name and location, using the Export Options window, as shown in the following example.

![Figure 6.40 Export Options](image)

The Export Results - Options window provides the following fields and options:

- **Export result as**: Displays the selected export file, including its file path, file name, and extension (which identifies the file format). This is a read-only field. To change this selection, click **Save As** and enter the required details to save the file using the application's format extension. For details, see "Text File Format" on page 264 or "CEQ File Format" on page 265.

- **Header**: Select this option to include general information regarding the sample and run conditions with the exported results.

- **Raw Data**: Select this option to include raw data with the exported results.

- **Result Data**: Select this option to include dye traces and data points with the exported results.

- **Result Output**: Select this option to include a fragment list with the exported results.

- **Remove CEQ Tracking Suffix**: Select this option to remove the sample plate and date from the exported file name.

- **Resolve Filename Conflicts**: Select this option to automatically append a unique sequence number to exported files of the same name.

6. Click **Finish** to complete the export application.
Text File Format

You can export the results file in a text file format. The data in this file are tab delimited and the export format has the extension *.txt.

Figure 6.41  Fragment Analysis Export Dialog Box

To export the results as a text file from the Export Results - Options window:

1. Click **Save As**. Use the folder navigation options next to the **Save in** field to locate and select the folder in which you want to save the export file.
2. Enter the desired file name in the **File name** field.

   **NOTE** Do not use special characters in the file name: “/ : * ? " < > |”.

3. Select **Text (Tab Delimited) (*.txt)** in the **Save as type** text box.
4. Click **Save**. The system returns to the Export Results - Options screen, displaying the file path to the specified text file in the **Export results as** field.
5. If desired, modify the fields that apply to the text file:
   a. Select **Header** and/or **Result Data** in the Elements section.
   b. Select **Remove CEQ Tracking Suffix** to automatically remove the plate position coordinates (*.A01, *.B01, etc.) as well as the time/date stamp from the sample name. These are generated by the CE system software.
   c. Select **Resolve Filename Conflicts** to enable the system to increment the sample names on export if it encounters samples with the matching names.
6. Click **Finish**.
7. Navigate to the target folder and double-click the exported file to open it in Excel, Notepad, or any other text editor.

You can view the properties at the beginning of the file.
CEQ File Format

The CE system offers the CEQ export option from the Fragment Analysis module. You can select *.*cq* as an export file type for exporting fragment results from the Fragment Analysis module.

![Fragment Result Export Dialog Box](image)

Figure 6.42 Fragment Result Export Dialog Box

To export fragment results in CEQ (*.cq*) format from the Export Results - Options window:

1. Click **Save As**. Use the folder navigation options next to the **Save in** field to locate and select the folder in which you want to save the export file.
2. Enter the desired file name in the **File name** field.
   
   **NOTE** Do not use special characters in the file name: “/ : * ? " < > |”.
3. Select **CEQ (*.cq*)** from the **Save as type** drop-down list.
4. Click **Save**. The system returns to the Export Results - Options screen, displaying the file path to the specified CEQ file in the **Export results as** field.
5. If desired, modify the fields that apply to the CEQ file:
   a. Select **Remove CEQ Tracking Suffix** to automatically remove the plate position coordinates (*.A01, *.B01, etc.) as well as the time/date stamp from the sample name. These are generated by the CE system software.
   b. Select **Resolve Filename Conflicts** to enable the system to increment the sample names on export if it encounters samples with the matching names.
6. Click **Finish** to export the Result Data and the Result Output.

Exporting Fragment Lists or Genotypes from a Study

This feature allows you to export the opened Study's fragment list or genotype data. The pedigree and genotype data included in the export come from the results included in the opened Study.

To export the properties with a fragment result:

1. Open the Fragment Analysis module and open a Study.
2. Select **File | Export Fragment/Genotypes**. The Export Fragments / Genotypes As window opens, as shown in the following example.

![Export Fragments/Genotypes As window](image)

**Figure 6.43** Exporting Fragment Lists and Genotypes

3. Use the folder navigation options next to the **Save in** field to locate and select the folder in which you want to save the export file.

4. Enter the desired file name in the **File name** field.

   **NOTE** Do not use special characters in the file name: "/ : * ? " < > |".

5. Select one of the four available export formats from the **Save as type** drop-down list:
   - CSV (Comma) *.csv
   - Linkage (Pedin) *.pre
   - Discovery Manager (DMPopulation) *.txt
   - Genotype Summary Report (tab delimited)*.gsr

6. Click **Save** to start the process and save the export file using your specified file parameters.

   The export status, along with a processing log, appears in a status window. This window indicates when the export procedure is complete and any export errors that may occur.

**Transferring Fragment Data to GeXP Data Tool**

Transfer fragment data from the GeXP System to GeXP Data Tool for use with normalization of gene expression results.

1. From the **Main** menu launch the **Fragment Analysis** module.
2. Open a set of analyzed GeXP data.
3. Select **File | Transfer Fragments for GeXP**...
4. Click **Transfer Fragments for GeXP**...
5. After the dialog box appears, name the file and browse to a transfer location.
6. Click **Save** to save the exported file as a CSV file. A message box will display confirming the export process.
7. Click **OK** to confirm the completion of the process and close the message box.
For additional information on using Fragment Data in the GeXP Data Tool, refer to Chapter 7 for the “GeXP Data Tool.”

**Format Descriptions and Requirements for Exporting Fragment List and Genotypes**

Export data along with their export requirements, by using one of the following file formats:

**CSV (Comma) *.csv**

Contains the export parameters of a Study's fragment list as selected, sorted, and ordered. Each line in the output file represents a fragment. The data in this export are comma delimited, suitable for viewing in most third-party spreadsheet applications. The export format has the *.csv extension.

**Linkage (Pedin) *.pre**

Contains the export parameters of a Study's pedigrees and genotypes. The Pedin file can be imported into a Linkage application's MakePed utility program. This file includes the pedigree and genotype information from each result in the Study. It supports up to two alleles per locus.

The export produces three files:

- *.pre = the Pedin file.
- *.log = the list of processing steps and errors encountered during the export.
- *.debug = the text file with column headings and comma separated data to aid in the correction of errors in the *.pre file.

The Pedin export requires a list of locus names, in a file named “LocusList.txt”. You must store this file in the CE system \export or root directory. This text file must have only one locus name per line. The order of the loci included in this file determines the order of the loci in the Pedin file.

The Pedin export also requires that every result in the Study includes the pedigree information (at least the individual ID). It also requires that at least one result per individual has a complete pedigree (Pedigree ID, Individual ID, Father ID, Mother ID, and Gender).

Pedigree information is associated with samples through the sample plate editor, using the sample property sets Pedigree template. As an alternative, you can associate the pedigree information with results, using the single result view's property sets tab.

**Discovery Manager (DMPopulation) *.txt**

Contains the export parameters of a Study's pedigrees and genotypes. The DMPopulation file is designed to be imported into Genomica's Discovery Manager application. The DMPopulation file can also be imported into Discovery Manager as a DMFastPopulation file. The pedigree and genotype information from each result in the Study is included in the DMPopulation file.

The DMPopulation export produces two files:

- *.txt = the DMPopulation file.
- *.log = a list of processing steps and errors encountered during the export.
The DMPopulation export requires a list of locus names, in a file named “LocusList.txt”. This file must be stored in the CE system’s \export or root directory. This text file must have only one locus name per line. The order of the loci included in this file determines the order of the loci in the DMPopulation file.

The DMPopulation export also requires that pedigree information (at least the Individual ID) be included in every result in the Study. Additionally, at least one result per individual must have a complete pedigree: Population ID (PopID), Pedigree ID (KinID), Individual ID (SubID), Mother ID (MID), Father ID (FID), and Gender (Sex).

Pedigree information is associated with samples through the sample plate editor, using the sample property sets “Pedigree” template. As an alternative, you can associate the pedigree information with results, using the single result view's property set tab.

**Genotype Summary Report (tab delimited) *.gsr**

Accommodates Subject IDs, the occurrence of more than two alleles, and the absence of alleles, as shown in the following illustration. Use the Locus List Editor to customize the LocusList.txt file before exporting a Genotype Summary Report. (For details, see "Creating a Genotype Summary Report" on page 269.)

The report layout is described below:

- Column/Row Individual headings are replaced with the heading of Subject ID.
- If the number of alleles is greater than two, the cell will indicate **Too many**.

When an allele is not found, the empty cell is replaced with **Unknown Allele**.

```
<table>
<thead>
<tr>
<th>Locus</th>
<th>Subject 33</th>
<th>Subject 63</th>
<th>Subject 65</th>
</tr>
</thead>
<tbody>
<tr>
<td>GATA193A07 A1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GATA193A07 A2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D11S1984 A1</td>
<td>182</td>
<td>Too many [3]</td>
<td>None found</td>
</tr>
<tr>
<td>D11S1984 A2</td>
<td>190</td>
<td>Too many [3]</td>
<td>None found</td>
</tr>
<tr>
<td>D14S599 A1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D14S599 A2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D1S1679 A1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D1S1679 A2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

*Figure 6.44  Genotype Summary Report*
Creating a Genotype Summary Report
The Locus List (LocusList.txt) is required to create the Genotype Summary Report (GSV) and to perform some exports. Use the Locus List Editor to customize the LocusList.txt file.

Press the F7 key or select View | Locus List Editor. The Locus List Editor opens, as shown in the following example.

![Edit Locus List Dialog Box](image)

**Figure 6.45 Edit Locus List Dialog Box**

**Table 6.16 Locus List Editor - Legend**

<table>
<thead>
<tr>
<th>Loci in Database</th>
<th>Lists the loci from the database that have not yet been moved to the Selected Loci list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other Loci</td>
<td>Lists the loci to be removed from the LocusList.txt file.</td>
</tr>
<tr>
<td>Selected Loci</td>
<td>Lists the loci to be added to the LocusList.txt file.</td>
</tr>
<tr>
<td>![Up Arrow]</td>
<td>Moves all loci from the Loci in Database and Other Loci list to the Selected Loci list.</td>
</tr>
<tr>
<td>![Up Arrow]</td>
<td>Moves only the selected loci from the Loci in Database and Other Loci list to the Selected Loci list.</td>
</tr>
<tr>
<td>![Up Arrow]</td>
<td>Moves all loci from the Selected Loci list to the Loci in Database or Other Loci list. If the loci exist in the database, moves the loci to the Loci in Database list.</td>
</tr>
<tr>
<td>![Up Arrow]</td>
<td>Moves the selected loci from the Selected Loci list to the Loci in Database or Other Loci list. If the loci exist in the database, moves the loci to the Loci in Database list.</td>
</tr>
<tr>
<td>![Up Arrow]</td>
<td>Use to rearrange the list order. Select an item and click the appropriate arrow to move it up or down the list.</td>
</tr>
</tbody>
</table>
7.1 Gene Expression Overview

The GenomeLab GeXP Genetic Analysis System (GeXP System) uses a patented, highly-multiplexed PCR* approach to efficiently examine the expression of multiple genes, with sensitivity and speed.

Perform a multiplex gene expression analysis by completing the following procedures:

- Design a custom multiplex using the NCBI Primer-BLAST
- Perform the Reverse Transcription (RT) reactions
- Perform the PCR reactions
- Run the PCR products on the GeXP System
- Analyze the data using the GeXP Fragment Analysis Module, GeXP Data Tool and GeXP Quant Tool

The flowchart on the next page depicts the Gene Expression workflow:
Gene Expression
Gene Expression Overview

*The PCR process is covered by patents owned by Roche Molecular Systems, Inc. and F. Hoffman-La Roche, Ltd.*
7.2 Multiplex Primer Design using NCBI Primer-BLAST

The NCBI Primer-BLAST tool is used to design an initial or “first-pass” multiplex, using accession numbers of target and reference genes. The primer and amplicon information for the multiplex are saved in a Microsoft Excel file. The multiplex primer and amplicon sequences are evaluated using BLAST analysis. If necessary, individual primers can be re-designed. Finally, the primer and amplicon information for the multiplex in the Microsoft Excel file is updated.

NOTE Add appropriate universal tag sequence at the 5’ end of the primers before ordering primers.

IMPORTANT The information that is provided in the section, and additional information, can be found in the GeXP Chemistry Protocol (A29143).

Pre-Design Considerations

1. Determine which genes to be included in the multiplex for your study.
2. Select a correct Accession Number for each of the targeting genes.
   If possible, always use reference sequence (RefSeq) (NM_XXXXXX).


Since the sequence represented by the accession number will be used to generate the multiplex primers, certain considerations should be made when selecting accession numbers. A single gene can be represented in the GenBank database by multiple accession numbers such as those that refer to genomic sequences, partial sequences, mutations, mRNA, ESTs, alternate transcripts, splice variants, or pseudogenes.

Ensure the following when selecting an accession number:

a. Correct Gene
   • Many genes have multiple names and aliases
   • Different genes can have similar names (e.g., IL2/IL2 receptor alpha/IL2 receptor beta/IL2 receptor gamma)
   • Verify that the gene is from the species of interest
b. Valid Sequence
   • Verify that the sequence contains only the letters A, T, G, C or N
   • Verify that the sequence is for mRNA (cDNA)
   • Avoid genomic DNA sequences with introns
   • Verify that the sequence is still active by reviewing the accession number’s revision history using the following page: www.ncbi.nlm.nih.gov/entrez/sutils/girevhist.cgi
   • RefSeq accession numbers starting with “NM_” are ideal choices for designing primers because they are from a curated, non-redundant database of known genes maintained by NCBI. The “NM_” accession prefix denotes mRNA sequences
   • Each RefSeq accession number correlates to an individual identified transcript variant. A gene may have more than one RefSeq identifiers
Gene Expression

Multiplex Primer Design using NCBI Primer-BLAST

- Be aware of and avoid pseudogenes by BLASTing the gene against the genome before primer design to avoid undesigned peaks. See BLAST tool on the NCBI web site (http://www.ncbi.nlm.nih.gov/)
- Mutations or repeats can also influence results of primer design
- Homologous genes, pseudogenes, or conserved domains should also be considered when choosing a gene sequence.

**NOTE** To aid in identifying a valid accession number, additional tools and information are available on the NCBI web site. Examples of these include Entrez Nucleotide, Entrez Gene, Homologene, Unigene, Blastn, or OMIM.

3. For genes with transcript variants, decide how many variants to detect.

**NOTE** Be aware of transcript variants before primer design to avoid undesigned peaks. See tools on the NCBI web site (http://www.ncbi.nlm.nih.gov/gene).

4. Select regions that do not have high homology to gene family members or regions without pseudogenes.

5. Choose Reference genes:

**NOTE** Several reference genes can be used as internal controls for normalizing gene expression level across samples.

**NOTE** The ability to choose multiple reference genes and use the calculated geometric mean of expression for these genes to normalize expression in each well is a powerful tool in the XP-PCR process.

a. Ideally, genes chosen for normalization purposes should be stably expressed in all samples under all conditions.

b. In order to determine which genes are stably expressed, one can assay the reference genes in experimental samples with a multiplex such as the Human ReferencePlex (A54657) or with one’s own custom multiplex.

c. To monitor the stability of gene expression between samples, the peak areas of the reference genes should be normalized to Kan' peak area in GeXP Data Tool and the resulting relative expression values compared between samples.

d. Those reference genes that have the most stable expression between samples should be chosen as normalization genes.

e. The greater the number of normalization genes used, the lower the chance of any one of those genes affecting the normalization factor. Therefore, if there is some fluctuation in expression of one reference gene, the effect will be diluted by the presence of the other reference genes.

6. Design amplicons with sizes in the range of 105 to 350 nt (without universal tags).

7. Ensure spacing between amplicons in the same multiplex is at least 5 nucleotides.

**Primer Design using NCBI Primer-BLAST**

2. In “PCR Template” box, enter accession number or FASTA sequence.
3. Under “Primer Parameters,” set PCR product size range as 105 to 350 nt.

**NOTE** For Primer melting temperatures, accept the default settings. Ensure that the Max Tm difference between the forward and the reverse primers is no more than 5.

**NOTE** For FFPE samples, set PCR product size range as 63 to 150.
4. In “Exon/Intron selection”:
   - For “Exon junction span” select “Primer must span an exon-exon junction.”
   - Check the box for “Intron Inclusion” and modify Min. Intron length as needed.
5. For “Primer Pair Specificity Checking Parameters”:
   - Check mark the box for “Specificity check.”
   - Select Refseq mRNA as Database; select appropriate organism.
6. Click on “Advanced parameters” hyperlink:
   - Check-mark the box for “Primer binding site may not contain known SNP”
   - Change Salt correction formula to “Schildkraut and Lifson 1965”
   - Change “Table of thermodynamic parameter” to “Breslauer et al. 1986”
7. Click on the “Get Primers” button to submit your search request.
8. Within a minute or two, the NCBI web site will return search results that contain primer pair(s) information.

Assemble a Multiplex

1. Start with designing primers for genes that require targeting to a specific region in order to detect desired number of transcript variants or to avoid pseudogene or highly homologous region among gene family members. Set PCR product size range as 105 to 350 nt to generate multiple primer pairs. Select the best primer pair based on evaluation of primer and amplicon sequences. In a Microsoft Excel worksheet, record the gene name, the primer sequence, primer positions, the Tm for the forward primer, Tm for the reverse primer, and the amplicon size (without universal tags) for the chosen primer pair. Save this file with the name of the multiplex.
2. Include primers that were previously validated for a gene target or a reference gene. Record primer and amplicon information as in step 1.
3. For the remaining gene targets in the multiplex, design amplicons with smaller sizes first, then, work toward larger amplicon sizes. To ensure a desired amplicon size is assigned for a particular gene target, set the minimum and the maximum PCR product size at the same value. For example, if 133 nt is the desired amplicon size, enter 133 both as the minimum PCR product size, and as the maximum PCR product size during primer design. Record primer and amplicon information as in step 1 for each gene target. Ensure the amplicons are at least 5 nt apart. In addition, due to the presence of the internal control peak (Kanr peak) at 325 nt, do not design any gene peak with an amplicon size (including tags) in the range of 320 to 330 nt.
4. In the Microsoft Excel worksheet, create a new column named “Amplicon size with Universal tags”. The amplicon size with universal tags is calculated by adding 37 nt to the amplicon size without universal tags.
5. In the Microsoft Excel worksheet, create a column named “reverse primer with tag”, copy and paste the reverse universal tag sequence at the 5’ end of gene-specific reverse primer sequence.
6. In the Microsoft Excel worksheet, create a column named “forward primer with tag”, copy and paste the forward universal tag sequence at the 5’ end of gene-specific forward primer sequence.
7. Save the changes to the Microsoft Excel worksheet.

NOTE Contact AB SCIEX Technical Support for sequences of universal tags.
Gene Expression

Multiplex Primer Design using NCBI Primer-BLAST

Evaluating Primer and Amplicon Sequences using NCBI BLAST Searches

1. Perform BLAST with each primer sequence to ensure it does not have significant homology to amplicon sequences for other genes in the multiplex.

2. If a primer has significant homology to a region of an amplicon of another gene in the multiplex, re-design the primer.

3. Use NCBI BLAST with species-specific searches to determine if the amplicon for each primer set contains homologous regions and if so, where those regions lie. BLASTing against the RefRNA database is helpful for homology.
   - If the homologous regions are within the reverse primer sequence, redesign the primer to target a region of low homology, particularly at the 3’ end of the primer.
   - If there is extensive homology between two genes within the same multiplex, be sure to design primers to unique regions of each gene in order to prevent cross amplification.

4. If primers were designed using primer 3, not using NCBI Primer-BLAST, evaluate primer and amplicon sequences by performing the following:
   - Examine each primer for nucleotide polymorphisms (SNP) with BLAST-SNP, especially at the 3’ end, which can lead to the preferential amplification of one allele over another. If a polymorphism is found, redesign the primer to a more conserved region.
   - Examine the amplicon sequence, generated by each set of primers, for repeat sequences.
     - Repeat sequences can lead to Taq polymerase slippage and result in stutter peaks.
     - If 5 or more consecutive single or di-nucleotide repeats or a series of such repeats in close proximity to each other are present, redesign the primers to target an amplicon without repeats.
   - BLASTing against a genomic database will help determine if any pseudogene expression may be detected.

Any set of primers that has the potential to generate an undesigned peak (UDP) within the size range of multiplex should be redesigned to prevent the production of a UDP.

Once the primer and amplicon sequences have been reviewed, update the Microsoft Excel worksheet for the multiplex. Proceed with ordering and testing the multiplex primers. Order the primers with the appropriate universal tag sequence.

IMPORTANT Do not order the KAN’ primers. They are included in the GeXP Start Kit Chemistry.

After primer multiplex is designed, various RT PCR reactions are performed with a reference RNA to evaluate the primers in the multiplex. Refer to detailed instructions on setting up RT and PCR reactions, and on optimizing multiplex in GeXP Chemistry Protocol, A29143. Once a multiplex is optimized, it is used to study gene expression in different samples. For customers who need to perform quantitative gene expression analysis, it is recommended that a standard curve be established through serial dilution of a reference RNA sample, as described in GeXP Chemistry Protocol, A29143.
7.3 Run Samples and Review Results in Fragment Analysis Result Set View

For various gene expression experiments; whether it is for evaluating primers, or for creating a standard curve or for comparing gene expression levels in different RNA samples; RT-PCR reactions are prepared as described in GeXP Chemistry Protocol, A29143. Fluorescent dye labeled DNA fragments are separated by capillary electrophoresis on the GeXP instrument. A new study is created in Fragment Analysis Module. Raw data and analyzed data are reviewed in Result Set View. Decision on downstream analysis and/or new experiment planning will be made based on the data review.

Prepare The GeXP System Before The Sample Run

Create a new database and a new project

1. From the main menu, launch the "DATABASE" module.
2. Create a new database for the interested multiplex or experiments, and make it the “Working Database”.
3. Create a new project in this database, and rename it as needed. For example, the project can be named as “Primer evaluation for Human breast cancer multiplex” or “Standard curve for Human breast cancer multiplex”.
4. Close the “DATABASE” module.

Create a new sample plate

1. From the main menu, launch the “SET UP” module.
2. Create a new sample plate for the sample run.
3. Name the samples.

NOTE For standard curve experiments, follow the instructions for naming standard and experimental samples. Standard names must start with “Std”, followed by a space character and the standard concentration in nanograms in the following format: “Std xxxng”; where xxx is any whole or decimal number. Sample names must start with “U”, followed by a space character and other information in the following format: “U HuBCRNA”.
4. Select “Frag-3” as the Separation Method.
5. Select Analysis parameters. For samples not including standard curve, use the “DefaultGeXPAnalysisParameters”. For samples containing standard curve, use “Sensitive GeXP Analysis Parameters”. The “Sensitive GeXP Analysis Parameters” are generated by making the following modification of the "DefaultGeXPAnalysisParameters": Slope threshold = 1, Relative peak height threshold = 0%.
6. Save the sample plate to the new project created in "Create a new database and a new project" above.

Prepare the GeXP instrument

1. Install capillary array and gel cartridge. Ensure the array S/N and gel lot number are entered into the system during installation.
2. Preheat capillaries to 50°C.
3. Perform Manifold Purge with 0.4 mL gel 3 times, and Gel Capillary Fill 3 times.
4. Perform an Optical Alignment.
5. Perform Monitor Baseline. Clean the array window if the baseline for any color is above 6000 counts.
6. Refresh the wetting tray with Deionized water.

**Start the Sample Run**

1. Load sample and buffer plates.
2. Select the sample plate set up created in "Create a new sample plate" on page 277.
3. Ensure the sample position in sample plate set up file matches the sample position on the actual sample plate and the buffer well position on the buffer plate.
4. Start the sample run.

**Create A New Study**

A “Study” is a set of multiple sample results together with the results of analyses performed on the group of sample results.

A new “Study” can be created from either:

- Raw Data
- Previously Analyzed Results.

For creating a new study with Raw Data, perform the following steps:

1. Select “Raw Data” by clicking on the circle next to “Raw Data.” Click on the “OK” button to continue.
   A display window will allow data file selection from a database of samples that have been “run” in a particular project. The data file selection can be made either through the List View or through the Plate View.
   The List View and Plate View tabs provide two methods of making the raw data selection. Each selection method contains the same sample information presented in different ways. Method to be selected for is based on personal preference.
   When creating a new study on a controller connected to a GeXP instrument that was used to collect the raw data, “Plate View” is used frequently due to the availability of the plate set-up information. If creating a new study on a laptop computer, it is a good idea to use “List View” since the plate set-up information may not have been imported to the laptop from the controller that was used to collect the raw data.
2. If using the “List View,” select the appropriate project name from the box next to “Project:” and then highlight the raw data files in the table named “Available.” Use the “>” button to move the selected files to the table named “Selected” on the right-hand side.
3. Click on “Next” to continue.
   A minimal of 10 data files is required if downstream analysis includes binning.
4. Select Analysis Parameters and click on “Next”

**NOTE** For samples not including standard curve, use the “DefaultGeXPAnalysisParameters”. For samples containing standard curve, use “Sensitive GeXP Analysis Parameters”.
5. Click on “Analyze” to start the data analysis.
   When the analysis is complete, the status column will indicate if the analysis succeeded
   or failed for each sample in the Study.

6. Click on “Next” to proceed.

7. Click “Finish” to complete the process of creating the new study. The data files in this
   study will be presented in a table under “Result Set View”.

8. From File | Save Study As, save the new study with a new name.

For creating a new study with previously analyzed results, perform the following steps:

1. Click on the circle next to “Analyzed Results.” Click on the “OK” button to continue.

2. Select interested data files from the appropriate project. Click the “Finish” button to
   complete the process of creating the new study. The data files in this study will be
   presented in a table under “Result Set View.”

3. From File | Save Study As, save the new study with a new name.

Review Data in Result Set View

1. In Result Set View, double-click on one of the data files to view the electropherogram of
   analyzed fragments.

   Figure 7.1 Data files selected for the new study

2. Check if all the size standard peaks are called correctly.

3. All designed gene peaks in the multiplex should be present and called appropriately.
4. Deselect D1, D2, and D3 traces and show only D4 trace for a simple view of the data.
5. Zoom-in inside the Fragment Data window to view all the peaks generated from the GeXP multiplex.

![Fragment Data Window](image)

**Figure 7.2 All gene peaks in the multiplex in zoomed-in view**

6. Click on “Raw Data” tab, review the raw data trace to ensure there is no separation anomalies such as split peaks or poor resolution.
7. Click on the “Current” tab to review the separation current trace. If there is current dip or crash present, this data file should be excluded from further analysis.
8. Click on “Inject Current” to review the injection current trace. The injection current values should be in the range of 1 to 5 microA. Some fluctuation is normal.
9. Remove data files that are unsuitable for the study. Refer to Figure 7.3. Data files can be removed by right clicking on the specific file and then clicking on “Exclude Results.”
   
   Data files contain the following situations should be removed:
   
   a. Over-range peaks that are split into two called peaks.
   b. Data with abnormal current.
   c. Data with separation anomalies such as split peaks or poor resolution of fragments.
   d. Negative controls: NTC and RTminus.
Run Samples and Review Results in Fragment Analysis Result Set View

Figure 7.3 Exclude data files from the study
7.4 Set-up Locus Tag and Allele IDs

The fragment results created through default GeXP analysis parameters in the Fragment Analysis module contain information on fragment size, peak height, and peak area. Labeling each gene peak with the gene name makes the results more meaningful to scientists working on gene expression experiments. It also facilitates sharing results with coworkers and collaborators. Labeling a gene peak with its corresponding gene name can be achieved by setting up locus tag and allele IDs through a process named “binning.” For each multiplex, setting up locus tag and allele IDs only needs to be done once on a GeXP system. After that, the allele IDs can be applied automatically to the new data generated with the same multiplex by selecting the locus tag as an STR locus tag during analysis.

Perform the following steps to setup the Locus Tag and Allele IDs:

1. From the Analysis menu, select the “New Binning Analysis...” command. Refer to Figure 7.4.

![Figure 7.4 New Binning Analysis Selection](image)

The Binning Analysis window with default Bin-Parameters will be displayed.
2. Modify the binning parameters. For example, for GeXP Human ReferencePlex use the following settings:
   - Dye: D4
   - Fragment Range: 149 to 340 (fragments size ranging from 150-338 nt)
   - Maximum Bin Width: 1
   - Maximum Data Points Per Bin: 2
   - Repeat Unit Length of Allele: 1
   - Allele Naming Convention: Alphabetic
3. Click Next. The new parameters will be applied to the scatter plot, and the bins will be assigned as specified, and the results of the binning analysis will be displayed.
Figure 7.6 New Binning Analysis Window

The New Binning Analysis is composed of the following three areas representing the selected results:

- **Bin View** -- A scatter plot showing the Fragment Size (x-axis) vs. the Relative Signal Strength (y-axis).
- **Trace View** -- Traces to be displayed are selected by clicking on a point in the bin view.
- **Allele List** -- Developed and carried over from previous views. When the analysis is completed, corrections to the allele list can be made.

4. Adjust the Minimal Relative Peak Height (Min Ref Peak Height) to exclude any data points generated from small “noise” peaks.

**NOTE** In Figure 7.6, excluded small peaks are shown as pink colored dots at the bottom of the Bin View.

5. If too many small peaks are excluded, reduce the Min Ref Peak Height from 0.01 to 0.00.
6. Double-click on “Num. Points” in the Allele List table to sort the alleles by number of data points in a bin. Bins with zero values in the “Num. Points” column are considered empty bins.

7. Select or highlight all alleles with empty bins by clicking on the gray boxes on the left side of the allele names. Then right-click on the highlighted area, and select **Remove Allele(s)** to delete alleles with empty bins.
If peak had a significant shoulder, or –A peak, then there will be a number of data points in the bin before the actual peak. These “–A” peaks should be deleted as well.

8. Sort by Nominal Size (nt) to put the alleles list back to the order of fragment size.

9. Rename the allele ID name with the corresponding gene name for each specific gene peak. Ensure the gene name is no more than 8 characters long.

10. After renaming all Allele IDs corresponding to all gene peaks in the multiplex, remove extra alleles.

11. Click on the Next button to continue.

![Figure 7.9 Rename Allele IDs During Binning Process](image)

A new display window will allow you to create the Locus Tag and Locus Name.
12. Select the **Locus Tag** tab and set the parameters as follows:
   - **Locus name** -- The Locus Tag and the Locus Name should be the same. For example, the Locus Tag and Locus Name was set up as “Human Ref” for GeXP Human ReferencePlex.
   - **Project** -- Select the project from where the data was selected for this study.
   - **Dye** -- 4
   - **Fragment length range between** -- 149 -340 (nt) for GeXP Human ReferencePlex.
   - **Repeat unit length** -- 1
   - **# of repeats in shortest Allele** -- 1
   - **Ploidy** -- 2 (default)
   - **Primer Label** -- None (default)

13. Select the **Allele ID Criteria** tab.
Gene Expression
Set-up Locus Tag and Allele IDs

Figure 7.11 Parameters for Allele ID Criteria

14. Set up the parameters as follows:
   - For Stutter Definition, Spurious Peak Detection, and +A Detection make no modifications.
   - For Confidence Interval click the check box to enable Overview system confidence interval and set the value to 0.5

At this point, the allele list can be either exported or printed. To export the allele list, right-click on the “ID” header in the Allele List table, and select “Export Grid...” and save it as a .csv file.

To print the allele list, right-click on the “ID” header in the Allele List table, and select “Print Grid...”.

15. Click on the Next button. The source data will be listed in the “Results” table. The “Summary” area at the bottom of this table lists all of the samples included in the Bin Analysis. You may view and compare individual samples manually to include or exclude individual samples, or groups of samples, from the analysis. You can also re-analyze selected samples.

16. Click on the Finish button to complete the binning process.

17. Open the “Results Set View” window.

18. Highlight all files in this study. Right-click on highlighted area. Select “Reanalyze Results...”, and then select “Using Additional/Edited Locus Tags.”
19. Select “STR” as the “Allele Identification Type.” This will activate the STR Locus Tags tab.

20. On the STR Locus Tags tab, select “Human Ref” from the “Available” list as the STR locus tag for Human Reference Plex. Move it to the “Selected” area using the “>” button.

21. Click on Next button to continue.

![Image](image_url)

**Figure 7.14 List of Sample Files Selected for Re-analysis**

22. Click on the Analyze button.

As the system proceeds with the re-analysis, the progress bar will be active and the lower dialog box will record and display the analysis log for each sample as it is re-analyzed.
Figure 7.15  Re-Analysis Is Complete

When the re-analysis is complete (Figure 7.15), the Status column will indicate pass or fail for each sample data selected for re-analysis.

23. Click the Finish button to return to the Result Set View window.

When reanalysis is completed, the initial selected results are removed from the study and replaced with the re-analyzed results.

To view the reanalyzed sample data, highlight a sample data file in the sample list and double-click it to open the data file. Refer to Figure 7.16.

Figure 7.16  Selecting Reanalyzed Sample File for Review
Review the electropherogram of the selected sample file to ensure that correct allele ID (gene name), and locus tag (Multiplex name), are tagged for each gene peak in the multiplex.

**Figure 7.17 Electropherogram after Reanalysis to Apply Allele IDs and Locus Tag**

For example, for GeXP Human ReferencePlex, a total of twenty-five alleles or gene peaks should be called with the correct allele IDs, locus tag, and labeled with the correct fragment size.
7.5 **Apply Exclusion Filter and Export Fragment Results**

After gene peaks are labeled with locus tag and allele IDs, there may be some untagged shoulder peaks or small noise peaks present. These untagged peaks can be excluded from further data analysis by applying an exclusion filter in “Fragment List” view. The fragment results can then be exported for downstream gene expression analysis.

**Apply Exclusion Filter**

Use the following Exclusion Filter in the “Study-Data-Fragments List” view to exclude untagged fragments from the sample results:

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Allele ID</td>
<td>=</td>
<td></td>
</tr>
</tbody>
</table>

Return to “Result Set View” to review the analyzed data.

**Export Fragment Results**

1. From the **File** menu, select **Transfer Fragments for GeXP…** to export fragment results.

2. From the **Transfer Fragment for GeXP…** window, type a file name (study name) for the fragment results in a designated direct path.
Apply Exclusion Filter and Export Fragment Results

3. From the drop-down list next to “Save as type,” select “.csv” as the export file format.
4. Click the Save button.
   The status of the data file exporting, along with a processing log, is displayed in a status window.
   The Transfer fragments for GeXP widow indicates when the export procedure is complete and any errors that may occur.

5. If no error observed, click the “OK” button to complete the export process.
7.6 GeXP Data Tool

The GeXP Data Tool is a software application that converts GeXP exported data into a format compatible with the GeXP Quant Tool or Microsoft Excel.

The GeXP Data Tool replaces the “eXpress Profiler” software application that was previously used with GenomeLab GeXP.

Downloading GeXP Data Tool

The GeXP Data Tool can be downloaded from the Beckman Coulter web site. Perform the following steps:

1. Launch the Internet Explorer browser and go the Beckman Coulter web site. The Beckman Coulter web site is: http://www.beckmancoulter.com
2. Click on Support and then select Software Downloads.
3. Select search by Software Name and then type in GeXP. All available software for GeXP will be displayed.
4. Select the GeXP Data Tool. Click on Download. To verify a successful download, check the download location to make sure the file is where you intended it to be placed.
5. Follow the instructions to install the GeXP Data Tool software.

Launching GeXP Data Tool

Use the Windows 7 Start menu on the GeXP instrument controller to find and then launch the GeXP Data Tool. A window similar to that shown in Figure 7-21 will be displayed.

Figure 7.21 GeXP Data Tool

GeXP Data Tool Applications

An input data file for GeXP Data Tool must have the following characteristics:

- Input date files for the GeXP Data Tool must be a valid GeXP Fragment Application file that is exported via the Transfer Fragments for GeXP selector. Refer to Figure 7-22.
An input data file allows up to 10 replicates of data per “Standard Concentrations” or “Samples.”

Figure 7.22  Select and Import a Data File

To display the input data file, perform the following steps:

1. Click the Open button. Refer to Figure 7-22.
2. Select the Transfer Fragments for GeXP file with the desired standards and/or samples.

**NOTE** Standards and samples may be present in the same file.

The opened data file is displayed in a scrollable list of tables ordered alphabetically by gene name similar to that shown in Figure 7-23.
Figure 7.23  Opened Input Data File

The data tables include the sample name, the columns of the values from replicate runs of the samples, and the mean, standard deviation and %CV of the data generated from the replicated runs.

Other characteristics of an opened input data file are as follows:

- All detected Sample names appear as a row in each Gene's table of data, even if there were no fragments associated with that Gene in a given sample.
- If there is no data for a cell in the table, that cell will contain “ND” (i.e., No Data).
- If no normalization is performed, the other values are as exported from GeXP.
- No user editing of data occurs within the GeXP Data Tool.

Characteristics of the data tables that are displayed (refer to Figure 7.23) are as follows:

- The background color differences of the borders around each gene's table of data are to enhance readability. It has no other significance.
- The check box adjacent to the gene name allows collapsing the display of individual Gene's table of data.

The data that is displayed within a data table is associated with initial input data source in the following ways:

- The data in the summary table is associated with the source Sample and Well.
- When the mouse cursor hovers over a cell with data (refer to Figure 7.24), a pop-up will occur that provides the following information:
Figure 7.24  Opened Input Data File

Normalization of Genes
The GeXP Data Tool will display a list of Genes included in the source data file, and will also allow selection of one gene from the list as the normalization gene.

The normalization is correlated by Sample name and Replicate.

To enable Normalization, perform the following steps:

1. Select the check box next to “Normalization.” Refer to Figure 7-25
2. Select one of the genes to be the basis for the normalization from the list of genes on the left side of the border area.

The default normalization gene is defined as Kan^r. An example is shown in Figure 7.25. **IMPORTANT** Normalization can be disabled by unchecking the check box next to the “Normalization.” Refer to Figure 7.26.

The area of the window (Figure 7.27) showing the list of gene names for normalization can be expanded to the width necessary to display the longest name.
The width allocation for the two regions of the display can be adjusted using the adjusting control (i.e., Splitter bar) between the regions.

Horizontal scroll bars appear as necessary to enable viewing all of the data.

---

**Figure 7.27** Horizontal scroll bars appear as needed

**Exporting A Data File to the GeXP Quant Tool**

Perform the following steps to export a Data File to the GeXP Quant Tool:

1. Click the Export button. Refer to Figure 7.27.
   
   A window similar to that shown in Figure 7.28 will be displayed.
The file extension default is .txt which is expected by the GeXP Quant Tool. The .txt file can also be opened in Microsoft Excel for further data analysis.

**NOTE** If the specified export file already exists, a dialog will be presented asking if the user wishes the existing file should be overwritten.

### Loading Additional Sample Data Files

Additional data file can be loaded onto the GeXP Data Tool that already has a data file imported. See Figure 7.22.

**NOTE** The initial and additional data files are not combined.

**IMPORTANT** Any previously processed data is replaced by the data in the additional data file.
Additional Features of the GeXP Data Tool

About Button
The About button displays software version. Refer to Figure 7.29.

Help Button
The Help button displays the instructions for use with the GeXP Data Tool. Refer to Figure 7.30.
Calculation and Formulas

Mean
The mean is calculated using the normal formulation for arithmetic mean:

\[
\text{Mean} = \frac{\text{SUM (replicate value)}}{\text{(count of replicate values)}}
\]

**NOTE** Replicate values shown as “ND” are not included in the Mean calculation.

Standard Deviation
The standard deviation is calculated using the normal formula for “corrected sample standard deviation”:

\[
\text{SD} = \sqrt{\frac{\text{SUM ((replicate value – Mean)²)}}{\text{(count of replicate value – 1)}}}
\]

**NOTE** Replicate values shown as “ND” are not included in the Standard Deviation calculation.

%CV
The %CV calculated using the following formula:

\[
\%CV = \left( \frac{\text{standard deviation}}{\text{mean}} \right) \times 100
\]

Error Messages
If there is an error opening the input file, or if the file is not in the expected format, an error message will be given and no further processing of the file will take place.

If there are any sample names which have more than 10 replicates, an error message will be given and no further processing of the file will take place.

If there are multiple values for a gene from the same replicate data (i.e., result), an error message will be given and no further processing of the file will take place.

Samples with no replicate data will be highlighted as errors with a red background. It will have a tool tip explaining the error and will be excluded from the export file.
Figure 7.32  Sample with no replicate data highlighted red

If a sample is named according to the Quant Tool convention for a Standard sample, then it will be subject to further error checking. Valid Standard sample names must be “Std”, followed by a space, followed by an integer or real number (representing the concentration), and followed by “ng” (nanograms).

If a sample Standard has no data in one gene, the corresponding standard row for all genes will be highlighted as warnings with a yellow background, will have a tool tip explaining the warning and will be excluded from the export file.

Figure 7.33  “No Data In Gene” Error Message

If any gene name begins with a digit, the entry in the Normalization gene list and the table heading for that gene will have an underscore character ( _ ) added as a prefix. The table heading for that gene will be highlighted as a warning with a yellow background. It will have a tool tip explaining the prefix to the gene name.

Figure 7.34  “Gene Name Begins With Digit” Error Message
7.7 **GeXP Quant Tool**

The Quant Tool automates quantitative analysis of data from “GeXP Data Tool.” It has functions of calculating the standard curve, determining the Gene Expression Quantization, normalizing the quantified gene expressions based on selection of one or more reference genes, and creating an Excel workbook with one worksheet for each gene in the analysis.

**Downloading GeXP Quant Tool**

The GeXP Quant Tool can be downloaded from the Beckman Coulter web site. Perform the following steps:

1. Launch the Internet Explorer browser and go the Beckman Coulter web site. The Beckman Coulter web site is: http://www.beckmancoulter.com
2. Click on Support and then select Software Downloads.
3. Select search by Software Name and then type in GeXP. All available software for GeXP will be displayed.
4. Select the GeXP Quant Tool.
5. Follow the instructions to install the GeXP Quant Tool software. There will be two links to select from for the appropriate version of the Data Tool worded as follows:
   - Install Quant Tool for use with Excel 2010 (version 1.1)
   - Install Quant Tool for use with Excel 2007 or 2003 (version 1.0)
6. Click on Download. To verify a successful download, check the download location to make sure the file is where you intended it to be placed.

**Launching GeXP Quant Tool**

Use the Windows 7 Start menu on the GeXP instrument to find and then launch the GeXP Quant Tool. When launched for the first time, a window similar to that shown in Figure 7-35 will be displayed.

![Figure 7.35 Launching the GeXP Quant Tool](image)
Once launched the main GeXP Quant Tool window, similar to the one shown in Figure 7.36 below, will be displayed.

![Figure 7.36 Main GeXP Quant Tool Window](image)

**Performing Quantitative Analysis with GeXP Quant Tool**

Perform the following steps:

1. From the “File” menu, select “Open Standards” to select and import Standard curve data for analysis. Refer to Figure 7.37.

![Figure 7.37 Selecting “Open Standards”](image)
2. Click on “Open Samples” to select and import an experimental sample file for analysis.

3. Once imported, the Standard and Sample files are listed in the “Files” area as shown in Figure 7.39.

4. In the “Processing Status” area, it shows there are a total of twenty-five genes present in this data file. The Number of Normalization Genes is labeled zero since no normalization gene is selected at this time. Refer to Figure 7.39.

5. From the “Normalize” menu, choose “Select Normalize Genes...”. Refer to Figure 7.40.
Figure 7.40 Number of genes available for processing shown

A “Select Normalization Genes” window will be displayed listing the genes that can be selected. Refer to Figure 7.41.

6. Select a normalization gene by clicking on the box next to a gene. You may select one or more genes as normalization gene(s). Click on “Ok” to continue.

Figure 7.41 List of genes that can be selected

7. Select “Run Quantitative Analysis” from the “Analyze” menu. Refer to Figure 7.42.
8. The GeXP Quant Tool will generate the standard curve for each gene in the multiplex, and calculate Gene Expression Values (GEQs) and Normalized Gene Expression Values (GEQ Norm) for each gene in the unknown samples. During the analysis process, the status of the analysis will be indicated by the status bar at the bottom of the window as well as green-colored text inside the “Processing Status” box, as shown in Figure 7.43.

Figure 7.42 Run Quantitative Analysis

9. When the analysis is completed, the status of the analysis will be changed from “Processing” to “Success.” Refer to Figure 7.44.
10. If any errors occurred, open “Help” as shown in Figure 7.45 to determine the possible root cause of the errors.

11. If the quantitative analysis is completed without any error, a Microsoft Excel file or workbook similar to the one shown in Figure 7.46 will be generated and displayed.
12. All genes and curve fit (R²) values for the standard curves are listed in the “Summary” worksheet. Refer to Figure 7.46.

As shown in Figure 7.47 below, the “Description” worksheet explains how each set of data for a gene in the multiplex is organized and displayed.
For example, as shown in Figure 7.48, results for “Gene 1” are displayed on the “Gene 1” worksheet. On the upper-left corner, data for the standard curve is listed. Note that the GeXP Quant Tool can accommodate up to 10 replicates for the same sample or the same standard concentration. On the upper-right area, the curve fitting information is provided. From the coefficient values, the standard curve equation can be deduced as:

\[ y = \text{Coeff3} \times (x^3) + \text{Coeff2} \times (x^2) + \text{Coeff1} \times (x) + \text{Coeff0} \]

In the middle of each gene worksheet in the “Samples” section, the relative signal level of each sample replicate imported from the sample file is displayed. Also, provided here are the statistics (mean values, standard deviation and %CVs). Right below the “Samples” section is the “GEQs” section listing the GEQ values derived from the sample replicates interpolated from the standard curve.

![Figure 7.48 Gene 1 worksheet in Excel Workbook](image)

As shown in Figure 7.49, near the bottom of the “Gene 1” worksheet, the GEQ Normalized values are listed. The GEQ normalized value can be derived from either one reference gene or a geometric mean of multiple reference genes, depending on how many reference genes are selected during GeXP Quant Tool analysis. In the example shown in Figure 7.49, the GEQ normalized value were derived from two reference genes: Gene 2 and Gene B. The mean GEQ Normalized values are used to create a bar chart on the worksheet. These values are the final quantitation values and are used to calculate fold change between samples.
Performing Fold Change Calculation

As shown in Figure 7.50, fold change for each gene between different samples are performed by dividing the GEQ normalized value for a “Treated” sample by the GEQ normalized value for a “Control” sample. Alternatively, fold change can be calculated by dividing the GEQ normalized value for a “Tumor” sample by the GEQ normalized value for a “Normal” sample.

\[
\text{Fold change} = \frac{\text{Treated GEQ norm value}}{\text{Control GEQ norm value}}
\]

OR

\[
\text{Fold change} = \frac{\text{Tumor GEQ norm value}}{\text{Normal GEQ norm value}}
\]

Figure 7.50 Fold Change Calculation
8.1 Data Manager Module Overview

Create, save, and modify databases.

These databases can contain any of the following data types:

- Filter Sets
- Fragment Analysis Parameters
- Fragment Results
- Methods
- Optical Scan Data
- Sample Data
- Sample Plates
- Sample Plate Results
- Sequence Analysis Parameters
- Sequence Results
- SNP Locus Tags
- Standards
- STR Locus Tags
Main Window

The main window of the Data Manager module is shown in Figure 8.1 and described in Table 8.1.

Figure 8.1 Main Window, Data Manager Module

The following table describes the items called out in Figure 8.1.

Table 8.1 Main Window, Data Manager Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Title Bar - Shows the module name (Data Manager).</td>
</tr>
<tr>
<td>B</td>
<td>Menu Bar - Provides access to all drop-down menus (<em>Menu Bar Options</em> on page 316).</td>
</tr>
<tr>
<td>C</td>
<td>Toolbar - Contains the icons that execute pre-defined functions (<em>Toolbar Icons</em> on page 321).</td>
</tr>
<tr>
<td>D</td>
<td>Display Area - Lists the files contained in the selected node.</td>
</tr>
<tr>
<td>E</td>
<td>Status Bar - Displays information concerning the current selection.</td>
</tr>
</tbody>
</table>

Menu Bar Options

The following example shows the Data Manager module's menu bar options.
The following topics describe each of these menus and their options.

**File Menu**

Click the **File** menu to display its drop-down menu, as shown in the following example.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create a new Project or Standard in a database.</td>
</tr>
<tr>
<td>New Database</td>
<td>Create a new database.</td>
</tr>
<tr>
<td>Open</td>
<td>Edit Fragment Results, Optical Scan Data, Sample Data, Sequence Results, Sample Plate Results, or Standards.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints a report of the selected item.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Define printer properties.</td>
</tr>
<tr>
<td>Print Screen</td>
<td>Send an image of the computer desktop or application window to the printer.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes items, projects, and databases.</td>
</tr>
<tr>
<td>Rename</td>
<td>Rename items, projects, and databases.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the current database and modification date as well as other sample data collection information concerning the selected item in the same format as Sequence Result Properties. See &quot;Sequence Result Properties&quot; on page 146.</td>
</tr>
<tr>
<td>Import</td>
<td>Import a file in one of the following formats:</td>
</tr>
<tr>
<td></td>
<td>* Standard Chromatogram Format v2.10 and v3.00 (*.scf)</td>
</tr>
<tr>
<td></td>
<td>* ESD (*.ESD)</td>
</tr>
<tr>
<td></td>
<td>* CEQ (<em>.cq</em>)</td>
</tr>
</tbody>
</table>

**NOTE** You must select a project in which to import the items.
Edit Menu

Click the Edit menu to display its drop-down menu, as shown in the following example.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Copies the selected item to the clipboard and removes it from its current location.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected item to the clipboard without removing it from its current location.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts one or more copied or cut items from the clipboard to other projects or databases.</td>
</tr>
<tr>
<td>Find</td>
<td>Opens a Find dialog box which you can use to locate a specific item, project, or database.</td>
</tr>
<tr>
<td>Find Next</td>
<td>Searches for the next occurrence of the item or folder defined in the Find dialog box.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all items under the selected item.</td>
</tr>
</tbody>
</table>
View Menu
Click the View menu to display its drop-down menu, as shown in the following example.

NOTE A "✓" next to an option indicates that the option is enabled.

Use the View menu to toggle the toolbar and status bar on and off, or to manage the database view.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Toggles between displaying or not displaying the toolbar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Toggles between displaying or not displaying the status bar.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Rebuilds the window display to reflect the most recent changes.</td>
</tr>
<tr>
<td>Filter By</td>
<td>Filter the list (in the right-hand side window) by the dates modified.</td>
</tr>
<tr>
<td>Database</td>
<td>Displays all items in the selected database.</td>
</tr>
<tr>
<td>Sample Run History</td>
<td>Displays a list of items that were run in a project during specified dates.</td>
</tr>
</tbody>
</table>

Tools Menu
Click the Tools menu to display its drop-down menu, as shown in the following example.

Use the Tools menu to back up, restore, and shrink a database, and to perform other database management tasks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Database</td>
<td>Creates a backup copy of the selected database.</td>
</tr>
<tr>
<td>Restore Database</td>
<td>Restores a previously backed up copy of a database to the Data Manager.</td>
</tr>
<tr>
<td>Shrink Database</td>
<td>Reduces the size of the currently selected database.</td>
</tr>
<tr>
<td>Associate Default Dye Spectra</td>
<td>Associates previously saved data with a new default dye spectra.</td>
</tr>
</tbody>
</table>
**Table 8.5 Tools Menu, Data Manager Module**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Individual ID to Subject ID</td>
<td>Converts all sample data records that use Individual IDs to records that use Subject IDs.</td>
</tr>
<tr>
<td>Administrative Tools</td>
<td>Add CeqUsers Group to SQL Login</td>
</tr>
</tbody>
</table>

**Window Menu**

Click the **Window** menu to display its drop-down menu, as shown in the following example.

![Window Menu Example]

The following table describes the Window menu options for Data Manager.

**Table 8.6 Window Menu, Data Manager Module**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window</td>
<td>Opens a new display window.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Cascades the open windows.</td>
</tr>
<tr>
<td>Tile</td>
<td>Tiles the windows in a horizontal orientation.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Automatically arranges the icons.</td>
</tr>
<tr>
<td>Close All</td>
<td>Closes all currently active windows.</td>
</tr>
<tr>
<td>⊘1</td>
<td>Brings the selected window (#1) to the foreground.</td>
</tr>
</tbody>
</table>
Help Menu
The following table describes the Help menu options.

Table 8.7 Help Menu, Data Manager Module

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Select this option to display the CE system online help. By default, the help system displays the Contents in the navigation pane, located on the left, and the introductory topic in the topic pane, located on the right. You can use the Contents to select and print specific help topics. The navigation pane also provides a Search tab and an Index tab. These tabs let you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td>Using Help</td>
<td>Select this option to display the Contents window on how to use the Windows Help system.</td>
</tr>
<tr>
<td>About GenomeLab System</td>
<td>Select this option to access software, instrument, and system information.</td>
</tr>
<tr>
<td>Beckman Coulter Home Page</td>
<td>Select this option to access the Beckman Coulter Home Page on the Internet.</td>
</tr>
</tbody>
</table>

Toolbar Icons
The Data Manager module provides one toolbar with icons that correspond to common menu items. Figure 8.2 shows this toolbar.

Figure 8.2 Toolbar, Data Manager Module

Table 8.8 Toolbar, Data Manager Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Up One Level" /></td>
<td>Up One Level - Moves the directory structure tree up one level.</td>
</tr>
<tr>
<td><img src="image2.png" alt="New" /></td>
<td>New - Create a new project or database.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Open" /></td>
<td>Open - Opens and edit standards.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Cut" /></td>
<td>Cut - Deletes selected items, projects, and databases.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Copy" /></td>
<td>Copy - Copies a selected item, project, or database to the clipboard.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Paste" /></td>
<td>Paste - Inserts one or more copied or cut items from the clipboard to selected project or database.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Print" /></td>
<td>Print - Prints a report of the selected item.</td>
</tr>
</tbody>
</table>
### Table 8.8 Toolbar, Data Manager Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="delete.png" alt="Delete Icon" /></td>
<td>Delete - Deletes selected items, projects, and databases.</td>
</tr>
<tr>
<td><img src="properties.png" alt="Properties Icon" /></td>
<td>Properties - Displays the current database and modification date and other information concerning the selected data file.</td>
</tr>
<tr>
<td><img src="backup.png" alt="Backup Database Icon" /></td>
<td>Backup Database - Creates a backup of the database.</td>
</tr>
<tr>
<td><img src="restore.png" alt="Restore Icon" /></td>
<td>Restore - Restores the database with the backup.</td>
</tr>
<tr>
<td><img src="help.png" alt="Help Topics Icon" /></td>
<td>Help Topics - Displays the CE Instrument System Help. By default, the help system displays the Contents in the navigation pane, located on the left, and the introductory topic in the topic pane, located on the right. You can use the Contents to select and print specific topics in CE Instrument System Help. The navigation pane also provides a Search tab and an Index tab. These tabs let you search for information by topic, index entry, and/or keyword.</td>
</tr>
<tr>
<td><img src="context-sensitive-help.png" alt="Context-Sensitive Help Icon" /></td>
<td>Context-Sensitive Help - Click this icon and then on a menu item to open the Help file related to the selection.</td>
</tr>
</tbody>
</table>
8.2 Data Manager Procedures

Storing Methods and Parameters
The USERTEMPLATE database stores newly created methods and parameters. This database is added when the during software installation. These methods and parameters are then included in all subsequently created databases. Use the Cut, Copy, and Paste functions to add methods and parameters to the USERTEMPLATE.

Although you cannot set the USERTEMPLATE database as the working database, you can delete it. If this database is deleted, no template will be used for subsequent databases. If you need a new template, create a new one named “USERTEMPLATE.”

Creating a Database
1. Click Data Manager on the Main Menu.
2. In the Data Manager window, right-click the GENOMELAB DBASE node and select New Database. The New Database dialog box opens.
3. Enter a name for the database and (if desired) select the Set As Working Database option (Figure 8.3).

Figure 8.3 Setting Up New Working Database in the Data Manager Module
4. Click OK.
**Setting the Working Database**

Program the database that contains all of the projects, and the location where the data are stored until another database is set as the working database.

1. Close all modules except for Data Manager module.
2. If necessary, open the Data Manager module. How do they know
3. Select the database you want to use as the working database. The system highlights the selected database in blue.
4. Select **File | Set as Working Database**. The name of the working database appears in bold to indicate that it is the working database.

**NOTE** The database size is limited to approximately 1700 megabytes. However, we recommend that you work with smaller databases to improve performance.

**Creating and Naming a Project**

To create and name a project:

1. In the Data Manager window, select and highlight the database where the project will reside then click **File | New**.
2. Highlight the new project and click **File | Rename**.
3. Enter a descriptive name for this project and press **Enter**.

**NOTE** Do not use special characters in the file name: “/ : * ? " < > |”.
4. Close the Data Manager module (**File | Exit**).

**Deleting a Project or Database**

1. In the Data Manager window, select and highlight the folder or database to be deleted.
2. Select **File | Delete**. A Data Manager dialog box opens, prompting you to confirm deletion.
3. Click **Yes** to delete the folder or database.

**NOTE** You cannot delete the working database.

**CAUTION** Deleting a folder deletes all data contained within that folder.

**Renaming a Project or Database:**

1. In the Data Manager window, select and highlight the project or database.
2. Select **File | Rename**.
3. Enter the new name for the database and press the **Enter** key.

**NOTE** Do not use special characters in the file name: “/ : * ? " < > |”.

Checking the Database Size

Check the size of each database.

1. Click Data Manager on the Main Menu.
2. Left-click the GENOMELAB DBASE node at the top of the left pane. The size for each database is shown in the right pane, as shown in Figure 8.4.

![Figure 8.4 Checking the Database Size](image)

**NOTE** If you recently removed data from the database, the size shown may not be accurate. See "Reducing the Database Size" on page 325, for more information.

Reducing the Database Size

Manually reduce the size of the database to its new (smaller) size. After removing studies or results from the database, the size of the database does not immediately reduce in size.

**NOTE** Always reduce the database size before backing it up. The database size cannot be reduced during database back up.

1. Open the Data Manager.
2. Select and highlight the database that will be reduced.
3. Select Tools | Shrink Database.
Database Management
Data Manager Procedures

Backing Up a Database

Periodic backups are essential to reduce the risk of losing data. Save backups to any folder on the local drive.

**IMPORTANT** If a database is deleted or damaged, only the data created since the last backup will be lost.

**NOTE** Shrink the database before backing up any database. For details, see "Reducing the Database Size" on page 325.

1. Open **Data Manager**.
2. Left-click the **GENOMELAB DBASE** node at the top of the left pane.
3. Select the database to be backed up. An example is shown in Figure 8.5.

![Figure 8.5 Select Database to Back Up](image)

4. Select **Tools | Backup Database**.
5. Browse to the location on the local disk where the file will be saved.

![Figure 8.6 Backup Database Dialog Box](image)
6. Accept the file name or rename it as necessary.

   **NOTE** Since databases are backed up frequently, you might want to add the date as part of the name to prevent overwriting valuable backups and to ensure accurate database recovery.

7. Click **Save**.

**Restoring the Database**

Recover a database that was previously saved using the backup procedure.

**WARNING** If you are restoring a database that has the same name as one already residing in the Database Manager, you must either restore it with a new name or delete the existing database before restoring it. **THIS Option IS NOT Recommended.**

1. Open **Data Manager**.
2. Select **Tools | Restore Database**.
3. Browse to the location on the local disk, where the backup file was saved.

4. Select and highlight the file to restore and click **Restore**.

   **NOTE** If a database with the same name exists, a warning will appear (Figure 8.8).

5. If this occurs, click **OK** and either:
   - Delete the database in the Data Manager (NOT recommended), or
   - Rename the database being restored. This is done by entering a new name in the **Database To Restore** field.
Converting Individual IDs to Subject IDs

Converts all sample data records with Individual IDs to records that use Subject IDs.

Before you begin, confirm that the present database is the Working Database. See "Setting the Working Database" on page 324 for more information.

The Subject ID attribute applies to the sequence and fragment records that were generated from the converted sample data record. Performing this action removes the Individual ID column and adds a new Subject ID column to all existing studies within the database.

1. Open Data Manager.

NOTE The working database cannot be changed while other modules are open.

2. Select and highlight the database to convert and ensure that it is the Working Database.

NOTE This option is available only for the working database.

3. Select Tools | Convert Individual ID to Subject ID. After the IDs are converted, the following message is displayed in the status bar:

Conversion Completed Successfully.

Creating New Size Standards

1. Open Data Manager.

2. Select the Default or Project folder.

3. Open the Standards sub-folder in the Default or Project folder.

4. Select File | New to create a new standard item.

5. Double-click on New Standard Item to begin defining the individual size standard fragments.

6. Select the appropriate dye label attached to the size standard fragments.

7. Input the sizes of each standard fragment with one fragment per line.

8. Select Save As to save the new Size Standard with a new name.
Exporting Database Files from the Data Manager

1. Open Data Manager.
2. Open a sequence result.
3. Select **File | Export** to open the Export dialog box.
4. Browse to the target folder, then select and highlight the file name.
5. Select the desired format in the **Save as type** field, as shown in Figure 8.9.

![Figure 8.9 Sequence Analysis Export Dialog Box](image)

6. Click **Export**.
Data Manager Export File Types

Table 8.9 describes the available export file types.

### Table 8.9 Data Manager Export Options

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCF (.scf)</td>
<td>The SCF (Standard Chromatogram Format) format stores analyzed DNA sequence or fragment data for a single sample. The format describes both public and private data sections. The well-defined public data section contains trace data points, the called sequence, or identified fragments and the positions of each called base or fragment within the trace data. A public comment section is also defined. The private section stores other information that most software packages ignore. The CE system uses the private data section to store sample data (including raw data along with current and voltage data). This may store sample data from either sequencing or fragment analysis samples can be stored. The notes and property sets are stored in the comment section. The CE system software supports SCF versions 2.1 and 3.0. (You would use this format, for instance, to export analyzed sequence data into Lasergene's SeqMan from DNASTAR Inc.). Third-party packages cannot currently view raw data, current, or voltage. However, custom applications can be written to view the data. Use the SCF format to transfer data from instrument to instrument, or to import data from third-party software into the Sequence Analysis module. If you use SCF to exchange data between instruments, you will lose informational data such as sample plate name, capillary array serial number, etc. If you want to maintain exact copies of data including header information, use the CEQ format and import and export these data using the Data Manager.</td>
</tr>
<tr>
<td>Tab-Delimited Text (.txt)</td>
<td>The tab-delimited format is valid for raw data, sequence results and fragment results. Select the <strong>Raw Data</strong> check box to include raw data, as well as current and voltage data. Select the <strong>Results Data</strong> and <strong>Results Output</strong> check boxes to include the sequence results. The format expresses the data points as text values, which can be viewed in any text editor or in Excel.</td>
</tr>
<tr>
<td>PHRED (.scf.phd.1)</td>
<td>The PHRED format produces two files — a PHRED file and an SCF file. A PHRED file is a text file composed of a SEQUENCE section containing a COMMENT and DNA section. The SEQUENCE section also contains the name of the Analyzed Result that was stored. The COMMENT section contains the file name of the associated SCF file (CHROMAT_FILE) that was produced along with the PHRED file. The values for ABI_THUMBPRINT and PHRED_VERSION are fixed text “N/A.” The values for CALL_METHOD and QUALITY_LEVELS are fixed as “CEQ SEQUENCING” and “99” respectively for the CE system. The TIME stamp is the current time at the time of export. The DNA section is composed of the base-call (always lower-case), PHRED Quality Value, and the Peak Index (data point) of the analyzed data contained within the associated SCF file. Values are separated by spaces.</td>
</tr>
</tbody>
</table>
### Table 8.9 Data Manager Export Options

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESD (.esd)</td>
<td>The ESD, electropherogram sample data, format exports raw data from the CE system to a third-party software package for analysis. This option exports only raw data and does not include any other information.</td>
</tr>
<tr>
<td>SEQ (.seq)</td>
<td>The SEQ format only applies to the sequence results portion (such as text bases) of analyzed data. You would use this format, for instance, to export data into Lasergene’s SeqMan from DNASTAR Inc.</td>
</tr>
<tr>
<td>FASTA (.fasta)</td>
<td>The FASTA format only applies to the sequence results portion (such as text bases) of analyzed data, and contains a comment line that is used to identify the data. Along with the text file, a quality values file is also generated (*.FASTA.QUAL) which lists the quality value for each base. (Quality values correspond to (-10\log_{10}[\text{error rate}])). The range for the quality values is 1 to 99. Edited and inserted bases have a value of 99. You would use this format, for instance, to export data into PHRAP. For instance, in PHRED, a quality value of 10 means 1 error in 10. A quality value of 20 means an error rate of 1 error in 100. A quality value of 30 means an error rate of 1 error in 1,000. A quality value of 40 means an error rate of 1 error in 10,000, etc. Normally PHRED would export these quality values into PHRAP. In the case of exporting from the CE system, we bypass PHRED and export directly into PHRAP.</td>
</tr>
</tbody>
</table>
### Data Manager Export Options

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
</table>
| CEQ (.cq*)   | Selecting the CEQ format, the format native to our database, exports sample data, sequence or fragment results, sample plate results, sequence or fragment analysis parameters, sample plates, methods, locus tags (fragment data only), standards (fragment data only), and optical scan data. The sample elements are automatically selected in the Export dialog box, which would export all of the associated information listed above. This format essentially takes a “snapshot” of the file and can retain all of the information belonging to that file.  

This format is available only when importing data into the Data Manager. This format can also be used when exporting data from the Sequence and the Fragment Analysis modules and the Data Manager.  

When exporting as CEQ data, the various data types are exported to files with the following extensions:  

- Sequence Analysis Parameter (CQA)  
- Sequence Investigator (CQC)  
- Fragment Size Standard (CQD)  
- Fragment Analysis Parameter (CQF)  
- Galvo Scan Data (CQG)  
- Fragment Locus Tags (CQL)  
- Method (CQM)  
- SNP Locus Tag (CQN)  
- Sequence Result (CQR)  
- Sample Data (CQS)  
- Sample Table (CQT)  
- Fragment Result (CQU)  
- Sample Table Result (CQX)  

| Remove CEQ Tracking Suffix | You may automatically remove the plate position coordinates (*.A01, *.B02, etc.) and the time/date stamp from the sample name which is normally generated by the CE system software on export. To do so, select the **Remove CEQ Tracking Suffix** check box (✓).                                                                                                                                 |
| Resolve Filename Conflicts | If the system encounters the same sample name at the destination, it usually overwrites the name (if you choose to remove the plate position coordinates and the time/date stamp which ensures a unique name). If you select the **Resolve Filename Conflicts** check box (✓), the system increments the sample names on export when it encounters duplicate names. For example, if the system encounters the duplicate sample name of “Fred” on export, it renames the file exported to “Fred_1”. |
To import files into the database:

1. Open Data Manager.
2. In the Data Manager window, browse and select the project where the imported file will reside.
3. Select File | Import. The Import dialog box opens.
4. Browse to locate the folder where the file resides.
5. Select the import format from the Files of type drop-down list.
6. Select the filename.
7. Click Import.

### Importing Database Files

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Trimming</td>
<td>Selecting this option removes the trims from the sequence before you export it and replaces internal trims with the letter “x”.</td>
</tr>
<tr>
<td>CRV (*.crv)</td>
<td>The CRV export option from the Data Manager module exports the four colors (dyes) as four separate files. When exporting batches, the resulting four files contain separate dye colors for all the samples. You can select *.CRV as an export file type for exporting fragment results from the Fragment Analysis module. Individual files are created representing individual colors:</td>
</tr>
</tbody>
</table>

- `{FileName}_D1.crv` contains dye 1 - red*
- `{FileName}_D2.crv` contains dye 2 - black*
- `{FileName}_D3.crv` contains dye 3 - green*
- `{FileName}_D4.crv` contains dye 4 - blue*  
  *Default dye colors. You may reassign the dye colors at any time.  

Batch CRV Exporting  
More than one result can be exported in a batch. If, for instance, more than one result is exported in a batch, the export generates five files; one for each dye and one to assist in determining the trace order. See the table below:  

- `{FileName}_D1.crv` contains all dye 1 results in the batch  
- `{FileName}_D2.crv` contains all dye 2 results in the batch  
- `{FileName}_D3.crv` contains all dye 3 results in the batch  
- `{FileName}_D4.crv` contains all dye 4 results in the batch  
- `{FileName}_CRV_TRACE_ORDER.txt` created for batch export files to assist in determining trace order in the CRV files  

See "Sequence Export File Types“ on page 167 for additional information on sample elements or refer to the Online Help.
Generating a Sample Run History

1. Select View | Sample Run History. The Sample Run History dialog box opens.
2. Select a Project name from the drop-down list.
3. Select Enable and enter a filtering start and end date.
4. Click Compute.
5. View the total number of runs during the specified dates in the Total Sum of Samples Run field.
6. If desired, print a report of all samples run during the specified dates by clicking the Print button.

Administrative Tools

The System Administrator can access the database without logging onto the computer as an Administrator. Before using the Administrative Tools, an Administrator must first set up a group and assign to it the users to have access to the CE system databases.

Users and Groups

Adding Users and Groups is done outside of the CE system. After creating the CEQUSERS group and adding users to it, you must activate the group within the Data Manager module.

Adding Users

1. Select Start | Settings | Control Panel | Administrative Tools | Computer Management. The Computer Management console opens (see Figure 8.10).

![Computer Management Console - Selecting Users](image)

2. In the left-pane, click on the “+” symbol next to the System Tools item to expand its contents.
3. Click on the “+” symbol next to the Local Users and Groups item to expand its contents.
4. Right-click Users and select New User. The New User dialog box opens (Figure 8.11).

![New User Dialog Box]

Figure 8.11 New Users Dialog Box

5. Enter the new User name (required) and edit the other fields as necessary.
6. Click Create.

Adding Groups

To add a new group from the Windows desktop:

2. In the left-pane, click on the “+” symbol next to the System Tools item to expand its contents.
3. Click on the “+” symbol next to the Local Users and Groups item to expand its contents.
4. Right-click Groups and select New Group. The New Group dialog box opens (Figure 8.12).
5. Enter CEQUSERS in the new **Group name** field and, if necessary, enter a description in the **Description** field.

![Figure 8.12 New Group Dialog Box](image1.png)

6. Click the **Add** button to add the users created as described in "Adding Users" on page 334. The Select Users or Groups dialog box opens. The local computer appears as the default location in the **Look in** field. If it isn’t, use the drop-down list and select the local computer.

7. Scroll down the **Name** list and select the user names created. If you created more than one user, click on the first name, press and hold the **Ctrl** key, then select any additional names to add to the group.

8. Click **Add** and then click **OK** to add the selected users to the new group.

![Figure 8.13 Select Users to the New Group](image2.png)
9. Click **Create** to save the new group.

![New Group Dialog Box](image)

**Figure 8.14 New Group Dialog Box**

**Activating the CEQUSERS Group**

After creating the CEQUSERS group and adding users to the group, you must activate the group within the Data Manager module. This is done only once and users can be added/removed at any time thereafter.

To activate the CEQUSERS group:

1. Open the Data Manager module.
2. Select **Tools | Administrative Tools | Add CeqUsers Group to SQL Login**.

All users added to the group CEQUSERS now have access to the database.
This chapter provides routine maintenance, replenishment, and biological waste disposal procedures. It provides a list of the consumable materials used in the system. It also includes some diagnostic procedures performed as needed.

9.1 Routine Maintenance

NOTE Use Figure 9.1 to locate hardware components referenced in this section.
Figure 9.1 User Accessible Hardware Components

1. Sample Access Cover (extended) 7. Manifold Access Cover
2. Capillary Access Cover (extended) 8. Gel Waste Bottle
4. Plate Holders/Sample Transport 10. Gel Pump
5. Capillary Temperature Control Cover 11. Gel Pump/Gel Cartridge Access Cover
6. Rubber Latches

Cleaning the Capillary Array

**CAUTION** The capillary array windows must kept free of any contaminants. Otherwise, high backgrounds and/or drifting baselines will occur. All background levels should be below 6000 counts.

Water used during this procedure must be fresh, distilled, deionized water (18 Mohm/cm water).

1. Select Replenish | Release Capillary Array in the Run module.
3. Open the sample access cover (Figure 9.1) and lift it to the vertical locking position.
4. Open the capillary access cover and lift it to the vertical locking position.
5. Unlatch the two rubber latches holding the capillary temperature control cover and lift it to the vertical locking position.
6. Loosen the manifold access cover captive screw (Figure 9.2), remove the cover, and set it aside.
7. Lift the eject lever (Figure 9.3) to release the array fitting.

8. Grasp the array fitting tab (Figure 9.3) and then:
   a. Pull the fitting approximately one inch away from the manifold.
   b. Touch the tip of the fitting to the bottom of the optics base plate.
   c. Hold this position and wait five seconds for the gel strand to dry.
   d. Pull the fitting away from the instrument.
   e. Use a tissue to wipe gel strands off of the instrument.
Figure 9.3 Removing/Replacing the Array Fitting

1. Guide Pins  
2. Eject Lever  
3. Array Fitting  
4. Gel Strand  
5. Optics Base Plate (bottom)  
6. Array Fitting

9. With the array fitting in hand, blow dust and debris off of the windows with compressed gas (Texwipe Microduster III, PN: TX2511).

10. Using a water-moistened swab (Texwipe Swab, PN: TX754B), gently wipe the detection window by stroking in one direction only as shown in Figure 9.4
Figure 9.4 Cleaning the Detection Window

1. Detection Window
2. Stroke in one direction ONLY!
3. Array Fitting

11. With a new water-moistened swab, repeat wiping on the other side of the window.
12. With a dry swab, gently wipe the windows to remove excess water, again repeating on the backside with a new, dry swab.
13. Blow compressed gas on the windows to remove all excess water.
   **CAUTION** Make sure not to invert the compressed gas bottle; otherwise, propellant will contaminate the capillary windows.
14. If dried gel or other debris remains on the window, repeat this procedure.
15. In the Remove Capillary dialog box (Figure 9.5), select the **Clean Capillaries** radio button and click **OK**.

![Remove Capillary Array Dialog Box](image)

**Figure 9.5 Remove Capillary Array Dialog Box**

16. While holding the array fitting tab, align the array fitting with the manifold opening and guide pins. Push the fitting into the manifold until it is completely seated against the bases of the guide pins (Figure 9.3).

17. Replace the manifold access cover and tighten the captive screw.

18. Lower the capillary temperature control cover and secure the two rubber latches.

19. Lower the capillary access cover and sample access cover to their closed/locked positions.
20. Click **Done** in the Install Capillary Array dialog box (Figure 9.6).

![Figure 9.6 Install Capillary Array Dialog Box](image)

**CAUTION** After cleaning the detection windows, perform the optical alignment procedure and monitor the baseline. If background levels are above 6000 counts, repeat the cleaning process.

### Replacing the Gel Waste Bottle For Dual Rail System

**NOTE** This procedure assumes that you are replacing a used (full) waste bottle with an empty waste bottle. Use the Run module to ensure the instrument is ready and follow these procedures to change the bottle.

1. In the Run module, select **Replenish | Empty Waste Bottle**. The following dialog box displays a warning as the instrument prepares for removal.

![Figure 9.7 Empty Waste Bottle Dialog Box - Stop](image)
2. Wait until the dialog box displays the “GO” message in green text. At this time, it is safe to open the sample access door. Leave this dialog box open.

![Empty Waste Bottle Dialog Box - Go](image)

**Figure 9.8 Empty Waste Bottle Dialog Box - Go**

3. Change the waste bottle, as described in the following steps.
4. Remove the cap from the new (empty) waste bottle.
5. Open the sample access cover (Figure 9.1) and lift to the vertical locking position.
6. With the gel waste bottle 80-90% full, remove the cap and pull the bottle out of the instrument.
7. Place the cap from the new bottle over the full waste bottle and secure.
8. Thread the new bottle onto the cap attached to the instrument and set the bottle into position.
9. Close the sample access cover.
10. Dispose of the full waste bottle according to procedures found in "Disposal of the Gel Waste Bottle" on page 379.
11. In the Empty Waste Bottle dialog box, click Done.

**Replacing the Gel Waste Bottle For Single Rail System**

**NOTE** This procedure assumes that you are replacing a used (full) waste bottle with an empty waste bottle. Replacing the gel waste bottle on the single rail system is performed through the Replenish | Replace Wetting Tray function.

Use the Run module to ensure the instrument is ready and follow these procedures to change the bottle.

1. Remove the cap from the new (empty) waste bottle.
2. Select Replenish | Replace Wetting Tray.
3. Click OK when prompted to verify this action.
4. Wait until the dialog box message displays “GO” with a green text message.
5. Open the sample access cover (Figure 9.1) and lift to the vertical locking position.
6. With the gel waste bottle 80-90% full, remove the cap and pull the bottle out of the instrument.
7. Place the cap from the new bottle over the full waste bottle and secure.
8. Thread the new bottle onto the cap attached to the instrument and set the bottle into position.
9. Close the sample access cover.
10. Click **Done** on the “Replace Wetting Tray” dialog box.
11. Dispose of the full waste bottle according to procedures found in "Disposal of the Gel Waste Bottle" on page 379.

Replacing the Wetting Tray

**Removing the Wetting Tray**

1. Select **Replenish | Replace Wetting Tray**.
2. Click **OK** when prompted to verify this action.
3. Wait until the dialog box message displays “GO” with a green text message.
4. Open the sample access cover (**Figure 9.1**) and lift to the vertical locking position.
5. Remove the sample plate and set it aside.
6. Rotate the wetting tray retainers outwards to release the wetting tray.
7. Lift the wetting tray vertically.

**Cleaning the Wetting Tray**

1. Remove the wetting tray lid assembly from the wetting tray reservoir.
2. Rinse the wetting tray lid and reservoir with deionized water and dispose of the rinse into a hazardous liquid organic waste container.
3. Dry the lid assembly and reservoir.

To fill with D.I. water:

1. Remove the lid of the wetting tray and fill it with D.I. water to the indicator line.
2. Replace the wetting tray lid.

**CAUTION** You should process no more than one 96-well plate for each wetting tray without replenishing the wetting tray.

Periodically check the liquid level in the wetting tray. The liquid level should NEVER be allowed to rise into the eight recesses of the wetting tray lid, nor drop below the fill level indicator line (9 mL minimum). The top surface of the wetting tray lid must remain clean and dry under any and all circumstances.

**Installing the Wetting Tray**

1. Select **Replenish | Replace Wetting Tray**.
2. Click **OK** when prompted to verify this action.
3. Open the sample access cover (**Figure 9.1**) and lift to the vertical locking position.
4. Rotate the wetting tray retainers outward. Insert the wetting tray into the receptacle between the Sample and Buffer plates (**Figure 9.9**) and then gently press it down into the well.
5. Rotate the wetting tray retainers inwards to lock the wetting tray in place.
NOTE If a sample plate is installed in the system, you must remove it before installing the wetting tray to allow movement of the wetting tray retainers.

Figure 9.9 Replacing the Wetting Tray

1. Front Location
2. Wetting Tray Well
3. Wetting Tray Lid
4. Wetting Tray
5. Wetting Tray Retainers
6. Sample Plate Holder

6. Close the sample access cover.
7. Click **Done** on the Replace Wetting Tray dialog box (Figure 9.10).

Figure 9.10 Replace Wetting Tray Dialog Box
9.2 Direct Control and Replenishment

The following procedures provide system replenishment procedures using the Run module's Direct Control functions. To access these functions, use the Run module’s Direct Control menu, the Replenish menu, and the selectable areas of the Direct Control window.

**NOTE** Use Figure 9.1 to locate hardware components referenced in this section.

Accessing the Direct Control Window

Launch the Run module to open the Direct Control window, then select the Direct Control tab.

![Figure 9.11 Direct Control Window](image-url)
Loading the Sample Plate and Buffer Plate For Dual Rail System

To load the sample plate or buffer plate:

1. Select **Direct Control | Access Plates**.

   ![Access Plates Dialog Box](image1)

   **Figure 9.12** Access Plates Dialog Box

   2. Click **Start**. The Capillaries Exposed dialog (**Figure 9.13**) opens.

   ![Capillaries Exposed Dialog Box](image2)

   **Figure 9.13** Capillaries Exposed Dialog Box

   3. Wait until the dialog box message displays “GO” with a green text message.

   4. Open the sample access cover (**Figure 9.1**) and lift to the vertical locking position.

**Loading the Sample Plate**

1. Make sure the Wetting Tray is installed or perform the procedure "Installing the Wetting Tray" on page 347, then return here.
2. Align the sample plate guide pin with the notched corner of the sample plate and gently lower the plate into position (Figure 9.14).

![Figure 9.14 Loading the Sample Plate](image)

Figure 9.14 Loading the Sample Plate

1. Sample Plate  
2. Wetting Tray Retainers  
3. Sample Plate Holder  
4. Sample Plate Notched Edge  
5. ALIGN together  
6. Sample Plate Guide Pin

3. When finished positioning the sample and buffer plates, close the Sample Access Cover and then select the position from which the plates were loaded (left or right).

4. Click the **Load** on the **Capillaries Exposed** dialog box (Figure 9.15).

**CAUTION** The separation gel within the capillaries will dry out if the capillaries are left exposed to the air for more than 15 minutes.

![Figure 9.15 Capillaries Exposed Dialog Box](image)

**Figure 9.15 Capillaries Exposed Dialog Box**

**Loading the Buffer Plate and Evaporation Cover**

1. Align the notched corner of the buffer plate with the alignment line on the buffer plate holder (Figure 9.16).
2. Gently push the buffer plate towards the front of the instrument and then set the plate into the transport.

3. At the rear of the buffer plate holder, align the buffer evaporation cover guide pin with the buffer evaporation cover alignment notch and then gently lower the cover over the buffer plate.

![Figure 9.16 Loading the Buffer Plate and Buffer Evaporation Cover](image)

- **1. Front Location**
- **2. Buffer Evaporation Cover**
- **3. Buffer Plate**
- **4. Buffer Evaporation Cover Alignment Notch**
- **5. Wetting Tray Retainers**

4. When finished positioning the sample and buffer plates, close the Sample Access Cover and then select the position from which the plates were loaded (left or right).

5. Click **Load** on the **Capillaries Exposed** dialog box (Figure 9.15).
Loading the Sample Plate and Buffer Plate For Single Rail System

To load the sample plate or buffer plate:

1. Select **Direct Control | Unload Plates** from the menu.

   ![Unload Plates Dialog Box](image)

   **Figure 9.17 Unload Plates Dialog Box**

2. Click **Unload**. The Capillaries Exposed dialog (Figure 9.18) opens.

   ![Capillaries Exposed Dialog Box](image)

   **Figure 9.18 Capillaries Exposed Dialog Box**

3. Open the sample access cover and lift to the vertical locking position.
   - If Sample Plate was selected, skip to "Loading the Sample Plate".
   - If Buffer Plate was selected, skip to "Loading the Buffer Plate and Evaporation Cover".

**Loading the Sample Plate**

1. Make sure the Wetting Tray is installed or perform the procedure "Installing the Wetting Tray" on page 347, then return here.
2. Align the sample plate guide pin with the notched corner of the sample plate and gently lower the plate into position (Figure 9.19).

![Figure 9.19 Loading the Sample Plate](image)

**Figure 9.19 Loading the Sample Plate**

1. Sample Plate  
2. Wetting Tray Retainers  
3. Sample Plate Holder  
4. Sample Plate Notched Edge  
5. ALIGN together  
6. Sample Plate Guide Pin

3. When finished positioning the sample and buffer plates, and close the Sample Access Cover.

4. Click the **Load** on the **Capillaries Exposed** dialog box (Figure 9.20).

**CAUTION** The separation gel within the capillaries will dry out if the capillaries are left exposed to the air for more than 15 minutes.

![Figure 9.20 Capillaries Exposed Dialog Box](image)
Loading the Buffer Plate and Evaporation Cover

1. Align the notched corner of the buffer plate with the alignment line on the buffer plate holder (Figure 9.21).
2. Gently push the buffer plate towards the front of the instrument and then set the plate into the transport.
3. At the rear of the buffer plate holder, align the buffer evaporation cover guide pin with the buffer evaporation cover alignment notch and then gently lower the cover over the buffer plate.

4. When finished positioning the sample and buffer plates, and close the Sample Access Cover.
5. Click Load on the Capillaries Exposed dialog box (Figure 9.20).
Specifying Capillary Temperature

1. Select **Direct Control | Capillary Temperature**. The Capillary Temperature dialog box opens, as shown in the following example.

![Capillary Temperature Dialog Box](image)

2. Enter a capillary holding temperature value in degrees centigrade.
3. Select **Wait for temperature to be reached**.
4. Click **Start**.

Denaturing a Sample

1. Select **Direct Control | Denature Samples**. The Denature Samples dialog box opens.

![Denature Samples Dialog Box](image)

2. Enter a time duration in seconds.
3. Identify the position of the **Sample Set**.
4. Click **Denature**.

Injecting a Sample

1. Select **Direct Control | Inject**. The Inject dialog box opens.
Figure 9.24 Inject Dialog Box

2. Enter a value for the voltage in kV.
3. Enter a time duration in seconds.
4. Identify the position of the sample using the Sample Set spin controls.
5. Select Inject.

Performing a Separation

1. Select Direct Control | Separate. The Separate dialog box opens.

Figure 9.25 Separate Dialog Box

2. Enter a value for the voltage in kV.
3. Enter a time duration in minutes.
4. Identify the position of the buffer using the Buffer Set spin controls.
5. Select Separate.

NOTE Data will not be saved.

Replenishing the Capillaries with Gel

1. Select Direct Control | Gel Capillary Fill. The Gel Capillary Fill dialog box opens.

Figure 9.26 Gel Capillary Fill Dialog Box

2. Select the Buffer Plate or Wetting Tray radio button to identify the position where waste will be expelled from the capillaries.
   - If you select Buffer Plate, use the Buffer Plate spin controls to identify the waste position in the buffer plate, then click Fill.
   - If you select Wetting Tray, click Fill.
Purging the Manifold


![Manifold Purge Dialog Box]

Figure 9.27 Manifold Purge Dialog Box

2. Enter a volume in milliliters (mL) (0.1mL default).
3. Enter the number of cycles.
4. Click Purge.

Performing an Optical Alignment

To align the lasers with the detection windows of the eight capillaries:

1. Select Direct Control | Optical Alignment. The Optical Alignment dialog box opens.

![Optical Alignment Dialog Box]

Figure 9.28 Optical Alignment Dialog Box

2. Save the alignment data:
   a. Select the Autosave check box.
   b. Enter a name in the Name field.
   c. Select a Project from the drop-down menu.
3. Select Align.

**NOTE** Prior to performing an Optical Alignment, it is advisable to purge the Array Manifold and fill the capillaries with fresh gel (in that order). See "Purging the Manifold" on page 358 and "Replenishing the Capillaries with Gel" on page 357.

Viewing Capillary Information

To view or change capillary information:

![Capillary Information Dialog Box](image)

Figure 9.29 Capillary Information Dialog Box

2. View the following information:
   - **Part Number**: Displays the part number of the installed capillary array.
   - **Serial Number**: Displays the serial number of the installed capillary array. (The serial number is used to track the capillary array along with the samples that have used the array.)
   - **Date Installed**: Displays the date the capillary array was installed.
   - **Time Installed**: Displays the time the capillary array was installed.
   - **Number of Runs**: Specify the desired number using the spin-control. (Set more than the recommended number of separations to be performed before the system alerts you that the recommended number of runs has been exceeded.)
   - **Days on instrument**: Specify the number of days on the instrument using the spin-control. (This allows the capillary array to reside on the instrument longer than the recommended length of time before the system alerts you that the recommended number of days on the instrument has been exceeded.)
   - **Advanced**: Click this button to display the Capillary Advanced Information dialog box. This dialog box displays the length and diameter of the installed capillary array based on the part number entered in the New Capillary Array dialog box. The fields are read-only and cannot be edited. Click **OK** to enter the information and close the dialog box.

3. When finished, click **OK** to close the windows.
Viewing Gel Information

1. Select **Replenish | Gel Cartridge/Buffer Information**. The Gel Cartridge/Buffer Information dialog box opens.

   ![Gel Cartridge/Buffer Information Dialog Box](image)

   **Figure 9.30** Gel Cartridge/Buffer Information Dialog Box

2. Use the Gel Cartridge/Buffer Information dialog box (Figure 9.30) to view the following information:
   - **Part Number**: Displays the part number of the installed gel cartridge.
   - **Lot Number**: Displays the lot number of the installed gel cartridge. (The lot number is used to track the gel lot along with the separations that have used the gel.)
   - **Gel Name**: The name of the gel.
   - **Date Installed**: Displays the date the gel cartridge was installed.
   - **Time Installed**: Displays the time the gel cartridge was installed.
   - **Hours on Instrument**: Displays the number of hours that the gel cartridge has remained on the instrument.

3. When finished, select **OK** to close the window.

Viewing or Changing Buffer Information

1. Select **Replenish | Gel Cartridge/Buffer Information** from the Run Module menu bar.

2. Use the Gel Cartridge/Buffer Information dialog box (see the figure above) to view or change the buffer lot number.

   **NOTE** The buffer lot number can only be changed when the instrument is not performing a separation.

Removing and Replacing the Capillary Array

   **CAUTION** Take care when installing/removing the capillary array to prevent damage and maintain low background signals. Clean all gel residues thoroughly.

   **NOTE** This procedure assumes that an expended capillary array is being replaced with a new capillary array.
1. Select **Replenish | Release Capillary Array**. After the system prepares for release of the capillary array, the **Remove Capillary Array** dialog box opens.

![Figure 9.31 Remove Capillary Array Dialog Box](image)

2. Open the Sample Access Cover (Figure 9.1) and lift to the vertical locking position.
3. Open the Capillary Access Cover and lift to the vertical locking position.
4. Unlatch the two rubber latches holding the Capillary Temperature Control Cover and lift to the vertical locking position.
5. Loosen the Manifold Access Cover captive screw (Figure 9.32), remove the cover and set it aside.
6. Loosen the two plenum assembly captive screws (Figure 9.33), pull the plenum assembly straight back and away from the instrument and set it aside.

**CAUTION** Slowly remove the plenum assembly as the electrode block may disengage from its mounting posts and become damaged.
7. Lift the plenum assembly (Figure 9.33) to release the Array Fitting.

8. Grasp the Array Fitting tab (Figure 9.33) and then:
   a. Pull the fitting approximately one inch out of the manifold.
   b. Touch the tip of the fitting to the bottom of the optics base plate.
   c. Hold and wait five seconds for the gel strand to dry.
   d. Pull the fitting away from the instrument.
   e. Wipe gel strands off of the instrument using a damp tissue.

**NOTE** Note the number of runs and days on the instrument for this capillary array for reference. If this capillary array is to be re-installed, this information is necessary. A label has been provided on the back of the array packaging container so that this information may be recorded.
9. Grasp the electrode block tab (Figure 9.34) and pull the block out and away from the instrument. If removal of the block tab is difficult, use the eject lever to assist.

10. From the Remove Capillary Array dialog box (Figure 9.31), select the Replace Capillary Array option and click OK.
Figure 9.35 Removing/Replacing the Electrode Block

1. Guide Block Pins  
2. Electrode Block

**CAUTION** Always grip the capillary array fitting near the end during removal or installation of the tip cap to prevent flexing and possible breakage of the capillary array as shown below.

Figure 9.36 Array Fitting
11. While holding the Array Fitting tab (of the new capillary array), align the Array Fitting (Figure 9.36) with the manifold opening and guide pins. Push the fitting into the manifold until it is completely seated against the bases of the Guide Pins. Make sure that the fitting tab is placed downward when inserting the capillary array into its slot.

12. While holding the electrode block tab, align the electrode block (Figure 9.35) with the guide block pins and gently push it in until resistance is met. (The resistance is from the spring-loaded contacts.)

13. When installing the capillary array, carefully route the capillaries through the hole in the plenum assembly (Figure 9.33) and straight across into the guide block pins (Figure 9.35).

NOTE When reinstalling the plenum assembly, gently gather the capillaries between your thumb and forefinger to make sure they pass through the hole in the plenum assembly without any constriction.

14. Replace the plenum assembly and tighten the two captive screws (Figure 9.37).

15. Replace the manifold access cover and tighten the captive screw (Figure 9.32).

16. Lower the capillary temperature control cover and secure the two rubber latches.

17. Lower the capillary access cover and sample access cover to their locking positions.

- If you are installing a new capillary array, in the Install Capillary Array dialog box (Figure 9.38), select the correct part number, enter the serial number, click Set to New, then click Done. The number of runs and days on instrument will revert to “0.”

- If you are installing the previous capillary array, do not change the serial number, number of runs, or the number of days on the instrument as they will be correct.

- If you are installing a capillary array that was previously used, but not the last capillary array on the instrument, enter its part number (if applicable) serial number, and adjust the number of runs and the previous cumulative days on the instrument. Then click Done.
NOTE Note the number of runs and days on the instrument for this capillary array for reference.

Figure 9.38 Install Capillary Array Dialog Box

18. The Confirm Capillary Array Selection dialog will appear. Read it and make the selection Yes to continue, or No to abort the capillary installation.

Removing and Replacing a Gel Cartridge/Gel Pump Plug For Dual Rail System

CAUTION Care must be exercised when installing/removing a gel cartridge due to the viscosity of the gel mixture.

NOTE This procedure assumes that an expended gel cartridge is being replaced with a fresh gel cartridge or that a used gel cartridge is being removed (for storage purposes) and being replaced with the gel pump plug.

1. Select Replenish I Release Gel Cartridge. When the system is ready to release the gel cartridge, the Release Gel Cartridge dialog box will be displayed. Wait until the lead screw is completely disengaged.

2. Open the Gel Pump/Gel Cartridge Access Cover by gently pushing in on the top of the cover. (The cover is spring-loaded and will pop open.)

3. Pull on the Cartridge Locking Lever. (The barrel will swing outwards to approximately a 90° angle from its locked position.)
4. Grasp the wings of the gel cartridge/gel pump plug and pull it out of the barrel.

**NOTE** Always note the lot number and the hours on the instrument for a gel cartridge if you are planning to use it for more than one session.

5. If necessary, use a tissue to wipe gel strands off of the instrument.
6. Remove any air pockets from the gel cartridge by grasping the cartridge wings between your first two fingers, and pressing the plunger with your thumb until a small amount of gel is pushed out of the cartridge tip.

7. Insert the new cartridge or the gel pump plug into the barrel and lock it into position by aligning the cartridge wings with the cartridge holder and pushing in.

8. Push the cartridge locking lever towards the back of the instrument (approximately a 90° angle) into its locked position.

9. Close the Gel Pump/Gel Cartridge Access Cover.

10. In the Remove Gel Cartridge dialog box (Figure 9.41):
    - Click **Install Cartridge** to indicate that a gel cartridge was installed.
    - OR
    - Click **Install Plug** to indicate that the gel pump plug (or empty cartridge) was installed.
11. If **Install Plug** was selected in step 10, proceed to step 12.

   If **Install Cartridge** was selected in step 10, use the Install Gel Cartridge dialog box (Figure 9.42) to enter the following information:
   
   a. If you are installing a new gel cartridge, click **New**. The system will automatically update the date and time installed and set the **Hours on Instrument** to “0.”
   
   b. Next, enter the lot number.
   
   c. If you are installing a used Gel Cartridge, select **Used**.
      
      - If you are installing the previous gel cartridge, do not change the lot number, or the hours on the instrument, as they will be correct.
      
      - If you are installing a previously used gel cartridge, but it was not the last one on the instrument, enter its part number and/or lot number, and adjust the hours to properly reflect the hours this cartridge has been on the instrument.
   
   d. Click **Done** on the Install Gel Cartridge dialog.

   **NOTE** Always note the lot number and the hours on the instrument for a gel cartridge if you are planning to use it for more than one session. The lot number is an alphanumeric text box for your own identification purposes.

12. Dispose of the used tissue and spent gel cartridge in accordance with the procedure. See "Biological Waste Disposal" on page 376.
Removing and Replacing a Gel Cartridge/Gel Pump Plug For Single Rail System

**CAUTION** Care must be exercised when installing/removing a gel cartridge due to the viscosity of the gel mixture.

**NOTE** This procedure assumes that an expended gel cartridge is being replaced with a fresh gel cartridge or that a used gel cartridge is being removed (for storage purposes) and being replaced with the gel pump plug.

1. Select **Replenish | Release Gel Cartridge**. When the system is ready to release the gel cartridge, the Release Gel Cartridge dialog box will be displayed. Wait until the lead screw is completely disengaged.
2. Open the Gel Pump/Gel Cartridge Access Cover by gently pushing in on the top of the cover. (The cover is spring-loaded and will pop open.)
3. Pull on the Cartridge Locking Lever. (The barrel will swing outwards to approximately a 90° angle from its locked position.)

---

**Figure 9.43 Removing/Replacing the Gel Cartridge**

1. Gel Pump/Gel Cartridge Access Cover
2. Cartridge Locking Lever (closed)
3. Cartridge Barrel
4. Cartridge Locking Lever (open)
5. Cartridge Barrel
4. Grasp the wings of the gel cartridge/gel pump plug and pull it out of the barrel.

**NOTE** Always note the lot number and the hours on the instrument for a gel cartridge if you are planning to use it for more than one session.

5. If necessary, use a tissue to wipe gel strands off of the instrument.

![Diagram of the gel cartridge and gel pump plug](image)

**Figure 9.44 Removing/Replacing the Gel Cartridge - Continued**

6. Remove any air pockets from the gel cartridge by grasping the cartridge wings between your first two fingers, and pressing the plunger with your thumb until a small amount of gel is pushed out of the cartridge tip.

7. Insert the new cartridge or the gel pump plug into the barrel and lock it into position by aligning the cartridge wings with the cartridge holder and pushing in.

8. Push the cartridge locking lever towards the back of the instrument (approximately a 90° angle) into its locked position.

9. Close the Gel Pump/Gel Cartridge Access Cover.

10. In the Remove Gel Cartridge dialog box (*Figure 9.45*):
    
    - Click **Install Cartridge** to indicate that a gel cartridge was installed.
    
    OR
    
    - Click **Install Plug** to indicate that the gel pump plug (or empty cartridge) was installed.
11. If **Install Plug** was selected in *step 10*, proceed to *step 12*.

   If **Install Cartridge** was selected in *step 10*, use the Install Gel Cartridge dialog box
   (**Figure 9.46**) to enter the following information:
   a. If you are installing a new gel cartridge, click the **Set to New** button, select the part
      number from the drop-down menu, enter the lot number, and then click **OK**. The  
      system will automatically update the date and time installed and set the **Hours on**  
      **Instrument** to “0.”
   b. If you are installing the previous gel cartridge, do not change the lot number, or the
      hours on the instrument, as they will be correct.
   c. If you are installing a used Gel Cartridge:
      • If it is the previous gel cartridge, do not change the lot number, or the hours on
        the instrument, as they will be correct.
      • If it is the previously used gel cartridge, but it was not the last one on the
        instrument, enter its part number and/or lot number, and adjust the hours to
        properly reflect the hours this cartridge has been on the instrument.
   d. Click **Done** on the Install Gel Cartridge dialog.

   **NOTE** Always note the lot number and the hours on the instrument for a gel cartridge if you are planning to
   use it for more than one session. The lot number is an alphanumeric text box for your own identification
   purposes.

   **CAUTION** If the gel cartridge has been on the instrument for more than 72 hours, it is likely that the gel will
   produce undesirable results.

**Figure 9.46 Install Gel Cartridge Dialog Box**

Dispose of the used tissue and spent gel cartridge in accordance with the procedure. See
*"Biological Waste Disposal" on page 376.*
Removing the Manifold Plug

The Manifold Plug is installed during shipping and when the instrument is not in use, to prevent drying of gel.

NOTE This procedure assumes that the Manifold Plug is being removed in preparation for Capillary Array installation.

1. Select **Replenish | Release Capillary Array** from the Run Module main menu.
3. Open the Sample Access Cover (Figure 9.1) and lift it to the vertical locking position.
4. Open the Capillary Access Cover and lift it to the vertical locking position.
5. Unlatch the two rubber latches holding the Capillary Temperature Control Cover and lift it to the vertical locking position (Figure 9.47).
6. Loosen the Manifold Access Cover captive screw, remove the cover and set it aside.

---

**Figure 9.47 Manifold Access Cover**

1. Capillary Temperature Control Cover
2. Plenum Assembly
3. Manifold Access Cover
4. Captive Screw
5. Manifold Access Cover (removed)
7. Lift the Eject Lever to release the Manifold Plug.
8. Grasp the Manifold Plug tab (Figure 9.48) and then:
   a. Pull the plug approximately one inch out of the manifold.
   b. Touch the tip of the plug to the bottom of the Optics Base Plate.
   c. Hold and wait five seconds for the gel strand to dry.
   d. Pull the plug out and set it aside for future use.
   e. Wipe gel strands off of the instrument using a damp tissue.

![Figure 9.48 Removing the Manifold Plug](image)

9. Click **OK** on the Remove Manifold Plug dialog box.
10. To install the capillary array, see "Removing and Replacing the Capillary Array" on page 360.
9.3 Biological Waste Disposal

**WARNING** The GenomeLab Genetic Analysis system has been designed to minimize exposure to hazardous chemicals and biological waste. However, care must still be exercised when removing used chemicals and biological samples from the instrument. The information below provides the minimum protocols to use when handling hazardous chemicals and biological waste.

**Disposal of Formamide from the Sample Plate**

**Multi-Channel Pipettor**

**Table 9.3-1**

<table>
<thead>
<tr>
<th>WARNING</th>
<th>When performing this procedure, use an exhaust ventilation unit that meets TLV requirements.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Aspirate 40 µL of formamide from the thermo-cycling plate.</td>
</tr>
<tr>
<td></td>
<td>2. Dispense the formamide into a hazardous liquid organic waste container.</td>
</tr>
<tr>
<td></td>
<td>3. After all wells are clear, allow the empty plate to sit in the ventilation unit for 24 hours.</td>
</tr>
</tbody>
</table>

**Table 9.3-2**

| WARNING | Dispose of formamide in accordance with all applicable federal, state, and local environmental regulations concerning hazardous liquid waste. |

**Bulk Disposal**

**Table 9.3-3**

<table>
<thead>
<tr>
<th>WARNING</th>
<th>When performing this procedure, use an exhaust ventilation unit that meets TLV requirements.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Using a 1L side arm flask as a trap, connect the trap to a vacuum.</td>
</tr>
<tr>
<td></td>
<td>2. Attach a pipette to the trap using chemical resistant tubing.</td>
</tr>
<tr>
<td></td>
<td>3. Aspirate the formamide from each well and dispose of it in a hazardous liquid organic waste container.</td>
</tr>
<tr>
<td></td>
<td>4. After complete removal of all formamide from the plates, allow the empty plate to sit in the ventilation unit for 24 hours.</td>
</tr>
<tr>
<td></td>
<td>5. Dispose of the plate in a solid waste container.</td>
</tr>
</tbody>
</table>

**Table 9.3-4**

| WARNING | Dispose of formamide in accordance with all applicable federal, state, and local environmental regulations concerning hazardous liquid waste. |


## Disposal of Buffer/Gel Mixture from the Buffer Plate

### Multi-Channel Pipettor

**Table 9.3-5**

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>When performing this procedure, use an exhaust ventilation unit that meets TLV requirements.</td>
</tr>
<tr>
<td>1. Aspirate 400 µL of buffer/gel mixture from the 96-well plate.</td>
</tr>
<tr>
<td>2. Dispose the buffer/gel mixture into a hazardous liquid organic waste container.</td>
</tr>
<tr>
<td>3. Rinse the plate wells with water and dispose of the rinse in the liquid waste container.</td>
</tr>
<tr>
<td>4. After all wells are clear, allow the empty plate to sit in the ventilation unit for 24 hours.</td>
</tr>
<tr>
<td>5. Dispose of the plate in a solid waste container.</td>
</tr>
</tbody>
</table>

### Table 9.3-6

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dispose of buffer/gel mixture in accordance with all applicable federal, state, and local environmental regulations concerning hazardous liquid waste.</td>
</tr>
</tbody>
</table>

### Bulk Disposal

**Table 9.3-7**

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>When performing this procedure, use an exhaust ventilation unit that meets TLV requirements.</td>
</tr>
<tr>
<td>1. Using a 1L side arm flask as a trap, connect the trap to a vacuum.</td>
</tr>
<tr>
<td>2. Attach a pipette to the trap using chemical resistant tubing.</td>
</tr>
<tr>
<td>3. Aspirate the formamide from each well and dispose of it in a hazardous liquid organic waste container.</td>
</tr>
<tr>
<td>4. After complete removal of all formamide from the plates, allow the empty plate to sit in the ventilation unit for 24 hours.</td>
</tr>
<tr>
<td>5. Dispose of the plate in a solid waste container.</td>
</tr>
</tbody>
</table>
Maintenance and Diagnostics

Biological Waste Disposal

Table 9.3-8

<table>
<thead>
<tr>
<th>WARNING</th>
<th>Dispose of buffer/gel mixture in accordance with all applicable federal, state and local environmental regulations concerning hazardous liquid waste.</th>
</tr>
</thead>
</table>

Table 9.3-9

<table>
<thead>
<tr>
<th>WARNING</th>
<th>After removing the expended capillary array from the instrument, dispose of it in a solid hazardous waste container.</th>
</tr>
</thead>
</table>

Disposal of the Gel Cartridge

Table 9.3-10

<table>
<thead>
<tr>
<th>WARNING</th>
<th>After removing the expended gel cartridge from the instrument, use a lab spatula or wooden dowel to push any remaining gel into a liquid hazardous waste container. Dispose of the empty cartridge in a solid hazardous waste container.</th>
</tr>
</thead>
</table>

Disposal of D.I. Water/Gel Mixture from the Wetting Tray

Table 9.3-11

<table>
<thead>
<tr>
<th>WARNING</th>
<th>When performing this procedure, use an exhaust ventilation unit that meets TLV requirements.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Pour the D.I. water/gel mixture into a hazardous liquid organic waste container.</td>
</tr>
<tr>
<td></td>
<td>2. Rinse the Wetting Tray with water and dispose of the rinse in the liquid waste container.</td>
</tr>
<tr>
<td><strong>Table 9.3-12</strong></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td><strong>WARNING</strong></td>
<td>Dispose of D.I. water/gel mixture in accordance with all applicable federal, state, and local environmental regulations concerning hazardous liquid waste.</td>
</tr>
</tbody>
</table>

**Disposal of the Gel Waste Bottle**

<table>
<thead>
<tr>
<th><strong>Table 9.3-13</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WARNING</strong></td>
<td>When performing this procedure, use an exhaust ventilation unit that meets TLV requirements. Dispose of buffer/gel mixture in accordance with all applicable federal, state, and local environmental regulations concerning hazardous liquid waste.</td>
</tr>
</tbody>
</table>
### 9.4 Consumable Items List

Table 1 provides a list of the required consumable items for the Sequence Analysis System.

**Table 1 Required Consumables for Performing Sequence Analysis**

<table>
<thead>
<tr>
<th>Item</th>
<th>P/N</th>
<th>QTY</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Methods Development Kit</td>
<td>608000</td>
<td>1</td>
<td>Dye Terminator Cycle Sequencing Kit for 96 reactions. Includes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- DNA polymerase</td>
</tr>
<tr>
<td>DTCS Quick Start Kit</td>
<td>608120</td>
<td>1</td>
<td>Dye Terminator Cycle Sequencing Kit for 96 reactions. Includes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- DTCS Quick Start Master Mix</td>
</tr>
<tr>
<td>Separation Gel - LPA I</td>
<td>391438</td>
<td>1</td>
<td>20 mL of gel in CE system compatible container. Sufficient to run two</td>
</tr>
<tr>
<td>Separation Gel - LPA I</td>
<td>608010</td>
<td>1</td>
<td>10 mL gel that is used for GeXP single rail systems. Sufficient to run</td>
</tr>
<tr>
<td>Separation Buffer</td>
<td>608012</td>
<td>1</td>
<td>Each container has a screw top and pour tip. The container has enough</td>
</tr>
<tr>
<td>DNA Separation Capillary Array 33-75B</td>
<td>608087</td>
<td>1</td>
<td>Eight capillaries, 75 μm i.d., 33 cm long, 200 o.d. complete with</td>
</tr>
<tr>
<td>Buffer Plates</td>
<td>609844</td>
<td>Box</td>
<td>Package of 100 flat-bottom polystyrene plates, non sterile, without lids.</td>
</tr>
<tr>
<td>Sample Plates</td>
<td>609801</td>
<td>Box</td>
<td>Package of 25 V-bottom thermal cycler-compatible polypropylene plates with 200 μL volume capacity. Required for use as the CE system sample plate. 25 Plates/Box</td>
</tr>
</tbody>
</table>
Table 2 provides a list of the required consumable items for the Fragment Analysis system.

Table 2 Required Consumables for Performing Fragment Analysis

<table>
<thead>
<tr>
<th>Item</th>
<th>P/N</th>
<th>QTY</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Separation Capillary Array 33-75B</td>
<td>608087</td>
<td>1</td>
<td>Eight capillaries, 75 μm i.d., 33 cm long, 200 o.d. complete with electrode block and detector array fitting. Ready for installation into the GenomeLab GeXP.</td>
</tr>
<tr>
<td>Separation Gel - LPA I</td>
<td>391438</td>
<td>1</td>
<td>20 mL of gel in CE system compatible container. Sufficient to run two 96 well plates.</td>
</tr>
<tr>
<td>Separation Gel - LPA I</td>
<td>608010</td>
<td>1</td>
<td>10 mL gel that is used for GeXP single rail systems. Sufficient to run one 96 well plate.</td>
</tr>
<tr>
<td>Separation Buffer</td>
<td>608012</td>
<td>1</td>
<td>Each container has a screw top and pour tip. The container has enough buffer (30 mL) to fill a CE System 96-well, flat bottom Buffer Plate. (Each well being ¾ full.) 4/Pack</td>
</tr>
<tr>
<td>DNA Size Standard Kit - 80</td>
<td>608395</td>
<td>1</td>
<td>Contains fragments of 13 and 88 nucleotides designed to accommodate a wide range of sizes for multiplexed and poolplexed SNP fragments.</td>
</tr>
<tr>
<td>DNA Size Standard Kit - 400</td>
<td>608098</td>
<td>1</td>
<td>DNA size standard for analysis of fragments up to 400 nucleotides. Includes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mineral Oil</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• DNA fragments of the following sizes labeled with CE system WellRED fluorescent dye: 60, 70, 80, 90, 100, 120, 140, 160, 180, 190, 200, 220, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 440, 460, 480, 500, 520, 540, 560, 580, 600, 620, and 640 nucleotides</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Sufficient for 96 fragment analysis separations.</td>
</tr>
<tr>
<td>DNA Size Standard Kit - 600</td>
<td>608095</td>
<td>1</td>
<td>DNA size standard for analysis of fragments up to 600 nucleotides. Includes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mineral Oil</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• DNA fragments of the following sizes labeled with CE system fluorescent dye: 60, 70, 80, 90, 100, 120, 140, 160, 180, 190, 200, 220, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 440, 460, 480, 500, 520, 540, 560, 580, 600, 620, and 640 nucleotides</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Sufficient for 96 fragment analysis separations.</td>
</tr>
<tr>
<td>SNPStart Kit</td>
<td>A23201</td>
<td>1</td>
<td>Includes reagents for 100 SNP genotyping reactions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• SNPStart Master Mix</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Control</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mineral oil</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Sample Loading Solution</td>
</tr>
</tbody>
</table>
### Table 2 Required Consumables for Performing Fragment Analysis

<table>
<thead>
<tr>
<th>Item</th>
<th>P/N</th>
<th>QTY</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GenomeLab GeXP Start Kit</td>
<td>A85017</td>
<td>1</td>
<td>Includes reagents for 100 RT and PCR reactions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- RT Buffer 5X</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Reverse Transcriptase</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- PCR Buffer 5X</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- KAN(^{+}) RNA with RI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- DNase/RNase Free H(_2)O</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- DNA Size Standard-400</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Mineral Oil</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- GenomeLab Sample Loading Solution</td>
</tr>
<tr>
<td>GenomeLab GeXP Human Reference Plex Kit</td>
<td>A54657</td>
<td>1</td>
<td>Includes primers and control RNA for 100 RT and PCR reactions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- RT Rev Primer Plex Human ReferencePlex</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- PCR Fwd Primer Plex Human ReferencePlex</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Control RNA Templates Human ReferencePlex</td>
</tr>
<tr>
<td>Thermo-Start Taq DNA Polymerase</td>
<td>A85022</td>
<td>1</td>
<td>Includes Thermo-Start Taq DNA polymerase and MgCl(_2) for 100 PCR reactions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Thermo-Start Taq DNA Polymerase</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 25 mM MgCl(_2)</td>
</tr>
<tr>
<td>GenomeLab Human STR Primer Set</td>
<td>A20100</td>
<td>1</td>
<td>Includes Human STR primer mixtures for 48 reactions.</td>
</tr>
<tr>
<td>Sample Loading Solution (SLS)</td>
<td>608082</td>
<td>1</td>
<td>Sample Loading Solution (SLS), 6.0 mL</td>
</tr>
<tr>
<td>Buffer Plates</td>
<td>609844</td>
<td>Box</td>
<td>Package of 100 flat-bottom polystyrene plates, non sterile, without lids.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Required for use as the CE system separation buffer plate.</td>
</tr>
<tr>
<td>Sample Plates</td>
<td>609801</td>
<td>Box</td>
<td>Package of 25 V-bottom thermal cycler-compatible polypropylene plates with 200 (\mu)L volume capacity. Required for use as the CE system sample plate. 25 Plates/Box</td>
</tr>
</tbody>
</table>
The following table identifies the materials that are required for either Sequence Analysis or Fragment Analysis, but do not come with the product.

### Table 3 Materials Required but not Supplied

<table>
<thead>
<tr>
<th>Item</th>
<th>Sequence Analysis</th>
<th>Fragment Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refrigerated microfuge</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Molecular Biology Grade: sterile dH₂O, 95% (v/v) ethanol/dH₂O, 70% (v/v) ethanol/ dH₂O</td>
<td>√</td>
<td>—</td>
</tr>
<tr>
<td>Sterile tubes - 0.5 mL microfuge tubes, 0.2 mL thin wall thermal cycling tubes or plates</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Thermal cycler with heated lid</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Sample Loading Solution (SLS)</td>
<td>—</td>
<td>√</td>
</tr>
<tr>
<td>Microduster III AccTech, P/N: 58019-538 (VWR)</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Mini Alpha Swab from Texwipe, PN: TX754B (VWR)</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>3M Sodium Acetate pH5.2 - Sigma, Cat. # S7899</td>
<td>√</td>
<td>—</td>
</tr>
<tr>
<td>100mM Na₂-EDTA pH8.0 (500 mM Sigma Cat. # E7889)</td>
<td>√</td>
<td>—</td>
</tr>
<tr>
<td>PCR enzyme and buffer</td>
<td>—</td>
<td>√</td>
</tr>
<tr>
<td>Labeled primers (available from Sigma and IDT or Integrated DNA Technologies)</td>
<td>—</td>
<td>√</td>
</tr>
<tr>
<td>Nuclease-Free H₂O, non-DEPC Treated (Affymetrix 71786 or Thermo Fisher 10977-015)</td>
<td>—</td>
<td>√</td>
</tr>
<tr>
<td>1 M Tris-HCl pH 8.0 (Affymetrix 22638) for gene expression analysis</td>
<td>—</td>
<td>√</td>
</tr>
<tr>
<td>The RNA Storage Solution (Thermo Fisher AM7000) for gene expression analysis</td>
<td>—</td>
<td>√</td>
</tr>
<tr>
<td>AmpliTaq Gold (Thermo Fisher 4311806) for Human STR analysis</td>
<td>—</td>
<td>√</td>
</tr>
<tr>
<td>Interrogation primers, Purified PCR products, Shrimp Alkaline Phosphatase and Exonuclease I for SNP genotyping</td>
<td>—</td>
<td>√</td>
</tr>
</tbody>
</table>
The following table identifies additional equipment and supplies needed.

**Table 4 Equipment and Supplies**

<table>
<thead>
<tr>
<th>Item</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>GenomeLab GeXP Genetic Analysis System</td>
<td>A26572 or A62684</td>
</tr>
<tr>
<td>Aluminum Foil Seal</td>
<td>538619</td>
</tr>
<tr>
<td>8-Well Cap Strips</td>
<td>BioRad TCS-0803 or Corning 3742, 3743</td>
</tr>
<tr>
<td>Pipettors, P10, P20, P100, P200, and P1000</td>
<td></td>
</tr>
<tr>
<td>Aerosol Resistant Tips for P10, P20, P100, P200 and P1000</td>
<td></td>
</tr>
<tr>
<td>Microtube Centrifuge</td>
<td>365603</td>
</tr>
<tr>
<td>Microplate Centrifuge</td>
<td></td>
</tr>
<tr>
<td>Thermocycler with Heated Lid for 96-Well Plates</td>
<td></td>
</tr>
<tr>
<td>Vortex Mixer</td>
<td></td>
</tr>
<tr>
<td>Non-Frost-Free Freezers (-80°C and -20°C)</td>
<td></td>
</tr>
</tbody>
</table>
9.5 Diagnostics

This section provides some common diagnostic procedures you may perform as needed on the GenomeLab GeXP system.

Re-Initializing the System

To re-initialize the system, select Run | Reset in the Run module.

Homing the Plates and/or Gel Pump

To re-establish the position of the plates and/or gel pump:

1. Select Run | Diagnostics in the Run module. The Diagnostics dialog box opens.
2. Select the Home Plate and/or Gel Pump check box.
3. Click OK.
4. Monitor the Tests dialog box and verify that the final results is “Test passed.”
5. Click the Close button.

Viewing PC Settings

To view the computer settings:

1. Select Run | Diagnostics in the Run module. The Diagnostics dialog box opens.
2. Click the PC Settings button. The PC Communication Settings dialog box opens.
3. View the settings the system uses to communicate with the instrument, then exit the dialog box.

Viewing Instrument Status

To view the instrument status:

1. Select Run | Diagnostics in the Run module. The Diagnostics dialog box opens.
2. Click Status.
3. View and/or change the settings in the Run Control Monitor dialog box.
4. Click OK.
5. The dual rail system has a barcode reader. To read the barcode on sample plates, click on Select Item under “Device/System Values” to select Left Barcode: and Right Barcode: from the “Available Information” List. Move them to the “Display Information” list, and then click the OK button. Load the sample plates with barcode by using the “Direct Control | Access Plates...” function. The barcode will be displayed in “Run Control Monitor” within the “Device/System Values” section.

Viewing Optical Scan Data

To view the optical scan data in either the Sequence Analysis or Fragment Analysis module:

1. Select File | Open from the desired analysis module. The Open dialog box opens.
2. Select the Optical Scan Data tab, highlight the desired sample name, then click OK.
3. Verify that the Optical Scan window is displayed.
Monitoring the Baseline

To ensure that the optics are working correctly and that the capillaries are clean, view the baseline after installing a new capillary array, filling with gel for the first time, or performing an optical alignment. The baseline trace should be low and relatively flat.

**NOTE** You must perform the optical alignment procedures prior to monitoring the baseline ("Performing an Optical Alignment" on page 358).

To monitor the baseline:


![Monitor Baseline Dialog Box](image)

**Figure 9.49 Monitor Baseline Dialog Box**

**NOTE** If you select **Autosave** on this dialog box, the system stores baseline data under the Sample Data node (for the selected project) in the Data Manager. If you do not manually end the Monitor Baseline, it collects baseline data until you run a sample plate or until six hours have elapsed from the start of the baseline monitoring process.

2. In the Monitor Baseline dialog box:
   a. Select the **Enable Monitor Baseline** check box.
   b. Click **OK**.

3. Select the Data Monitor tab to view the baseline trace.

To view the baseline trace:

1. Access the desired analysis module.
2. Select **File | Open**.
3. Select the **Sample Data** tab and select the desired baseline data (the baseline data is displayed).

After reviewing the baseline trace, disable **Monitor Baseline**. To do this:

1. Select **Run | Monitor Baseline**.
2. In the Monitor Baseline dialog box:
   a. Select the **Enable Monitor Baseline** check box to clear the check mark.
   b. Click **OK**.